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“Workgroup” AutoCAD & 3ds Max Job Training Center မွ အမွာစာ

ျမန္မာျပည္တြင္ AutoCAD ပညာႏွင့္ ပတ္သက္ျပီး စာအုပ္စာေပ ထြက္ရိွမႈ အလြန္နည္းေနေသးသျဖင့္ သင္တန္းသို႔

မသြားႏိုင္သူမ်ား ႏွင့္ ကိုယ္တုိင္ ေလ့လာလိုသူမ်ား အေနျဖင့္ အခက္ေတြ႕ရေလ့ ရိွပါသည္။ စာအုပ္တစ္အုပ္ ၀ယ္ယူျပီး

ေနရာတိုင္း ယူသြားဖို႔ မျဖစ္ႏိုင္သူမ်ားအတြက္ လည္းေကာင္း၊ စာအုပ္ေစ်းႏႈန္း ပမာဏကုိ စဥ္းစား ရသူမ်ား အတြက္

လည္းေကာင္း မည္သည့္ေနရာေဒသ ေရာက္ေနသည္ ျဖစ္ေစ Online မွ တစ္ဦးကို တစ္ဦး ေပးပုိ႔လိုသူမ်ား

အတြက္လည္းေကာင္း အားလံုးအတြက္ အဆင္ေျပေစရန္ eBook အေနျဖင့္ အခမဲ့ ျဖန္႔ေ၀ေပးရန္ ရည္ရြယ္ခ့ဲျခင္း

ျဖစ္ပါသည္။

အတတ္ပညာ တစ္ခုကုိ သင္ယူလိုေသာ ဆႏၵျပင္းျပပါလ်က္ႏွင့္ လိုအပ္ေသာ အေထာက္အကူ ပစၥည္းမ်ားေၾကာင့္ အားမတန္

မာန္ေလ်ာ့ရေသာ အလားအလာေကာင္းသည့္ ပညာရွင္ အေလာင္းအလ်ာမ်ားအတြက္ ရည္ရြယ္ျပီး Workgroup AutoCAD

& 3ds Max Job Training Center မွ “ပညာလုိသူ ပညာရေစ” ဟူေသာ ေစတနာျဖင့္ အခမဲ့ ျဖန္႔ေ၀ေပးျခင္းလည္း

ျဖစ္ပါသည္။

အေျခခံမွ အဆင့္ျမင့္ AutoCAD ပညာအထိ ေလ့လာလိုသူမ်ားအတြက္ အလြန္အသုံး၀င္သည့္ ဤစာအုပ္ေလးမွာ AutoCAD

Software ကုိ တီထြင္သည့္ Autodesk ကုမၼဏီက AutoCAD 2010 ကုိ သင္တန္းေက်ာင္း လက္စြဲအေနျဖင့္

အသုံးျပဳရန္အတြက္သာ Exam Guide vol- 1 ႏွင့္ vol-2 ဟု စာအုပ္ႏွစ္အုပ္ ထုတ္ေ၀ခဲ့သျဖင့္လည္း ရွားပါးလွသည့္

စာအုပ္ေလး ျဖစ္ပါသည္။ မူလ စာအုပ္အတုိင္း eBook ၌ အပုိင္း ၂ ပုိင္း ပါ၀င္လာမည္ ျဖစ္သလုိ ပူးတြဲပါလာသည့္ Workfiles

မ်ားႏွင့္ ေပါင္းစပ္ ေလ့လာပါမွ ပုိမုိျပည့္စုံသည့္ အဆင့္သုိ႔ ေရာက္ရိွလာမည္ ျဖစ္ျပီး Autodesk မွ ၾကီးမွဴး စစ္ေဆးသည့္

စာေမးပြဲသာမက ICDL CAD စာေမးပြဲ မ်ားကုိပါ ၀င္ေရာက္ေျဖဆို ေအာင္ျမင္နိုင္ရန္ အေထာက္အကူျပဳမည္ ျဖစ္ပါသည္။

အသက္ေမြး၀မ္းေၾကာင္း အတတ္ပညာ တစ္ခုအျဖစ္ AutoCAD ႏွင့္ ဆက္စပ္ေသာ နယ္ပယ္တြင္ တက္စုံရြက္စုံျဖင့္ မိမိတုိ႔၏

အနာဂတ္ကုိ မိမိတို႔ ကုိယ္တုိင္ စိတ္တုိင္းက် ဖန္တီး တည္ေဆာက္နိုင္သူမ်ား ျဖစ္ၾကပါေစဟု ဆႏၵျပဳ ဆုမြန္ေကာင္း

ေတာင္းလုိ္က္ရပါသည္။

ဤစာမူေလးအတြက္ ရရိွခဲ့ေသာ စာမူခ မ်ားကုိ အနာၾကီးေရာဂါ ျပဳစုေစာင့္ေရွာက္ေရးေဖါင္ေဒးရွင္း Leprosyhelp.org သုိ႔

လွဴဒါန္းခ့ဲသည့္ မၾကာမီ ေဒါက္တာဘဲြ႔ပါ ရရိွလာေတာ့မည့္ စာေရးဆရာ ကုိေအာင္ေဇာ္လတ္၏ ေစတနာ

ေမတၱာမ်ားအတြက္လည္း ၾကည္ႏူးမႈ အျပည့္ျဖင့္ သာဓုသုံးၾကိမ္ ေခၚဆိုအပ္ပါသည္။

Workgroup AutoCAD & 3ds Max Job Training Center

(International Computer Driving Licence Approved Test Center )

Rm- 403, Excel Tower Apartment, Gabar Aye Pagoda Rd,

Bahan Township, Yangon,Myanmar.

Ph: 951 559377 Ext: 6413. Email – infor@Workgroupweb.com
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စာေရးသူ၏ အမွာစာ

ကမၻာတစ္၀ွမ္းလံုး လူသိမ်ားျပီး၊ Engineering နယ္ပယ္တြင္ တြင္တြင္က်ယ္က်ယ္ သံုးလာသည့္ AutoCAD ဆုိေသာ CAD

(Computer Aided Design or Computer Aided Drafting) Software ကို 2D& 3D န႕ဲ Drafting မ်ားအတြက္

အေမရိကန္ အေျခစိုက္ Company ျဖစ္ေသာ Autodesk Company က 82 ေႏွာင္းပိုင္းတြင္ အထူးစီမံ ထုတ္လုပ္ခဲ႕ျခင္း

ျဖစ္ပါသည္။ AutoCAD Software သည္ Personal Computer တြင္ Run ျပီး ပထမဆုံး အသုံးျပဳခဲ႕ေသာ CAD system

ျဖစ္ပါသည္။

အေစာပ္ုိင္းကာလက AutoCAD System တြင္ Lines, Polylines, Circles, Arcs န႕ဲ Text စသည္ Objects မ်ားသာ

ပါ၀င္ခဲ႕ျပီး၊ ထို Objects မ်ားျဖင့္သာ Designs မ်ားဖန္တီးခ႕ဲၾကရ ပါသည္။ ေနာက္ပိုင္းတြင္ AutoCAD system ကို

တစ္နွစ္ထက္ တစ္နွစ္ Functions မ်ားျဖည့္စြက္ခ႕ဲၾကျပီး၊ Designs မ်ားအတြက္ အဆင့္ျမင့္ System ျဖစ္ေသာ C++ API

system ျဖင့္ ေပါင္းစပ္တီထြင္ထားသည့္ Solid modeling န႕ဲ 3D tools ကုိျဖည့္စြက္ ႏိုင္ခ႕ဲျခင္းသည္ အေကာင္းဆံုး

ျဖည့္စြက္မွဳ႕ တစ္ခုျဖစ္ခ႕ဲပါသည္။ ထုိသုိ႕ Versions မ်ားျမွင့္တင္ ထုတ္လာရင္း၊ ယခု AutoCAD software 2010 version

ကုိထုတ္လုပ္ျဖန္႕ခ်ီ ေပးႏိုင္ခ႕ဲျပီ ျဖစ္သည္။ ထို Software ကုိျဖန္႕ခ်ီလိုက္သည္ႏွင့္ တစ္ျပိဳင္နက္တည္း Autodesk Company

က AutoCAD Software 2010 ကို ေလ့လာသူမ်ားအတြက္ အေထာက္အကူျပဳေစရန္ Learning AutoCAD 2010 and

AutoCAD LT 2010 Autodesk Official Training Guide ဆုိေသာ နာမည္ျဖင့္ Guide Book ကုိပါ ေရးသား

ထုတ္ေ၀ေပးခ႕ဲပါသည္။ Autodesk Company ကၾကီးမွဴး ဖြင့္လွစ္ထားေသာ Authorized Training Center (ATC®) ႏွင့္

အျခားေသာ Training Classroom မ်ား၌လည္း ဤစာအုပ္တြင္ ပါ၀င္ေသာ Courses မ်ားအတိုင္း သင္ၾကားေပး

ေနၾကျခင္းျဖစ္ပါသည္။ ျမန္မာႏိုင္ငံမွ AutoCAD ပညာရပ္ျဖင့္ အသက္ေမြး၀မ္းေက်ာင္း ျပဳလိုသူမ်ား၊ တုိင္းတစ္ပါးသုိ႕

AutoCAD ပညာရပ္ျဖင့္ သြားေရာက္ အလုပ္လုပ္ကိုင္ရန္ ျပင္ဆင္ေနသူမ်ားႏွင့္ AutoCAD ပညာရပ္ကုိ စိတ္ပါ၀င္စားျပီး

သင္တန္းတက္ရန္ အခက္ခဲ ရိွေသာေက်ာင္းသားမ်ား အတြက္ အေထာက္အကူ ျပဳေစရန္ ရည္ရြယ္ျပီး စာေရးသူ အေနျဖင့္

မူရင္းစာအုပ္ကုိ အနီးစပ္ဆံုး ဘာသာျပန္ ေရးသားျပဳစုေပး လိုက္ပါ သည္။

ဤစာအုပ္ ျဖစ္ေျမာက္ေရးအတြက္ အဖက္ဖက္မွ ပံ႕ပိုးကူညီ ေပးခဲ႕ေသာ ရန္ကုန္ျမိဳ႕၊ “Workgroup” AutoCAD & 3ds Max

Job Training Center / ( Mutdfan.com ၏ အယ္ဒီတာခ်ဳပ္) ဦးေဇာ္လြင္၀င္း ႏွင့္ ဇနီး ေဒၚဥမၼာေအာင္၊ စာေရးသူကုိ

AutoCAD ဆိုေသာ ပညာရပ္ျဖင့္ စတင္မိတ္ဆက္ ေပးခ႕ဲသည့္ စာေရးသူ၏ လက္ဦးဆရာျဖစ္ေသာ ကိုၾကီး ဆန္းလင္းထြန္း၊

AutoCAD ႏွင့္ပတ္သက္ျပီး စိတ္ရွည္လက္ရွည္ သင္ၾကားျပသေပးေသာ Moscow State University of Rainway

Engineering တကၠသုိလ္၊ CAD Transportation Structures and Construction ဌာနမွ ကထိက C.H.Hazarenko ႏွင့္

ေက်းဇူးရွင္ မိဘႏွစ္ပါး တို႕ကို အထူးေက်းဇူးတင္ေၾကာင္း ေျပာၾကားရင္း၊ ေလ့လာသူမ်ား အေနျဖင့္ ရည္မွန္းခ်က္ ပန္းတိုင္ကုိ

အေရာက္ ေလွ်ာက္လွမ္းနိုင္ၾကပါေစလို႕ ဆုေတာင္းေပးလိုက္ပါသည္။

ေအာင္ေဇာ္လတ္ (Master of Engineering in Science and Production Engineering)

Moscow State University Of Railway Engineering



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

4

Contents

Introduction

Chapter 1: Taking the AutoCAD Tour

Lesson: Navigating the Working Environment

Setting the Workspace

Keyboard Input

User Interface Layout

About Shortcut Menus

More AutoCAD-Specific Interface Tools

Lesson: Working with Files

Working with Files

Lesson: Displaying Objects

Display Tools

Pan

Zoom Realtime

Zoom Command Options

Wheel Mouse Features

Regen

Exercise: Zoom and Pan in the Drawing

Exercise: Hands-On Tour

Chapter Summary

Chapter 2: Creating Basic Drawings

Lesson: Inputting Data



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

5

About the Command Line

About the Coordinate System

About Dynamic Input

Using the Dynamic Input Interface

Using Direct Distance Entry

Exercise: Input Data

Lesson: Creating Basic Objects

Line Command

Circle Command

Arc Command

Erase Command

Undo and Redo Commands

Rectangle Command

Polygon Command

Exercise: Create Basic Objects

Lesson: Using Object Snaps

About Object Snap

Object Snaps

Using Object Snap

Exercise: Use Object Snaps

Lesson: Using Polar Tracking and PolarSnap

Using Polar Tracking and PolarSnap

Exercise: Use Polar Tracking and PolarSnap
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Lesson: Using Object Snap Tracking

About Object Snap Tracking

Using Object Snap Tracking

Exercise: Use Object Snap Tracking

Lesson: Working with Units

About Units

Setting Units

Exercise: Use Architectural Units

Exercise: Use Surveyor's Units

Challenge Exercise: Architectural

Challenge Exercise: Mechanical

Chapter Summary

Chapter 3: Manipulating Objects

Lesson: Selecting Objects in the Drawing

Using a Window to Select Objects

Object Selection with Grips

Select Objects Options

Exercise: Select Objects

Lesson: Changing an Object's Position

Moving Objects

Exercise: Move Objects

Lesson: Creating New Objects from Existing Objects

Copying Objects
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Exercise: Copy Objects

Lesson: Changing the Angle of an Object's Position

Rotating Objects

Exercise: Rotate Objects

Lesson: Creating a Mirror Image of Existing Objects

Mirroring Objects

Exercise: Mirror Objects in the Drawing

Lesson: Creating Object Patterns

Creating an Array of Objects

Exercise: Array Objects in the Drawing

Lesson: Changing an Object's Size

Scaling Objects

Exercise: Scale Objects Using the Copy Option

Challenge Exercise: Grips

Challenge Exercise: Architectural

Challenge Exercise: Mechanical

Chapter Summary

Chapter 4: Drawing Organization and Inquiry Commands

Lesson: Using Layers

Organizing Objects with Layers

Default Layer

Layer Tools
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Exercise: Work with Layers

Lesson: Changing Object Properties

About Object Properties

ByLayer Property

Changing Object Properties

Exercise: Change Object Properties

Lesson: Quick Properties

About Quick Properties

Using Quick Properties

Exercise: Use Quick Properties

Lesson: Matching Object Properties

Matching an Object's Properties

Exercise: Match Object Properties

Lesson: Using the Properties Palette

Using the Properties Palette

Exercise: Manipulate Object Properties

Lesson: Using Linetypes

About Linetypes

Adding Linetypes to Your Drawing

Exercise: Use Linetypes

Lesson: Using Inquiry Commands

About Measuring

Using Measure Tools
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Obtaining Object Information

Exercise: Obtain Geometric Information

Exercise: Measure Objects

Challenge Exercise: Architectural

Challenge Exercise: Mechanical

Chapter Summary

Chapter 5: Altering Objects

Lesson: Trimming and Extending Objects to Defined Boundaries

Using the Trim and Extend Commands

Exercise: Trim and Extend Objects

Lesson: Creating Parallel and Offset Geometry

Offsetting Objects

Exercise: Create Parallel and Offset Geometry

Lesson: Joining Objects

Joining Objects

Exercise: Join Objects

Lesson: Breaking an Object into Two Objects

Breaking Objects

Exercise: Break Objects

Lesson: Applying a Radius Corner to Two Objects

Creating Fillets

Exercise: Create a Filleted Corner

Lesson: Creating an Angled Corner Between Two Objects
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Creating Chamfers

Exercise: Create a Chamfered Corner

Lesson: Changing Part of an Object's Shape

Stretching Objects

Exercise: Stretch Objects

Challenge Exercise: Architectural

Challenge Exercise: Mechanical

Chapter Summary

Introduction

Drawing မ်ားေရးဆြဲရန္အတြက္ အဓိက စီမံျပဳလုပ္ထားေသာ Engineer Software ျဖစ္တ႕ဲ AutoCAD Software ကို

၁၉၈၂ခုနွစ္ကေန စတင္စီမံျပဳလုပ္ခ႕ဲျပီး၊ AutoCAD Software ကုိ တစ္နွစ္ထက္တစ္နွစ္ Functions မ်ားပိုမို

စုံလင္လာေအာင္ မြမ္းမံျဖည့္စြက္ ထုတ္လုပ္လာခ႕ဲၾကပါသည္။ ယခု Autodesk companyက AutoCAD 2010 Software

ကုိ ၂၀၀၉ခုနွစ္ မတ္လ ၂၄ရက္ေန႕တြင္ စတင္ျဖန္႕ခ်ီႏုိင္ခဲ႕ ျပီျဖစ္ပါသည္။ Autodesk company က AutoCAD Software

2010 ကုိ ေလ့လာရာတြင္ အေထာက္အကူ ျပဳေစရန္ အတြက္ Learning AutoCAD 2010 and AutoCAD LT 2010

Autodesk Official Training Guide ဆုိျပီး Authorized Training Center (ATC®) ႏွင့္ အျခားေသာ Training

Classroom မ်ားအတြက္ ရည္ရြယ္ျပီး ဤစာအုပ္ကုိ ေရးသားထုတ္ေ၀ ေပးလိုက္ပါ သည္။

ဤစာအုပ္ကုိ Instructor မ်ားအတြက္ ရည္ရြယ္ျပီး ေရးသားထုတ္ေ၀ ေပးလိုက္ေသာ္လည္း၊ ေလ့လာလိုသူမ်ား အေနျဖင့္

ဤစာအုပ္ကုိ ဖတ္ရႈ႕ျပီး Self-learning ပုံစံမ်ိဳးျဖင့္ AutoCAD Software 2010 လိုက္ပါ ေလ့လာႏိုင္ပါ သည္။

Introduction အပိုင္းတြင္ ေအာက္ေဖာ္ျပပါ topics မ်ားကို အနည္းငယ္ေဆြးေႏြး တင္ျပသြားလုိပါသည္။

၎တုိ႕မွာ -

 Course objectives

 Prerequisites

 Using this guide

 Default installation

 CD contents

 Completing the exercises

 Settings for the exercises

 Imperial and metric datasets
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Course Objectives

ဤ Course ေလ့လာျပီးသြားေသာ သူမ်ားအေနျဖင့္ -

 Files မ်ား ဖြင့္/ပိတ္ျခင္း၊ Zoom command ကုိအသံုးျပဳျပီး drawings မ်ားကို Screen တြင္ လိုအပ္သလုိ

ခ်႕ဲ/ခ်ဳ႕ံျခင္း၊ Interface ကုိရင္နီွးကၽြမ္း၀င္လာေစရန္။

 Units မ်ားအသုံးျပဳျခင္း၊ Function keys မ်ား၊ coordinate systems အေၾကာင္း၊ basic objects မ်ားဖန္တီးျခင္း၊

object snaps ,object snap tracking, polar tracking, PolarSnap နဲ႕ မတူညီေသာ နည္းလမ္းမ်ားျဖင့္ data

မ်ား Input လုပ္တတ္လာေစရန္။

 Select လုပ္ျခင္း၊ objects ၏ properties မ်ားကို Modify လုပ္ျခင္း၊ Move, Copy, Rotate,Mirror, နဲ႕ Array

commands မ်ားအသံုးျပဳတတ္လာေစရန္။

 Layers မ်ား ဖန္တီးျခင္းႏွင့္ ထိန္းခ်ဳပ္ျခင္း၊ linetypes မ်ားအသံုးျပဳျခင္း၊ drawing အတြင္းမွ objects မ်ား၏

Informations မ်ားကို obtain လုပ္တတ္လာေစရန္။

 Size, Shape, Orientation, Extend, Offset, Join, န႕ဲ Trim commands မ်ား အသုံးျပဳျပီး Objects မ်ားကို

Modify လုပ္တတ္လာေစရန္။

 Layouts မ်ားဖန္တီးျခင္း၊ Layout ေပၚတြင္ Viewport မ်ား ဖန္တီးတတ္လာေစရန္။

 Multiline နဲ႕ Single line text မ်ားအသံုးျပဳျပီး၊ annotation objects မ်ားဖန္တီးျခင္းႏွင့္ Edit လုပ္တတ္လာ

ေစရန္။

 Dimensions န႕ဲ dimension styles မ်ားဖန္တီးျခင္းႏွင့္ ထိန္းခ်ဳပ္ျပဳျပင္တတ္လာေစရန္။

 Drawings မ်ားရုပ္လံုးၾကြလာေစရန္ hatch patterns န႕ဲ gradient fills မ်ားအသံုးျပဳတတ္လာေစရန္။

 Blocks မ်ားဖန္တီးကာ Insert command ကုိအသုံုးျပဳျပီး drawings မ်ားတြင္ ျပန္လည္အသုံးခ်ျခင္း။ထို႕အျပင္

DesignCenter န႕ဲ tool palettes မွ Blocks မ်ား designs မ်ားကို drawings မ်ားအတြင္းတြင္ ျပန္လည္

အသုံးခ်တတ္ လာေစရန္။

 Polyline object ကိုအသံုးျပဳျပီး multiple segmented မ်ားဖန္တီးျခင္း၊ splines န႕ဲ ellipses objects

မ်ားအသုံးျပဳျပီး မ်ဥ္းခုံး/မ်ဥ္းေကြးမ်ား ဖန္တီးျခင္း၊ drawing အတြင္းတြင္ ဇယားမ်ားထည့္ျခင္း တို႕ကို

နားလည္သေဘာေပါက္ လာေစရန္။

 layouts န႕ဲ model space မ်ားအသံုးျပဳျပီး မိမိတို႕ ဖန္တီးထားေသာ design ကုိ Plot လုပ္တတ္လာေစရန္။

Prerequisites

ဤ Guide တြင္ စတင္ေလ့လာသူမ်ား အေနျဖင့္ AutoCAD (သို႕မဟုတ္) AutoCAD LT တြင္ 2D drawing, design, န႕ဲ

drafting မ်ားကုိ professional က်က်ေရးဆြဲႏုိင္ရန္ အဓိကက်ေသာ commands မ်ားကို သိရိွလာေစရန္ အဓိက ရည္ရြယ္

ထားပါသည္။ Computer- aided design (CAD) အေတြ႕အၾကံဳ အနည္းငယ္ လိုအပ္ပါသည္။

လုိက္ပါေလ့က်င့္သူမ်ား အတြက္ အၾကံဳျပဳခ်က္ -
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Microsoft® Windows® XP, or Microsoft® Vista®.

Drafting နဲ႕ design အေတြ႕အၾကံဳ အနည္းငယ္ လိုအပ္ပါသည္။

Using This Guide

ဤစာအုပ္တြင္ ပါ၀င္ေသာ သင္ခန္းစာမ်ားမွာ တစ္ခုနွင့္ တစ္ခု ဆက္စပ္မွဳ႕မ်ား ရိွေနပါသည္။ Chapter တစ္ခုစီ တြင္ -

သင္ခန္းစာ- အမ်ားအားျဖင့္ Chapter တစ္ခုတြင္ သင္ခန္းစာ နွစ္ခုနွင့္ နွစ္ခုအထက္ ပါ၀င္ပါသည္။

ေလ့က်င့္ခန္း - သင္ခန္းစာတစ္ခုတုိင္းတြင္၊ ထုိသင္ခန္းစာႏွင့္ ပတ္သက္ေသာ လက္ေတြ႕ေလ့က်င့္ခန္း မ်ားပါ၀င္ပါသည္။

ေလ့က်င့္ခန္း တစ္ခုခ်င္းစီကုိလည္း တစ္ဆင့္ျခင္း အေသးစိတ္ အစီလုိက္ ေဖာ္ျပေပး ထားပါသည္။

Default Installation

ဤGuide တြင္ AutoCAD (သုိ႕မဟုတ္) AutoCAD LT ကုိ Installed လုပ္ထားျပီး default installation ကုိသာအသံုးျပဳရန္

အၾကံဳျပဳထားပါသည္။ ဤ course ကုိေလ့လာသူမ်ားအေနျဖင့္ workspace ကုိ active လုပ္ေသာ အခါ 2D Drafting &

Annotation workspace ကိုသာ အသံုးျပဳသင့္ပါသည္။ ထုိအေၾကာင္းကို Chapter 1 တြင္ေလ့လာသြားရမည္ ျဖစ္ပါသည္။

CD Contents

ဤ guide ကုိအသံုးျပဳျပီး စာအုပ္တြင္ တြဲဖက္ပါ၀င္ေသာ data နွင့္ drawings မ်ားကုိ ျပီးျပည့္စုံေစရန္ ျဖည့္စြက္ ေလ့က်င့္

ေရးဆြသဲြားရမည္ ျဖစ္ပါသည္။

Completing the Exercises

ေအာက္ပါ သင္ခန္းစာကုိ ျပီးေျမာက္ေအာင္ စာအုပ္ကို အသံုးျပဳျပီး သင္ခန္းစာမ်ားကို တစ္ဆင့္ခ်င္း လုိက္ပါေလ့က်င့္ျခင္း။
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Settings for the Exercises

Exercise တုိင္းတြင္ ေအာက္ေဖာ္ျပပါ Object snap setting ကုိ active လုပ္ထားရပါမည္။

Exercise တိုင္းနီးပါးတြင္ အသံုးျပဳမည့္ Object snap setting ကုိ Status bar တြင္ Turn on လုပ္ေပးရပါမည္။
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Imperial and Metric Datasets

အခ်ိဳ႕ေသာ သင္ခန္းစာမ်ားကုိ Units ႏွစ္မ်ိဳးျဖင့္ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ Exercise files မ်ား၏ နာမည္တြင္

အသုံးျပဳရမည့္ Units ကိုထည့္သြင္းေဖာ္ျပေပးထားပါသည္။

 I_stair_settings.dwg (imperial) (သုိ႕မဟုတ္) M_stair_settings.dwg (metric) ကုိဖြင့္ပါ။

 အဆိုပါ ေလ့က်င့္ခန္းမ်ား အတြက္ဆိုလွ်င္ ေအာက္တြင္ေဖာ္ျပေပးထားသည့္ ဥပမာအတိုင္း imperial (သုိ႕မဟုတ္)

metric တန္ဖုိး မ်ား ရိုက္ထည့္ေပးရမည္။

 Length အတြက္ 13'2" ရိုက္ထည့္ပါ။

 Length အတြက္ 4038 mm ရိုက္ထည့္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ေလ့က်င့္ခန္းမ်ား အတြက္ဆုိလွ်င္ အတိုင္းအတာ Units မ်ားမလုိအပ္ေပ။

 C_stair_settings.dwg (common) ဖြင့္ပါ။

 အဆိုပါ ေလ့က်င့္ခန္းမ်ားတြင္ တန္ဖိုးမ်ားကုိ ေအာက္ေဖာ္ျပပါအတိုင္း အသံုးျပဳသြားရမည္ ျဖစ္သည္။

 Length အတြက္ 400 ရိုက္ထည့္ပါ။

Chapter 1:Taking the AutoCAD Tour

AutoCAD ရဲ႕ေနာက္ဆုံးဗားရွင္းျဖစ္တ႕ဲ AutoCAD 2010 Software ကုိကၽြမ္းက်င္ပိုင္ႏိုင္ သူတစ္ေယာက္ျဖစ္ လာရန္အတြက္

AutoCAD 2010 ရ႕ဲ Working Environment နဲ႕ Interface Elements အမ်ိဳးအစားေတြကုိ ရင္းနီွးကၽြမ္း၀င္ေအာင္

ပထမဦးဆံုး အေနန႕ဲ ေလ႕လာရပါမည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Main Interface Elements မ်ား၏ အဓိကလုပ္ေဆာင္ခ်က္မ်ားကုိ ကြဲကြျဲပားျပား သိလာေစရန္။

 Drawings မ်ားကုိ Open, Close န႕ဲ Save ျခင္းတို႕ကို နားလည္သေဘာေပါက္လာေစရန္။
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 Zoom နဲ႕ Pan commands ကုိအသုံးျပဳျပီး Drawing အတြင္းမွ Objects မ်ားကို ရႈ႕ေထာင့္အမ်ိဳးမ်ိဳးမွ

ၾကည့္ရႈ႕တတ္လာေစရန္။

Lessong 1:Navigating the Working Environment

ဤသင္ခန္းစာတြင္ Drawings ဖန္တီးမွဳ႕မ်ား မစတင္မီ Users မ်ားအေနျဖင့္ User Interfaceကုိ ရင္းႏီွးကၽြမ္း၀င္ လာေအာင္

အရင္ဆံုး ေလ႕လာသြားရပါမည္။ AutoCAD 2010 software ေလးကုိ စတင္ဖြင့္လိုက္ၾကပါစို႕။

Start ►All Programs ► Autodesk ► AutoCAD 2010 ► AutoCAD 2010 ကို Double Click န႕ဲ AutoCAD software

ကုိဖြင့္လိုက္ပါ။ ထိုအခါ ေအာက္တြင္ ျပထားသည့္ ပုံအတုိင္း Drawing1.dwg နာမည္န႕ဲ Drawing Window ေပၚလာ

ပါလိမ္႕မည္။

Application Menu Drawing area

Quick Access Toolbar Crosshairs

Info Center Command Window

Title Bar Status bar

Ribbon

AutoCAD 2010 2D Drafting & Annotation workspace န႕ဲ ဖြင့္ထားတဲ႕ ျမင္ကြင္းပါ။

၁) Application Menu  New,Save,Save As… etc တုိ႕ကုိလည္း Application Menuမွ လုပ္ေဆာင္ ႏိုင္သည္။
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၂) Quick Access Toolbar Quick Access Toolbar၏ Default ပုံစံတြင္ New, Open, Save, Plot, Undo, Redo

စသည့္ commands မ်ားကုိ ကုိယ္စားျပဳေသာ Iconေလးမ်ား ပါရိွျပီးသား ျဖစ္ေနေပလိမ္႕မည္။ သို႕ေသာ္ မိမိတုိ႕ မၾကာခဏ

အသုံးျပဳေလ႕ရိွေသာ Command Icon မ်ားကုိလည္း ထပ္မံျဖည့္စြက္ ႏိုင္ပါသည္။ အဆုိပါ Toolbar၏ လြတ္ေနေသာ

ေနရာတြင္ right click ႏိွပ္လုိက္ပါက Menu ေလးတစ္ခု ေပၚလာပါလိမ္႕မည္။ ထုိ Menu မွ Customize Quick Access

Toolbar ကို select လုပ္လုိက္ပါက Dialogue Box တစ္ခုေပၚလာပါလိမ္႕မည္။ ထုိ Dialogue Box မွ မိမိတုိ႕ မၾကာခဏ

အသုံးျပဳေလ႕ရိွေသာ command icon ကို drag လုပ္ျပီး Quick Access Toolbarတြင္ Display လုပ္ထားႏိုင္ပါသည္။

၃) Info Center  AutoCAD Software နဲ႕ပတ္သက္ျပီး သိလုိသည္မ်ားကုိ Info Centerက Search boxတြင္

ရိုက္ရွာႏိုင္ပါသည္။

၄) Title Bar  မိမိတုိ႕လက္ရိွ အသံုးျပဳေနေသာ AutoCAD၏ ဗားရွင္းနွင့္ Drawing name ကိုေဖာ္ျပေပးပါသည္။

အကယ္၍ Drawing ကုိနာမည္မေပးရေသးပါက Drawing1.dwg ဟုေဖာ္ျပေပးလိမ္႕မည္။

၅) Ribbon  Workspace တစ္ခုခ်င္းဆီန႕ဲ ဆက္စပ္ေသာ Tools မ်ားပါ၀င္တ႕ဲ panelမ်ား အုပ္စုလိုက္ျဖင့္ စုေပါင္းဖြ႕ဲစည္း

ထားေသာ Special Tool Palette တစ္ခုျဖစ္ပါသည္။

၆) Drawing area  မိမိတို႕ ဖန္တီးမည့္ Drawings မ်ားေပၚေနေသာ Graphics Screen Area ျဖစ္ပါသည္။ Drawing

area တြင္ မိမိတို႕ နွစ္သက္ရာ အရာင္ေျပာင္းလဲ ႏိုင္ေသာ Model Spaceႏွင့္ ပုံထုတ္ရန္ႏွင့္ Templateမ်ား ဖန္တီးရန္

အတြက္ အျဖဴ Layout space ဟူ၍ ႏွစ္မ်ိဳး ပါ၀င္ေနသည္ကုိ ေတြ႕ရမည္။

၇) Crosshairs  ကြန္ပ်ဴတာတြင္ အသုံးျပဳေသာ Mouse pointer သည္ ျမွား သဏၭာန္္ အျဖစ္ရိွေနျပီး၊ AutoCAD Drawing

window တြင္လည္း Cursor အျဖစ္ Crosshairsႏွင့္ Pick box ေပါင္းစည္းထားေသာ အေပါင္းလဏၡာ ပုံစံေလးကုိ

ေတြ႕ရေပမည္။ ထုိအေပါင္းလကၡဏ ပုံစံရိွေသာ အရာသည္ Crosshairs ျဖစ္ပါသည္။ Crosshairs ၏အလယ္တြင္ ရိွေသာ

Pick box ကုိမိမိတုိ႕ နွစ္သက္အရြယ္အစား ေျပာင္းလဲႏိုင္သလို၊ Crosshairs ကုိလည္း ေျပာင္းလဲေပးႏိုင္ပါသည္။

ေျပာင္းလလုိဲလွ်င္ Command line တြင္ Cursorsize ဟုရိုက္ထည့္ျပီး နွစ္သက္ရာ ရြယ္အစားကုိ ေျပာင္းလဲႏိုင္သည္။

Crosshairs အရြယ္အစားကုိ 100 ထားလွ်င္ AutoCAD Drawing window အျပည့္ေတြ႕ျမင္ ရေပမည္။မူလ အရြယ္အစားမွာ

5 ျဖစ္ပါသည္။ Crosshairs အလယ္မွာ ေလးေထာင့္ပုံ Pickbox ကုိလည္း ႏွစ္သက္ရာ အရြယ္အစားသုိ႕

ေျပာင္းလဲႏိုင္ပါသည္။ ေျပာင္းလလဲိုလွ်င္ Command lineတြင္ Pickbox ဟု ရိုက္ထည့္ျပီး ႏွစ္သက္ရာ အရြယ္အစားကို

ေျပာင္းလဲ အသုံးျပဳႏိုင္ပါသည္။

၈) Command Window  မိမိတုိ႕ ဖန္တီးလုိေသာ Drawings မ်ားကို ေရးဆြရဲာတြင္ အသံုးျပဳမည့္ Objectမ်ား၊ AutoCAD

န႕ဲပတ္သက္ေသာ Applications မ်ားကုိ Command windowမွာ ရိုက္ထည့္ေခၚယူ အသံုးျပဳႏိုင္ပါသည္။ (Computer

Application မွ Notepad အစရိွသည္တုိ႕ကုိပင္ Command Window မွ ေခၚယူအသုံးျပဳႏိုင္သလို၊ လက္ရိွ

မိမိတုိ႕ဖန္တီးေနေသာ Drawing window တစ္ခုလံုးကုိပင္ Quit ဟုရိုက္ထည့္ျပီး ပိတ္ႏိုင္ပါသည္။)

၉) Status bar  Status bar တြင္ Crosshairs သြားရာ Coordinate အမွတ္မ်ားကုိ ေဖာ္ျပေပးရံုသာမက၊ မိမိတုိ႕

ဖန္တီးေနေသာ Drawings မ်ားအတြက္ အေထာက္အကူျပဳ Commands မ်ားလည္ တည္ရိွေနသည္။ Status bar ေပၚတြင္

Right click ေထာက္ျပီး၊ AutoCAD Applications Window Setting ကုိလည္း အေျပာင္းအလဲ ျပဳလုပ္ႏိုင္ပါသည္။

Toolbars မ်ားကို ေသာ႕ပုံေလးကုိ နိွပ္ျပီး Lokced ပါခ်ႏိုင္သလုိ၊ Workspace မ်ားကုိလည္း အလြယ္တကူ status bar ေပၚမွ

ေျပာင္းႏိုင္ပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

17

Setting the Workspace

AutoCAD 2010 တြင္ Default workspace မွာ workspace (၄) မ်ိဳးပါ၀င္ပါသည္။ ၎တုိ႕မွာ -

၁) 2D Drafting & Annotation

၂) 3D Modeling

၃) AutoCAD Classic

၄) Initial Setup Workspace တုိ႕ျဖစ္ၾကပါသည္။

AutoCAD 2010၏ Default workspace ပုံမ်ားမွာ ေအာက္ပါအတိုင္း ျဖစ္ပါသည္။

AutoCAD2010ရဲ႕ 2D Drafting & Annotation workspace
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3D Modeling workspace

AutoCAD Classic workspace

AutoCAD 2010 ကိုစဖြင့္ဖြင့္ျပီးခ်င္း ၾကိဳက္နွစ္သက္ရာ Workspace ကုိေျပာင္းလဲ အသုံးျပဳႏိုင္ပါသည္။ 2Dအတြက္

Workspace မွာ 2D Drafting & Annotation န႕ဲ AutoCAD Classic တုိ႕ကုိေရြးခ်ယ္ အသံုးျပဳရပါမည္။ AutoCAD 2010

ကုိပိတ္ျပီး အသစ္ျပန္လည္ ဖြင့္မည္ဆိုပါက ဖြင့္လုိက္ေသာ AuotCAD Workspaceမွာ ေနာက္ဆံုး အသံုးျပဳခ႕ဲေသာ
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workspace ျဖင့္သာ ေတြ႕ျမင္ရမည္ ျဖစ္သည္။ Workspaceမ်ားကုိ ေျပာင္းလဲ အသုံးျပဳလုိပါက AuotCAD window ၏

Status Bar ေပၚညာဖက္ေထာင့္တြင္ သြားေရာက္ ေျပာင္းလဲႏိုင္ပါသည္။

Status Bar ေပၚရိွ workspace ေျပာင္းလဲရမည့္ေနရာ

Note။ ။ Menu Bar  Tool workspace တြင္ နွစ္သက္ရာ Workspace ကုိသြားေရာက္ ေျပာင္းလဲ အသုံးျပဳႏိုင္ပါသည္။

Setting the 2D Drafting & Annotation Workspace

2D Drafting & Annotation Workspace ကုိ ေလ႕လာၾကည့္ၾကပါ။

၁) AutoCAD 2010 ကုိဖြင့္လိုက္ပါ။

၂) Default Drwaing (သို႕မဟုတ္) Quick Access toolbar ေပၚက New ကုိနိွပ္ျပီးလည္း Drawing window တစ္ခုကို

ဖြင့္လွစ္ႏိုင္ပါသည္။

Quick Access toolbar ေပၚက New

၃) Template file ထဲက acad.dwg (imperial) (သုိ႕မဟုတ္) acadiso.dwt (metric) တစ္ခုခုကုိ ေရြးခ်ယ္ႏိုင္ပါ သည္။
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၄)Drawing window ရဲ႕ Status Bar ေပၚ ညာဖက္ေထာင့္တြင္ 2D Drafting & Annotation Workspace ကုိေရြးလုိက္ပါ။

2D Drafting & Annotation Workspace ေရြးခ်ယ္ပုံ

အထက္ပါ နည္းသည္ Startup system variable value 0 ျဖင့္ စတင္ေသာ နည္းလမ္းျဖစ္သည္။ အသံုးမ်ားေသာ System

variable value 1 ျဖင့္ New Drawings ကို ေလ႕လာၾကည့္ရေအာင္။

၁) AutoCAD 2010 ကုိ Default အတုိင္းဖြင့္လိုက္ပါ။

၂) ျပီးလွ်င္ AutoCAD window ရဲ႕ command line တြင္ startup ဟုရိုက္လိုက္ပါ။

၃) Starup(0): ဟုေပၚလာပါလိမ္႕မည္။ system variable value ကုိ (1) ဟုရိုက္ထည့္လုိက္ျပီး Drawing window ကို

ပိတ္လိုက္ပါ။

၄) ဖြင့္ဖြင့္ျပီးခ်င္းတြင္ Creat New Drawing window box ေလးေပၚလာမည္။ ထို box တြင္ (၁)Start from scratch (၂)

Use Template (၃) Use a Wizard ဟုေအာက္ပါ ပုံအတုိင္း သုံးမ်ိဳးပါ၀င္ေနမည္ ျဖစ္သည္။ ထုိ၃မ်ိဳးထဲမွ Start from

scratch က matric ကို အသံုးျပဳၾကည့္ ၾကပါစို႕။ Ok ကုိနိွပ္ျပီးသည္နွင့္ New Drawing ကုိ စတင္ႏိုင္ျပီ ျဖစ္သည္။
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၅) ျပီးလွ်င္ အထက္ပါအတုိင္း Workspaceကုိ ေရြးခ်ယ္ႏိုင္ပါသည္။

Keyboard Input

မိမိတုိ႕သြားလိုေသာ အပိုင္းကုိ Mouse ျဖင့္တစ္ဆင့္ခ်င္း သြားေနစရာမလိုပဲ keyboardမွ keystrokes မ်ားကုိ အလြယ္

တကူႏိွပ္ျပီး ျမန္ျမန္ဆန္ဆန္ သြားႏိုင္ေအာင္ ေလ႕လာၾကည့္ပါ။

Special keys

AutoCAD software ရဲ႕ Special keys တစ္ခ်ိဳ႕ကေတာ႕ ေအာက္ပါအတုိင္းျဖစ္သည္။

ESC – Drawing windowတြင္ မိမိတုိ႕ လက္ရိွ မိမိတုိ႕ Drawings ဖန္တီးေနေသာ အခ်ိန္တြင္ အသုံးမျပဳလိုေသာ

commands မ်ားမွားယြင္း ေခၚမိပါက Esc ႏိွပ္ျပီး Cancel လုပ္ႏိုင္ပါသည္။

ENTER – Commands တစ္ခုအသံုးျပဳျပီးုတိုင္း မိမိအသုံးျပဳေသာ command ဆံုးလိုလွ်င္ Enter ႏိွပ္ျပီး အသံုးျပဳ ႏိုင္ပါသည္။

SPACEBAR – ENTER command ျဖင့္လုပ္ေဆာင္ခ်က္ တူညီပါသည္။

UP DOWN ARROW - မိမိ အသံုးျပဳျပီးေသာ commandကို ျပန္ေခၚလိုပါက command lineတြင္ UP DOWN ARROW key

အသုံးျပဳျပီး ျပန္လည္ေခၚႏိုင္ပါသည္။

TAB – Dialog box တစ္ခုမွ တစ္ခုကုိ ေျပာင္းလိုပါက TAB key ႏိွပ္ျပီး လ်င္ျမန္စြာ ေရြ႕ေျပာင္းႏိုင္ပါသည္။ သုိ႕ေသာ္ TAB

အသုံးျပဳကာ ေရြ႕ျပီးတုိင္း Enter ကုိအထူးသတိျပဳျပီး နိွပ္ပါ။

Function keys
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Option အက်ိဳးသက္ေရာက္မွဳ႕

F1 Displays Help

F2 Text Window (ON/OFF)

F3 OSNAP (ON/OFF)

F4 TABMODE (ON/OFF)

F5 ISOPLANE (ON/OFF)

F6 UCSDETECT (ON/OFF) (Not available in AutoCAD LT)

F7 GRIDMODE (ON/OFF)

F8 ORTHOMODE (ON/OFF)

F9 SNAPMODE (ON/OFF)

F10 Polar Tracking (ON/OFF)

F11 Object Snap Tracking (ON/OFF)

F12 Dynamic Input (ON/OFF)

Keyboard Shortcut Keys အက်ိဳးသက္ေရာက္မွဳ႕

Ctrl+1 Properties

Ctrl+2 AutoCAD Design Center

Ctrl+3 Tool Palettes

Ctrl+4 Sheet Set Manager

Ctrl+5 Sheet Set Manager

Ctrl+6 DB connect Manager

Ctrl+7 Markup Set Manager

Ctrl+8 QuickCalc

Ctrl+9 Close Command Line
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Ctrl+0 Full Screen

Ctrl+A Select all

Ctrl+B Snap Mode(ON/OFF)

Ctrl+C Copy

Ctrl+D UCSDETECT

Ctrl+E ISOPLANE

Ctrl+F Object Snap (ON/OFF)

Ctrl+G GRIDMODE (ON/OFF)

Ctrl+H Pickstyle

Ctrl+I Auto Save to

Ctrl+J Execute Last Command

Ctrl+K Hyperlink

Ctrl+L Ortho (ON/OFF)

Ctrl+N New

Ctrl+M New

Ctrl+O Open

Ctrl+P Plot

Ctrl+Q Quit

Ctrl+S Save

Ctrl+T Toggles Tablet mode

Ctrl+U Polar mode(ON/OFF)

Ctrl+V Paste

Ctrl+W Object Snap mode (ON/OFF)
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Ctrl+X Cute

Ctrl+Y Redo

Ctrl+Z Undo

User Interface Layout

AuotCAD 2010ရ႕ဲ User interface မွာဆိုရင္ Ribbon Pannel, Menus, Toolbars စသည့္ အျခားေသာ applications

windows မ်ားျဖင့္ ဖြဲ႕စည္းထားပါသည္။ ထိုက႕ဲသုိ႕ အျခားေသာ Applications windows မ်ားကုိ အသုံးျပဳဖူးသူမ်ား အတြက္

Interface elements မ်ားသည္ စိမ္းေနမည္ မဟုတ္ေပ။ မည္သုိ႕ပင္ ျဖစ္ေစကာမူ Interface တစ္ခုလံုးတြင္ အားလံုး၏

အသက္သည္ Command lineႏွင့္ Status bar ပင္ျဖစ္သည္။

Ribbon Pannel Defined

Ribbon Pannelသည္ workspace တစ္ခုခ်င္းဆီန႕ဲ ဆက္စပ္ေသာ Toolsန႕ဲ Control လုပ္ႏိုင္ေသာ အရာမ်ား ပါ၀င္သည့္

special tool palette တစ္ခုျဖစ္ပါသည္။ ဥပမာ - 2D Drafting & Annotation Workspace ရ႕ဲ Ribbon ကို အသံုးျပဳမယ္

ဆုိပါစို႕။ ထုိ Ribbon Pannelတြင္ 2D Drawings, Dimensions, Annotation တို႕န႕ဲ ပတ္သက္ေသာ Toolsမ်ားသာ

ပါ၀င္ေနမွာ ျဖစ္ျပီး၊ 3D Geometry ဖန္တီးမည့္ Tools မ်ား ပါ၀င္ေနမည္ မဟုတ္ေပ။

Ribbon Pannel ကိုအသံုးျပဳျခင္း အားျဖင့္ မိမိဖန္တီးေနေသာ Drawings window တြင္ ribbon အတြက္ ေနရာပိုမို

ေပးရေသာ္လည္း၊ မိမိဖန္တီးေနေသာ Drawings န႕ဲပတ္သက္ေသာ Tools မ်ားကို အလြယ္တကူ လ်င္ျမန္စြာ လိုအပ္သလုိ

ထိန္းခ်ဳပ္အသံုးျပဳ ႏိုင္မည္ျဖစ္သည္။

Ribbon Controls

AutoCAD 2010 ကိုစတင္ဖြင့္ လုိက္ျပီ ဆုိသည္နွင့္ Ribbon Pannel သည္ 2D Drafting & Annotation (သုိ႕မဟုတ္) 3D

Modeling workspace ၂မ်ိဳးလုံးတြင္ နဂိုပါ၀င္ျပီးသား ျဖစ္ေနေပလိမ္႕မည္။ အဆုိပါ Ribbon tab တြင္ သက္ဆုိင္ရာ

Workspace ျဖင့္ဆက္စပ္ေသာ tabs မ်ားပါ၀င္ေနေပလိမ္႕မည္။ Ribbon panelတြင္ commands အမ်ိဳးအစားလိုက္

ဖြဲ႕စည္းထားေသာ tabs မ်ားပါ၀င္ေနျပီး၊ ထုိtabs မ်ားသည္ Ribbon panel တြင္ အုပ္စုလုိက္ သီးသန္႕တစ္ကန္႕စီ

တည္ရိွေနသည္ကို ေတြ႕ရမည္။ ထို tabs မ်ားတြင္ ဆက္စပ္ေနေသာ tools မ်ားပါ၀င္ဖြ႕ဲစည္း ထားသည့္ panel

တစ္ခုစီပါ၀င္သည္။ Ribbon panel ၏ လြတ္ေနေသာ အပိုင္းတြင္ Right-click ေထာက္ကာ Ribbon panel ကိုေဖ်ာက္ျခင္း

(သုိ႕မဟုတ္) ေဖာ္ျခင္း ျပဳလုပ္ႏိုင္ပါသည္။ (command line တြင္ ribbonclose ဟုရိုက္၍လည္း Ribbon panel ကုိပိတ္ႏိုင္

ပါသည္။)
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Ribbon panel တြင္ 2D drawing, adding text (သို႕မဟုတ္) adding dimensions စသည္တို႕ကုိ အုပ္စုလိုက္ တစ္ကန္႕စီ

tabs အလုိက္ တစ္ကန္႕စီ ခြထဲားသည္။ တစ္ခ်ိဳ႕ေသာ tabsမ်ား၏ pannelတြင္ တည္ရိွေနေသာ tools မ်ားကုိ Down arrow

ႏိွပ္ကာ အေသးစိတ္ ထပ္မံၾကည့္ရႈ႕ႏိုင္ပါသည္။

Ribbon tabs ရိွ tab တစ္ခုခ်င္းစီ၏ panelမ်ား၊ toolsမ်ားကုိ ေအာက္ပါပုံတြင္ ရွင္းရွင္းလင္းလင္း ၾကည့္ရႈ႕ ႏိုင္ပါသည္။

Tabs ဆက္စပ္ေနေသာ toolsမ်ား ပါ၀င္သည့္ panelကုိ နာမည္တစ္ခုစီျဖင့္ ခြဲျခားေပးထားျခင္း။

Panel ဆက္စပ္ေနေသာ tools မ်ားပါ၀င္ ဖြဲ႕စည္းထားေသာ အုပ္စု။

More tools Panelမ်ား၏ ေအာက္တြင္ Down arrow ကိုႏိွပ္ကာ tools မ်ားကို ထပ္မံေရြးခ်ယ္ အသံုးျပဳ ႏိုင္သည္။

Add or Remove Tabs

Ribbon၏ လြတ္ေနေသာ ေနရာတစ္ေနရာတြင္ Right click ေထာက္ကာ Ribbon tabsတြင္ မိမိေဖ်ာက္ထား လိုေသာ

(သုိ႕မဟုတ္) ေဖာ္ထားလိုေသာ tabsမ်ား၊ panelမ်ားကုိ စိတ္ၾကိဳက္ျပဳလုပ္ႏိုင္ပါသည္။ ေအာက္ပါ ပုံကုိၾကည့္ကာ

ေဖာ္လိုေသာ (သုိ႕မဟုတ္) ေဖ်ာက္ထားလိုေသာ tabs ႏွင့္ panels မ်ားကို အလြယ္တကူ လ်င္ျမန္စြာ left click

ေလးတစ္ခ်က္ျဖင့္ ticket ေလးေပးကာ ေဖာ္ႏိုင္၊ ေဖ်ာက္ႏိုင္ပါသည္။

Application Menu
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Application menu မွ Drawings အသစ္မ်ား ဖန္တီးျခင္း (New)၊ ဖန္တီးျပီးသား Drawings မ်ားကိုဖြင့္ျခင္း (Open)၊

ဖန္တီးျပီးသား Drawingsမ်ားကုိ သိမ္းဆည္းျခင္း (Save)၊ မိမိတို႕ ဖန္တီးျပီးသား Drawings မ်ားကိုထုတ္ျခင္း (Print)

စသည့္ commands မ်ားကို အသုံးျပဳႏိုင္ပါသည္။ အဆိုပါ commands မ်ားကုိ Application menu မွအသံုးျပဳပါက

command တစ္ခုခ်င္းစီ၏ အေသးစိတ္ အခ်က္အလက္မ်ားကုိ Submenu တြင္ေဖာ္ျပ ေပးထားပါသည္။

Application Menu

Panels

AutoCAD 2010 တြင္အသုံးျပဳေနေသာ Ribbon panel ၌ ဆက္စပ္မွဳ႕ ရိွေသာ commands မ်ားစုစည္းပါ၀င္ေသာ panels

မ်ားအုပ္စုလုိက္ tab တစ္ခုစီတြင္ တည္ရိွေနပါသည္။ အဆိုပါ panel မွမိမိတို႕ အသုံးျပဳလုိေသာ commands မ်ား၏ icon ကို

တစ္ခ်က္ click လိုက္ယုံျဖင့္ လြယ္ကူစြာ အသုံးျပဳႏိုင္ပါသည္။ Panels တိုင္းတြင္ ဆက္စပ္လ်က္ရိွေသာ tools မ်ားသာ

ပါ၀င္ေနမည္ျဖစ္သည္။

ေလ႕လာသူမ်ား အေနျဖင့္ 2D Drafting & Annotation workspace ကို အသံုးျပဳမည္ဆိုပါစို႕။ Status barမွ 2D Drafting

& Annotation workspace ကိုေရြးခ်ယ္လိုက္သည္နွင့္ Drawings area ၏အထက္တြင္ 2D Drafting & & Annotation

workspace ျဖင့္ သက္ဆိုင္ေသာ Panels မ်ားသည္ သတ္မွတ္စံပုံစံအတိုင္း ေရျပင္ညီတည္ရိွေန သည္ကို

ေတြ႕ျမင္ရေပမည္။ Panel တြင္ပါရိွေသာ tools မ်ားကို Ribbon panel တြင္အနည္းငယ္သာ ေဖာ္ျပထား

သည္ကုိေတြ႕ရမည္။ မိမိအမ်ားဆုံး အသုံးျပဳေလ႕ရိွေသာ commands မ်ားကုိ အလြယ္တကူ အသံုးျပဳႏိုင္ရန္ Ribbon panel

တြင္အျမဲတေစ ေဖာ္ျပထားလုိပါက မိမိတို႕ စိတ္ၾကိဳက္ေရြ႕ေျပာင္း ႏိုင္ပါသည္။ ေရြ႕ေျပာင္းလိုေသာ commands ပါ၀င္သည့္

panelကို mouse ျဖင့္ေထာက္လုိက္ပါက Drawing area သို႕ အကန္႕ေလးတစ္ကန္႕ ေပၚလာမည္ျဖစ္ျပီး၊ ထုိေပၚလာေသာ

အကန္႕အတြင္းမွ commands မ်ားကုိ mouse ျဖင့္Drag လုပ္ကာ Ribbon panel သုိ႕ ေျပာင္းေရြ႕ႏိုင္ပါသည္။
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Panel Visibility

Panels မ်ားကို Ribbon tab တြင္ မိမိတုိ႕စိတ္ၾကိဳက္ Remove (သုိ႕မဟုတ္) Diplay လုပ္ႏိုင္ပါသည္။ Panel ၏

လြတ္ေနေသာ ေနရာတစ္ေနရာကို Right-click ေထာက္လိုက္ပါ။ Tabs Panels ပါေသာ Submenu ေလးတစ္ခု

ေပၚလာပါလိမ္႕မည္။ ထို Submenu မွ panel ကိုသြားျပိး မိမိ Remove (သို႕မဟုတ္) Display လုပ္လုိေသာ panel ကို

Select လုပ္ကာ အလြယ္တကူ Remove (သို႕မဟုတ္) Display ျပဳလုပ္ႏိုင္ပါသည္။ ဥပမာ - Draw panel ကုိ Ribbon tabs

မွ Remove လုပ္သည္ကုိ ေအာက္ပါပုံတြင္ ေလ႕လာႏိုင္ပါသည္။

Draw panel ကို Ribbon tab မွ remove လုပ္ျခင္း

Panel and Tools Visibility

အခ်ိဳ႕ေသာ Panel၌ ညာဖက္ေအာက္ေထာင့္ တြင္တည္ရိွေသာ Down arrow ေလးကုိ click လုပ္သည္နွင့္

ဆက္စပ္လ်က္ရိွေသာ tools မ်ား ပါ၀င္သည့္ Panel ခဲြေလး က်လာသည္ကို ေတြ႕ရေပမည္။ ထုိသို႕ က်လာေသာ Panel

ခြဲေလးသည္ Mouse Pointer ေလးေရြ႕လုိက္သည္နွင့္ ျပန္လည္ ေပ်ာက္ကြယ္ သြားမည္ကို ေတြ႕ရေပလိမ္႕မည္။ ထိုသုိ႕

မေပ်ာက္သြားေအာင္ ထုိ Panel ခြဲေလး၏ ဘယ္ဖက္ေအာက္နားတြင္ ရိွေသာ thumbtack (ပင္အပ္ သဏၭာန္) ေလးကုိ click

လိုက္ပါက Mouse Pointer ေရြ႕လုိက္ေသာ္ျငားလည္း ထုိ Panel ခြဲေလးသည္ ေပ်ာက္ကြယ္သြားမည္ မဟုတ္ပဲ thumbtack

(ပင္အပ္ သ႑ာန္)ကုိ မျဖဳတ္မခ်င္း ေပၚေနမည္ ျဖစ္သည္။ ေအာက္ပါပုံတြင္ ဆက္လက္ေလ႕လာ နိုင္ပါသည္။
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Status Bar

Status barသည္ Drawing window ရဲ႕ေအာက္ဆုံးတြင္ တည္ရိွေနေသာ Bar ျဖစ္သည္။ ထိုBar၏ ဘယ္ဖက္ အစြန္ဆံုးတြင္

Drawing မ်ားဖန္တီးခ်ိန္ ေရြ႕ရွားေနမည့္ Crosshairs ၏ X,Y,Z Coordinate အမွတ္မ်ားကုိ ေဖာ္ျပေပးသည္။ Coordinate

ေဖာ္ျပေပးေနေသာ ေနရာကုိ clickျပီး ON/OFF လုပ္ႏိုင္ပါသည္။

Coordinate Display

ထုိ Coordinate Display ၏ေဘးတြင္ ကပ္လ်က္ရိွေနေသာ Buttons မ်ားသည္ Drafting Setting ျဖစ္ပါသည္။ ထို

Settings သည္ မိမိတုိ႕ဖန္တီးေနေသာ Drawings မ်ားကို အေထာက္အကူျပဳ ေပးေသာ Setting မ်ားျဖစ္ပါသည္။ (အဆုိပါ

Settings မွ Buttons မ်ားကုိ Shortcut keys & Functions key မ်ားျဖင့္ အသံုးျပဳပုံကုိ အထက္တြင္ တင္ျပ ျပီးျဖစ္ပါသည္။)

Drafting Settings

Status Bar၏ ညာဖက္အလယ္နားတြင္ မိမိတုိ႕ နွစ္သက္ရာ အေရာင္ေျပာင္းလျဲပီး Drawings မ်ားဖန္တီးႏိုင္သည့္ Model

Space ႏွင့္ ပုံထုတ္ရန္ အတြက္ အျဖဴ Layout space ဟူ၍ ႏွစ္မ်ိဳး ပါ၀င္ေနသည္ကို ေတြ႕ရမည္။ (ထို Model Spaceႏွင့္

Layout Space တုိ႕သည္ Drawing area ၏ ေအာက္နားတြင္လည္း ပါရိွသည္။)

Model Space and Layout Settings

Model Space and Layout Settings ညာဖက္ေဘးတြင္ Drawings area ျမင္ကြင္းကို စိတ္ၾကိဳက္ေရြ႕ႏိုင္ေသာ

လက္ပုံသဏၭာန္ Realtime pan command ႏွင့္ မိမိတုိ႕ ျမင္ကြင္းက်ယ္ျဖင့္ ၾကည့္ရႈ႕လိုေသာ အပိုင္းကုိ Select လုပ္ျပီး

ၾကည့္ႏိုင္ေသာ Zoom command တုိ႕ပါရိွေနပါသည္။

Pan and Zoom
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Pan and Zoom ညာဖက္ေဘးတြင္ မိမိတုိ႕ ဖန္တီးထားေသာ Drawings မ်ား၏ Text,Dimension Scaleကို

ေဖာ္ျပေပးေသာ Annotation Options Settings ပါရိွပါသည္။ Annotations ျဖင့္ ဖန္တီးထားေသာ text,dimensions မ်ား၏

Scale ကုိ Annotation Scale ၌ Annotation visibility ကုိ click ေပးျပီး Scale မ်ားစိတ္ၾကိဳက္ Add/Delete

လုပ္ႏိုင္ပါသည္။

Annotation Settings

About Shortcut Menu

Panel အသီးသီးကေန ကြဲျပားျခားနားတဲ႕ Commands မ်ားစုစည္းျပီး ေဖာ္ျပေပးတဲ႕ Menu ေလးပါ။ လက္ရိွ ဖန္တီးေနေသာ

Drawings ကုိအေျခခံ၍ ေဖာ္ျပေပးေသာ Shortcut Menu မွ commands မ်ားျဖင့္ Drawings Objects မ်ားကုိ အလိုရိွသလုိ

လ်င္ျမန္စြာ ေျပာင္းႏိုင္ျပင္ႏိုင္ပါသည္။ ဥပမာအားျဖင့္ - Polyline တစ္ခုကုိ ဖန္တီးမည္ ဆိုပါစို႕။ Polyline command ကို

command line မွျဖစ္ေစ၊ Drawing panel မွျဖစ္ေစ Command ကိုေခၚျပီး စမွတ္တစ္ခုကုိ Drawing area

တစ္ေနရာရာတြင္ စိတ္ၾကိဳက္ သတ္မွတ္ေပးလိုက္ပါ။ ထို႕ေနာက္ Polyline မွ Arc တစ္ခုသို႕ ေျပာင္းလဲ ဖန္တီးလုိလွ်င္

Ployline command မဆံုးခင္တြင္ Drawing area ၌ Right-click ႏိွပ္ျပီး ေပၚလာေသာ Shortcut menu မွ Arc command

ကုိ Select လုပ္ျခင္းျဖင့္ လ်င္လ်င္ျမန္ျမန္ ေျပာင္းလဲဖန္တီးႏိုင္ေပသည္။ Polyline ေရးဆြဲျပီး Shortcut menu ေခၚထားေသာ

ေအာက္ပါပုံကုိ ေလ့လာၾကည့္ပါ။

Menu ရဲ႕ အေပၚဆံုး အပိုင္းမွာ Enter,Cancel and Recent Input Options တို႕ပါ၀င္ေနမည္ကို ေတြ႕ရမည္ ျဖစ္သည္။

Menuရဲ႕ အလယ္ပိုင္းတြင္ Polyline ျဖစ္ေသာေၾကာင့္ မိမိတို႕ဖန္တီးမည့္ Polyline အမ်ိဳးအစားကုိ စိတ္ၾကိဳက္

ေရြးခ်ယ္ႏိုင္သလို၊ line ၏ Width, Length စသည့္ျဖင့္ စိတ္ၾကိဳက္ ေရြးခ်ယ္ ႏိုင္ပါသည္။ ထုိ Options မ်ားကုိ Shortcut

menu မွေရြးခ်ယ္ အသံုးျပဳႏိုင္သလို၊ Command line မွလည္း ေရြးခ်ယ္အသံုးျပဳ သြားႏိုင္ပါသည္။ Menu ရ႕ဲေအာက္ဆံုး

အပိုင္းကေတာ႕ Pan,Zoom န႕ဲ QuickCalc တို႕ပဲျဖစ္ပါတယ္။ Polyline ဆြဲေနရင္း Drawing area ကုိေရြ႕လုိပါက Pan ကို
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Select လုပ္ျပီး လုိသေလာက္ ေရြ႕ေျပာင္းႏိုင္ပါသည္။ ထုိ႕သို႕ Pan ျဖင့္ေရြ႕ေျပာင္းျပီးပါက Esc key ကုိႏိွပ္လိုက္ယံုျဖင့္ Pan

command ဆုံးသြားျပီး၊ မိမိတို႕ဆြဲေနေသာ Polyline commandက Active ျပန္ျဖစ္လာပါလိမ္႕မည္။

More AutoCAD-Specific Interface Tools

Layouts (Drawing sheets)

Drawing Design မ်ားဖန္တီးရန္ Model Space, Annotation, Borders, Title Blocks န႕ဲ Plotting တို႕အတြက္ Layouts

(drawing sheets) သည္ Drawing area window ေအာက္တြင္ တည္ရိွေနသည္ကုိ ေတြ႕ရေပမည္။ Model Space

တြင္ေနရာ အကန္႕အသတ္မရိွ Drawing မ်ားဖန္တီးႏိုင္ေသာေၾကာင့္ Designers မ်ားအေနျဖင့္ Model Space တြင္

မိမိတုိ႕၏ Desings မ်ားကုိ Full Scale ျဖင့္သာ ဖန္တီးသင့္ပါသည္။

Layout Spaceတြင္ Template မ်ားဖန္တီးႏိုင္သလုိ၊ မိမိတုိ႕ ဖန္တီးထားေသာ Drawings မ်ားကုိလည္း သတ္မွတ္ Paper

Size area အတုိင္း Print လုပ္ႏိုင္သည္။ Model Space န႕ဲLayout တို႕ကို AutoCAD Drawing windowရဲ႕ ေအာက္ဆုံးက

Status Bar တြင္လည္း အခ်ိန္းအေျပာင္း ျပဳလုပ္ႏိုင္ပါသည္။

Layer List

Layer သည္ မိမိတုိ႕ ဖန္တီးထားေသာ Design မ်ားရိွ Objects မ်ားကုိအပိုင္းလိုက္ သီးသန္႕ခြဲထုတ္ ၾကည့္ရႈ႕ရာတြင္

အလြန္အသုံး၀င္ေသာ Tool တစ္ခုျဖစ္သည္။ Layer မ်ားျဖင့္ assign လုပ္ထားေသာ Objects မ်ား၏ layers တို႕ကို

(ON/OFF), Freezee န႕ဲ Lock စသည္တုိ႕ အသီးသီး ျပဳလုပ္ႏိုင္ပါသည္။
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Tool Palettes

Tool Palettes တြင္ Engineer နယ္ပယ္၌ အသံုးျပဳေနေသာ Pattern မ်ားပါ၀င္သလုိ၊ မိမိတုိ႕ အသုံးျပဳလိုေသာ Pattern

မ်ားကို Block အျဖစ္ စိတ္ၾကိဳက္ဖန္တီးျပီး Add ထားနိုင္ပါသည္။ Tool Palettes တြင္ Right-click ေထာက္လိုက္ပါက

Menu ေလးတစ္ခု ေပၚလာပါလိမ္႕မယ္။ ထို Menuတြင္ New Palettes ကုိ select လုပ္ျပီး၊ ထုိ New Palettes ကုိ

မိမိစိတ္ၾကိဳက္ နာမည္ေပးလိုက္ပါ။ ထုိ႕ေနာက္ Drawing area တြင္ မိမိတုိ႕ မၾကာခဏ အသံုးျပဳ သြားမည့္ Patterns မ်ားကို

စိတ္ၾကိဳက္ေရးဆြဲျပီး Block တစ္ခုဖန္တီးလုိက္ပါ။ ျပီးလွ်င္ Mouse ျဖင့္အဆုိပါ Block ကုိ မိမိတုိ႕ နာမည္ေပးထားေသာ

Palettes သုိ႕ Drag လုပ္လိုက္ယုံျဖင့္ မိမိတုိ႕ ဖန္တီးလုိက္ေသာ Patterns မ်ားသည္ Palettes tools တြင္ Delete

မလုပ္မခ်င္း တည္ရိွေနမည္ ျဖစ္သည္။ Tools Palettes တြင္ Engineering နယ္ပယ္မွ Civil, Electrical, Structure,

Mechanical, Architectural, Hatches, Modeling,…etc. တုိ႕ျဖင့္ ဆက္စပ္ေနေသာ Patternႏွင့္ Commandsမ်ား

အေျမာက္အျမား ပါ၀င္ေနေသာေၾကာင့္ Tools Palettes အေၾကာင္းကုိလည္း အေသးစိတ္ ေလ႕လာရန္ လိုအပ္ပါသည္။

Tool Palettes
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InfoCenter

AutoCAD 2010ရဲ႕ Title Bar ညာဖက္ေထာင့္တြင္ Center Panel ျဖင့္ ဆက္သြယ္ထားေသာ InfoCenter search တစ္ခုပါ

ပါ၀င္ေနသည္ကုိ ေတြ႕ရမည္။ AutoCAD 2010နဲ႕ ပတ္သက္ျပီး မိမိတုိ႕ သိရိွလိုေသာ ေမးခြန္းမ်ားကုိ ထို InfoCenter

search တြင္ရိုက္ထည့္ျပီး ရွာေဖြႏိုင္ပါသည္။ InfoCenter ကို AutoCAD အတြင္းမွ Locations အေျမာက္အျမားျဖင့္

ခ်ိတ္ဆက္ ေပးထားသည္။ InfoCenter ကိုေအာက္ပါ Locations မ်ားျဖင့္ အသီးသီးခ်ိတ္ဆက္ ေပးထားပါသည္။

 User's Guide

 Command Reference

 New Features Workshop

InfoCenter Menu Bar

Communication Center

InfoCenter Menu Barတြင္ ပါ၀င္ေသာ Communication Center ကို click လိုက္ယံုျဖင့္ AutoCAD ႏွင့္ ပတ္သက္ေသာ

ထုတ္ျပန္ခ်က္၊ သတိေပးခ်က္မ်ားကုိ အခ်ိန္ႏွင့္ တေျပးညီ ေဖာ္ျပေပးေနသည္ကုိ ေတြ႕ရမည္။ ထုိေဖာ္ျပ ေပးေသာ

ထုတ္ျပန္ခ်က္မ်ားကုိ သြားေရာက္ ဖတ္ရႈ႕ရန္အတြက္ မိမိတုိ႕ကြန္ပ်ဴတာတြင္ အင္တာနက္ ရိွရန္လိုအပ္ ပါသည္။ မိမိတုိ႕

ကြန္ပ်ဴတာတြင္ အင္တာနက္ျဖင့္ ခ်ိတ္ဆက္ထားပါက ေအာက္ပါ အခ်က္အလက္ မ်ားကုိလည္း Access လုပ္ႏိုင္ပါသည္။

 New Software Updates

 Product Support

 CAD Manager Channel

 RSS Feeds

Access

AutoCAD Help field တြင္းမွ မိမိသုိ႕ သိလုိေသာ ေမးခြန္းမ်ား၊ အေၾကာင္းအရာမ်ားကို ထုိ InfoCenter Search တြင္

ရိုက္ထည့္ျပီး အလြယ္တကူ ရွာေဖြႏိုင္ပါသည္။

InfoCenter Search တြင္ မိမိတုိ႕ သိလုိေသာ အေၾကာင္းအရာ ေမးခြန္းကုိ ရိုက္ထည့္ျပီး ထုိမွန္ဘီလူး သဏၭာန္ Search

Button ကုိ click လုိက္ပါက Search တြင္ ရိုက္ထည့္လုိက္ေသာ keywords မ်ားကို Help field မွရွာေဖြ ေပးသြားလိမ္႕မည္။

ရိုက္ထည့္လုိက္ေသာ keywords မ်ားနွင့္ ဆက္စပ္ေသာ အေၾကာင္းအရာမ်ား ပါ၀င္သည့္ Browser ေလးတစ္ခု
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က်လာလိမ္႕မည္။ ထုိမွန္ဘီလူး သဏၭာန္ Search Button ေလးကို click လိုက္ပါက ထို Browser ျပန္လည္

ေပ်ာက္ကြယ္သြား ပါလိမ္႕မည္။

Search Button (မွန္ဘီလူး သဏၭာန္)ေဘးတြင္ ရိွေသာ Down arrow ေလးကို click လိုက္သည္ႏွင့္ InfoCenter ၏

configure မ်ားကုိ ေဖာ္ျပေပးေသာ Drop-down list ေလးတစ္ခု က်လာလိမ္႕မည္။ ထိုက်လာ ေသာ Drop-down list ထဲမွ

ေအာက္ဆံုးတြင္ တည္ရိွေနေသာ Search setting ေလးကို click လုိက္ပါက Communication center ပါ၀င္ေသာ

InfoCenter Setting box ေလးကုိ ေတြ႕ရေပလိမ္႕မည္။ ထိုBoxထဲ ၀င္၍ Help field အတြက္ အျခားေသာ Guide မ်ားကို

Select လုပ္ကာ ထပ္မံ Add ႏိုင္သလို၊ မိမိတုိ႕ အလိုမရိွေသာ Guide မ်ားကိုလည္း Remove လုပ္ႏိုင္ပါသည္။

Search Button ညာဖက္ေဘးက Key ေလးကုိ click လုပ္လွ်င္ Ceter ကုိ Subscription လုပ္ႏိုင္ပါသည္။

Subscription Center တြင္ accountမ်ား ျပဳလုပ္ျပီး AutoCAD အေထာက္အကူျပဳ Softwareမ်ား၊ E-Learning Catalogs

မ်ားႏွင့္ သင္ခန္းစာမ်ားကို ေတာင္းဆိုႏိုင္ပါသည္။

Key ညာဖက္ေဘးမွ Satellite Dish Icon (စေလာင္းပုံ) ကုိ Click လုပ္ပါက Communication drop-down list ေလး

က်လာပါလိမ္႕မည္။
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Communication Center drop-down list မွ RSS Feeds title bar ညာဖက္ရိွ ေအာက္ဆုိက္ေနေသာ arrow ေလးကို

click လုိက္ရင္ RSS Feeds ရ႕ဲ configured မ်ားကုိ ေတြ႕ျမင္ရမည္ ျဖစ္သည္။ ထုိ List ထဲမွ အခ်ိဳ႕ေသာ RSS Feeds

မ်ားသည္ AutoCAD Software ကိုစတင္ Run စဥ္ကတည္းက နဂိုပါရိွျပီးသား ျဖစ္သည္။

Satellite Dish Icon ညာဖက္ေဘးမွ Star ပုံေလးသည္ favorites ျဖစ္ေသာ link ကုိၾကည့္ရန္ ျဖစ္သည္။

Star Iconေလး ညာဖက္ေဘးတြင္ ရိွေနေသာ Question icon ေလးသည္ AuotCAD၏ Help file ကုိၾကည့္ရန္

ျဖစ္ပါသည္။

ေလ့လာသူမ်ား အေနျဖင့္ AutoCAD Software အေၾကာင္း က်ယ္က်ယ္ျပန္႕ျပန္႕ ေရးသား ေဖာ္ျပေပးထားေသာ Help

Documents နွင့္လည္း ရင္နီွးကၽြမ္း၀င္မွဳ႕ ရိွေအာင္ ေလ႕လာရပါမည္။ Help Icon ၏ညာဖက္ေဘးတြင္ ရိွေသာ drop-down

arrow ေလးကို click ပါက အထက္ပါ ပုံအတုိင္း drop-down listေလး က်လာလိမ္႕မည္။ ထိုList၏ အေပၚဆံုးတြင္

AutoCAD Software တစ္ခုလုံး၏ အေၾကာင္းကို အက်ယ္တ၀ံ႕ ေဖာ္ျပေပးထားေသာ Help၊ AutoCAD Versionsမ်ား

တစ္ခုနွင့္ တစ္ခုအၾကား ကြားျခားမွဳ႕ေလးမ်ားကို ေဖာ္ျပေပးသည့္ New Feature Wokshop၊ AutoDesk site မွ online

trainging center မ်ားသုိ႕ သြားေရာက္ႏိုင္ေသာ Additional Resources၊ AutoCAD Software န႕ဲ ပတ္သက္ျပီး

တုန္႕ျပန္ခ်က္မ်ား ေပးပို႕ႏိုင္ေသာ Send Feedback စသည္တုိ႕ အသီးသီး ပါ၀င္သည္။
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Command window

Command window သည္ ပုံမွန္အားျဖင့္ Drawing window ႏွင့္ Status bar၏ အၾကားတြင္ တည္ရိွေသာ window

ျဖစ္ပါသည္။ ထုိ Command Window မွမိမိတုိ႕ ဖန္တီးမည့္ Drawings မ်ားတြင္ အသံုးျပဳမည့္ tools မ်ားကို keyboard မွ

Command ရိုက္ထည့္ျပီး ေခၚဆုိႏိုင္ပါသည္။ Command Window တြင္ Commands မ်ားရိုက္ထည့္ရန္ Command

Window တြင္ အတိအက် cursor သြားထားရန္ မလုိေပ။ AutoCAD window ရ႕ဲ toolbars တစ္ေနရာရာကုိ click

ေထာက္ျပီး keyboard မွမိမိတုိ႕ အသံုးျပဳမည့္ tools ၏ command ကုိရိုက္ေခၚ ႏိုင္ပါသည္။ AutoCAD Software

ကုိအသံုးျပဳျပီး Drawings မ်ားဖန္တီးမည့္ Users မ်ားအေနန႕ဲ Drawings မ်ား ဖန္တီးေနခ်ိန္၌ Command Line မွ Prompt

မ်ားကို အာရုံစိုက္ ဖတ္ရႈ႕ရန္မွာ လြန္စြာမွ အေရးပါလွသည္။ Command window တြင္ သာမန္အားျဖင့္ Text Lines (၃)

lines ပါရိွပါသည္။ Command window မွ အေပၚ (၂) Lines သည္ ယခင္ ေခၚဆို အသံုးျပဳထားေသာ Command

(သုိ႕မဟုတ္) လက္ရိွေခၚဆိုျပီး Command History မ်ားကို ေဖာ္ျပေပးကာ၊ ေအာက္ဆံုး Line သည္ လက္ရိွ

လုပ္ေဆာင္ေနသည့္ Command Line ျဖစ္ပါသည္။ Drawings မ်ားဖန္းတီးေနသူမ်ား အေနျဖင့္ ေအာက္ဆံုးက Command

Line မွ Prompt မ်ားကုိ အထူးသတိထား ဖတ္ရႈ႕ရန္ လုိအပ္သည္။ Command တစ္ခုကုိ ေခၚယူအသုံးျပဳျပီးတုိင္း ထို

Command ကိုအဆုံးသတ္ရန္ အတြက္ Spacebar (သုိ႕မဟုတ္) Enter ကိုနိုပ္ရန္ အထူးဂရုစိုက္ရမည္။

Lesson: Working with Files

ဤသင္ခန္းစာတြင္ Drawings မ်ားကုိ Open၊ Create န႕ဲ Save လုပ္ျခင္းမ်ားကုိ ေလ႕လာသြားရ မည္ျဖစ္ပါ သည္။

Drawings မ်ားကုိ Create တ႕ဲအခါမွာပဲျဖစ္ျဖစ္၊ Save တဲ႕အခါမွာပဲျဖစ္ျဖစ္ Files ရ႕ဲ Formatကုိေတာ႕ DWG Format ကုိပဲ

အသုံးျပဳသြားရမွာ ျဖစ္ပါသည္။ ထိုအခ်က္လက္ေတြကုိ သတိထားျပီး ေလ႕လာသူမ်ား အေနနဲ႕ New Drawings မ်ား

Create ျခင္း၊ Open ျခင္း၊ Save ျခင္းမ်ားကုိ ဆက္လက္ ေလ႕လာသြားရပါမည္။ လ်င္လ်င္ ျမန္ျမန္နဲ႕ လြယ္ကူစြာ

စတင္ႏိုင္ရန္ Quick Access Toolbar ကေနပဲ Create New Drawing၊ Open၊ Save icon မ်ားကုိ အသုံးျပဳပါ။

Open a Drawig

Drawing တစ္ခုကုိ Open ရန္အတြက္ Open command ကို click ျပီး၊ မိမိတို႕ Open ခ်င္ေသာ File ကုိ Select လုိက္ပါ။

Command Access

Open
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Command Line: OPEN

Application Menu: File > Open

Toolbar: Quick Access

Open File Dialog Box

Drawing တစ္ခုတည္း Open မည္ဆိုလွ်င္ Open ခ်င္ေသာ File ကုိ Selectလုပ္ျပီး Open ႏိုင္သလို၊ Drawings Files 2Files

( သို႕မဟုတ္) 3 Files စသည္ Multiple Files မ်ားဖြင့္ခ်င္သူမ်ား အေနျဖင့္ Ctrl+( သုိ႕မဟုတ္) Shift+ ကုိPress ျပီး Select

လုပ္ Open ႏိုင္ပါသည္။

Create New Drawing

New Drawing တစ္ခုကုိ Create ရန္အတြက္ New command ကိုအသံုးျပဳ ရပါမည္။ Template မွ Select လုပ္ျပီး

ဖြင့္ႏိုင္သလို၊ Template မွမဖြင့္ပဲ (Imperial or Matric) တစ္ခုခုတို႕ကို Select ႏိုင္ပါသည္။ Template ထကဲေန ပဲ Create

မည္ဆုိလွ်င္ DWG format န႕ဲပဲ template ထဲမွာ Saved မွာျဖစ္ျပီး၊ ထို template ထတဲြင္ မိမိတို႕ Create ေနတ႕ဲ Drawing

န႕ဲ ဆက္စပ္ေသာ Title block, Layers, Text styles, Dimension styles, န႕ဲ Settings စသည့္ Information အေသးစိတ္

အခ်က္အလက္မ်ား ပါ၀င္ပါသည္။

Command Access



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

37

New

Command Line: New

Application Menu: File > New

Toolbar: Quick Access

Select Template Dialog Box

Saving Your Drawings

Created ထားတ႕ဲ Drawing ကုိ Save command အသံုးျပဳျပီး Save ရပါမည္။ Created ထားေသာ Drawing ကိုပထမ

ဆံုးအၾကိမ္ Save ေသာအခ်ိန္တြင္ Save command ကိုေခၚလိုက္သည္နွင့္ Save Drawing As dialog box တစ္ခု

ေပၚလာပါလိမ္႕မည္။ ထို dialog box ေပၚလာေသာအခါ Created ထားေသာ Drawing ကုိမိမိတုိ႕ ထားခ်င္ေသာ Folder

သုိ႕သြားျပီး၊ Folder ကို Rename ေပးကာ Save ကုိ Select လုပ္လုိက္ပါ။

Command Access
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Save; Save As

Command Line: SAVE; SAVEAS

Application Menu: File > Save; Save As

Toolbar: Quick Access

Save Drawing As Dialog Box

Notice။ ။ Users မ်ားအေနျဖင့္ AutoCAD ကိုဖြင့္ Drawing Create ရန္အတြက္ New ကုိ Open လုပ္သည္နွင့္

တစ္ျပိဳင္နက္ ခ်က္ခ်င္း Save တတ္ေသာ အက်င့္ျဖစ္ေအာင္ သတိထား ေလ႕က်င့္သင့္ပါသည္။ Drawings Create

ေနရင္းန႕ဲလည္း မၾကာခဏဆုိသလို Save တတ္တ႕ဲ အက်င့္ေလး ျဖစ္ေအာင္ အထူးဂရုစိုက္ပါ။ Command တစ္ခုကို

အသုံးျပဳကာ Object တစ္ခု Create ျပီးတိုင္း Ctrl+S ႏိွပ္ယံုျဖင့္ အလြယ္တကူ လ်င္ျမန္စြာ Saved ျပီးသား

ျဖစ္ေနေပလိမ္႕မည္။

Lesson: Displaying Objects

AutoCAD Software ကုိအသုံးျပဳျပီး Dawings မ်ားကုိ Create တုိင္း Full Scale ျဖင့္သာ အသုံးျပဳ Create ရန္

အထူးသတိျပဳပါ။ တစ္ခါတစ္ရံမွာ မိမိတုိ႕ Created ထားေသာ Drawing တစ္ခုလံုးကုိ ျခံဳငုံၾကည့္ရမည္ ျဖစ္သလို၊

တစ္ခါတစ္ရံမွာ Drawings မ်ားရဲ႕ အေသးစိတ္ အခ်က္အလက္ကို ဆြဲၾကည့္ရမည္ ျဖစ္ေသာေၾကာင့္ Full Scale ျဖင့္
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Created ထားမွသာ အဆင္ေျပႏိုင္မည္ ျဖစ္ပါသည္။ မိမိတုိ႕ Created ထားေသာ Drawings မ်ားကို ရႈ႕ေထာင့္

အမ်ိဳးမ်ိဳးကေန ၾကည့္ရႈ႕ႏိုင္ရန္အတြက္ Zoom နဲ႕ Pan စသည့္ Tools မ်ားကို အသံုးျပဳ သြားရမည္ ျဖစ္ပါသည္။ ထို Tools

မ်ားကို အသံုးျပဳျပီး Created ထားေသာ Drawings မ်ားမွ မိမိတုိ႕ ၾကည့္လုိေသာ အပိုင္းကို ေရြးခ်ယ္ျပီး အနီးအေ၀း ခ်ဲ႕

(သုိ႕မဟုတ္) ခ်ဳံ႕ျပီး ၾကည့္ႏိုင္ပါသည္။

ဤသင္ခန္းစာတြင္ Zoom န႕ဲ Pan ဆုိေသာ Tools မ်ားကို နည္းအမ်ိဳးမ်ိဳးန႕ဲ အသံုးျပဳႏိုင္ေအာင္ ေလ႕လာ သြားရမည္ ျဖစ္ျပီး၊

Interface န႕ဲပတ္သက္ျပီး မိမိတုိ႕ရ႕ဲ ေလ႕လာမွဳ႕ တိုးတက္လာေစရန္ ျဖစ္ပါသည္။ Zoom နဲ႕ Pan commands မ်ားကို

အသုံးျပဳျပီးေတာ႕ မိမိတို႕ရ႕ဲ Drawings မ်ားကုိ ရွင္းလင္းျပတ္သားစြာ ၾကည့္ရႈ႕ႏိုင္ေအာင္ လုပ္ေဆာင္ ႏိုင္ပါသည္။

Zoom န႕ဲ Pan တို႕ရဲ႕ Options ကိုေလ႕လာျပီး သြားလွ်င္၊ Zoom နဲ႕ Pan တို႕ကို အသံုးျပဳျပီးေတာ႕ Drawings မ်ားရဲ႕ View

Display မ်ားကုိ Control လုပ္ျခင္း၊ Wheel Mouse ကုိအသုံးျပဳျပီးေတာ႕ Drawins မ်ားကုိ အနီးအေ၀း ခ်႕ဲ (သို႕မဟုတ္) ခ်ဳ႕ံ

ၾကည့္ျခင္း၊ Drawing View မ်ားကုိ Regenerate လုပ္ျခင္းတုိ႕ကုိ ဆက္လက္ ေလ႕က်င့္ေလ႕လာသြားရမည္ ျဖစ္သည္။

ေအာက္တြင္ေဖာ္ျပထားေသာ Typical Drawing ကိုအသံုးျပဳ ေလ႕က်င့္သြားမည္ ျဖစ္သည္။ သုိ႕ေသာ္ ထုိ Typical

Drawing တစ္ခုလံုးကုိ မိမိတုိ႕၏ Monitor ျဖင့္ ရွင္းလင္းျပတ္သားစြာ ၾကည့္ႏိုင္ဖို႕ရာက မျဖစ္ႏိုင္ေပ။ ထို႕ေၾကာင့္ Display

Tools မ်ားကုိ အသုံးျပဳျပီးေတာ႕ မိမိတုိ႕၏ Monitor မ်က္နွာျပင္ျဖင့္ ကုိက္ညီေသာ အပိုင္းကုိ ဆြဲၾကည့္ ရမည္ျဖစ္သည္။

Display Tools

Drawings မ်ား၏ View ကုိ Zoom ျဖင့္ ခ်ဲ႕ (သုိ႕မဟုတ္) ခ်ဳံ႕ ၾကည့္ရာတြင္ Wheel mouse ကိုအမ်ားဆုံး အသံုးျပဳ

သြားရမည္ျဖစ္သည္။ Zoom Tools သည္ Ribbon Toolbar ၏ View tabs မွ Navigate panel တြင္တည္ရိွ ပါသည္။

Command Access
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Display Tools

Command Line: Zoom, Z or Pan

Status Bar: Pan or Zoom

Ribbon: View tab > Navigate panel > Pan

Pan

Drawing area တြင္းမွ View မ်ားကုိ Pan command အသံုးျပဳျပီး မိမိတို႕ စိတ္ၾကိဳက္ Position ကို ေရြ႕ေျပာင္း

ၾကည့္ရႈ႕ႏိုင္ပါသည္။ အရာ၀တၳဳတစ္ခုကုိ Vedio Camera တစ္ခုျဖင့္ ေရြ႕ေျပာင္းျပီး လုိက္ရိုက္သကဲ႕သို႕၊ Drawing Area

တြင္းမွ Drawings မ်ားကို လက္ပုံ သဏၭာန္္ Pan command ျဖင့္ေရြ႕ေျပာင္းၾကည့္ရႈ႕ ႏိုင္ပါသည္။ Drawing Area ထမွဲ

Drawings မ်ားကုိ ခ်ဲ႕(သို႕မဟုတ္) ခ်ဳံ႕ၾကည့္ မ်ိဳးျခင္းမဟုတ္ေပ။

Command Access

Pan

Command Line: PAN, P

Ribbon: View tab > Navigate panel > Pan

(အထက္ပါ အဆင့္အတိုင္းမသြားပဲ wheel mouse ေလးကို ဖိလိုက္ရုံျဖင့္လည္း Pan ကုိ လြယ္ကူစြာ အသံုးျပဳ ႏိုင္ပါသည္။)
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Shortcut Menu: Pan

Pan command သည္ active ျဖစ္ေနပါက Cursor Icon သည္ လက္ပုံ သဏၭာန္ေလး ျဖစ္ေနေပလိမ္႕မည္။ ထုိ Cursor

ေလးျဖင့္ Drawing area ကုိ click ျပီး အေရြ႕အေျပာင္း လုပ္ႏိုင္ပါသည္။

Pan command Active Icon

Command Options

User မ်ားအေနျဖင့္ Pan command အသုံးျပဳ ေနခ်ိန္၌ Drawing Area တြင္ Right click ႏိွပ္ကာ Shortcut menu ကို

Diplayလုပ္ျပီး အျခားေသာ Zoom န႕ဲ Pan command ကို Access လုပ္ႏိုင္ပါသည္။

Exit – Zoom နဲ႕ Pan command ကုိ Exit ခ်င္လွ်င္ Select လုပ္ရမည့္ commad.

Zoom – Zoom Realtime command ကုိေျပာင္းလဲ အသုံးခ်င္လွ်င္ Select လုပ္ရမည့္ commad.



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

42

3D Orit – 3D Orbit View ျဖင့္ၾကည့္ခ်င္လွ်င္ Select လုပ္ရမည့္ command. (2D Drafting & Annotation workspace

တြင္ ၾကည့္လုိ႕မရေပ။)

Zoom Window - မိမိတုိ႕ ၾကည့္လိုေသာ အပိုင္းကိုသာ အေသးစိတ္ ေရြးခ်ယ္ၾကည့္လိုလွ်င္ Zoom Window Commad ကုိ

Select လုပ္ျပီး ၾကည့္ႏိုင္ပါသည္။

Zoom Origial – Zoom Realtime န႕ဲ Pan command ကုိစတင္ အသံုးျပဳခ႕ဲသည့္ View ကုိ ျပန္သြားလုိလွ်င္ Zoom

Original ကုိ Select လုပ္သည္ႏွင့္ ျပန္လည္ ေရာက္ရိွသြားမည္ ျဖစ္သည္။

Zoom Extents – Drawing တစ္ခုလုံးကို ၾကည့္ရန္ Zoom Extents ကုိ Select လုပ္ျပီး အသုံးျပႏိုင္သလို၊ Pan နဲ႕ Zoom

Realtime Command သုိ႕ Return ႏိုင္ပါသည္။

Procedure: Panning in Real Time

ေအာက္ပါအဆင့္အတုိင္း Realtime မွာ Pan ျဖင့္ Drawing ကုိေရြ႕ေျပာင္း ၾကည့္ႏိုင္ပါသည္။

၁) Ribbon Panel မွ View tab > Navigate panel > Pan.

၂) Left Click ကို Drag လုပ္ျပီး Drawing View ကို မိမိတုိ႕ ေရြ႕ေျပာင္း ၾကည့္ခ်င္တ႕ဲ ဦးတည္ဖက္သုိ႕ ေရြ႕ေျပာင္း

ႏိုပ္ပါသည္။ မိမိတုိ႕ ေရြ႕ေျပာင္းၾကည့္ခ်င္ေသာ အပိုင္းသို႕ ေရာက္ျပီဆုိမွ Left Click Drag လုပ္ထားသည္ကုိ လႊတ္

လိုက္ရပါမည္။

၃) ဆက္လက္ ေရြ႕ေျပာင္းၾကည့္ရႈ႕ လုိပါက left click ကုိ drag လုပ္ျပီး လိုအပ္သလုိ ေရြ႕ေျပာင္း နိုင္ပါသည္။
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၄) Pan commandကုိ exit လုပ္လိုပါက ESC (သို႕မဟုတ္) ENTER ကို နိွပ္လုိက္ပါ။

Panning Considerations

Panning ၏လုပ္ေဆာင္ ခ်က္သည္ Drawing area မွ horizontal န႕ဲ vertical scroll bars မ်ား၏ လုပ္ေဆာင္ခ်က္ႏွင့္

တူညီပါသည္။

Drawings မ်ားကုိ Pan လုပ္ျခင္းသည္ geometry ကုိေရြ႕ေျပာင္းျခင္း မဟုတ္ပဲ၊ Drawing ၏ျမင္ကြင္း position ကုိ မိမိတုိ႕

အတြက္ အဆင္ေျပသလို ေရြ႕ေျပာင္းျခင္း သက္သက္သာ ျဖစ္ပါသည္။

Zoom Realtime

Zoom Command သည္ Drawing Area တြင္းမွ Objects မ်ား၏ ျမင္ကြင္းကုိ ခ်ဳံ႕ (သို႕မဟုတ္) ခ်ဲ႕ ရာတြင္ အသံုးျပဳ

ႏိုင္ပါသည္။ Zoom command ျဖင့္ Created ထားေသာ Drawing မ်ားကုိ Select လုပ္ျပီး Zoom Out လုပ္ရင္ Objects

၏ျမင္ကြင္းက ေသးငယ္သြားမည္ ျဖစ္သလုိ၊ Zoom In လုပ္ရင္ Objects ၏ျမင္ကြင္းသည္ ၾကီးလာမည္ျဖစ္သည္။ Zoom

Command သည္ Camera မ်ားတြင္အသံုးျပဳေနေသာ Zoom ၏လုပ္ေဆာင္ခ်က္နွင့္ အတူတူပဲ ျဖစ္သည္။ ပုံကို

ျမင္ကြင္းက်ယ္ ၾကည့္ခ်င္လွ်င္ Zoom In ေပးျပီး ၾကည့္သလုိ၊ ခ်ဳံ႕ျပီး ၾကည့္ခ်င္လွ်င္ Zoom Out ေပးျပီး ၾကည့္ႏိုင္သည့္

သေဘာတရာမ်ိဳး သက္သက္သာ ျဖစ္သည္။

Command Access

Zoom
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Command Line: Zoom, Z Press ENTER on the keyboard for Realtime option

Status Bar: Zoom

Ribbon: View Tab > Navigate Panel > Zoom drop-down > Realtime

Zoom

Notice။ ။ Zoom Realtime ၏ Command Icon သည္ Ribbon Panel တြင္ Displayed လုပ္ထားျခင္း မရိွလွ်င္ Drop-

down list ထဲမွ Select လုပ္ႏိုင္ပါသည္။

Shortcut Menu: Zoom

Zoom Realtime Command သည္ Active ျဖစ္ေနပါက Cursor Icon သည္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ျဖစ္ေနမည္

ျဖစ္သည္။ Drawing မ်ားကုိ ပုံၾကီးခ်ဲ႕ ၾကည့္လိုပါက Left Click ကို Drag ျပီး အေပၚသို႕ ေရြ႕ပါက ပုံျမင္ကြင္း ၾကီးလာမည္

ျဖစ္ျပီး၊ ေအာက္ကို ေရြ႕ပါက ပုံျမင္ကြင္း က်ဳံ႕၀င္သြားမည္ျဖစ္သည္။
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Zoom Realtime command Active Icon

Procedure: Zooming in Real Time

ေအာက္ေဖာ္ျပပါ အဆင့္အတုိင္း Zoom Realtime ကုိ အသံုးျပဳႏိုင္ပါသည္။

၁) Ribbon Panel မွ Click View Tab > Navigate Panel > Zoom drop-down > Realtime. ျပီးလွ်င္ ENTER

ကုိနိွပ္လိုက္ပါ။

၂) Left Click ကို Drag လုပ္ျပီး Cursor ကုိအေပၚသုိ႕ ေရြ႕ပါက View သည္ ၾကီးလာမည္ ျဖစ္သည္။

၃) Left Click ကို Drag လုပ္ျပီး Cursor ကုိေအာက္သုိ႕ ေရြ႕ပါက View သည္ က်ံဳ႕လာမည္ ျဖစ္သည္။

၄) Zoom ကုိမိမိတုိ႕ လိုသေလာက္ ခ်ဲ႕ (သုိ႕မဟုတ္) ခ်ံဳ႕ ႏိုင္ပါသည္။
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၅) Zoom Command ကုိ Exit လုပ္လိုပါက ESC (သို႕မဟုတ္) ENTER ကို ႏိွပ္ႏိုင္ပါသည္။

Zoom Command Options

Zoom Command အသံုးျပဳရာတြင္ Zoom ၏သေဘာတရား အရ Multiple Options အျဖစ္ေရြးခ်ယ္ အသံုးျပဳ ႏိုင္ပါသည္။

Command Access

Drawing area အတြင္းမွ Drawings မ်ားကို ရႈ႕ေထာင့္ အမ်ိဳးမ်ိဳးမွ ၾကည့္္ရႈ႕ႏိုင္ရန္အတြက္ အသုံးျပဳရေသာ Zoom

Command ကိုေအာက္ပါအတုိင္း ေခၚယူအသံုးျပဳ ႏိုင္ပါသည္။

Note။ ။ Zoom Command ရ႕ဲ Options မ်ားန႕ဲ ပတ္သက္ျပီး အထက္တြင္ ေဆြးေႏြးျပီးသား ျဖစ္ပါသည္။

Zoom Command Options

Command Line: Zoom, Z ( command line မွ zoom ကုိေခၚျပီးပါက zoom command lists မ်ားကုိ

ေတြ႕ရမည္ျဖစ္သည္။ ထုိ Command Lists ထဲမွ မိမိတုိ႕ အသံုးျပဳလိုေသာ Command ကုိ ေရြးခ်ယ္ႏိုင္ပါသည္။ ထိုသုိ႕

ေရြးခ်ယ္ရာတြင္ ဥပမာ- Extents Command ကုိေရြးခ်ယ္မည္ ဆုိပါစို႕။ Extents အတြက္ E ဆိုေသာ Keyword

ေလးတစ္လံုး ရိုက္ထည့္ယံုျဖင့္ Extents ကုိအသံုးျပဳ ႏိုင္မည္ျဖစ္သည္။ ဆိုလုိရင္းမွာ - Command မ်ားတြင္

စာလုံုးအၾကီးျဖင့္ ေဖာ္ျပထားေသာ Keywords မ်ားသည္ ထုိ Commandကုိ ကုိယ္စားျပဳ Keyword ပင္ျဖစ္သည္။)

Ribbon panel> View tab > Navigate panel > Zoom pull-down

Zoom Command Options
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Zoom Window Icon

Zoom Window - Zoom,Z; ဟု command line မွ command ကုိရိုက္ေခၚျပီးခ်ိန္တြင္ မည္သည့္ keyword မွရိုက္ထည့္

စရာမလိုပဲ၊ Drawing area အတြင္းမွ မိမိတို႕ အနီးကပ္ၾကည့္လုိေသာ Object အစိတ္အပိုင္း ေနရာကို Window Selection

ျဖင့္ေရြးခ်ယ္ၾကည့္ရႈ႕ ႏိုင္ပါသည္။ Window Selection ျဖင့္ေရြးခ်ယ္ ၾကည့္ရႈ႕ရာတြင္ First Conrner န႕ဲ Second Corener

အမွတ္ႏွစ္မွတ္ သတ္မွတ္ေပးရန္လုိအပ္ပါသည္။ ထုိ First Corner ႏွင့္ Second Corner အၾကား Window Selection

လုပ္ထားေသာ Object အပိုင္းသည္ ၾကီးလာျပီး အေသးစိတ္ ၾကည့္ရႈ႕ ႏိုင္မည္ ျဖစ္သည္။ ေအာက္တြင္ First

Corner,Second Corner အမွတ္ႏွစ္မွတ္ျဖင့္ Window Selection လုပ္ထားပုံ ကိုပုံနွင့္ တကြေလ႕လာႏိုင္ပါသည္။

Zoom Extents – Drawing area အတြင္းမွ Object မ်ားကို အနီးကပ္ဆုံးနွင့္ အရွင္းလင္းဆံုး ျမင္ေတြ႕လိုေသာ အခါ

အသုံးျပဳ ရပါသည္။ Objects မ်ားကုိ Zoom Extents အသုံးျပဳျပီး ၾကည့္လိုက္သည္နွင့္ Object တစ္ခုလုံးကို Drawing Area

Screen အျပည့္ျမင္ေတြ႕ ရေပမည္။ Model Space တြင္ျဖစ္ေစ၊ Paper Space တြင္ျဖစ္ ၂မ်ိဳးလံုး တြင္အသုံးျပဳ ႏိုင္ပါသည္။

Command line: ZOOM, Z; > E ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါက Zoom Extents ကုိအသံုးျပဳ ႏိုင္ျပီ ျဖစ္သည္။
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Zoom Previous – Previous ကအသုံးျပဳခဲ႕ေသာ Zoom ကုိျပန္လည္ ေခၚယူအသံုးျပဳ ျခင္းျဖစ္သည္။

Command line: ZOOM, Z; > P ဟုရိုက္ထည့္ျပီး ENTER ႏိွပ္လိုက္ပါက Previous က Zoom ကုိျပန္လည္

ေရာက္ရိွသြားမည္ ျဖစ္သည္။

Wheel Mouse Features

ကြန္ပ်ဴတာတြင္ အသုံးျပဳေနၾကေသာ Mouse၏ Left clickႏွင့္ Right click အၾကားရိွ Wheel Mouse ေလးသည္ AutoCAD

တြင္ မည္သည့္ commands မွအသုံးျပဳစရာ မလုိပ၊ဲ Zoom န႕ဲ Pan Command ကုိယ္စား ေရွ႕ေနာက္ အသာအယာေလး

တြန္းရုံျဖင့္ လြယ္ကူစြာ အသံုးျပဳႏိုင္ပါသည္။ Wheel Mouse အသံုးျပဳျပီး Zoom ခ်ဳံ႕( သို႕မဟုတ္) ခ်ဲ႕ျခင္း၊ Panning

လုပ္ျခင္းသည္ Zoom န႕ဲ Pan Command တို႕ျဖင့္ လုပ္ေဆာင္ျခင္းထက္ လြယ္ကူစြာျဖင့္ လ်င္လ်င္ျမန္ျမန္ လုပ္ေဆာင္

နိုင္သည္။

How to Use the Wheel Mouse

Do this… To…

Roll the wheel forward Zoom In

Roll the wheel backward Zoom Out

Double-click the wheel button Zoon Extents

Wheel Mouse ကုိဖိျပီး drag လုပ္ျခင္း Pan

Keyboard မွ Shift key ကုိႏိွပ္ျပီး wheel ကုိ Constrained Orbit

ဖိျပီး drag လုပ္ျခင္း

Keyboard မွ Ctrl key ကုိႏိွပ္ျပီး wheel ကို Pan (Joystick)

ဖိျပီး drag လုပ္ျခင္း

Note။ ။ Pan (Joystick)- ဥပမာအားျဖင့္ ဂိမ္းကစားေသာ ခလုတ္က႕ဲသုိ႕ မိမိတုိ႕ ေရြ႕လိုသည့္ဖက္ကို ဖိထားရံုျဖင့္

သူ႕အလုိအေလ်ာက္ ေရြ႕ေနမည္ျဖစ္ျပီး၊ မိမိတို႕ အလုိရိွေသာ ေနရာေရာက္ပါက ဖိထားသည္ကုိ လြတ္လိုက္ရုံျဖင့္

လြယ္ကူလ်င္ျမန္စြာ အေရြ႕အေျပာင္း ျပဳလုပ္ႏိုင္ပါသည္။

Wheel Button Modes
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Wheel Button ၏ Function mode ကို (၂) မ်ိဳးေျပာင္းလဲ အသုံးျပဳ နိုင္ပါသည္။ MBUTTONPAN ဟု Command Line

တြင္ရိုက္ထည့္ျပီး မိမိတုိ႕ ထားလုိေသာ Function mode ၏ system variable value ရိုက္ထည့္ကာ mode ႏွစ္မ်ိဳး အသံုးျပဳ

ႏိုင္ပါသည္။

အကယ္၍ MBUTTONPAN ရ႕ဲ System Variable Value ကုိ 1 ထားပါက wheel mouse ကုိအသံုးျပဳတုိင္း Pan command

သည္ activate ျဖစ္ေနမည္ ျဖစ္သည္။

အကယ္၍ MBUTTONPAN ရ႕ဲ system variable value ကုိ 0 ထားပါက wheel mouse ကုိအသုံးျပဳတိုင္း Object Snap

menu က displayed ျဖစ္ေနမည္။

Regen

Regen သည္ မိမိတို႕ ဖန္တီးေနေသာ Drawings မ်ား၏ ေနာက္ဆုံးေျပာင္းလဲမွဳ႕ အေျခအေနကို ၾကည့္ရႈ႕ရာတြင္

အသုံးျပဳေသာ command ျဖစ္သည္။ မ်ဥ္းေကြးမ်ားျဖင့္ Create ထားေသာ Objects မ်ားကို Zoom command မ်ားျဖင့္

အသုံးျပဳျပီး Zoom In (သို႕မဟုတ္) Zoom out ျပဳလုပ္ပါက အဆိုပါ Objects မ်ား၏ မူလအတုိင္း ေျပျပစ္မွဳ႕ မရိွေတာ႕ေပ။

ထုိသို႕ေသာ အေျခအေနမ်ိဳးတြင္ Regen All command ျဖင့္ regenerate လုပ္လုိက္ပါက Objects မ်ားသည္ မူလအတိုင္း

ျပန္လည္ေျပျပစ္ သြားေပလိမ္႕မည္။

Command Access

Regen

Command Line: RE, REGEN, REGENALL

Automatic Drawing Regeneration

မူလအတုိင္း ေျပျပစ္မွဳ႕မရိွေတာ႕သည့္ Objectsမ်ားကို Regen All command ေပးျပီး regenerate လုပ္စရာ မလိုပဲ

အလုိအေလ်ာက္ regenerate လုပ္သြားေစရန္ REGENMODE ၏ system variable ေျပာင္းေပးရပါမည္။ REGEMODE

တြင္ system variable value 1 ျဖစ္ပါက Drawings မ်ားကို အလိုအေလ်ာက္ regenerate လုပ္ေပး ေနမည္ျဖစ္သည္။

REGEMODE တြင္ system variable value 0 ျဖစ္ပါက Drawings မ်ားကို regenerate လုပ္ေပးရန္ အတြက္ Regen All

command ေခၚယူလုပ္ေဆာင္ သြားရမည္ျဖစ္ပါသည္။ ( AutoCAD ၏မူရင္း REGENMODE တြင္ system variable value

သည္ 1 ျဖစ္ပါသည္။)

Exercise: Zoom and Pan in the Drawing

ဤသင္ခန္းစာသည္ Zoom န႕ဲ Pan command ကို အသုံးျပဳျပီး ေလ့က်င့္ေလ႕လာသြားရမည့္ သင္ခန္းစာပဲ ျဖစ္ပါသည္။

Drawing ကုိဖြင့္ျပီး လိုက္ပါေလ့က်င့္ ၾကည့္ၾကရေအာင္။
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၁) Displaying-Objects.dwg ကို Open လုိက္ပါ။

၂) View Tab ေပၚက Navigate Panel click ျပီး Pan commandကုိ Click လုိက္ပါ။

၃) Alternatively:

 Drawing area တြင္ Right click ႏိွပ္ျပီး Displayed လာမည့္ shortcut menu မွ Pan.

 Wheel Mouse ကုိ ဖိ၍လည္းေကာင္း Drawings ကို drag လုပ္ျပီး နွစ္သက္ေသာ View ကုိၾကည့္ ႏိုင္ပါသည္။

၄) Shift key ကို press ထားျပီး Wheel Mouse ျဖင့္ Drawing ကုိ Panning လုပ္ၾကည့္ပါ။ Drawing area မွ Drawing

မ်ားကို စက္၀ိုင္း သဏၭာန္ ေလးဖက္ေလးလံ လွည့္ပတ္ ၾကည့္ႏိုင္ေပလိမ္႕မည္။

၅) Drawing area ၏ တစ္ေနရာရာကို Right-click press ျပီး Pan command ကုိ Exit ေပးလုိက္ပါ။ (Keyboard မွ Esc

key ကုိ press ၍လည္း Pan command ကို Exit ႏိုင္ပါသည္။)

၆) Statuts Bar တြင္ရိွေသာ Zoom command ကို click လိုက္ပါ။ Extents commad ကုိအသံုးျပဳရန္အတြက္ command

line တြင္ E ဟုရိုက္ထည့္လိုက္ပါ။ Extends command ကို အသုံးျပဳလွ်င္ Drawing၏ View ေျပာင္းလဲ သြားပုံကို

ဂရုတစိုက္ၾကည့္ပါ။ Note။ ။ Wheel Mouse ကုိ Double – click ႏိွပ္၍လည္း Extents command ကုိ အသုံးျပဳႏိုင္ပါသည္။

၇) Zoom in real time:

 Status Bar မွ Zoom command ကို Click လုိက္ပါ။

 Real time command ကုိ အသုံးျပဳရန္အတြက္ Enter ကုိ Press လုိက္ပါ။

 ျပီးလွ်င္ Mouse ရ႕ဲ left click ကို Press ထားျပီး အထက္သို႕ ေရြ႕ၾကည့္ပါ။

 ထုိ႕ေနာက္ Mouse ရ႕ဲ left click ကိုပဲ Press ထားျပီး ေအာက္သုိ႕ ျပန္ေရြ႕ၾကည့္ပါ။

 Left click ကုိ Press ထားျပီး အထက္သုိ႕ ေရြ႕စဥ္ Drawing view သည္ Zoom In ျဖစ္လာမည္ ျဖစ္ျပီး၊

ေအာက္သုိ႕ျပန္ေရြ႕စဥ္ Drawing view သည္ Zoom Out ျဖစ္သြားသည္ ကိုေတြ႕ျမင္ ရေပလိမ္႕မည္။

 မွတ္ခ်က္။ ။ Real time command Activate ျဖစ္ေနစဥ္ Wheel Mouse ကုိ ေရွ႕/ေနာက္ လိွမ္႕ျခင္းျဖင့္ လည္း

Zoom Out/ Zoom In ၾကည့္ႏိုင္ပါသည္။ Wheel Mouse ကုိေရွ႕သို႕ လိွမ္႕လွ်င္ Drawing view သည္ Zoom In

ျဖစ္လာမည္ ျဖစ္ျပီး၊ Wheel Mouse ကုိ ေနာက္သုိ႕ျပန္လွိမ္႕ပါက Drawing view သည္ Zoom Out ျဖစ္သြား

သည္ကုိ ေတြ႕ရမည္။

၈) Zoom to a window:
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View tab မွ Navigate panel ကို click ပါ။ ျပီးလွ်င္ Zoom drop-down > Window ကုိ click လုိက္ပါ။ ျပီးလွ်င္ Object ရ႕ဲ

မိမိတုိ႕ အေသးစိတ္ ခြထဲုတ္ၾကည့္ခ်င္ေသာ အပိုင္းကုိ Center သတ္မွတ္ျပီး Cursor ကို ေအာက္တြင္ တစ္ခ်က္၊ အေပၚတြင္

တစ္ခ်က္ click လိုက္ပါ။ Click ျပီးေသာ အခ်ိန္တြင္ Window Selection အပိုင္းသည္ Zoom In ျဖစ္လာသည္ကို

ေတြ႕ရမည္။ ေအာက္ပုံတြင္ ေလ႕လာၾကည့္ပါ။

၉) Pan command ျဖင့္ Drawing ကုိ ဘယ္ဖက္ေအာက္ေထာင့္သုိ႕ ေရြ႕ၾကည့္လိုက္ပါ။

၁၀) ထို႕ေနာက္ View tab မွ Navigate panel ကုိ Click ပါ။ ျပီးလွ်င္ Zoom drop-down > Previous ကုိ Click လိုက္ပါ။

ထုိအခါ Drawing Pan ျဖင့္ မေရြ႕ခင္က View သုိ႕ ျပန္လည္ေရာက္ရိွ သြားမည္ကို ေတြ႕ရေပလိမ္႕မည္။

 Previous command သည္ လက္ရိွView မတုိင္မီွ ၾကည့္ခ႕ဲေသာ View မ်ားကုိ ျပန္လည္ ေခၚယူၾကည့္ရႈ႕ ႏိုင္ပါ

သည္။

၁၁) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Exercise: Hands-On Tour

ဒီသင္ခန္းစာကေတာ႕ AutoCAD ရဲ႕ User Interface မွာရိွတဲ႕ Display command ေတြကုိအသုံးျပဳ၍ ေလ့က်င့္ေလ႕လာ

သြားရမည့္ သင္ခန္းစာပဲ ျဖစ္ပါသည္။

၁) Hummer-Elevation.dwg ကုိ Open လုိက္ၾကရေအာင္။ Layout ျဖင့္ပြင့္မည့္ Drawing ကုိေလ႕လာမည္

ျဖစ္ေသာေၾကာင့္ Color layout ျဖင့္ Saved ထားေသာ Hummer-Elevation.dwg ကုိ ဖြင့္ရန္ ေရြးခ်ယ္ ရျခင္းပါသည္။
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၂) Status Bar ေပၚမွာ Zoom command ကုိ click ပါ။ Zoom Extents ကုိ အသံုးျပဳမည္ ျဖစ္ေသာေၾကာင့္ command line

တြင္ E ဟုရိုက္ျပီး Enter ႏိွပ္လုိက္ပါ။ Drawing သည္ Screen အျပည့္ ပုံၾကီးခ်႕ဲလာ ေပလိမ္႕မည္။ (Zoom Extents

အတြက္ အထက္တြင္ ေဖာ္ျပထားသည့္အတုိင္း Wheel Mouse ကုိ Double-click Press ၍လည္း အသုံးျပဳႏိုင္ပါသည္။)

Statub Bar မွ Zoom command

၃) Wheel Mouse ကို အသံုးျပဳမည့္ သူမ်ားအေနျဖင့္ ထို layout space တြင္ျမင္ေတြ႕ေနရေသာ Drawing ၏ ဘယ္ဖက္

ေအာက္ေထာင့္တြင္ Cursor ကို ထားျပီး Wheel ကုိေရွ႕/ေနာက္ လွိမ္႕ၾကည့္ပါ။ အကယ္၍ Wheel Mouse ကိုအသံုးမျပဳပဲ

Left Click/ Right Click ကိုသာ အသုံးျပဳမည့္ သူမ်ားအေနျဖင့္ Drawing window တြင္ Right Click ႏိွပ္လုိက္ပါ။

ေပၚလာေသာ Shortcut menu မွ Zoom ကုိ Click လိုက္ပါ။ ထို႕ေနာက္ Left Click ကို Drag လုပ္ကာ

ေရွ႕/ေနာက္ေရြ႕ၾကည့္ျပီး Drawing ၏ Zoom Out/ Zoom In ေျပာင္းလဲသြားပုံကို ဂရုတစိုက္ ေလ့လာၾကည့္ပါ။
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၄) Layout space မွ ပုံကို Screen အျပည့္ခ်ဲ႕ၾကည့္ရန္ View tab မွ Navigate panel ကို Click လိုက္ပါ။ ျပီးလွ်င္ Zoom

drop-down > Extents ကို Click လိုက္ပါ။

၅) လက္ရိွ Drawing ကုိ Layout space မွ Model Space ျဖင့္ေျပာင္းလဲ ၾကည့္ရႈ႕ပုံကို ေလ့လာၾကည့္ပါမည္။ Drawing ကို

Model Space တြင္ ေျပာင္းလဲၾကည့္ရႈ႕ရန္အတြက္ AutoCAD window ေအာက္ဆုံးတြင္ ရိွသည့္ Status Bar၏ ညာဖက္၌

ျမင္ေတြ႕ရေသာ Model ကုိ Click လိုက္ပါ။

(မွတ္ခ်က္။ ။ Drawing area ၏ ေအာက္နားတြင္ ရိွေသာ Model space ကုိလည္း Click ၍ေျပာင္းႏိုင္သည္။

Status Bar မွ Model Space

၆) Zoom Window View န႕ဲ ၾကည့္ၾကရေအာင္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

54

View tab မွ Navigate panel ကုိ Click လိုက္ပါ။ ျပီးလွ်င္ Zoom drop-down list > Window ကို Click လိုက္ပါ။ မိမိတုိ႕

ခြဲထုတ္ၾကည့္ လိုေသာအပိုင္းကုိ ဗဟိုထားျပီး Select Window ျဖင့္ပုံ၏ ေအာက္တြင္ အမွတ္တစ္မွတ္ အထက္တြင္

အမွတ္တစ္မွတ္ သတ္မွတ္လိုက္ပါ။ ထုိ Select Window ထဲမွ Object သည္ Screen အျပည့္ ပုံၾကီးခ်႕ဲသြားမည္ ျဖစ္သည္။

ေအာက္ပါပုံတြင္ ေလ့လာၾကည့္ပါ။

၇) ျပီးလွ်င္ Drawing ကုိ မူလ View အတုိင္းျပန္ထားရန္ အတြက္ View tab မွ Navigate panel ကုိ Click လိုက္ပါ။ ျပီးလွ်င္

Zoom drop-down list > Previous ကုိ Click လုိက္ပါ။

၈) Quick Access toolbar ေပၚမွ Save ကို Click ပါ။

၉) ထုိ႕ေနာက္ Application Menu မွ Close File ကုိ Select ျပီး Click လုိက္လွ်င္ Drawing window သည္ပိတ္

သြားပါလိမ္႕မည္။ Drawing file မ်ား၁ခုထက္ပိုျပီး ဖြင့္ထားပါက Close File မွ တဆင့္ နွစ္သက္ရာ Drawing မ်ားကုိ

ေရြးခ်ယ္ Close နိုင္ပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

55

၁၀) Application Menu ၏ ညာဖက္ေထာင့္နားတြင္ Previous ကဖြင့္ထားေသာ Drawings မ်ားကုိလည္း ေဖာ္ျပ

ေပးထားသည္။ Previous ကဖြင့္ထားခ႕ဲေသာ Drawings မ်ားထဲမွလည္း မိမိတုိ႕ ျပန္လည္ ဖြင့္လိုေသာ Drawing ကုိ Select

ေပးျပီး ျပန္ဖြင့္ႏိုင္ပါသည္။

၁၁) ဆက္လက္ျပီး Color layout Activated ျဖစ္ေစရန္အတြက္ AutoCAD window ရဲ႕ ညာဖက္ေအာက္နားက layout ကို

Click လိုက္ပါ။ ျပီးလွ်င္ Drawing ကုိ Close လိုက္ပါ။

၁၂) Quick Access toolbar ေပၚမွ New Drawing ကို Click လိုက္ပါ။

၁၃) New Drawing ဖြင့္တဲ႕အခါ Select Template Dialog Box ေပၚလာပါလိမ္႕မည္။ ထို dialog box မွ Open tab ရ႕ဲ

drop-down arrow ကုိ Click ျပီး Open with no Template – Imperial ကို Select လုပ္လိုက္ပါ။ ထုိသို႕ ဖြင့္လိုက္ေသာ

New Drawing သည္ Basic Setting ျဖင့္ ဖြင့္ထားျခင္းေၾကာင့္ Units format ကို စိတ္ၾကိဳက္ ေျပာင္းလဲႏိုင္ပါသည္။
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၁၄) Open with no Template – Imperial ျဖင့္ ဖြင့္ထားေသာ Drawing area ရ႕ဲ ညာဖက္ထိပ္ေထာင့္သုိ႕ Cursor

ေရြ႕ထားလုိက္ပါ။ ျပီးလွ်င္ Status Bar ဘယ္ဖက္ဆံုးတြင္ရိွေသာ Coordinate Point value ကိုဖတ္ၾကည့္လိုက္ပါ။ Drawing

Screen Size ဟာ 12 X 9 Units ျဖစ္ေနသည္ကုိ ေတြ႕ရေပလိမ္႕မည္။

၁၅) Files အားလံုးကို မ Save ပဲျပန္ပိတ္လိုက္ပါ။

Chapter Summary

အခ်က္အခ်ာက်တ႕ဲ Feautures တစ္ခ်ိဳ႕တစ္၀က္နဲ႕ မိတ္ဆက္ေပးျပီးျပီ ျဖစ္ေသာေၾကာင့္ ေလ့လာသူမ်ား အေနျဖင့္၊

Drawing မ်ားဖန္တီးျခင္း အပိုင္းကုိ စတင္ေလ့လာ ႏိုင္ျပီျဖစ္ပါသည္။

Chapter (1) တြင္ -

 Main Interface မွာရိွတဲ႕ Elements မ်ားရဲ႕ အဓိက ရည္ရြယ္ခ်က္နဲ႕ လုပ္ေဆာင္ခ်က္ ။

 Drawings မ်ား Open,Create န႕ဲ Save ျခင္း။

 Zoom န႕ဲ Pan commands မ်ားကုိ အသံုးျပဳျပီးေတာ႕ Drawings မ်ားကုိ View အမ်ိဳးမ်ိဳးမွ ၾကည့္ျခင္း။

 စသည္တို႕ကုိ ရွင္းလင္းေဖာ္ျပ ေပးထားသည္။

Chapter 2 : Creating Basic Drawings

Basic geometry ျဖင့္ Create မည့္ Drawings အားလုံးကုိ Lines, Circles, Arcs, န႕ဲ Rectangles စသည့္ Objects

မ်ားျဖင့္သာ Create ရျခင္းျဖစ္ပါသည္။ ရႈပ္ေထြးလွတ႕ဲ Block ေတြကုိ Create မည့္ Designer ေကာင္းတစ္ေယာက္ျဖစ္ဖို႕

အတြက္ အေျခခံ command ေတြကအစ ပိုင္ႏိုင္ကၽြမ္းက်င္စြာ အသုံးခ် ႏိုင္ဖုိ႕လုိအပ္ပါသည္။

ထုိသို႕ ကၽြမ္းက်င္ ပိုင္ႏိုင္လာေစရန္အတြက္ command တစ္ခုခ်င္းစီ၏ အေၾကာင္းကို အေသးစိတ္ အေသအခ်ာ ေလ႕လာ

ေလ့က်င့္သြားဖို႕ လိုအပ္ပါသည္။ မည္သည့္ command သည္ AutoCAD ၏ မည္သည့္ေနရာတြင္ရိွျပီး၊ မည္သည့္

command ကမည္သုိ႕ အက်ိဳးသက္ေရာက္မွဳ႕ရိွသည္ စသည္ျဖင့္ တစ္ခုခ်င္းစီ အေသးစိတ္ သိရိွေနဖို႕မွာ လြန္စြာမွ

အေရးပါလွသည္။ အေျခခံ Drawings မ်ားအတြက္ အေထာက္အပံ႕ ျဖစ္သည့္ object snaps, object snap tracking န႕ဲ

တျခားေသာ Feautures မ်ား၏ Settings ပိုင္းကုိလည္း စြဲစြဲျမဲျမဲ မွတ္သားရန္ လိုအပ္ပါသည္။ အေျခခံ Drawings မ်ားကို

စတင္ေလ့လာေတာ႕မည့္ သူမ်ားျဖစ္ေစ၊ AutoCAD Software ကိုအသံုးျပဳျပီး Drawings မ်ား Create မည့္သူမ်ားအေနျဖင့္

Coordinate System အေၾကာင္းကို လုံးေစ႕ပတ္ေစ႕ သိရိွနားလည္ ထားဖို႕ရာမွ အေရးၾကီးဆုံး အခ်က္ျဖစ္ပါသည္။
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AutoCAD Software တစ္ခုလုံး၏ အလုပ္လုပ္ပုံကုိ ေကာင္းမြန္စြာ သိရိွနားလည္ႏိုင္ဖို႕ ေလ့လာရာတြင္ နည္းလမ္းေပါင္း

မ်ားစြာျဖင့္ ေလ့လာသြားႏိုင္ပါသည္။ သုိ႕ေသာ္လည္း Commands and Features ေတြအေၾကာင္းကုိ ပိုင္ပိုင္ႏိုင္ႏိုင္

သိရိွထားမွ၊ မည္သို႕ေသာ နည္းလမ္းမ်ားသည္ မိမိတို႕အတြက္ အေကာင္းဆံုး နည္းလမ္းျဖစ္လိမ္႕မည္ ဆိုသည္ကို

ေသေသခ်ာခ်ာ စဥ္းစားဆံုးျဖတ္ ႏိုင္ေပလိမ္႕မည္။

ဤစာအုပ္အတြင္းမွ Chapter မ်ားကို ေလ့လာရာတြင္၊ ေလ့လာသူမ်ား အေနျဖင့္ 2D Drafting & Annotations

workspace ႏွင့္ AutoCAD window ၏အထက္နားတြင္ တည္ရိွေနေသာ Ribbon Toolbar ကုိအသုံးျပဳျပီး ေလ႕လာ

သြားမည္ဟု ယူဆမိပါသည္။

Objectives

ေလ့လာသူမ်ား အေနျဖင့္ ဤသင္ခန္းစာကို ေလ့လာျပီး သြားပါက -

 နဂိုမူလ Coordinate system နွင့္ Dynamic input အသုံးျပဳပုံ၊ Shortcut Menus အေၾကာင္း၊

 Drawings မ်ားတြင္ Geomentry မ်ားကုိ Line, Circle, Arc, Erase, Rectangle, နဲ႕ Polygon commands မ်ား

အသုံးျပဳျပီး Creat ျခင္းႏွင့္ မလုိအပ္ေသာ Objects မ်ားကို Erase လုပ္တတ္ေစရန္။

 Object snaps အသုံးျပဳကာ Drawings မ်ားတြင္ Objects မ်ားကုိ လိုအပ္သလို တိတိက်က် Create ႏိုင္ရန္။

 မတူညီေသာ Angles မ်ားျဖင့္ Drawings မ်ားတြင္ Geomentry မ်ားကို Polar Tracking and PolarSnap modes

တုိ႕ျဖင့္ အမွားအယြင္းမရိွပဲ တိတိက်က် Create နိုင္ရန္။

 Chapter 2 အတြင္းမွ Tools မ်ား၏ သေဘာတရားကို သိရိွနားလည္သြားလွ်င္ အေသးစား architectural floor

plan တုိ႕ကုိ စတင္ ဖန္တီးႏိုင္ေစရန္။

 Chapter 2 အတြင္းမွ Tools မ်ား၏ သေဘာတရားကို သိရိွနားလည္သြားလွ်င္ အေသးစား mechanical

assembly drawing မ်ား၏ initial geometry မ်ားကို စတင္ဖန္တီး ႏိုင္ေစရန္ ရည္ရြယ္ပါသည္။

Lesson: Inputting Data

Drawings မ်ားဖန္တီးရာတြင္ Objects တိုင္းအတြက္ ရိုက္ထည့္ရမည့္ Data မ်ားလုိအပ္ပါသည္။ မိမိတုိ႕ ဖန္တီးမည့္

Geomentry အမ်ိဳးအစားေပၚ မူတည္ျပီး၊ Data မ်ားရိုက္ထည့္ေပးရမည္ ျဖစ္ျပီး၊ ဖန္တီးသည့္ အၾကိမ္တိုင္း ရိုက္ထည့္ေပး

ရမည္ျဖစ္ပါသည္။ ဤသင္ခန္းစာတြင္ command line၊ dynamic input, direct distance entry, shortcut menus န႕ဲ

Cartesian coordinate system တို႕မွသက္ဆိုင္ရာ data မ်ားရိုက္ထည့္ျခင္း သင္ခန္းစာမ်ားကို ေလ႕လာ

သြားရမည္ျဖစ္သည္။

ဤသင္ခန္းစာ အျပီးတြင္ ေလ့လာသူမ်ား အေနျဖင့္ command line အသုံးျပဳပုံ၊ မတူညီေသာ Coordinate အမ်ိဳး

အစားမ်ားကို သိရိွနားလည္ျခင္း၊ Dynamic Input interface အသုံးျပဳပုံ၊ တန္ဖုိးမ်ား ရိုက္ထည့္ျပီး direct distance

မ်ားအသုံးျပဳျခင္းႏွင့္ Shortcut menus မ်ားအသံုးျပဳျပီး commands မ်ား Access လုပ္ျခင္း၊ Options မ်ားေရြးခ်ယ္ျခင္း

စသည္တုိ႕ကုိ သိရိွနားလည္လာမည္ ျဖစ္သည္။
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Dynamic Input interface အသံုးျပဳျပီး ၃၀ဒီဂရီနွင့္ ၁၀ယူနစ္ အကြာအေ၀းရိွ မ်ဥ္းကုိ ဖန္တီးထားေသာ ေအာက္ပါ ပုံကုိ

ေလ့လာၾကည့္ပါ။

About the Command Line

AutoCAD Software ရ႕ဲ အစိတ္အပိုင္းမ်ား ျဖစ္ေသာ Ribbon, menus န႕ဲ တစ္ျခားေသာ tools မ်ားသည္ Microsoft

Windows applications မ်ားတြင္ ပါ၀င္ေနၾက အစိတ္အပုိင္းမ်ားနွင့္ သေဘာတရားျခင္း ဆင္တူေသာ သာမန္

အစိတ္အပိုင္းမွ်သာ ျဖစ္သည္။ သုိ႕ေသာ္လည္း AutoCAD တြင္ ပါ၀င္ေနေသာ command line interface သည္ မည္သည့္

Applications မ်ားႏွင့္ ႏႈိင္းယွဥ္လို႕မရေသာ ထူးျခားခ်က္ တစ္ခုျဖစ္ပါသည္။ Command အမ်ားစု တြင္ commands

မ်ားဆင့္ပြား ေရြးခ်ယ္ရေသာေၾကာင့္ မိမိတုိ႕ အသုံးျပဳေသာ command ကုိ command line တြင္ အထူးသတိထားျပီး

ေရြးခ်ယ္လုပ္ေဆာင္သြားရပါမည္။

Command Line Defined

Command line သည္ AutoCAD Software န႕ဲဆက္သြယ္ေပး ေနေသာ အဓိက အက်ဆံုး ေနရာပင္ျဖစ္သည္။ Command

line သည္ commands မ်ားကို ေခၚယူရန္ သက္သက္သာ အသုံးျပဳႏိုင္ျခင္းမဟုတ္ပ၊ဲ Prompt မ်ားကုိ ဖတ္ျပီး မိမိတုိ႕

သံုးေနေသာ command တြင္ ေရွ႕ဆက္လုပ္ေဆာင္ရမည့္ သတင္းအခ်က္အလက္ မ်ားကုိပါ ညႊန္ၾကားေပးသည္။

Command Line Options

Command line တြင္ command တစ္ခုကုိ ရိုက္ထည့္လုိက္ျပီ ဆုိသည္နွင့္ ထပ္မံေရြးခ်ယ္ ပိုင္ခြင့္ ရိွသည့္ command

မ်ားကို command line တြင္ ေတြ႕ရိွရမည္။ ထုိသို႕ ေရြးခ်ယ္ရာတြင္ commands တုိင္း၌ စာလံုးအၾကီးျဖင့္ ေရးထားေသာ

စာလုံးတစ္လံုး ပါ၀င္ေနသည္ကုိ ေတြ႕ရမည္။ ထုိစာလံုးအၾကီးသည္ ထို command ကုိကိုယ္စားျပဳေသာ စာလုံးပင္

ျဖစ္သည္။ မိမိတုိ႕ ဆက္လက္ အသံုးျပဳလိုေသာ command တြင္ စာလံုးအၾကီးျဖင့္ ေရးထားေသာ
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စာလုံးတစ္လံုးတည္းကိုသာ command line တြင္ ရိုက္ထည့္ျပီး ေခၚယူနိုင္သည္။ ထုိသုိ႕ ရိုက္ထည့္ရာတြင္ User

မ်ားအေနျဖင့္ စာလုံးအၾကီး အတုိင္း ရိုက္ထည့္ရန္ မလုိေပ။

ေရြးခ်ယ္ႏိုင္သည့္ commands မ်ားဆိုလွ်င္ […..] ေလးေထာင့္ကြင္း ပိတ္ျပီးေဖာ္ျပေပးထားမွာ ျဖစ္သျပီး၊ မိမိတုိ႕

ရိုက္ထည့္ထားေသာ command ၏ default command ဆုိလွ်င္ <…..> ျဖင့္ေဖာ္ျပ ေပးသြားမည္ ကုိေတြ႕ရမည္။

Command window ကုိသီးသန္႕ ၾကည့္လိုလွ်င္ F2 ႏိွပ္ျပီး ေခၚယူၾကည့္ရႈနိုင္ပါသည္။ မိမိတုိ႕ လက္ရိွဖန္တီး ေနေသာ ပုံတြင္

အသုံးျပဳျပီးေသာ commands မွန္သမွ်ကုိ ထို command windw တြင္ အားလုံးကို ျပန္လည္ ၾကည့္ရႈ႕ႏိုင္ပါသည္။

Command window ကုိပိတ္လိုပါက F2 နိွပ္ျပီး ျပန္ပိတ္ရမည္။

ေအာက္ေဖာ္ျပပါပုံရိွ command line ကုိေလ့လာၾကည့္ပါ။ အဆုိပါ ျမင္ကြင္းသည္ User မ်ားအေနျဖင့္ rectangle

command ကို ေခၚထားျပီး၊ Drawing area တြင္ First Point သတ္မွတ္ျပီး အေျခအေနျဖစ္သည္။ First Point

သတ္မွတ္ျပီးပါက command line Prompt ကဆက္လက္ေရြးခ်ယ္ႏိုင္သည့္ command မ်ားကုိ ေဖာ္ျပေပးသည္။

ေအာက္ေဖာ္ျပပါ ပုံသည္ Dimension command ကုိေရြးခ်ယ္ထားျပီး ျဖစ္ေသာေၾကာင့္ rectangle ၏ Dimension

အကြာအေ၀းကို ရိုက္ထည့္ ေပးရေတာ႕မည္ျဖစ္သည္။ လက္ရိွ command line တြင္ Dimension အကြာအေ၀းသည္

default တန္ဖိုး 7.0000 ဟုေဖာ္ျပေနသည္။ User မ်ားအေနျဖင့္ command line တြင္ မည္သည့္ တန္ဖိုးမွ မရိုက္ထည့္ပဲ

Enter ကုိ Press လိုက္မည္ဆိုလွ်င္ rectangle ၏ Dimension အကြာအေ၀းသည္ default တန္ဖိုး 7.0000 သာ

ျဖစ္ေနမည္။

Command Line Example

ေအာက္တြင္ ေဖာ္ျပထားေသာ Command window မွ အေပၚ (၂) Lines သည္ ယခင္ ေခၚဆုိ အသံုးျပဳထားေသာ

command (သို႕မဟုတ္) လက္ရိွေခၚဆိုျပီး command history မ်ားကုိ ေဖာ္ျပေပးကာ၊ ေအာက္ဆုံး Line သည္ လက္ရိွ

လုပ္ေဆာင္ေနေသာ command line ျဖစ္ပါသည္။

About the Coordinate System

Drawing area ထဲတြင္ ဖန္တီးထားေသာ Objects မွန္သမွ်သည္ World Coordinate System (WCS) န႕ဲ User

Coordinate System (UCS) ေအာက္တြင္ တည္ရိွေနပါသည္။ 2D geomentry တစ္ခုဖန္တီး ေသာအခါတြင္၊ ထို

geomentry အတြက္ မိမိတို႕ ရိုက္ထည့္လိုက္ေသာ Data မ်ားသည္ Cartesian (x,y) (သုိ႕မဟုတ္) Polar Coordinates

(distance, angle) တုိ႕ကုိ ေနာက္ဆုံးျဖတ္သန္းျပီးမွ Software အတြင္းသုိ႕ ေရာက္သြားမည္ ျဖစ္သည္။ Coordinate မ်ားကို
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သာမန္အားျဖင့္ command line မွ တြက္ခ်က္ျပီး ရိုက္ထည့္ ႏိုင္သလုိ၊ Drawing area အတြင္းမွလည္း Cursor အသံုးျပဳျပီး

Point မ်ားျဖင့္ သတ္မွတ္ႏိုင္ပါသည္။

Cartesian Coordinate System

Cartesian Coordinate System ဆိုသည္မွာ Drawing area အတြင္းတြင္ ေတြ႕ျမင္ရေသာ UCS Icon တည္ရိွရာ Origin

Point ေနရာမွ စကာ အကြာအေ၀းကို တုိင္းတာရသည္။

World coordinate system တြင္မူ X ၀င္ရိုးဆုိလွ်င္ ေရျပင္ညီ အတိုင္းသြားမည္ျဖစ္ျပီး၊ Y ၀င္ရိုးဆုိလွ်င္ ေဒါင္လိုက္ အတိုင္း

သြားမည္ျဖစ္သည္။ Origin အမွတ္ကေတာ႕ 0,0 တြင္တည္ရိွမည္။ X တန္ဖိုး အေပါင္း လကၡဏာ ဆိုလွ်င္ ညာဖက္သုိ႕

သြားမည္ျဖစ္ျပီး၊ Y တန္ဖိုး အေပါင္းလကၡဏာ ဆုိလွ်င္ အေပၚသို႕ ေထာင္တက္သြားမည္ ျဖစ္ကာ၊ Z တန္ဖိုး

အေပါင္းလကၡဏာ ဆိုလွ်င္ User ဖက္သို႕ ဦးတည္လာမည္ ျဖစ္သည္။

မွတ္ခ်က္။ ။ လက္ရိွ ေလ့လာေနသည္မွာ 2D အပိုင္းသာ ျဖစ္ေသာေၾကာင့္ X နဲ႕ Y ၀င္ရုိး တန္ဖိုးမ်ားသာ ပါ၀င္မည္ ျဖစ္ျပီး၊

Z ၀င္ရိုးတန္ဖိုးမ်ားသည္ (0) သာျဖစ္မည္။ (0) ျဖစ္ေသာေၾကာင့္ Z တန္ဖိုးကုိ ထည့္တြက္ စရာမလိုေပ။ Z တန္ဖိုးသည္ 3D

ပိုင္းတြင္သာ အသုံးျပဳရမည္ ျဖစ္သည္။

ေအာက္ေဖာ္ျပပါ ပုံတြင္ Line ၏အစကုိ Coordinate system ရဲ႕ Origin Point 0,0 အျဖတ္ သတ္မွတ္ဆြဲထားျပီး၊

ဆံုးမွတ္အျဖစ္ Coordinate အမွတ္ 4,6 တြင္ဆြဲထားျခင္း ျဖစ္ပါသည္။

အထက္ပါ ပုံကို ေရးဆြဲရာတြင္ command line တြင္ L ဟုရိုက္ထားျပီး Line command ကိုေခၚလိုက္ပါ။ ထုိ႕ေနာက္

command line တြင္ First Point ေတာင္းလာလိမ္႕မည္ ျဖစ္ျပီး ထို First Point အတြက္ 0,0 ဟုရိုက္ထည့္ လိုက္ပါ။ ျပီးလွ်င္

command line ၌ Second Point ထပ္မံေတာင္းလာပါလိမ္႕မည္။ 4,6 ဟုရိုက္ထည့္လိုက္ပါ၊ ျပီးလွ်င္ command ဆုံးေစရန္

Enter ကုိ Press လိုက္ပါက အထက္ပါ ပုံကုိ ဆြဲျပီးသား ေတြ႕ရေပလိမ္႕မည္။

Polar Coordinates

Coordinate system တစ္မ်ိဳးျဖစ္သည့္ Polar Coordinate တြင္ အမွတ္တစ္မွတ္၏ တည္ေနရာကို သတ္မွတ္ ရာတြင္၊

Origin Pointမွ အဆုိပါ Point ရိွရာ အကြာအေ၀း နွင့္ ေထာင့္တုိ႕ကုိ ၾကည့္ျပီး သတ္မွတ္ရသည္။ ေအာက္ေဖာ္ျပပါ ပုံမွ

Lineကုိ ဆြဲထားသည္မွာ Origin Point မွ 7Units အကြာအေ၀းျဖစ္ျပီး၊ ေထာင့္မွာ 45 ဒီဂရီ ျဖစ္ပါသည္။
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အထက္ပါ ပုံကို ေရးဆြဲရာတြင္ command line တြင္ L ဟုရိုက္ထားျပီး Line command ကိုေခၚလိုက္ပါ။ ထုိ႕ေနာက္

command line တြင္ First Point ေတာင္းလာလိမ္႕မည္ ျဖစ္ျပီး ထို First Point အတြက္ 0,0 ဟုရိုက္ထည့္ လိုက္ပါ။ ျပီးလွ်င္

command line ၌ Second Point ထပ္မံေတာင္းလာပါလိမ္႕မည္။ Polar coordinate အျဖစ္သတ္မွတ္ ေရးဆြဲမည္

ျဖစ္ေသာေၾကာင့္ Second Point အတြက္ သတ္မွတ္ရာတြင္ 7<45 ဟု ရိုက္ထည့္လုိက္ပါ။ ျပီးလွ်င္ command ဆုံးေစရန္

Enter ႏိွပ္လိုက္ပါက အထက္ပါ ပုံကို ဆြဲျပီးသား ေတြ႕ရေပလိမ္႕မည္။ 7 မွာ အကြာအေ၀းကို ကုိယ္စားျပဳျပီး၊ <45 မွာ 45

ဒီဂရီ ကုိကုိယ္စားျပဳပါသည္။

(မွတ္ခ်က္။ ။ဒီဂရီအတြက္ (< ) သေကၤတကို အသံုးျပဳရပါသည္။)

Polar Angle

Default Polar angle ကိုတုိင္းတာရာတြင္ angle Position 0 ဒီဂရီမွ နာရီလက္တံ ေျပာင္းျပန္အတိုင္း ဆုိလွ်င္ အေပါင္းတန္

ဖိုးအျဖစ္ သတ္မွတ္ျပီး၊ နာရီလက္တံအတုိင္း ဆိုလွ်င္ အႏုတ္တန္ဖိုးအျဖစ္ သတ္မွတ္ပါသည္။ ေအာက္ေဖာ္ျပပါပုံကို

ၾကည့္ျခင္းအားျဖင့္ Polar angle ၏တုိင္းတာနည္းကုိ ရွင္းရွင္းလင္းလင္း သေဘာေပါက္ ေပလိမ္႕မည္။

Absolute and Relative Coordinates

Coordinate အမွတ္မ်ား ရိုက္ထည့္ရာတြင္ absolute coordinate ပုံစံ နွင့္ relative coordinate ပုံစံဟူ၍ နွစ္မ်ိဳးႏွစ္စား

ရိုက္ထည့္ႏိုင္ပါသည္။

Absolute coordinate

Absolute coordinate ပုံစံအတြက္ coordinate တန္ဖိုး သတ္မွတ္ရာတြင္ Origin Point မွစျပီး အကြာအေ၀း တန္ဖိုးကို

တုိင္းတာ တြက္ခ်က္ပါသည္။ Absolute coordinate တန္ဖိုးမ်ား ရိုက္ထည့္ရာတြင္ အထက္တြင္ တင္ျပ ထားျပီး ျဖစ္ေသာ
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Cartesian coordinate (x,y) (သို႕မဟုတ္) Polar coordinate (distance< angle) ဟု ရိုက္ထည့္ ရသည့္ ပုံစံမ်ိဳး

ျဖစ္သည္။

Relative coordinate

Relative coordinate ပုံစံအတြက္ coordinate တန္ဖိုး သတ္မွတ္ရာတြင္ ေနာက္ဆံုး သတ္မွတ္ခ႕ဲေသာ coordinate

အမွတ္ေနရာမွ စတင္ တြက္ခ်က္ယူရသည္။ Relative coordinate ပုံစံအသုံးျပဳျပီး coordinate သတ္မွတ္ရာ၌ first point

အတြက္ coordinate တန္ဖိုး တစ္ခုခုကုိ ရိုက္ထည့္လုိက္ပါ။ ျပီးလွ်င္ မိမိတုိ႕ရိုက္ထည့္ လုိက္ေသာ coordinate အမွတ္ကေန

ေနာက္တစ္မွတ္ ကူးရန္အတြက္ @ သေကၤတ ရိုက္ထည့္ျပီး သြားလုိေသာ coordinate တန္ဖိုးကုိ ရိုက္ထည့္ရပါမည္။

Absolute and Relative Coordinate Examples

Example of Cartesian Coordinate Input

ေအာက္ပုံတြင္ ေဖာ္ျပထားေသာ Line ေရးဆြဲရာတြင္ Cartesian (သုိ႕မဟုတ္) Polar coordinates နွစ္မ်ိဳးလုံး အသံုးျပဳျပီး

ေရးဆြနိုဲင္ပါသည္။ ျမွားျဖင့္ ျပထားေသာ ေနရာသည္ Point 1: စမွတ္ျဖစ္ပါသည္။ ေလ့လာသူမ်ား အေနျဖင့္ ေအာက္တြင္

Cartesian (သို႕မဟုတ္) Polar coordinates နွစ္မ်ိဳးစလုံး အတြက္ ေဖာ္ျပေပးထားေသာ coordinate အမွတ္မ်ားကို

command line တြင္ ရိုက္ထည့္ျပီး လုိက္ပါေလ့က်င့္ၾကည့္ပါ။

Point 2: @4,0 or @4<0

Point 3: @0,2 or @2<90

Point 4: @-1,0 or @1<180

About Dynamic Input
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Dynaminc Input Interface သည္ Command line က႕ဲသုိ႕ပင္ commands မ်ားရိုက္ထည့္ျပီး အသံုးျပဳႏိုင္ ပါသည္။

Cursor ၏ Location ထဲတြင္ပင္ရိွေသာ command မ်ားရိုက္ထည့္ ႏိုင္သည့္ Box နွင့္ ရိုက္ထည့္ လိုက္ေသာ command

ျဖင့္ပတ္သက္ျပီး ေရွ႕ဆက္လုပ္ေဆာင္ရမည့္ ညႊန္ၾကားခ်က္မ်ား ေဖာ္ျပေသာ box ကိုပါ ေတြ႕ရမည္ ျဖစ္သည္။

Dynamic Input Interface

Dynamic Input Interface တြင္ modes ႏွစ္မ်ိဳးရိွပါသည္။ ၎တို႕မွာ Dimensional Input Mode နဲ႕ Pointer Input ဟူ၍

ျဖစ္ပါသည္။ ေအာက္တြင္ ေဖာ္ျပထားေသာ Dynamic Input Interface အမ်ိဳးအစားမွာ Dimensional Input Mode

အမ်ိဳးအစား ျဖစ္ပါသည္။ Status Bar တြင္ရိွေသာ Dimensional Input Icon ကို Select ျပီး၊ command line မွ Line,

Circle, နဲ႕ Arc စသည့္ command တစ္ခုခုကို ရိုက္ထည့္လိုက္ပါက Dimensional Input Mode ကို ေတြ႕ျမင္ရမည္

ျဖစ္သည္။

မွတ္ခ်က္။ ။ Dynamic Input ကုိ Status bar ၌ Select ႏိုင္သလို၊ အထက္တြင္ Shortcut Keys မ်ားတြင္ ေဖာ္ျပျပီး

ျဖစ္သည့္ F12 key ကို ႏိွပ္၍လည္း Dynamic Input ကုိ အသုံးျပဳႏိုင္ပါသည္။

Tooltip: လက္ရိွအသံုးျပဳေနေသာ command ရ႕ဲ ဆက္လက္ လုပ္ေဆာင္ရမည့္ အစီစဥ္ကို ညႊန္ၾကားေပးျပီး၊ command

line မွ Prompt တြင္ ဆက္လက္ လုပ္ေဆာင္ရမည့္ အစီစဥ္ကုိ ညႊန္းၾကားျပသ ေပးသကဲ႕သို႕ ညႊန္ၾကားေပးေသာ Box

ေလးျဖစ္ပါသည္။

Coordinate, Length, or Angle input fields: Mode အေပၚ မူတည္ျပီးေတာ႕ ထုိ box ေလးထဲတြင္ မိမိတုိ႕

ေရးဆြေဲနေသာ ပုံ၏ တန္ဖုိးကုိ ေျပာင္းလဲေပးႏိုင္ပါသည္။ အထက္တြင္ Polyline ေရးဆြဲထားသည္ ကိုၾကည့္ပါ။ ထို Polyline

၏စမွတ္နွင့္ မိမိတုိ႕ Cursor ထားေသာ အကြာအေ၀းသည္ 21.6333 ရိွေနသည္ကုိ ေဖာ္ျပ ေပးထားသည္။

Userမ်ားအေနျဖင့္ ထုိ box ေလးထတဲြင္ တန္ဖိုးတစ္ခုခု ရိုက္ထည့္လိုက္ျပီး Enter ႏိွပ္ကာ command ဆုံးေပးလုိက္ပါက၊

မိမိတုိ႕ ရုိက္ထည့္လုိက္ေသာ တန္ဖိုးအကြာအေ၀းရိွ Polyline ေလးတစ္ေၾကာင္းကို ေရးဆြဲျပီး ျဖစ္ေနမည္ကုိ ေတြ႕ရမည္။

ထုိ box ေလးထတဲြင္ တန္ဖိုးရိုက္ထည့္ရန္ Curosor ခ်ဖို႕အတြက္ Tab key ေလးကုိ အသံုးျပဳရပါမည္။
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Down arrow: Down arrow key (Keyboard မွ )ေလး ႏိွပ္ျပီး Dinamic Input Menu ကုိ ၾကည့္ရႈ႕ႏိုင္ ပါသည္။ Up

arrow key ကေတာ႕ Previously ကအသံုးျပဳခ႕ဲေသာ Coordinate ကုိျပန္လည္ ေခၚယူႏိုင္ပါသည္။

Dynamic Input Menu: Dynamic Input Menu မွ လက္ရိွ command န႕ဲ ဆက္စပ္ေသာ commands မ်ားကို

ေရြးခ်ယ္ႏိုင္ပါသည္။ command line တြင္ဆင့္ပြား commands မ်ားေရြးခ်ယ္ရသက႕ဲသို႕ပင္ ျဖစ္သည္။ ထုိဆင့္ပြား

commands မ်ားသည္ Dynamic Input Menu တစ္ခုတည္းတြင္သာ ေပၚေနမည္ မဟုတ္ပ၊ဲ ေအာက္ command line

တြင္လည္း ထုိ commands မ်ားကို ေဖာ္ျပေပးေနမည္ ျဖစ္သည္။

Dynamic Input Interface—Pointer Input Mode

Coordinates အမွတ္@ 10 < 45 ကုိ Keyboard မွ ရိုက္ထည့္လိုက္ေသာ အခါ ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံအတုိင္း၊

Dynamic Input Interfaceရဲ႕ Pointer Input Mode သို႕ေျပာင္းလဲသြားမည္ ျဖစ္သည္။ Pointer Input Mode ရိွ

command line တြင္ coordinates အမွတ္မ်ား ရိုက္ထည့္ရသကဲ႕သို႕ Pointer မွလည္း coordinates အမွတ္မ်ား ရိုက္ထည့္

ႏိုင္ပါသည္။ Pointer Input Mode ကို Absolute န႕ဲ Relative coordinates တုိ႕တြင္ အသုံးျပဳ နိုင္ပါသည္။ Pointer Input

Mode သည္ Move, Copy, န႕ဲ Rotate စသည့္ commands မ်ား၏ default mode ျဖစ္ပါသည္။

Lock icons ေလးျဖင့္ ျပထားေသာ တန္ဖိုးမ်ားသည္ User မ်ား လက္ရိွ အသံုးျပဳေနသည့္ တန္ဖိုးျဖစ္ပါသည္။ ထုိ Lock icons

ေလးမ်ားကုိ Unlock ျဖစ္ရန္အတြက္ Tab key ေလး ႏိွပ္လိုက္ျပီး၊ ထို field တြင္းမွ တန္ဖိုးကုိ ဖ်က္ရန္ အတြက္ Delete key

ကုိႏိွပ္လိုက္ပါ။ မိမိတို႕ ရိုက္ထည့္လိုေသာ တန္ဖုိးမ်ား ရိုက္ထည့္ျပီးလွ်င္ Lock ျပန္ခ်ရန္ အတြက္ Tab key ေလးကို

ျပန္ႏိွပ္လိုက္ပါ။

Dinamic Input ရဲ႕ default mode ဟာ relative coordinates အတြက္ ဆုိေပမ႕ဲ၊ absolute coordinates မ်ားလည္း

ရိုက္ထည့္ ႏိုင္ပါသည္။

Dynamic Input Options

Drafting Settings dialog box ကိုေခၚ၍ Dynamic Input tab ကုိႏိွပ္ကာ Dynamic Input interface န႕ဲ ပတ္သက္ေသာ

setting မ်ားကို မိမိတို႕အတြက္ သင့္ေတာ္သလုိ အေျပာင္းအလဲ လုပ္ႏိုင္ပါသည္။
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Pointer Input Options မ်ားျပဳျပင္ရမည့္ေနရာ။

Dimensional Input Options မ်ားျပဳျပင္ရမည့္ေနရာ။

Dynamic Input tooltips န႕ဲ ဆက္စပ္ပတ္သက္ သည္မ်ားကို ျပဳျပင္ရမည့္ေနရာ။

Guidelines for Using Dynamic Input

Objects မ်ားကုိ stretch လုပ္သည့္အခ်ိန္ ျဖစ္ေစ (သုိ႕မဟုတ္) New Objects မ်ား Create သည့္အခါမ်ိဳး၌ ျဖစ္ေစ၊

dimensional inputတြင္ ေထာင့္က်ဥ္းမ်ားကို ေဖာ္ျပေပးပါသည္။ ၁၈၀ ဒီဂရီနွင့္ ၁၈၀ဒီဂရီ ထက္နည္းေသာ

ေထာင့္မ်ားကိုသာ ေဖာ္ျပမည္ျဖစ္သည္။ ၂၇၀ ဒီဂရီရိွေသာ ေထာင့္အတြက္ ေဖာ္ျပရာတြင္ ၉၀ ဒီဂရီဟုသာ ေဖာ္ျပေပး

လိမ္႕မည္ ျဖစ္သည္။

Dynamic Input ကုိ command line ကုိအစားထုိးဖို႕ အတြက္ ရည္ရြယ္ျပီးေတာ႕ စီမံထားျခင္း မ်ိဳးေတာ႕ မဟုတ္ေပ။

Dynamic Interface prompt ေကာ command line ႏွစ္မ်ိဳးစလံုးကုိ မိမိတုိ႕၏ Workflow အရ တစ္ျပိဳင္တည္း

အသုံးျပဳႏိုင္ပါသည္။

မိမိ cursor ၏ Location ေပၚမွာမူတည္ျပီးေတာ႕၊ object snaps,polar tracking, tooltips, န႕ဲ object snap tips တုိ႕ရ႕ဲ

အေျခအေနေတြကုိပါ Dynamic Input Interface တြင္ command line မွ prompt က႕ဲသုိ႕ပင္ ၾကည့္ရႈ႕နိုင္မည္ ျဖစ္သည္။

Using the Dynamic Input Interface

Dynamic Input Interface ကုိ နည္းလမ္းေပါင္းမ်ားစြာန႕ဲ အသံုးျပဳႏိုင္ပါသည္။ သို႕ေသာ္ မည္သို႕ေသာ နည္းလမ္းကို

အသုံးျပဳသည္ျဖစ္ေစ အဓိကရည္ရြယ္ခ်က္မွာ Drawing မ်ားေရးဆြဲရာတြင္ အေထာက္အကူ ျပဳေစရန္နွင့္ heads-up mode

ေတြကုိ edit လုပ္သည့္ အခါမ်ိဳးတြင္ command line က႕ဲသုိ႕ပင္ အသံုးတည့္ ေစရန္ ျဖစ္ပါသည္။ Dynamic Input mode

အသုံးျပဳျခင္းသည္ မိမိတို႕ ေရးဆြဲေနေသာ Drawing မ်ားနွင့္ ဆက္စပ္ေသာ သတင္း အခ်က္အလက္မ်ား ေဖာ္ျပရာတြင္

ပိုမိုလ်င္ျမန္ မွဳ႕ရိွပါသည္။ Dynamic Input Interface အသံုးျပဳျပီးေတာ႕ Drawing မ်ားေရးဆြဲျခင္းႏွင့္ Edit လုပ္ျခင္းတို႕ကို

ေအာက္တြင္ ပုံန႕ဲတကြ ေဖာ္ျပေပးထား ပါသည္။ ေလ႕လာၾကည့္ၾကပါစို႕။
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Command Access

Dynamic Input Mode

Command Line: DYNMODE

Function Key: F12

Procedure: Drawing with Dynamic Input

Dynamic Input interface and Polar coordinates တုိ႕ကိုအသံုးျပဳျပီးေတာ႕ geometry မ်ားေရးဆြဲရန္ ေအာက္ပါ

အဆင့္တုိင္း လိုက္ပါလုပ္ေဆာင္ ၾကည့္ၾကရေအာင္။

မွတ္ခ်က္။ ။Dynamic Input display က activated ျဖစ္ေနတဲ႕ အတြက္ေၾကာင့္ ampersand symbol ျဖစ္တ႕ဲ (@)

ကုိရိုက္ ထည့္စရာ မလုိအပ္ပါဘူး။

၁) Dynamic Input command ကိုစတင္ဖြင့္လိုက္ပါ။Command တစ္ခု စရိုက္လုိက္တာနဲ႕ Dynamic Input field ထမွဲာ

ေအာက္ပါပုံအတိုင္း ေပၚလာပါလိမ္႕မည္။
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၂) ထုိသို႕ ရိုက္ျပီးပါက Enter ကုိ Press လုိက္ရင္ ေအာက္ပါပုံအတုိင္း Point Input mode ေလးအျဖစ္ေျပာင္း

သြားပါလိမ္႕မည္။ ထုိ႕ေနာက္ tooltip ထတဲြင္ မိမိတုိ႕ ေရွ႕ဆက္လုပ္ေဆာင္ရန္ လုိအပ္ခ်က္မ်ားကုိ ေဖာ္ျပေပး လိမ္႕မည္

ျဖစ္ျပီး၊ Input field တြင္မူ လက္ရိွ Cursor ေရာက္ေနေသာ X,Y coordinate ရ႕ဲ တန္ဖိုးေတြကုိလည္း ေဖာ္ျပေပး

ေနပါလိမ္႕မည္။

၃) First point သတ္မွတ္ရန္အတြက္ နွစ္သက္ရာ တစ္ေနရာတြင္ cursor ထားျပီး Enter ႏိွပ္လိုက္ပါက First point

ကုိသတ္မွတ္ေပးျပီး ျဖစ္လိမ္႕မည္။ (မွတ္ခ်က္။ ။ first point သတ္မွတ္ရာတြင္ မိမိတို႕ နွစ္သက္ရာ X,Y coordinate

တန္ဖိုးမ်ား ရိုက္ထည့္ျပီးေတာ႕လည္း သတ္မွတ္ေပးႏိုင္ပါသည္။ First Pint သတ္မွတ္ေပးျပီး ျဖစ္ေသာေၾကာင့္ Dynamic

Input display prompts တြင္ ဆက္လက္လုပ္ေဆာင္ရမည့္ ညႊန္ၾကားခ်က္ အျဖစ္ Next point သတ္မွတ္ ေပးရန္

ေတာင္းခံေနေပလိမ္႕မည္။
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၄) Input field ထဲတြင္ အကြာအေ၀း တန္ဖိုးရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္လွ်င္ အကြာအေ၀း တန္ဖိုး lock က်သြားျပီး၊

cursor သည္ Angle input field ထသိုဲ႕ ေရာက္သြားပါလိမ္႕မည္။ Angle အတြက္ တန္ဖိုးကုိ 0 ဒီဂရီျဖင့္ Tab key ႏိွပ္ကာ

lock ခ်လိုက္ပါ။ ျပီးလွ်င္ Point သတ္မွတ္ရန္ တစ္ခ်က္ Click လုိက္ပါ။ ေအာက္ပါ ပုံမွ တန္ဖိုးအတိုင္း

လိုက္ပါေလ႕က်င့္ၾကည့္ပါ။

၅) ဆက္လက္ျပီး ေအာက္ပါ distance Input field တြင္ ေတြ႕ရေသာ တန္ဖိုးကို ရိုက္ထည့္၍ Tab key ႏိွပ္ကာ lock ခ်ျပီး ၊

angle ကိုလည္း ေအာက္ပါ ပုံတြင္ angle input field မွ ေဖာ္ျပေပးထားေသာ တန္ဖိုးကို ရိုက္ထည့္ျပီး lock ခ်လိုက္ပါ။

ျပီးလွ်င္ လက္ရိွေနရာတြင္ တစ္ခ်က္ click လိုက္ပါ (သုိ႕မဟုတ္ ) Enter ႏိွပ္လိုက္ပါ။
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၆) ျပီးလွ်င္ လက္ရိွ point ၏ အထက္တစ္ေနရာရာတြင္ Cursor ခ်၍ Enter ႏိွပ္လိုက္ပါကာ ေအာက္ပါ ပုံအတိုင္း

ရရိွသြားမည္ ျဖစ္ပါသည္။

Procedure: Editing with Dynamic Input

Dynamic Input interface န႕ဲ Objects မ်ားကို Edit လုပ္တ႕ဲ နည္းလမ္းတစ္ခ်ဳိ႕ကို ေအာက္တြင္ ေဖာ္ျပ ေပးလုိက္ပါသည္။

၁) Circle ကို Edit လုပ္တ႕ဲ ေလ့က်င့္ခန္းေလးကို လိုက္ပါေလ့က်င့္ၾကည့္ ၾကရေအာင္။ Ribbon ရဲ႕ Home tab မွ Modify

panel > Copy command ကုိ clickလုိက္ပါ။ ျပီးလွ်င္ Circle ကို select ျပီး Enter ႏိွပ္လုိက္ပါ။

၂) Enter ႏိွပ္ျပီးပါက Dynamic Input interface prompts ေလး ေပၚလာပါလိမ္႕မည္။ Keyboard မွ Down arrow key

ႏိွပ္ျပီး copy ကုိ Single copy mode (သုိ႕မဟုတ္) Multiple copy mode တို႕ကို ေရြးခ်ယ္ႏိုင္ပါသည္။ Dynamic Input
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interface prompts တြင္ base point ေတာင္းခံလာသည္ကို ေတြ႕ရမည္။ Objects အနီးနား တစ္ေနရာကုိ base point

အျဖစ္ သတ္မွတ္ေပးလိုက္ပါ။

၃) Dynamic Input tooltip ကတုန္႕ျပန္ခ်က္ေလး တစ္ခု ေဖာ္ျပေပးလိမ္႕မည္။ Distance Input field တြင္ 38.500

ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္ကာ Lock ခ်လိုက္လွ်င္ cursor သည္ Angle Input field သို႕ ေရာက္သြားလိမ္႕မည္။ Angle

Input field တြင္ ၁၈၀ ဒီဂရီဟု ရိုက္ထည့္ျပီး Tab key ႏွိပ္၍ Enter ႏိွပ္လိုက္ပါ။

၄) Circle တစ္ခုကုိ grip လုပ္လုိက္ပါ။

၅) Grip လုပ္ထားေသာ Circle ရ႕ဲ quadrant ကုိ တစ္ခ်က္ထပ္ Click လုိက္လွ်င္ Dynamic Input interface

ေပၚလာပါလိမ္႕မည္။ Dynamic Input interface မ်ားမွ လက္ရိွ Circle ၏ Radius မ်ားကို ျပန္လည္ သတ္မွတ္ႏိုင္ပါသည္။

Dynamic Input interface ႏွစ္ခုရိွေနသည္ကို ေတြ႕ရမည္။ တစ္ခုမာွ Cursor ေရာက္ေနေသာ Radius အကြာအေ၀းကုိ

ျပသေနမည္ျဖစ္ျပီး၊ တစ္ခုမွာ လက္ရိွ Circle ၏ Radius ကုိ မိမိတုိ႕ လုိခ်င္သေလာက္ ရိုက္ထည့္ႏိုင္ေသာ ေနရာျဖစ္သည္။
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၇) Radius ျပန္လည္ ျပင္ဆင္သတ္မွတ္ ထားျပီးေသာ ပုံပါ။

Using the Dynamic Input Interface to Reveal Information

Dynamic Input Interface ကုိ ON ထားျခင္းအားျဖင့္ Objects မ်ားကို Grip လုပ္ျပီး၊ ထုိ Objects မ်ားန႕ဲ ပတ္သက္ေသာ

အခ်က္အလက္မ်ားကုိ သိရိွႏိုင္ပါသည္။ Line Object ကုိ grip လုပ္လိုက္ယံုျဖင့္ ထို Line ၏ Length န႕ဲ Angle ၊ Arc

(သုိ႕မဟုတ္) Circle တုိ႕ကုိ grip လိုက္ယံုျဖင့္ ထို Arc (သုိ႕မဟုတ္) Circle တို႕၏ Radius တုိ႕ကုိ သိရိွႏိုင္မည္ ျဖစ္သည္။

Line ကုိ Grip လုပ္ျပီးပါက Cursor ကို Line ၏ အဆုံးတစ္ဖက္တြင္ တင္ထားၾကည့္ လိုက္ပါက ထုိ Line၏ angle နွင့္

length ကုိေဖာ္ျပေပးလိမ္႕မည္။

Guidelines for Using Dynamic Input

 Length (သုိ႕မဟုတ္) Angle တုိ႕၏ တန္ဖိုးမ်ား ရိုက္ထည့္ျပီးခ်ိန္တြင္ Tab key ႏွိပ္ျပီး Lock ခ်ရပါမည္။
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 Input fields အတြင္းသုိ႕ Length (သို႕မဟုတ္) Angle တုိ႕၏ တန္ဖိုးမ်ားကုိ မရိုက္ထည့္မီ Input fields မ်ားသုိ႕

Tab key နိွပ္ျပီး ကူးေျပာင္း သြားလာႏိုင္သည္။

 Objects မ်ားကို Grip အသုံးျပဳျပီး Dynamic Input Interface မွ Objects မ်ားကို Modify လုပ္ႏိုင္ပါသည္။ မိမိတုိ႕

Modify လုပ္လိုေသာ Objects ကို Grip activated ျဖစ္သြားေအာင္ Select လုပ္လုိက္ပါ။ Selected

လုပ္ျပီးသြားလွ်င္ Grip သည္ activated ျဖစ္သြားပါျပီး၊ Dynamic Input Interface ေပၚလာပါလိမ္႕မည္။ ထို

Dynamic Input Interface မ်ားတြင္ Tab key ႏိွပ္ကာ မိမိတို႕ စိတ္ၾကိဳက္ Modify လုပ္ႏိုင္ပါသည္။

 (X,Y) ပုံစံျဖင့္ coordinates မ်ားကုိ ရိုက္ထည့္လိုလွ်င္ absolute coordinate mode ျဖစ္မွ ရိုက္၍

ရမည္ျဖစ္ေသာေၾကာင့္၊ coordinates မ်ားကုိ absolute coordinate mode ျဖင့္ Software အတြင္းသုိ႕

၀င္သြားရန္ coordinates မ်ားေရွ႕တြင္ (#) ခံျပီးရိုက္ရမည္ျဖစ္သည္။

Using Direct Distance Entry

Direct Distance Entry သည္ လက္ရိွေရာက္ေနေသာ အမွတ္မွ မိမိတို႕ သြားလုိေသာ လမ္းေၾကာင္းကို Mouse

ျဖင့္ဦးတည္ထားျပီး အကြာအေ၀းတန္ဖိုး ရိုက္ထည့္ကာ သြားရေသာ နည္းျဖစ္ပါသည္။ တစ္နည္းအားျဖင့္ မိမိတုိ႕

သြားလိုေသာ အမွတ္ကုိ Previous ကေရာက္ခ႕ဲေသာ အမွတ္မွ အေျခခံထား တြက္ခ်က္ရျပီး၊ Mouse ညႊန္ျပေသာ

လမ္းေၾကာင္းအတုိင္း သြားမည္ျဖစ္သည္။ ဤနည္းလမ္းတြင္ Polar Tracking အသုံးျပဳရန္ အေကာင္းဆုံး အေျခ

အေနျဖစ္သည္။

Guidelines for Using Direct Distance Entry

 Cursor ၏ angle ကုိ display ရန္ Polar Tracking ကို ON လိုက္ပါ။

 Polar Tracking settings ၀င္ျပီး မိမိတို႕စိတ္ၾကိဳက္ Polar angle၏ တန္ဖိုးကို ေရြးခ်ယ္/ ရိုက္ထည့္ လိုက္ပါ။

 မိမိတုိ႕ စိတ္ၾကိဳက္ တန္ဖိုးကို ရိုက္ထည့္ျပီးလွ်င္ Enter ကုိႏိွပ္လိုက္ပါ။ Polar Tracking က angles တန္ဖိုးမ်ားကုိ

ျပေသာအခါ တိက်ေသာ တန္ဖိုးေဖာ္ျပ ႏိုင္ေစရန္ ျဖစ္သည္။

 AutoCADသည္ တန္ဖိုးမ်ားကို ဒႆမ၁၄လုံး (1.00000000000000) အထိယူလွ်င္ အမွားအယြင္း ကင္းႏိုင္သည္။

ထုိ႕ေၾကာင့္ အကြာအေ၀း တန္ဖိုးမ်ား ရိုက္ထည့္ျခင္းသည္ လြန္စြာမွ အေရးၾကီးလာျပီ ျဖစ္ျပီး အေသးစိတ္

လြန္းေသာေၾကာင့္ Polar Snap ကို အသံုးျပဳ ရပါမည္။

Procedure: Using Direct Distance Entry
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Direct Distance Entry အသုံးျပဳေသာ နည္းလမ္းမ်ားကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Line command ကိုရုိက္ထည့္ျပီး စမွတ္တစ္ခုကုိ သတ္မွတ္လုိက္ပါ။

Tip: Dynamic Input ကို OFF လုိက္ပါ။

၂) လက္ရိွအမွတ္မွ ေနာက္တစ္မွတ္သုိ႕ သြားရန္ မိမိတုိ႕ နွစ္သက္ရာ လားရာဖက္သို႕ Mouse ေရြ႕ထားပါ။ ျပီးလွ်င္

command line မွ အကြာအေ၀းတစ္ခုကုိ ရိုက္ထည့္လုိက္ပါ။

၃) ေနာက္တစ္မွတ္ ဆြဲရန္အတြက္ Mouse ကိုေအာက္ပါပုံတြင္ ေဖာ္ျပထားသည့္ အေနထားအတိုင္း ေရြ႕လုိက္ပါ။ ျပီးလွ်င္

ပထမ line တုန္းက ရိုက္ထည့္ခဲ႕ေသာ တန္ဖိုးန႕ဲ မတူေသာ တန္ဖိုးတစ္ခုကုိ ရိုက္ထည့္လုိက္ပါ။
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၄) ၾတိဂံ ပုံသဏၭာန္မ်ိဳး ျဖစ္သြားရန္ ေအာက္ပါပုံအတုိင္း Mouse ကုိေရြ႕ျပီး ဒုတိယ line တြင္ရိုက္ထည့္ခ႕ဲေသာ တန္ဖိုးကို

ထပ္မံရိုက္လည့္လုိက္ပါ။

၅) Line command ကုိဆုံးသြားေစရန္ Enter ႏိွပ္လိုက္ပါက ေအာက္ပါပုံအတုိင္း ၾတိဂံပုံတစ္ပုံကုိ ေတြ႕ရမည္ ျဖစ္သည္။

Exercise: Input Data

ဤေလ႕က်င့္ခန္းသည္ ေလ့လာသူမ်ားကို Input Methods မ်ားျဖစ္သည့္ command line, keyboard န႕ဲ dynamic

interface စသည္တို႕ျဖင့္ ပိုမို အကၽြမ္း၀င္သြားေစမည္ ျဖစ္သည္။
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၁) Quick Access toolbar မွ New ကုိ Click လုိက္ပါ။

၂) Select Template dialog box ၏ ညာဖက္ေအာက္နား တြင္ရိွေသာ Open button မွ drop-down arrow ကိုႏိွပ္ျပီး

Open with no Template – Imperial ကို Select လိုက္ပါ။

၃) Status Bar ေပၚက dynamic input ကို OFF လုိက္ပါ။

၄) Command line ကိုအသုံးျပဳျပီးေတာ႕ Circle တစ္ခု ဖန္တီးရပါမည္။

 Command line တြင္ Circle ကုိရိုက္ျပီး Enter နိွပ္လုိက္ပါ။

 Brackets […] ထမွဲ Options lists ကုိ ေသခ်ာ ဂရုတစိုက္ ဖတ္ၾကည့္ပါ။
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 Center Point သတ္မွတ္ရန္ အတြက္ Graphics Window ၏ တစ္ေနရာတြင္ တစ္ခ်က္ Click လိုက္ပါ။

 Command line တြင္ (1) ဟုရိုက္ျပီး Enter ႏိွပ္လုိက္ပါ။

မွတ္ခ်က္။ ။ Circle ေသးငယ္ေနလွ်င္ Zoom command သုံးျပီး မိမိတုိ႕အတြက္ သင့္ေတာ္သေလာက္ ခ်႕ဲလုိက္ပါ။

၅) ပထမ Circle ႏွင့္အရြယ္အစားတူ Circle တစ္ခုကုိ ထပ္မံ ဖန္တီးပါမည္။

 Circle command ကိုျပန္လည္ေခၚယူ အသုံးျပဳရန္ အတြက္ Enter ႏိွပ္လုိက္ပါ။ ( Command တစ္ခု ျပီးဆံုးခ်ိန္ ထို

command ကို Enter ႏိွပ္ျပီး အလြယ္တကူ ျပန္လည္ ေခၚယူႏိုင္ပါသည္။)

 Center Point သတ္မွတ္ရန္ အတြက္ ပထမ Circle၏ ဘယ္ဖက္ တစ္ေနရာရာတြင္ တစ္ခ်က္ Click လုိက္ပါ။

 Radius တန္ဖိုးသည္ ပထမ Circle ၏ တန္ဖိုး ေဖာ္ျပေနမည္ ျဖစ္ေသာေၾကာင့္ Enter ႏိွပ္လိုက္ပါက ပထမ Circle

ျဖင့္ အရြယ္တူ Circle တစ္ခုကုိ ဖန္တီးျပီး ျဖစ္ေနလိမ္႕မည္။

၆) Command line အသံုးျပဳျပီး Circle ႏွစ္ခုေဘးတြင္ polar coordinates ျဖင့္ triangle ေလးတစ္ခု ထပ္မံ ဖန္တီးရန္ -

 Line command ကုိအသံုးျပဳမည္ ျဖစ္ေသာေၾကာင့္ command line တြင္ L ဟုရိုက္ထည့္ကာ Enter ႏိွပ္လုိက္ပါ။

 Drawing window ထကဲ Circle ႏွစ္ခုေဘး တစ္ေနရာရာတြင္ First Point သတ္မွတ္ရန္ အတြက္ တစ္ခ်က္ Click

လိုက္ပါ။

 Second Point အတြက္ Polar coordinate ပုံစံျဖင့္ @2<45 ဟုရိုက္ထည့္ျပီး၊ Enter ႏိွပ္လိုက္ပါ။

 Third Point အတြက္ Polar coordinate ပုံစံျဖင့္ @2<135 ဟုရိုက္ထည့္ျပီး၊ Enter ႏိွပ္လုိက္ပါ။
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 Triangle ျဖစ္သြားရန္ အတြက္ line ႏွစ္ခုဆက္သြားရန္ command line Close ကုိေရြးလုိက္ျပီး Enter ႏိွပ္လိုက္ပါ။

၇) အသံုးျပဳခ႕ဲျပီးေသာ command မ်ားကို ျပန္လည္ၾကည့္ရႈ႕ရန္ -

 F2 ကုိနိွပ္လိုက္ပါက command window တက္လာသည္ကို ေတြ႕ရမည္။

 အသုံးျပဳခ႕ဲျပီးေသာ command တို႕ကို ထို command window တြင္ အစအဆုံး ျပန္ၾကည့္ႏိုင္ပါသည္။

 ၾကည့္ျပီးလွ်င္ F2 ႏိွပ္ျပီး ထုိ command window ကိုျပန္ပိတ္လုိက္ပါ။

၈) Dynamic Input ကုိ ON ရန္အတြက္ Status Bar မွ Dynamic Input ကုိ Click လိုက္ပါ။

၉) Dynamic interface အသုံးျပဳျပီးေတာ႕ geometric data ေတြကုိၾကည့္ရန္ -

 အထက္တြင္ ဖန္တီးထားေသာ ပထမ Circle ကုိ Select လိုက္ပါ။

 Crosshairs ေလးကို Circle ၏မ်ားတြင္ ရိွေသာ ေလးေထာင့္ကြက္ေလးေပၚသုိ႕ တင္လိုက္ပါ။ (Click ရန္

မလုိအပ္ေပ။)
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 Circle ၏ Radius တန္ဖိုးကို (1) ဟုေဖာ္ေပးလိမ္႕မည္။

 ျပီးလွ်င္ Circle ေပၚမွာ Grip ေလးေပ်ာက္သြားေအာင္ Esc key ကုိနိွပ္လိုက္ပါ။

၁၀) Dynamic interface အသံုးျပဳျပီးေတာ႕ Additional geometric data မ်ားကို ၾကည့္ရန္ -

 အထက္တြင္ ဖန္တီးထားေသာ triangle ရ႕ဲ ထိပ္ခၽြန္ေထာင့္ကုိ ဆက္သြယ္ေနေသာ Line ႏွစ္ေၾကာင္းကို Select

လုိက္ပါ။

 Crosshairs ေလးကို triangle၏ ထိပ္ခၽြန္ေထာင့္ေပၚမွ ေလးေထာင့္ကြက္ေလး ေပၚသို႕ တင္လုိက္ပါ။ (Click ရန္

မလုိအပ္ေပ။)

 ထုိ Select ထားေသာ Line နွစ္ေၾကာင္း၏ Length နွင့္ Angle data တို႕ကိုေဖာ္ျပေပးမည္ကို ေတြ႕ရ ေပလိမ္႕မည္။

 Line ႏွစ္ခုေပၚမွ Grip ေလးမ်ားေပ်ာက္သြားေအာင္ Esc key ကုိနိွပ္လိုက္ပါ။

၁၀) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Creating Basic Objects

အားလုံးေသာ Basic Objects မ်ားကုိ basic commands မ်ားျဖင့္သာ ဖန္တီးထားျခင္းျဖစ္ပါသည္။ ဤသင္ခန္းစာသည္

lines, circles, arcs, rectangles, န႕ဲ polygons စသည့္ commands မ်ားအသုံးျပဳျပီး Objects မ်ား ဖန္တီးပုံကုိ
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ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Basic Objects ေတြကုိ ကၽြမ္းက်င္စြာဖန္တီးႏိုင္မွ ရႈပ္ေထြးေသာ Objects types မ်ားကို

ဖန္တီးႏိုင္မည္ ျဖစ္ေသာေၾကာင့္ Basic Objects မ်ားဖန္တီးျခင္း သင္ခန္းစာကို ဂရုတစိုက္ ေလ့လာသြားရမည္ျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကုိ သင္ၾကားျခင္း ျပီးေျမာက္သြားလွ်င္ -

 Line command ကုိအသံုးျပဳျပီး Drawing မ်ားတြင္ Line မ်ားဖန္တီး တတ္လာေစရန္။

 Circle command ကိုအသံုးျပဳျပီး Drawing မ်ားတြင္ Circle မ်ားဖန္တီး တတ္လာေစရန္။

 Arc command ကုိအသံုးျပဳျပီး Drawing မ်ားတြင္ Arc မ်ားဖန္တီး တတ္လာေစရန္။

 Erase command ကိုအသံုးျပဳျပီး Drawing တြင္းမွ Objects မ်ားကို Erase တတ္လာေစရန္။

 Undo and Redo command မ်ားအသံုးျပဳျပီး Previous Drawing မ်ားသို႕ သြားပုံကုိ သိရွိလာေစရန္။

 Rectangle command ကိုအသုံးျပဳျပီး Drawing မ်ားတြင္ Rectangle မ်ား ဖန္တီးတတ္လာေစရန္။

 Polygon command ကုိအသုံးျပဳျပီး Drawing မ်ားတြင္ Polygon မ်ား ဖန္တီးတတ္လာေစရန္။

Line command

Line command ျဖင့္ sigle line (သို႕မဟုတ္) multiple line မ်ားေရးဆြဲရာတြင္ Start point န႕ဲ End Point သတ္မွတ္ျပီး

ေရးဆြသဲြားရမည္။ ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံကုိ ေလ့လာၾကည့္ပါ။ Dynamic Input Interface တြင္ Length(1)

တန္ဖိုးႏွင့္ Angle(2) ရိုက္ထည့္ျပီး ေရးဆြဲထားျခင္းျဖစ္သည္။

Command Access
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Line

Command Line: Line, L

Ribbon: Home tab > Draw panel > Line

Menu Bar: Draw > Line

Command Options

ေအာက္ပါ Line command options မ်ားကို Right-click ေထာက္ျပီး shortcut menu (သို႕မဟုတ္) command line မွ

ေရြးခ်ယ္သတ္မွတ္ ႏိုင္ပါသည္။

First point - Default ( Line ဆြဲရာတြင္ စတင္ သတ္မွတ္ရမည့္ စမွတ္)

Next Point - Default ( စမွတ္သတ္မွတ္ထား line အတြက္ ဆုံးမွတ္သတ္မွတ္ ေပးျခင္း။ ဆုံးမွတ္ သတ္မွတ္ျပီးပါက

ေနာက္ထပ္မ်ဥ္းတစ္ပိုင္း ေရးဆြဲရန္ ေနာက္တစ္မွတ္ ဆက္လက္ သတ္မွတ္ႏိုင္သည္။)

Undo - မိမိတို႕ ေရးဆြဲျပီးေသာ Line ကို သေဘာမက်၍ line command မဆံုးပဲ remove လုပ္လုိလွ်င္ အသံုးျပဳရသည္။

အသုံးျပဳလိုလွ်င္ (U) ဟူေသာ စာလုံးအၾကီးကုိ command line တြင္ ရိုက္ထည့္လိုက္ပါ။

Close - မိမိတုိ႕ လက္ရိွေရာက္ေနေသာ အမွတ္မွ စမွတ္ကုိ ဆက္ေပးလိုလွ်င္ အသုံးျပဳႏိုင္သည္။ အသံုးျပဳလိုလွ်င္ (C) ဟု

command line တြင္ ရိုက္ထည့္ေပးလိုက္ပါ။

Line Command Guidelines

 Single line (သို႕မဟုတ္) multiple line မ်ားေရးဆြဲရာတြင္ အသံုးျပဳႏိုင္သည္။

 မိမိတုိ႕ ေရာက္ေနေသာ အမွတ္ႏွင့္ စမွတ္ကို ဆက္ေပးလုိလွ်င္ Close Option ကုိေရြးျပီး ဆက္ေပး ႏိုင္သည္။

 Line မ်ားေရးဆြဲရာတြင္ line command ကိုမဆံုးပဲ မိမိတုိ႕ သေဘာမေတြ႕ေသာ Line ကုိ remove လုပ္ရာတြင္

Undo (U) Option ကုိအသုံးျပဳႏိုင္သည္။

Practice Exercise: Line Command
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Line command အသုံးျပဳျပီး၍ ေအာက္ပါ လက္ေတြ႕ ေလ႕က်င့္ခန္းကုိ ေရးဆြၾဲကည့္ရန္။

၁) New Drawing ကုိအရင္ဆံုး Open လိုက္ပါ။

၂) Select template dialog box ထဲက acad template file (dwt) ကုိ Select လုပ္လုိက္ပါ။

၃) Status Bar ကေအာက္ပါ Setting မ်ားကို အေသအခ်ာ ON လိုက္ပါ။

 Polar tracking

 Object snap

 Object snap tracking

၄) ေရျပင္ညီမ်ဥ္း ေရးဆြဲရန္ -

 Ribbon, Home tab > Draw panel > Line ကို select လိုက္ပါ။

 စမွတ္အတြက္ Screen ေပၚ နွစ္သက္ရာ တစ္ေနရာတြင္ Click လိုက္ပါ။

 Polar angle တန္ဖိုး 0 ဒီဂရီအတုိင္း mouse ကို ေရျပင္ညီ ဆြဲသြားလိုက္ပါ။
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 ျပီးလွ်င္ command line မွ 4 ဟုရိုက္ထည့္လုိက္ပါ။

၅) Line command န႕ဲပဲ Point (2), Point (3) မ်ားကို ဆက္လက္ေရးဆြဲၾကရေအာင္။

Tooltips တြင္ Polar angle 90 ဒီဂရီ ျဖစ္သြားေအာင္ Mouse ကုိေရြ႕လိုက္ပါ။

 ျပီးလွ်င္ 1 ဟုရိုက္ထည့္ျပီး Enter ကုိနိွပ္လိုက္ပါ။

 ဆက္လက္ျပီး mouse ကုိ Polar angle 0 ဒီဂရီျဖစ္ေအာင္ ေရြ႕ျပီးလွ်င္ 1ကုိရိုက္ကာ Enter နိွပ္လုိက္ပါ။

 Mouse ကုိ Polar angle 90 ဒီဂရီျဖစ္ေအာင္ ေရြ႕ျ့ပီး 1.5 ကုိရိုက္ကာ Enter ႏိွပ္လိုက္ပါ။

 Mouse ကုိ Polar angle 180 ဒီဂရီျဖစ္ေအာင္ ေရြ႕ျ့ပီး 1 ကုိရိုက္ကာ Enter ႏိွပ္လုိက္ပါ။

 Mouse ကုိ Polar angle 90 ဒီဂရီျဖစ္ေအာင္ ေရြ႕ျ့ပီး 1 ကုိရိုက္ကာ Enter ႏိွပ္လုိက္ပါ။

 Mouse ကုိ Polar angle 180 ဒီဂရီျဖစ္ေအာင္ ေရြ႕ျ့ပီး 4 ကုိရိုက္ကာ Enter ႏိွပ္လုိက္ပါ။

၆) Mouse ကုိ Polar angle 270 ဒီဂရီ သို႕ေရြ႕လိုက္ပါက Ent point ျဖစ္မ႕ဲ Point (1) ေနရာတြင္ object snap က

ညႊန္ျပပါလိမ္႕မည္။ ထုိ Ent Point အျဖစ္ညႊန္ျပေပးမည့္ အမွတ္အသား အေနရာသုိ႕ Click လိုက္ပါ။ ျပီးလွ်င္ Enter ႏိွပ္ျပီး

command ကို အဆုံးသတ္ေပးလိုက္ပါ။

Circle Command

Circle command ကို Drawing area တြင္ Circle မ်ားေရးဆြဲရာတြင္ အသံုးျပဳပါသည္။ Circle Command ကို

စတင္လိုက္ျပီ ဆိုသည္နွင့္ Circle ၏ Center point ပထမဦးဆုံး သတ္မွတ္ေပးရမည္ ျဖစ္ျပီး၊ ဒုတိယအေနျဖင့္ Radius ကို

သတ္မွတ္ေပးရမည္ ျဖစ္ပါသည္။

Center Point သတ္မွတ္ျပီး ျဖစ္တ႕ဲ Circleတြင္ Radius သတ္မွတ္ေပးရန္ ညႊန္ၾကားထားသည့္ ေအာက္ပါပုံကို

ေလ့လာၾကည့္ပါ။

Command Access

Circle

Command Line: CIRCLE, C
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Menu Bar: Draw > Circle > choose option

Ribbon: Home tab > Draw panel > Circle

Circle Command Options

Circle options ကို Ribbon: Home tab > Draw panel > Circle ညာဖက္ေအာက္နားမွ drop-down ကိုႏိွပ္ျပီး

ေရြးခ်ယ္ႏိုင္ပါသည္။

ေအာက္ပါ Circle command options မ်ားကို Right click ေထာက္ျပီး shortcut menu (သုိ႕မဟုတ္) command line မွ

ေရြးခ်ယ္သတ္မွတ္ ႏိုင္ပါသည္။ Command line တြင္ ( C ) တစ္လုံးတည္း ရိုက္ထည့္ျပီးလည္း ေခၚယူႏိုင္ ပါသည္။

Specify center Point - (default ) တစ္ေနရာရာကုိ Click ျပီး သတ္မွတ္ႏိုင္သလုိ၊ Coordinate အမွတ္

ရိုက္ထည့္ျပီးလည္း သတ္မွတ္ ႏိုင္ပါသည္။

D - Center Point သတ္မွတ္ျပီးေသာ အခ်ိန္တြင္၊ Radius အစား Diameter တန္ဖိုးကို

သတ္မွတ္ရသည္။

3P - Circle ဆြဲရန္ Circle ၏ diameter ကုိ အမွတ္၃မွတ္ သတ္မွတ္ေပးရသည္။
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2P - Circle ဆြဲရန္ Circle ၏ diameter ကုိ အမွတ္၂မွတ္ သတ္မွတ္ေပးရသည္။

Ttr (tan tan radius) – အျခားေသာ Objects နွစ္ခု၏ tangents မ်ားကို click ျပီး radius သတ္မွတ္ကာ ေရးဆြဲရသည့္

Circle.

Circle Command Guidelines

Command line မွ Circle command ကုိေခၚျပီးပါက၊ Ceter Point န႕ဲ Radius ကုိသတ္မွတ္ကာ Circle ကုိေရးဆြရဲသည္။

Circle၏ Options မ်ားကို Ribbon toolbar မွလည္း drop-down ကိုနိွပ္ကာ Select ႏိုင္ပါသည္။

Circle တစ္ခုေရးဆြဲျပီး၊ အရြယ္အစားတူ Circle ထပ္မံေရးဆြဲလုိပါက Cent Point သတ္မွတ္ေပးျပီး၊ Enter ႏိွပ္လိုက္ယုံျဖင့္

အရြယ္အစားတူ Circleကုိ ျမန္ျမန္ဆန္ဆန္ ေရးဆြဲႏိုင္ပါသည္။

Center Point သတ္မွတ္ေပးျပီးပါက၊ Circle ကုိ Diameter ျဖင့္ေရးဆြဲလိုပါက D ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။ ျပီးလွ်င္

Diameter တန္ဖိုးကို ရိုက္ထည့္ေပးလုိက္ပါ။

Practice Exercise: Circle Command

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Tan, Tan, Radius, Circle command န႕ဲ 2-Point Circle တုိ႕ကိုေရးဆြဲ

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ ပထမဦးစြာ ေအာက္ပါပုံအတိုင္း 5.25 units ရိွတဲ႕ Line ႏွစ္ခုကုိ ဆြဲလုိက္ပါ။

၁) New Drawing ကုိအရင္ဆံုး Open လိုက္ပါ။

၂) Select template dialog box ထဲက acad template file (dwt) ကုိ Select လုပ္လုိက္ပါ။
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၃) Status Bar ကေအာက္ပါ Setting မ်ားကို အေသအခ်ာ ON လိုက္ပါ။

 Polar tracking

 Object snap

 Object snap tracking

၄) Lines ဆြဲရန္ -

 Line command ကုိ စတင္လိုက္ပါ။

 Start Point သတ္မွတ္ေပးရန္ Drawing area ၏တစ္ေနရာရာကို Click လုိက္ပါ။

 ျပီးလွ်င္ Mouse ကုိ Polar angle 270 ဒီဂရီ ျဖစ္ေအာင္ ေရြ႕လိုက္ပါ။ 5.25 ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။

 Mouse ကုိ Polar angle 0 ဒီဂရီ ျဖစ္ေအာင္ ေရြ႕လုိက္ပါ။ 5.25 ကိုရိုက္ထည့္ျပီး Enter ကုိႏိွပ္လုိက္ပါ။

 Line command ဆံုးသြားေအာင္ Enter ကုိနိွပ္လိုက္ပါ။

၅) ထုိ Line ႏွစ္ေၾကာင္းကုိ Zoom န႕ဲ Pan Real-time command အသုံးျပဳျပီးေတာ႕ View ကုိလုိအပ္သေလာက္

ေရြ႕လုိက္ပါ။

၆) ပံုတြင္ ျပထားေသာ နံပါတ္ (၃) Circle ေလးကုိဆက္ဆြဲၾကည့္ရေအာင္။

 Ribbonမွ Home tab > Draw panel > Circle drop-down > Tan, Tan, Radius အဆင့္ဆင့္သြား လို္က္ပါ။

 Cursor ကုိ Vertical line သုိ႕ေရြ႕ျပီး tangent အမွတ္အသားေလး ညႊန္ျပထားေသာ ေနရာကို Click လုိက္ပါ။

 ထုိ႕ေနာက္ Cursor ကုိ Horizontal line သုိ႕ေရြ႕ျပီး tangent အမွတ္အသားေလး ညႊန္ျပထားေသာ ေနရာကို Click

လိုက္ပါ။

 Circle ၏ radius သတ္မွတ္ေပးရန္ အတြက္ 2 ဟုရိုက္ထည့္ျပီး Enter ကုိႏိွပ္လိုက္ပါ။

၇) ဆက္လက္ျပီး ပုံတြင္ ျပထားေသာ နံပါတ္ (၄) Circle ကိုဆြဲၾကည့္ရေအာင္။

 Ribbonမွ Home tab > Draw panel > Circle drop-down > 2-Point အဆင့္ဆင့္သြား လို္က္ပါ။

 Cursor ကုိ line (1) ၏ မ်ဥ္းဆုံးေနရာသို႕ ေရြ႕ပါက Object snap mode က End point ကုိညႊန္ျပေပး

သြားပါလိမ္႕မည္။ ထို ျပေပးေသာ End Point အမွတ္အသားေပၚသို႕ Click လုိက္ပါ။
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 Cursor ကုိ line (2) ၏ မ်ဥ္းဆုံးေနရာသို႕ ေရြ႕ပါက Object snap mode က End point ကုိညႊန္ျပေပး

သြားပါလိမ္႕မည္။ ထို ျပေပးေသာ End Point အမွတ္အသားေပၚသို႕ Click လုိက္ပါ။

Arc Command

Arc command ကုိအသုံးျပဳျပီး Objects မ်ားေရးဆြဲရာတြင္ အမွတ္(၃) မွတ္ျဖင့္အေျခခံျပီး ေရးဆြဲရပါသည္။ Default

method ျဖင့္ arc မ်ားေရးဆြဲရာတြင္ start point, second point နဲ႕ end point ဟူ၍ သတ္မွတ္ေပး ရပါသည္။ Arc ရ႕ဲ

radius နဲ႕ center point တုိ႕ကုိ မိမိတုိ႕ အစဥ္လုိက္ သတ္မွတ္ေပး လိုက္ေသာ အမွတ္(၃) မွတ္ေပၚမွာ အေျခခံျပီး

တြက္ခ်က္ရပါသည္။

ေအာက္ပါပုံသည္ အမွတ္ (၃) သတ္မွတ္ေပးျပီး ေရးဆြဲထားေသာ Arc object ေလးျဖစ္ပါသည္။

Command Access

Arc

Command Line: ARC, A

Menu Bar: Draw > Arc > 3 Points

Ribbon: Home tab > Draw panel > Arc
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Command Options

Arc command Options ကုိ ေအာက္ပါ ပုံတြင္ ေတြ႕ျမင္ရသည့္ အတုိင္း drop-down menu မွလည္း Access

လုပ္ႏိုင္ပါသည္။ Uesrs မ်ားပုံမွန္ ျမင္ေတြ႕ေနက် Arc Opiton ကုိ ပုံတြင္ ျမွားအနီျဖင့္ ျပထားပါသည္။

ေအာက္ပါ Arc command options မ်ားကုိ Right click ေထာက္ျပီး shortcut menu (သို႕မဟုတ္) command line မွ

ေရြးခ်ယ္သတ္မွတ္ ႏိုင္ပါသည္။ Command line တြင္ ( S ) တစ္လံုးတည္း ရိုက္ထည့္ျပီးလည္း ေခၚယူႏိုင္ ပါသည္။

C - Arc ရ႕ဲ Center Point သတ္မွတ္ျခင္း ျဖစ္ပါသည္။ ထုိ႕ေနာက္ Start Point ကုိသတ္မွတ္ေပးရပါမည္။

Angle – Arc ၏ angle သတ္မွတ္ျခင္း။

Chord Length - Angle chord ၏ Length ကိုသတ္မွတ္ေပးျခင္း။

Practice Exercise: Arc Command

ဤ လက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Arc Options ၏ Start, Center, End Arc command တို႕ကိုအသံုးျပဳ သြားရပါမည္။

ပထမဆံုး အေနန႕ဲ Rectangle တစ္ခုကုိ အရင္ဆြဲရပါမည္။ ပုံမ်ားကို နာရီလက္တံ ေျပာင္းျပန္ အတိုင္း

ေရးဆြေဲပးေသာေၾကာင့္ Start Point နွင့္ End Point မ်ားသတ္မွတ္ရာတြင္ မိမိတို႕ လိုခ်င္ေသာ ခုံး/ခြက္ရရန္ အထူး

သတိျပဳရပါမည္။
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၁) New Drawing ကုိအရင္ဆံုး Open လိုက္ပါ။

၂) Select template dialog box ထဲက acad template file (dwt) ကုိ Select လုပ္လုိက္ပါ။

၃) Status Bar ကေအာက္ပါ Setting မ်ားကို အေသအခ်ာ ON လိုက္ပါ။

 Polar tracking

 Object snap

 Object snap tracking

၄) Rectangle ဆြဲရန္ -

 Ribbon, Home tab > Draw panel> Line ကုိ click ပါ။

 Start Point သတ္မွတ္ရာ၌ ပုံတြင္ျပထားသည့္ (1) ေနရာတြင္ သတ္မွတ္ လိုက္ပါ။

 Polar Tracking အသံုးျပဳျပီး Line ျဖင့္ Rectangle ေရးဆြဲလုိက္ပါ။

၅) ပထမ Arc ကိုေရးဆြဲရန္ -
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 Ribbon,Home tab > Draw panel> Start, Center, End Arc ကို Select လုိက္ပါ။ (Arc button တြင္ရိွေသာ

drop-down arrow ကိုႏိွပ္ျပီး Select ရပါမည္။)

 ျပီးလွ်င္ Rectangle တြင္ (2) ဟုျပထားေသာ ေနရာကုိ click ျပီး Start Point သတ္မွတ္လိုက္ပါ။

 ဆက္လက္ျပီး Center Point ကိုသတ္မွတ္ေပးပါမည္။ MID ဟုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Rectangle တြင္ (3) ျပထားေသာ ေနရာကုိ Click လိုက္ပါ။

 Rectangle ၏ End Point ကုိသတ္မွတ္ေပးရပါမည္။ ပုံတြင္ (4) ဟုျပထားေသာ ေနရာကုိ Click ျပီး End Point

အျဖစ္သတ္မွတ္လိုက္ပါ။

၆) ထုိနည္းအတုိင္း က်န္ရိွေနေသးေသာ္ Arc မ်ားကုိ ေရးဆြဲလိုက္ပါ။ Start, Center, End Arc command တြင္ ပုံမ်ားကို

နာရီလက္တံေျပာင္းျပန္ ေရးဆြဲေပးသည္ကို မေမ႕ေလ်ာ႕ပါေစနွင့္။

Erase Command

Erase command သည္ Drawings မ်ားမွ geomentry မ်ားကုိ remove လုပ္လုိေသာ အခါတြင္ အသံုးျပဳ ရပါသည္။

Remove လုပ္လုိေသာ geomentry မ်ားကုိ တိုက္ရိုက္ Pick up လုပ္ျပီး အသံုးျပဳႏိုင္သလို၊ window or crossing window

မ်ားျဖင့္ Select လုပ္ျပီး geomentry အေျမာက္အျမားကုိ တစ္ျပိဳင္နက္တည္း Remove ႏိုင္ပါသည္။

Command Access

Erase

Command Line: ERASE, E

Menu Bar: Modify > Erase

Ribbon: Home tab > Modify panel > Erase
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OOPS Command

မိမိတုိ႕ Remove လုပ္မိ လိုက္ေသာ geomentry မ်ားကုိ Undo ျပန္လုပ္ျပီး ေခၚယူ၍ မရပါက၊ command line တြင္ OOPS

ဟုရိုက္ထည့္ျပီး ျပန္လည္ေခၚယူႏိုင္ပါသည္။

Use a Shortcut Menu

Erase command ကိုလ်င္လ်င္ျမန္ျမန္ ေခၚယူအသံုးျပဳလိုပါက Drawing area တြင္ Right click ႏိွပ္ျပီး Shortcut menu မွ

Erase command ကိုSelect ျပီး အသုံးျပဳႏိုင္ပါသည္။

Practice Exercise: Erase Command

Erase command ကို ေလ့က်င့္ၾကည့္ၾကရေအာင္။ ပထမဆုံးအေနန႕ဲ Drawing area ထမွဲာ lines, circles, န႕ဲ arcs တို႕ကို

ေရးဆြလဲိုက္ပါ။ ထို႕ေနာက္ ေရးဆြဲထားတ႕ဲ lines, circles, န႕ဲ arcs တို႕ကုိ remove လုပ္ၾကည့္ပါ။ Remove လုပ္ဖို႕

Objectsမ်ားကုိ Select ရာတြင္ နည္းအမ်ိဳးမ်ိဳးသံုးျပီး လုပ္ၾကည့္ပါ။

၁) New Drawing ကုိအရင္ဆံုး Open လိုက္ပါ။

၂) Select template dialog box ထဲက acad template file (dwt) ကုိ Select လုပ္လုိက္ပါ။

၃) Drawing window ထမွဲာ Objects မ်ားကုိ အနည္းဆုံး 8ခုေလာက္ ေရးဆြဲလုိက္ပါ။

 Line command ကုိေခၚျပီး Lines အခ်ိဳ႕ကို ေရးဆြဲလိုက္ပါ။

 Circlecommand ကုိေခၚျပီး Circles အခ်ိဳ႕ကုိ ေရးဆြလဲိုက္ပါ။

 Arc command ကုိေခၚျပီး Arcs အခ်ိဳ႕ကို ေရးဆြဲလုိက္ပါ။

4) Erase လုပ္ဖို႕အတြက္ ေအာက္ပါ နည္းလမ္းအတုိင္း လိုက္ပါေလ့က်င့္ၾကည့္ပါ။

 Ribbon, Home tab > Modifypanel > Erase ကုိ click လိုက္ပါ။ Erase လုပ္ရန္ အတြက္ Objects (၃) ကို

Select လုိက္ျပီး Enter ႏိွပ္လိုက္ပါ။

 ျပီးလွ်င္ Undo လုပ္ရန္ command line မွာ U ဟုရိုက္ျပီး Enter ႏိွပ္လုိက္ပါ။

 ဆက္လက္ျပီး Objects (၃) ခုကို Select ထပ္လုပ္လုိက္ပါ။ ျပီးလွ်င္ Right click ႏိွပ္ျပီး ေပၚလာေသာ shortcut

menu မွ Erase ကို Select လုပ္လုိက္ပါ။

 ျပီးလွ်င္ Undo လုပ္ရန္ command line မွာ U ဟုရိုက္ျပီး Enter ႏိွပ္လုိက္ပါ။
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 ထပ္မံ၍ Erase command ျပန္ေခၚလိုက္ပါ။ ျပီးလွ်င္ command line တြင္ L ဟုရိုက္ထည့္လိုက္ပါက မိမိတုိ႕

ေနာက္ဆံုး ေရးဆြဲခဲ႕ေသာ Object ကုိ Erase ရန္ select ျပီးသြားျဖစ္သြား ပါလိမ္႕မည္။ ထုိ႕ေနာက္ Enter

ကုိႏိွပ္လိုက္ပါ။

 ထုိ႕ေနာက္ Undo လုပ္ရန္ command line မွာ U ဟုရိုက္ျပီး Enter ႏိွပ္လုိက္ပါ။

 ထပ္မံ၍ မည္သည့္ command မွမေခၚပဲ Object တစ္ခုကုိ Select လိုက္ပါ။ ျပီးလွ်င္ Keyboard မွ DELETE key

ကုိနိပ္လိုက္ပါ။

၅) Cross Window ေလးအသံုးျပဳျပီးေတာ႕ Objects မ်ားကုိ Erase လုပ္ၾကည့္ရေအာင္။

Command line တြင္ E ဟုရိုက္ထည့္လိုက္ျပီး၊ Enter ကိုႏိွပ္လုိက္ပါ။ Command line တြင္ Select Object ဆိုတ႕ဲ Prompt

ေလးကို ေတြ႕လာပါလိမ္႕မည္။ ထုိ႕ေနာက္ မိမိတုိ႕ Erase ခ်င္ေသာ Drawing ၏ ညာဖက္တြင္ Cursor ကုတိစ္ခ်က္ Click

လုပ္ပါ။ ဤသည္ကာ Selection Window စမည့္ေနရာ ျဖစ္ပါသည္။ ျပီးလွ်င္ Mouse ကို မိမိတို႕ Erase ခ်င္ေသာ Object ၏

ဘယ္ဖက္သို႕ drag လုပ္လိုက္ပါ။ Cross Window သည္ dashedlines ျဖစ္ေနသည္ကုိ သတိထားၾကည့္ပါ။ Cross Window

ျဖတ္သြားေသာ Objects မ်ားအားလုံးအျပင္၊ Cross window အတြင္းမွ Selected ခံထားရေသာ Objects တစ္ခ်ိဳ႕ရ႕ဲ

အစိတ္အပိုင္းေတြပါ dashedlines န႕ဲ grips ျဖစ္သြားသည္ကုိ ေတြ႕ရမည္။ Enter ကုိႏိွပ္လိုက္ပါက dashedlines န႕ဲ grips

ျဖစ္ေနေသာ Objects မ်ားအားလုံး Erase ျဖစ္သြားမည္ ျဖစ္သည္။

၆) Window Options အသံုးျပဳျပီး Objects မ်ားကုိ Erase လုပ္ၾကည့္ရေအာင္။

Command line တြင္ E ဟုရိုက္ထည့္လုိက္ျပီး၊ Enter ကုိႏိွပ္လိုက္ပါ။ command line တြင္ Select Object ဆိုတ႕ဲ Prompt

ေလးကို ေတြ႕လာပါလိမ္႕မည္။ ထုိ႕ေနာက္ မိမိတို႕ Erase ခ်င္ေသာ Drawing ၏ ဘယ္ဖက္တြင္ Cursor ကိုတစ္ခ်က္ Click

လုပ္ပါ။ ဤသည္ကာ Selection Window စမည့္ေနရာ ျဖစ္ပါသည္။ ျပီးလွ်င္ Mouse ကုိ မိမိတုိ႕ Erase ခ်င္ေသာ Object

၏ ညာဖက္သုိ႕ drag လုပ္လုိက္ပါ။ Selection Window ၏ မ်ဥ္းသည္ Cross Winodw ကဲ႕သို႕ dashedlines မဟုတ္ပဲ၊

တစ္ဆက္တည္းမ်ဥ္း ျဖစ္ေနသည္ကို ေတြ႕ရမည္။ Selection Window ထဲတြင္ bject တစ္ခုလုံးကို selected မိေသာ

Objects မ်ားသာ dashedlines န႕ဲ grips ပုံစံသုိ႕ ေျပာင္းလဲသြားမည္ ျဖစ္သည္။ ( ဥပမာ - Line တစ္ခုကို Selection

Window ျဖင့္ Select လုပ္လိုက္ျပီ ဆုိပါေတာ႕။ ထုိSelection Window ထဲတြင္ Line တစ္ခုလုံး မဟုတ္ပဲ၊ Line

တစ္၀က္ကိုသာ Selected လုပ္မိယံုဆိုလွ်င္ ထုိ Objects ကုိ Erase လုပ္လို႕ရမည္ မဟုတ္ေပ။)

၇) Command line တြင္ U ဟုရိုက္ထည့္ျပီး Undo ျပန္လုပ္လိုက္ပါ။

၈) OOPS command ေလးျဖင့္ Erased ထားေသာ Objectsမ်ားကုိ ျပန္ေခၚၾကည့္ၾကရေအာင္။

 Command line တြင္ E ဟုရိုက္ျပီး Enter နိွပ္လိုက္ပါ။ Select objects ဆိုတ႕ဲ prompt ေပၚလာရင္ ALL ဟု

ရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Objects အားလုံးကုိ Selected လုပ္သြားပါလိမ္႕မည္။ ျပီးလွ်င္ Erase လုပ္ရန္အတြက္ Enter ကုိႏိွပ္လိုက္ပါ။

 ထုိ႕ေနာက္ Line, Circle, (သုိ႕မဟုတ္) Arc commands တုိ႕ကုိ အသံုးျပဳျပီး Objects မ်ားကို ေရးဆြဲ လိုက္ပါ။

 Command line တြင္ OOPS ဟုရိုက္ထည့္ျပီး Enter ကိုနိွပ္လုိက္ပါ။

 Drawing window တြင္ ဂရုတစိုက္ ၾကည့္ၾကည့္ပါ။ Erased All လုပ္ထားတဲ႕ Objects မ်ား Drawing window

တြင္ ျပန္လည္ ေရာက္ရိွေနမည္ကုိ ေတြ႕ရေပလိမ္႕မည္။

၈) Files အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။
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Undo and Redo Commands

Undo command ျဖင့္ မိမိတို႕ လုပ္ေဆာင္ျပီးခ႕ဲေသာ Action မ်ား အားလုံးကို ကုိျပန္လည္ ေခၚယူႏိုင္ပါသည္။ Undo

command ျဖင့္ျပန္လည္ ေခၚယူခဲ႕ေသာ Action မွ ေနာက္ဆံုး Action တစ္ခုကုိ ျပန္သြားခ်င္လွ်င္ Redo

command အသုံးျပဳျပီး ျပန္သြားႏုိင္သည္။ သုိ႕ေသာ္ Redo command သည္ Undo ကုိအသုံးျပဳ ျပီးျပီးခ်င္း အသုံးျပဳမွရမည္

ျဖစ္သည္။

Undo command ကို command line မွလည္းေခၚယူအသံုးျပဳ နိုင္ပါသည္။ U ဟုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။ Enter

ကုိထပ္တစ္ၾကိမ္ ႏိွပ္ျပီး Undo command ကုိ repeat လုပ္ႏိုင္ပါသည္။ အကယ္၍ command line တြင္

undo ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္လွ်င္ Command line prompt တြင္ Undo options lists ကိုေတြ႕ရပါမည္။

Command Access

Undo

Command Line: U, UNDO

Menu Bar: Edit > Undo

Quick Access Toolbar: Undo



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

93

Command Access

Redo

Command Line: REDO

Menu Bar: Edit > Redo

Quick Access Toolbar: Redo

Command Options

Command line တြင္ Undo ဟုရိုက္ထည့္လိုက္လွ်င္ ေအာက္ပါ Undo Optons မ်ားကုိ ေတြ႕ရမည္ ျဖစ္သည္။ Right click

ႏိွပ္ျပီး Shortcut menu မွ Undo command ကို select လုပ္ျခင္းျဖင့္လည္း အဆုိပါ Undo Options မ်ားကုိ command

line တြင္ေတြ႕ျမင္ႏိုင္သည္။

Procedure: Using Undo and Redo

Drawings မ်ားတြင္ Undo န႕ဲ Redo commands မ်ား အသံုးျပဳပုံကုိ ေအာက္တြင္ ပုံနွင့္တကြ တစ္ဆင့္ခ်င္း

ေဖာ္ျပေပးထားသည္။

၁) Quick Access Toolbar ေပၚက Undo (1) ကုိ Click ပါ (သုိ႕မဟုတ္) command line တြင္ U ဟုရိုက္ထည့္ လိုက္ပါ။
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၂) Undo button ကိုႏိွပ္ျပီး အသံုးျပဳပါက Undo တစ္ခုတည္းကိုပဲ ဆက္တုိက္ လုုပ္ေဆာင္ေနမည္ မဟုတ္ေပ။ Command

line မွ U ဟုရိုက္ထည့္ျပီး Undo command ကုိအသုံးျပဳလွ်င္ Enter ႏိွပ္ယုံျဖင့္ Undo command ကုိအၾကိမ္ၾကိမ္

ေခၚယူအသံုးျပဳ ႏိုင္မည္ ျဖစ္သည္။

၃) Redo command ကိုအသံုးျပဳရန္ အတြက္ Quick Access Toolbar ေပၚက Redo button (2) ကုိနိွပ္ျပီး၍ ျဖစ္ေစ

(သို႕မဟုတ္) command line မွ REDO ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္၍ျဖစ္ေစ အသုံးျပဳႏိုင္ပါသည္။ မိမိတုိ႕ လိုခ်င္ေသာ

အပိုင္းမေရာက္အခ်င္း Redo command ကုိအၾကိမ္ၾကိမ္ ေခၚယူအသံုးျပဳ ႏိုင္ပါသည္။

၄) Standard Toolbar မွ Undo/ Redo button ေဘးမွ drop-down list မွလည္း မိမိတို႕ Undo/Redo လုပ္လိုေသာ

အပိုင္းကို ေရြးခ်ယ္ႏိုင္ပါသည္။

Undo and Redo Guidelines

 Undo command သည္လက္ရိွ ေရးဆြဲေနေသာ Drawing မ်ား၏ Data မ်ားကုိသာ သိမ္းဆည္း ေပးသြားမည္

ျဖစ္သည္။ လက္ရိွဆြဲေနေသာ Drawinကုိ Exit ကာ ထုိDrawing ကိုျပန္ဖြင့္ျပီး မိမိတုိ႕ လုိခ်င္ ေသာအပိုင္းကို

Undo ျပန္လုပ္ေသာ္လည္း အက်ိဳးသက္ေရာက္မွဳ႕ ရိွမည္ မဟုတ္ေတာ႕ေပ။

 Redo command ကုိ Undo command အသုံးျပဳ ျပီးျပီး အခ်ိန္တြင္သာ အသံုးျပဳႏိုင္မည္ ျဖစ္သည္။

 Undo command ျဖင့္ Drawings စဆြဲထားေသာ ေနရာအထိ သြားႏိုင္သည္။

 Command line တြင္ UNDO ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါက Undo command၏ ဆင့္ပြား ေရြးခ်ယ္ႏိုင္ေသာ

Undo Options Lists ကုိေတြ႕ရမည္ျဖစ္သည္။

 Command line တြင္ MREDO ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါက Redo command၏ ဆင့္ပြား ေရြးခ်ယ္ႏိုင္ေသာ

Redo Options Lists ကုိေတြ႕ရမည္ျဖစ္သည္။

 Drawings မ်ား (၂)ပုံ (သို႕မဟုတ္) ၃(ပုံ)ကုိ တစ္ျပိဳင္နက္တည္း ဖြင့္ထားလွ်င္လည္း Undo command သည္

တစ္ပုံခ်င္းစီ၏ ကြဲျပားျခားနားတ႕ဲ အခ်က္လက္မ်ားကုိ သူ႕ပုံ၊ သူ႕ data အလုိက္ Save ထားေပးႏိုင္သည္။

Practice Exercise: Undo and Redo Commands
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ေအာက္ပါ လက္ေတြ႕ေလ့က်င့္ခန္းသည္ Undo/Redo command အသုံးျပဳပုံနွင့္ Undo Options တစ္ခ်ိဳ႕ကုိပါ

ေရြးခ်ယ္အသုံးျပဳ ေလ့က်င့္သြားရမည့္ ေလ့က်င့္ခန္း ျဖစ္ပါသည္။

၁) New Drawing ကုိအရင္ဆံုး Open လိုက္ပါ။

၂) Select template dialog box ထဲက acad template file (dwt) ကုိ Select လုပ္လုိက္ပါ။

၃) Circles မ်ားေရးဆြဲျပီး Undo လုပ္ရန္ -

 Command line တြင္ C ဟုရိုက္ျပီး Enter ႏိွပ္ကာ Circle ကုိေရးဆြဲ လိုက္ပါ။ Enter ထပ္ႏိွပ္ျပီး Circles ကို (၅)

ခုတိတိ ေရးဆြဲလုိက္ပါ။

 Quick Access toolbar ေပၚမွ Undo command ကို Circles (၅) ခုလုံး မက်န္ေအာင္ (၅) ၾကိမ္ ႏိွပ္လိုက္ပါ။
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 Quick Access toolbar ေပၚမွ Redo command ကို Circles (၅) ခုလံုး ျပန္ေပၚလာေအာင္ (၅)ၾကိမ္

တိတိႏွိပ္လုိက္ပါ။

၄) Undo command ကုိ command line တြင္ရိုက္ျပီး အသံုးျပဳ ၾကည့္ရန္ Line တစ္ခ်ိဳ႕ကုိ ေရးဆြဲ ၾကရန္။

 Command line တြင္ L ဟုရိုက္ျပီး Enter ႏိွပ္ကာ Line command ကုိေခၚလုိက္ပါ။ Line မ်ားကို မိမိတုိ႕

နွစ္သက္သလို ေရးဆြဲလိုက္ပါ။ ျပီးလွ်င္ Line command ဆံုးသြားေအာင္ Enter ႏိွပ္လိုက္ပါ။

 Command line တြင္ U ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။ Drawing area က မိမိတုိ႕ ေရးဆြဲထားေသာ

Line မ်ားေပ်ာက္ကြယ္သြားမည္ကုိ ေတြ႕ရေပမည္။

 Command line တြင္ L ဟုရိုက္ျပီး Enter နိွပ္လိုက္ပါ။ မိမိတုိ႕ စိတ္ၾကိဳက္ Line မ်ားေရးဆြဲလိုက္ပါ။

Line မ်ားဆြဲျပီးလွ်င္ ထုိ Line command ကုိ မဆံုးေသးေစပဲ Drawing area တြင္ Right – Click ကုိနိွပ္ျပီး၊

ထြက္ေပၚလာေသာ Shortcut menu မွ Undo ကုိ select လုပ္လုိက္ပါ။

 ထုိသို႕ Undo command ကုိ selected ျပီးပါက ေနာက္ဆုံးေရးဆြဲခ႕ဲေသာ Line ေလး ေပ်ာက္ကြယ္သြားသည္ကို

ေတြ႕ရေပလိမ္႕မည္။ Command line ကုိ Exit မေပးေသးပဲ Line ဆက္ဆြဲလုိက္ပါ။ ျပီးလွ်င္ Enter ႏိွပ္ျပီး Line

command ကို exit ေပးလိုက္ပါ။

၅) Undo Options list ထဲက BEgin န႕ဲ Back ကုိအသံုးျပဳရန္ -

 Command line တြင္ Undo ဟုရိုက္ထည့္ျပီး Enter နိွပ္လုိက္ပါ။

 ဆက္လက္ျပီး (Begin) အတြက္ BE ဟုရိုက္ထည့္ျပီး Enter နိွပ္လိုက္ပါ။

 Command line မွ L ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ကာ Line Objects တစ္ခ်ိဳ႕ကုိေရြးဆြဲလိုက္ပါ။ ျပီးလွ်င္ Line

command ကို ျပီးဆုံးသြားေအာင္ Enter ႏွိပ္လိုက္ပါ။
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 Circles, Rectangles န႕ဲ Arcs Objects တစ္ခ်ိဳ႕ကုိ မိမိတုိ႕ စိတ္ၾကိဳက္ ေရးဆြဲလိုက္ပါ။

 ျပီးလွ်င္ မည္သည့္ command မွမေခၚပဲ keyboard မွ UP arrow key ေလးအသံုးျပဳျပီးေတာ႕ UNDO command

ေလးကို command line တြင္ျပန္ရွာလုိက္ပါ။ အကယ္၍ ရွာေနရင္း၊ UNDO command ကုိေက်ာ္သြားမိပါက

DOWN arrow key ေလးႏိွပ္ျပီး ေနာက္သုိ႕ ျပန္ဆုတ္ႏိုင္ ပါသည္။ UNDO command ကိုေတြ႕လွ်င္ Enter

ႏိွပ္လိုက္ပါ။

 ေနာက္သုိ႕ျပန္သြားရန္ အတြက္ B ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

 ထုိအခါ BE ရိုက္ထည့္ျပီး ေနာက္ပိုင္းတြင္ ေရးဆြဲထားေသာ Objects မ်ားအားလုံး ေပ်ာက္ကြယ္

သြားမည္ျဖစ္သည္။

Rectangle Command

Rectangle command အသံုးျပဳျပီးေတာ့၊ rectangles မ်ားကို ေရးဆြဲႏိုင္ပါသည္။ Rectangle Object type သည္ Polyline

type ၀င္ျဖစ္ပါသည္။ Rectangle Object ကုိ ဖန္တီးရန္ အရိုးရွင္းဆံုးေသာ နည္းလမ္းမွာ First point ကို

သတ္မွတ္ေပးျပီးေနာက္၊ ဆန္႕က်င္ဖက္ ေနရာတြင္ End point သတ္မွတ္ေပးလိုက္ေသာ နည္းလမ္းပင္ျဖစ္သည္။

Rectangle Object ေရးဆြဲရာ အျခားေသာ Optionsမ်ားျဖစ္သည့္ Area, Dimension, နဲ႕ Rotation စသည့္ options

မ်ားလည္း ပါ၀င္ပါသည္။

ေအာက္ေဖာ္ျပပါ ပုံသည္ Rectangle ေရးဆြဲရာတြင္ အရိုးရွင္းဆံုးေသာ နည္းျဖင့္ ေရးဆြဲထားသည္။

Command Access

Rectangle

Command Line: RECTANGLE, REC

Menu Bar: Draw > Rectangle

Ribbon: Home tab > Draw panel > Rectangle
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Command Options

ေအာက္ေဖာ္ျပပါ Options မ်ားသည္ rectangle အတြက္ first point သတ္မွတ္ေပးျပီးပါက select ႏိုင္ေသာ rectangle

options မ်ားျဖစ္ပါသည္။ Right-click ႏိွပ္ျပီး Shortcut menu select လုပ္ႏိုင္သလို (သို႕မဟုတ္) command line

တြင္လည္း ေဖာ္ျပေပးထားေသာ စာလုံးအၾကီးမ်ား ရိုက္ထည့္ကာ ေရြးခ်ယ္ႏိုင္ပါသည္။

Area - Area Options အသုံးျပဳ၍

Dimensions - ဤ Options ကုိအသုံးျပဳ၍ rectangle ၏ length န႕ဲ width တုိ႕ကုိပုံမွန္အတိုင္း ရိုက္ထည့္ ႏိုင္ပါသည္။

Rotation - ဤ Options ကုိအသံုးျပဳ၍ rectangle ၏ angles မ်ားကုိ rotation လုပ္ႏိုင္ပါသည္။

Rectangle Command Guidelines

 Rectangle command သည္ပုံမွန္အားျဖင့္ Polyline type မ်ားကို ဖန္တီးေပးျခင္းပဲျဖစ္ပါသည္။

 ဘာေၾကာင့္ Polyline အမ်ိဳးအစား ျဖစ္သလဲဆုိရင္၊ မ်ဥ္းပိုင္းမ်ားကုိ selecting လုပ္ျပီး rectangle တစ္ခု အျဖစ္

ဖန္တီးႏိုင္ေသာေၾကာင့္ ပင္ျဖစ္ပါသည္။

 Rectangle ေရးဆြဲရာတြင္ အရိုးရွင္းဆံုးေသာ နည္းလမ္းမွာ first point သတ္မွတ္ေပးျပီး၊ ဆန္႕က်င္ဖက္တြင္ End

point သတ္မွတ္ေပးရေသာ နည္းလမ္းျဖစ္ပါသည္။

 Rectangle ၏ first point သတ္မွတ္ရာတြင္ ႏွစ္သက္ရာ corner မွ စတင္သတ္မွတ္ျပီး၊ first point

သတ္ထားေသာ corner ၏ဆန္႕က်င္ဖက္သည္ End point ျဖစ္ပါသည္။

Practice Exercise: Rectangle Command

Coordinate dimensions မ်ားအသုံးျပဳျပီးေတာ႕ rectangle ေရးဆြဲျခင္း လက္ေတြ႕ေလ့က်င့္ခန္းကုိ ေလ့လာၾကည့္

ၾကရေအာင္။

၁) New Drawing ကုိ Open လိုက္ပါ။
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၂) Status Bar က Dynamic Input ကုိ ON လုိက္ပါ။

၃) Rectangle ေရးဆြရဲန္ အတြက္ relative coordinates @x,y ကိုအသံုးျပဳၾက ရေအာင္:

 Ribbon, Home tab > Draw panel > Rectangle ကုိ Click လုိက္ပါ။

 First Point သတ္မွတ္ရန္အတြက္ Drawing area တြင္း တစ္ေနရာရာကုိ Click လိုက္ပါ။

 First Point ကုိသတ္မွတ္ေပးျပီး ေသာအခ်ိန္တြင္ @4,5 ဟု Dynamic Input (သို႕မဟုတ္) command line တြင္

ရိုက္ထည္ျပီး Enter ႏိွပ္လိုက္ပါ။

 ထုိအခါ first point အျဖစ္သတ္မွတ္ထားေသာ အမွတ္ရ႕ဲ ညာဖက္တြင္ rectangle ေလးတစ္ခု ေရးဆြဲျပီးသားကို

ေတြ႕ရပါမည္။ ထုိသုိ႕မျဖစ္ပါက @ သေကၤတ က်န္ခ႕ဲေသာေၾကာင့္ ျဖစ္မည္။ @ သေကၤတ ရိုက္ထည့္ရန္

မေမ႕ေလ်ာ႕ပါႏွင့္။

၄) Relative coordinates @x,y ကုိအသုံးျပဳျပီးေတာ႕ Rectangle မ်ားဆက္လက္ေရးဆြဲရန္ -

 Ribbon, Home tab > Draw panel > Rectangle ကုိ Clickျပီး First point ကို Drawing area တြင္း

တစ္ေနရာရာတြင္ သတ္မွတ္ေပးလုိက္ပါ။

 Relative coordinates @x,y အမွတ္မ်ား ရိုက္ထည့္ျပီး rectangle ေရးဆြဲၾကရေအာင္။ Rectangle အတြက္

ေအာက္ပါ Dimensions မ်ားကုိ အသံုးျပဳသြားပါမည္။

 6 x 7 (enter @6,7)

 7 x 6 (enter @7,6)

 9 x 9 (enter @9,9)

၅) Status Bar က Dynamic Input ကုိ ON လုိက္ပါ။

၆) 7x10 rectangle ေလးေရးဆြဲရန္ -

 Ribbon, Home tab > Draw panel > Rectangle ကုိ Clickျပီး First point ကို Drawing area တြင္း

တစ္ေနရာရာတြင္ သတ္မွတ္ေပးလုိက္ပါ။

 7,10 ဟု ရိုက္ထည့္လုိက္ပါ။ (@ သေကၤတ ထည့္ရန္ မလိုပါ) Enter ႏိွပ္လိုက္ပါ။

 first point အျဖစ္သတ္မွတ္ထားေသာ အမွတ္ရ႕ဲ ညာဖက္တြင္ rectangle ေလးတစ္ခု ေရးဆြဲျပီးသားကို

ေတြ႕ရပါမည္။

 F2 key ကုိႏိွပ္လုိက္ပါ။

 Command window ထဲတြင္ မိမိတို႕ ရိုက္ထည့္လုိက္ေသာ coordinate 7,10 ေရွ႕တြင္ @ သေကၤတ

အလုိအေလ်ာက္ ေရာက္ေနသည္ကုိ ေတြ႕ရေပမည္။

ထုိနည္းအတုိင္း ေအာက္ပါ coordinates အမွတ္မ်ားျဖင့္ လက္ေတြ႕ေလ့က်င့္ၾကည့္ပါ။

 2 x 2 (enter 2,2)



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

100

 4 x 6 (enter 4,6)

၇) Rectangle command ၏ Area option ကုိအသံုးျပဳၾကည့္ရေအာင္ -

 Ribbon, Home tab > Draw panel > Rectangle ကုိ Click လုိက္ပါ။

 Drawing area ၏တစ္ေနရာရာတြင္ First corner အတြက္ Click လုိက္ပါ။

 Area အတြက္ A ဟုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Area အတြက္ 35 ရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။

 ျပီးလွ်င္ Length သတ္မွတ္ေပးရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။ ( command line တြင္ default အျဖစ္ [Line] ဟု

bracket ျဖင့္ေဖာ္ျပေပးထားပါလိမ္႕မည္။)

 Rectangle length ၏အတြက္ 7 ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

Polygon Command

Polygon command ကုိအသုံးျပဳျပီး Polygon မ်ားကုိ -

 Center Point န႕ဲ ခန္႕မွန္း စက္၀ိုင္း ရဲ႕ radius တန္ဖိုး။

 Polygon တစ္ခု၏ ေထာင့္ခၽြန္းမွ Start point , End point မ်ား၏ တန္ဖိုး မ်ားကုိ အသုံးျပဳျပီး ေရးဆြႏိုဲင္ပါသည္။

Polygon မ်ားဖန္တီးရာ default နည္းလမ္းမွာ Center Point နဲ႕ radius တုိ႕သတ္မွတ္ျပီး ေရးဆြဲျခင္းပင္ျဖစ္သည္။

အကယ္၍ ဒီနည္းကုိ အသုံးျပဳလွ်င္ Inscribed or Circumscribed Options တို႕ကို ထပ္မံေရြးခ်ယ္ေပးသြား ရမည္ျဖစ္သည္။

မိမိတုိ႕ ေရြးခ်ယ္ေသာ Options ေပၚမွာမူတည္ျပီး၊ Polygon ၏အရြယ္အစား မ်ားကုိ ေအာက္တြင္ ျပထားေသာ ပုံအတိုင္း

တြက္ခ်က္ပါသည္။

Command Access
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Polygon

Command Line: POLYGON, POL

Menu Bar: Draw > Polygon

Ribbon: Home tab > extended Draw panel > Polygon

Command Options

ေအာက္ပါ Polygon Options မ်ားကုိ right – click ကိုႏိွပ္ျပီး shortcut menu (သုိ႕မဟုတ္) command line မွေရြးခ်ယ္

အသုံးျပဳႏုိင္ပါသည္။

Enter number of sides Polygon အေရအတြက္ 3 နားမွ 1024 နားအထိ ေရးဆြဲႏိုင္သည္။

Specify center of polygon Polygon ေရးဆြဲရန္အတြက္ Center point သတ္မွတ္ေပးျခင္း။

Inscribed in circle Radius သတ္မွတ္ထားေသာ Polygon ကုိေရးဆြဲျခင္း။

Circumscribed about circle Radius သတ္မွတ္ထားျခင္း မရိွေသးပဲ Polygon ကိုေရးဆြဲျခင္း။

Edge Polygon အတြက္ basepoint ကုိ ေထာင့္ခၽြန္းမ်ားမွ သတ္မွတ္ျခင္း။
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Polygon Command Guidelines

 Polygon အေရအတြက္ 3 နားမွ 1024 နားအထိ ေရးဆြဲႏိုင္သည္။

 Polygon အနားအေရအတြက္ကုိ စိတ္ၾကိဳက္ ေရးဆြဲႏိုင္ျပီး၊ အနားအားလံုး၏ length သည္တူညီပါသည္။

 Polygon command ျဖင့္ Polyline Objects မ်ားေရးဆြဲႏိုင္ပါသည္။

 Balloons နဲ႕ annotation symbols မ်ားေရးဆြဲရာတြင္ Polygon သည္အေကာင္းဆံုးေသာ Tool ျဖစ္ပါသည္။

Practice Exercise: Polygon Command

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းသည္ Polygon command အသုံးျပဳျပီး 6 နားဗဟုဂံ မ်ားေရးဆြဲသြားရမည္။ စက္၀ိုင္း (1) ကို

inscribed Options ျဖင့္ ေရးဆြဲမည္ျဖစ္ျပီး၊ စက္၀ိုင္း (2) ကို circumscribed Option ျဖင့္ ေရးဆြဲသြားမည္။ ျပီးလွ်င္ 1.5

radius ရိွေသာ စက္၀ိုင္း တစ္၀ိုင္းကို ေရးဆြဲလိုက္ပါ။

မွတ္ခ်က္။ ။ Inscribed န႕ဲ Circumscribed polygon တုိ႕ကုိ Circle အတြင္းတြင္ ေရးဆြဲသြားမည္ ျဖစ္ေသာ္လည္း၊ Point

(2) Points ကုိ ႏိႈင္းယွဥ္ျပခ်င္ေသာေၾကာင့္ ေရးဆြဲျခင္းျဖစ္ပါသည္။ တကယ္တမ္း Polygon ေရးဆြဲရာတြင္ Circle ကို

ေရးဆြရဲန္ မလုိအပ္ေပ။

၁) New Drawing ကုိအရင္ဆံုး Open လိုက္ပါ။

၂) Select template dialog box ထဲက acad template file (dwt) ကုိ Select လုပ္လုိက္ပါ။
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၃) Status bar မွ ေအာက္ပါ Setting မ်ားကုိ ON လိုက္ပါ။

 Polar tracking

 Object snap

 Object snap tracking

 Status bar ေပၚမွ Object snap ကို right –click ႏိွပ္ျပီး Center snap modeကို select လိုက္ပါ။

၄) ဥပမာ -၁ တြင္ ျပထားေသာ Inscribed polygon ကုိ စက္၀ိုင္းအတြင္းတြင္ ေရးဆြဲရန္ -

 Ribbon, Home tab > Draw panel> Polygon ကို select လုိက္ပါ။

 Polygon အနား အေရအတြက္ကို ၆ ခုဟု ရုိက္ထည့္လုိက္ပါ။

 Polygon center သတ္မွတ္ရန္အတြက္ စက္၀ိုင္း၏ center အမွတ္ကုိ Click လိုက္ပါ။ (Object snap ဖြင့္ထားလွ်င္

Center point ေနရာတြက္ အမွတ္အသားေလး တစ္ခု ျပေပးပါလိမ္႕မည္။)
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 Inscribed Polygon အတြက္ I ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Polygon circle ၏ radius သတ္မွတ္ေပးရန္ 1.5 ကိုရုိက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

၅) ဥပမာ -၂ တြင္ ျပထားေသာ Circumscribed polygon ကို စက္၀ိုင္းအတြင္းတြင္ ေရးဆြဲၾကည့္ရေအာင္။

 Ribbon, Home tab > Draw panel> Polygon ကို select လုိက္ပါ။

 Polygon အနား အေရအတြက္ကို 6 ခုဟု ရုိက္ထည့္လုိက္ပါ။

 Polygon center သတ္မွတ္ရန္အတြက္ စက္၀ိုင္း၏ center အမွတ္ကုိ Click လိုက္ပါ။ (Object snap ဖြင့္ထားလွ်င္

Center point ေနရာတြက္ အမွတ္အသားေလး တစ္ခု ျပေပးပါလိမ္႕မည္။)

 Circumscribed polygon အတြက္ C ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Polygon circle ၏ radius သတ္မွတ္ေပးရန္ 1.5 ကိုရုိက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

၆) ဥပမာ -၃ တြင္ ျပထားသည့္ အတိုင္း Polygon ကုိ Edge Option ျဖင့္ေရးဆြၾဲကည့္ၾကရေအာင္။

 Ribbon, Home tab > Draw panel> Polygon ကို select လုိက္ပါ။

 Polygon အနား အေရအတြက္ကို 6 ကိုရုိက္ထည့္လုိက္ပါ။

 Edge အတြက္ E ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Edge ၏ ပထမဆုံး End Point သတ္မွတ္ေပးရန္ အတြက္ Drawing window ရ႕ဲ တစ္ေနရာရာကုိ Click လုိက္ပါ။

 Cursor ေလးကို drag လုပ္ၾကည့္လိုက္ပါ။ ျပီးလွ်င္ Polar Snap ကုိ ON ထားတ႕ဲအတြက္ေၾကာင့္ Edge ရ႕ဲ Polar

angle ကုိ Polar Snap တြင္သတ္မွတ္ႏိုင္သည္ကုိ သတိထားၾကည့္ၾကည့္ပါ။ 1 ကိုရိုက္ထည့္ျပီး Enter

ကုိႏိွပ္လိုက္ပါ။
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Exercise: Create Basic Objects

Line,Circle, Arc, Rectangle, န႕ဲ Polygon စေသာ အေျခခံ geomentry မ်ားကို အသုံးျပဳ၍ Mechanical Bracket

ေလးတစ္ခုကို လက္ေတြ႕ေရးဆြဲျခင္း သင္ခန္းစာကို လုိက္ပါေလ့က်င့္ၾကည့္ပါ။

Practice Creating Basic Objects: Part 1

ဤလက္ေတြ႕ေလ့က်င့္ခန္းမွာတြင္ Bracket ကိုေရွ႕တည့္တည့္မွ ျမင္ရေသာ ျမင္ကြင္းအတုိင္း ေရးဆြဲသြားမည္ ျဖစ္ျပီး၊ Point

(1) နဲ႕ စဆြျဲပီး Point (2) မွာ ဆုံးသြားမည့္ လမ္းေၾကာင္းအတိုင္း ေရးဆြဲျပသြားမည္။ ေလ့လာသူမ်ား အေနျဖင့္ Point (1) န႕ဲ

စဆြဲျပီး Point (3) မွာဆုံးမည့္ လမ္းေၾကာင္းအတိုင္း လက္ေတြ႕ေရးဆြဲ ေလ့က်င့္ၾကည့္ပါ။

၁) Open M_Create-Basic-Objects.dwg ကိုဖြင့္လုိက္ပါ။

၂) Status Bar ေပၚရိွ ေအာက္ပါ Settings မ်ားကို ON လိုက္ပါ။

 Polar tracking

 Object snap

 Object snap tracking
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 Dynamic input

၃) Point (1) ကေနစျပီး ေရးဆြဲမည့္ Line ကိုေရးဆြရဲန္ -

 Home tab,Draw panel > Line ကုိ Click လုိက္ပါ။

 100,50 ဟုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။

 100. ကုိရိုက္ျပီး Tab key နိွပ္လုိက္ပါ။

 0 ဟုရိုက္ထည့္လိုက္ပါ။ ( ေအာက္ပါပုံတြင္ ေဖာ္ျပထားသည့္ အတုိင္း 0သည္ Input Interface field

ထေဲရာက္ေနသည္ကုိ ေတြ႕ရမည္။

 Enter ႏိွပ္ျပီး Line တစ္ခုေရးဆြဲလိုက္ပါ။

၄) ဒုတိယ lineကုိ ပထမ line န႕ဲ ေထာင့္မွန္က်ေအာင္ ဆက္လက္ေရးဆြဲရန္ -

 Cursor ကုိ အေပၚသုိ႕ drag လုိက္ျပီး 100 ကုိရိုက္ထည့္ကာ Tab key ႏိွပ္လိုက္ပါ။

 Angle field တြင္ 90 ဒီဂရီ ျဖစ္ေအာင္ cursor ကိုdrag လုပ္ပါ။ 90 ဒီဂရီ ျဖစ္သြားျပီ ဆုိလွ်င္ Enter ႏိွပ္ျပီး

line ကုိေရးဆြဲလုိက္ပါ။

၅)ထပ္မံ၍ Line တစ္ေၾကာင္းကုိ ေရးဆြဲရန္ -

 Cursor ကုိ လက္ရိွေနရာမွ ဘယ္ဖက္သုိ႕ drag လုပ္လိုက္ပါ။ Cursor ကုိ angle field တြင္ 180 ဒီဂရီ ျပတဲ႕ အထိ

drag လုပ္ပါ။

 25 ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

မွတ္ခ်က္။ ။ ဤကဲ႕သို႕ dynamic Input field မွ direct distance entry ကိုအသံုးျပဳျပီး ေရးဆြဲျခင္းသည္ မိမိတုိ႕

အလုိမက်သည္မ်ားကုိ ျပန္လည္ျပင္ဆင္ ေရးဆြဲရာတြင္ အလြယ္ကူဆုံးေသာ နည္းလမ္းျဖစ္သည္။
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၆) Line ေနာက္တစ္ေၾကာင္း ေရးဆြဲရန္ -

 Cursor ကို လက္ရိွေနရာမွ ေအာက္သုိ႕ drag လုပ္ပါ။ angle field တြင္ 90 ဒီဂရီျဖစ္ေအာင္ cursor ကုိ drag

လုပ္ပါ။

 50 ဟုရိုက္ျပီး Enter နိွပ္လိုက္ပါ။

 Line command ကုိ Point (2) တြင္ဆံုးသြားေအာင္ Enter ထပ္တစ္ၾကိမ္ ႏိွပ္လိုက္ပါ။

၇) မိမိတို႕ ေရးဆြဲခ႕ဲျပီးေသာ Line မ်ားကုိ Undo လုပ္ၾကည့္ရေအာင္ -

 Quick Access toolbar ေပၚမွ Undo command ကို click လိုက္ပါ။

ထိုအခါ မိမိတုိ႕ ေနာက္ဆံုးအၾကိမ္ ေရးဆြခဲ႕ဲေသာ line သည္ removed ျဖစ္သြားမည္ကို ေတြ႕ရမည္။

၈) Undo လုပ္၍ removed ျဖစ္သြားေသာ Line ျပန္ျပီး ေပၚလာေအာင္ Redo လုပ္ၾကည့္ရေအာင္ -

 Quick Access toolbar ေပၚမွ Redo command ကုိ click လုိက္ပါ။
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 Removed ျဖစ္သြားေသာ Line ျပန္လည္ေပၚလာသည္ကို ေတြ႕ရမည္ ျဖစ္သည္။

၉) Object Snap အသံုးျပဳျပီး line မ်ားေရးဆြဲၾကည့္ရေအာင္ -

မွတ္ခ်က္။ ။ Object Snap အသံုးျပဳျပီး Objects မ်ားေရးဆြဲရာတြင္ တစ္ခုနွင့္တစ္ခု ဆက္သြယ္ရာတြင္

တိတိက်က်ျဖစ္ေစရန္ အေထာက္အကူျပဳပါသည္။ Objects Snap န႕ဲပတ္သက္ေသာ ေလ့က်င့္ခန္းမ်ားကုိ ေအာက္တြင္

အေသးစိတ္ ရွင္းလင္း ေပးသြားပါမည္။

 Home,Draw panel > Line ကို Click ပါ။

 Line ဆံုးသြားေသာ ေနရာသုိ႕ Cursor ကုိ dragလိုက္ေသာအခါ End Point အမွတ္အသားေလးကုိ Object snap

ကေဖာ္ျပေပးပါလိမ္႕မည္။

 ထုိအမွတ္အသား ျပထားေသာ End Point ေနရာကုိ Click လုိက္ပါ။

၁၀) ေထာင့္မွန္က်ေသာ Line တစ္ေၾကာင္းကုိ ေရးဆြရဲန္ -

 Cursor ကို လက္ရိွေနရာမွ ေအာက္သုိ႕ drag လုပ္ပါ။ angle field တြင္ 90 ဒီဂရီျဖစ္ေအာင္ cursor ကုိ drag

လုပ္ပါ။

 100 ကိုရုိက္ျပီး Enter ကိုနိွပ္လုိက္ပါ။

၁၁)ထပ္မံ၍ Line တစ္ေၾကာင္းကို ေရးဆြဲရန္ -
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 Cursor ကို လက္ရိွေနရာမွ ညာဖက္သုိ႕ drag လုပ္ပါ။ angle field တြင္ 0 ဒီဂရီျဖစ္ေအာင္ cursor ကုိ drag

လုပ္ပါ။

 35 ကုိရိုက္ျပီး Enter ကုိႏိွပ္လိုက္ပါ။

 မိမိတုိ႕ ေနာက္ဆံုး ေရးဆြဲလိုက္ေသာ Point အနီးတြင္ right – click နိွပ္ကာ shortcut menu မွ Undo ကုိ select

လုိက္ပါ။ လက္ရိွ line command အသက္၀င္ ေနေသးေသာေၾကာင့္ မိမိတို႕ ေနာက္ဆံုး ေရးဆြဲခ႕ဲေသာ line သာ

removed ျဖစ္သြားမည္ကုိ ေတြ႕ရမည္။

 Cursor ကို လက္ရိွေနရာမွ ညာဖက္သုိ႕ drag လုပ္ပါ။ angle field တြင္ 0 ဒီဂရီျဖစ္ေအာင္ cursor ကုိ drag

လုပ္ပါ။

 25 ကုိရိုက္ျပီး Enter နိွပ္လိုက္ပါ။

၁၂) ေထာင့္မွန္က်ေနေသာ ေနာက္ဆံုး Line တစ္ေၾကာင္းကို ေရးဆြဲရန္ -

 Cursor ကိုလက္ရိွေနရာမွ ေအာက္သုိ႕ drag လုပ္ပါ။ angle field တြင္ 90 ဒီဂရီျဖစ္ေအာင္ cursor ကုိ drag

လုပ္ပါ။

 50 ကုိုရိုက္ျပီး Enter နိွပ္လိုက္ပါ။

၁၃) Line command ကုိ Exit ရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။

ဤလက္ေတြ႕ေလ့က်င့္ခန္း၏ Part 2 ကုဆိက္လက္ ေလ့က်င့္ေရးဆြဲ သြားၾကပါမည္။

Practice Creating Basic Objects: Part 2

၁) Arc ေလးေရးဆြဲလိုက္ၾကရေအာင္ -

 Home tab, Draw panel > Arc ကုိ Click လိုက္ပါ။
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 ေနာက္ဆံုး ေရးဆြဲခဲ႕ေသာ line ၏ End Point ကုိ click လိုက္ပါ။

 Keyboard မွ DOWN ARROW key ေလးကို ႏိွပ္ျပီး ေပၚလာေသာ Shortcut menu မွ End ကို Click

လုပ္လိုက္ပါ။

၂) ညာဖက္တြင္ရိွေသာ line ၏ End point ကို click လုိက္ပါ။

၃) Arc command ကုိ Exit ျပန္လုပ္ရန္ -

 Cursor ကုိ ဘယ္ဖက္သုိ႕ drag လုပ္လုိက္ပါ။ Angle field တြင္ 180 ဒီဂရီ ျဖစ္သြားေအာင္ drag လုပ္ပါ။

 25 ဟုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။

ေအာက္တြင္ ျပထားေသာ ပုံကုိ ေရးဆြျဲပီး ျဖစ္သြားလိမ့္မည္။
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၄) File menu မွ Save ကုိ Click လုိက္ပါ။

Tip: Object တစ္ခု ဖန္တီးျပီးတိုင္း Save တတ္တဲ႕ အက်င့္ေလးရေအာင္ သတိထား ေလ့က်င့္ပါ။

၅) Rectangle ေလးဆြဲရန္ -

 Home tab, Draw panel > Rectangle ကို Click ပါ။

 ေအာက္ပုံတြင္ ျပထားေသာ Point (1) ကို မထိပဲ Cursor ကို ညာဖက္သို႕ drag ျပီး (2) ေနရာတြင္ Click လိုက္ပါ။

၆) Rectangle ကုိေနရာသတ္မွတ္ေပးရန္ -

 Click လုိက္ေသာ (2) အမွတ္၏ ေဘးတြင္ Right – click ႏိွပ္ျပီး ေပၚလာေသာ shortcut menu မွ Dimensions

ကုိ Select လိုက္ပါ။

မွတ္ခ်က္။ ။ Dimensions သည္ Rectangle command ၏ option ျဖစ္ပါသည္။

 Length အတြက္ 25 ကိုရိုက္ျပီး Enter နိွပ္လိုက္ပါ။

 Width အတြက္ 100 ကိုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Rectangle ကို ေနရာသတ္မွတ္ေပးရန္ အတြက္ Drawing ၏ညာဖက္အေပၚေထာင့္ တစ္ေနရာကုိ Click လိုက္ပါ။
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 အထက္ပါ အဆင့္မ်ားကို ေရးဆြဲျပီးပါက ေအာက္တြင္ျပထားေသာ ပုံအတိုင္း မိမိတုိ႕၏ Drawing area

တြင္ျမင္ေတြ႕ရမည္ ျဖစ္ပါသည္။

၇) Circle ေရးဆြဲရန္ -

 Home tab, Draw panel > Circle ကုိ Click ပါ။

 112.50,65 ကိုရိုက္ျပီး Enter ႏိွပ္ပါ။

 Dynamic Input Radius field တြင္ 7.5 ကိုရိုက္ထည့္ျပီး Enter နိွပ္လိုက္ပါ။

၈) Rectangle ေရးဆြရဲန္ -

 Home tab, Draw panel > Rectangle ကို Click ပါ။

 ေရးဆြထဲားေသာ Circle (1) ၏ Center Point ကို Click လုပ္ပါ။

မွတ္ခ်က္။ ။ Object snap က Circle ၏ Center Point အမွတ္ကုိ ညႊန္ေပးပါလိမ္႕မည္။
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 Cursor ကို ေအာက္ပါပုံတြင္ (2) ျပထားေသာ ညာအေပၚဖက္သုိ႕ drag လုပ္ျပီး 75,70 ကိုရိုက္ထည့္ျပီး Enter

နိွပ္လိုက္ပါ။

 ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း ရရိွသြားမည္ျဖစ္သည္။

၉) Circles မ်ားကို ဆက္လက္ေရးဆြၾဲကရေအာင္ -

 Home tab, Draw panel > Circle ကုိ Click ပါ။

 Rectangle ၏ End Point မ်ားကို Circle ၏ Center အျဖစ္သတ္မွတ္ျပီး Radius 7.5 ရိွေသာ Circles မ်ားကို

ေရးဆြလဲိုက္ပါ။

Tip: AutoCAD software သည္ မိမိတုိ႕ ေနာက္ဆံုးေရးဆြဲခဲ႕ေသာ တန္ဖိုးကုိသာ ျပန္လည္ေဖာ္ျပေပးမည္ ျဖစ္ေသာေၾကာင့္

Circle command ကုိ ေခၚျပီးသည္နွင့္ radius သည္ ေနာက္ဆံုးသတ္မွတ္ခ႕ဲေသာ 7.5ကို prompt တြင္

ေဖာ္ျပေပးလိမ္႕မည္။ Enter ႏိွပ္ျပီး ဆက္လက္ေရးဆြဲ လိုက္ယံုပင္ျဖစ္သည္။

၁၀) Home tab, Modify panel > Erase ကုိ Click လိုက္ပါ။ Circles မ်ားေနရာသတ္ရာတြင္ တိက်ေစရန္ အတြက္

အသုံးျပဳထားေသာ rectangle ကို Select ျပီး remove လုပ္လိုက္ပါ။

၁၁) ဘယ္ဖက္ထိပ္ေထာင့္တြင္ ရိွေသာ စက္၀ိုင္းတြင္ polygon circumscribing ေရးဆြရဲန္ -
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 Home tab, Draw panel > Polygon

 Prompt ကအနားအေရအတြက္ ရိုက္ထည့္ရန္ ေဖာ္ျပလာစဥ္ 6 ကိုရိုက္ထည့္ လိုက္ပါ။

 ဘယ္ဖက္ထိပ္ေထာင့္တြင္ ရိွေသာ စက္၀ိုင္း၏ Center point ကို Select လိုက္ပါ။

 Dynamic Input menu တြင္ Circumscribed About circleကုိ Select လုိက္ပါ။

 Radius အတြက္ 8 ကုိရိုက္ျပီး Enter ႏိွပ္ပါ။

12) က်န္ရိွေနေသးေသာ စက္၀ိုင္း (၃) ခုတြင္ လည္း တူညီေသာ polygons circumscribing ေရးဆြဲရန္ -

 Enter ႏိွပ္ျပီး Polygon command ကိုျပန္ေခၚလိုက္ပါ။

 က်န္ရိွေနေသးေသာ စက္၀ိုင္း (၃) ခုတြင္လည္း အထက္ပါ နည္းအတိုင္း ေရးဆြဲလိုက္ပါက ေအာက္ေဖာ္ျပပါ

ပုံအတိုင္း ရရိွသြားမည္ ျဖစ္သည္။

၁၃) Files အားလုံးကို မ Save ပဲ ပိတ္လုိက္ပါ။

Lesson: Using Object Snaps

ဤသင္ခန္းစာတြင္ Object snaps ဆုိတာဘာလဲ၊ ဘာလို႕ သူတုိ႕ဟာ အေရးပါသလဲ၊ မိမိတို႕ ေရးဆြေဲသာ Drawings

မ်ားအတြက္ ဘယ္ေလာက္အထိ အက်ိဳးသက္ေရာက္မွဳ႕ ရိွသလဲဆုိတာေတြကို ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Objest
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snaps ကို ON ျပီး ေရးဆြဲထားေသာ ပုံနွင့္ OFF ျပီးေရးဆြဲထားေသာ ပုံေတြ ဘယ္လို ကြာျခားမွဳ႕ ရိွတယ္ဆုိတာကုိ နားလည္

သေဘာေပါက္ သြားမည္ျဖစ္သလုိ၊ Object snaps ရဲ႕ အဓိက က်ပုံကုိ သိရိွနားလည္လာမည္ ျဖစ္သည္။

Object snaps ကိုမ်ားေသာအားျဖင့္ Drawing မ်ားတြင္ Editing အပိုင္းတြင္ အသုံးမ်ားၾကသည္။ တိက်မွန္ကန္ ေသာ

Drawings ရလုိလွ်င္ Object snaps ကုိအသုံးျပဳျပီး ေရးဆြဲေသာ နည္းလမ္းသည္ အေကာင္းဆုံးေသာ နည္းလမ္း

ျဖစ္ပါသည္။

ေအာက္ပါပုံတြင္ ေဖာ္ျပထားေသာ Door ပုံႏွစ္ခုကုိ ႏိႈင္းယွဥ္ေလ့လာၾကည့္ပါ။ Object snaps အသံုးျပဳျပီး ေရးဆြထဲားေသာ

ဘယ္ဖက္ Door သည္ Objects မ်ားကုိတိတိက်က် ဆက္ထားေပးျပီး၊ Object snaps အသံုး မျပဳပဲ ေရးဆြဲထားေသာ

ညာဖက္ Door သည္ Objects တစ္မ်ားကုိ ဆက္ေပးရာတြင္ တိက်ျခင္း မရိွသည္ကုိ ေတြ႕ျမင္ရမည္ ျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျပီးသြားပါက ေလ့လာသူမ်ားကို -

 Object snaps ဆိုတာဘာလ၊ဲ သူတို႕ကုိ ဘာလုိ႕ အသုံးျပဳရသလဲ ဆိုတာကုိ သိရိွနားလည္လာေစရန္။

 Object snaps mode အသံုးျပဳျပီး ေရးဆြထဲားေသာ ပံုနွင့္ အသံုးမျပဳပဲ ေရးဆြဲထားေသာ ပုံတုိ႕၏ ကြဲျပားျခားနား

ခ်က္ကုိ ေကာင္းစြာသိရိွနားလည္လာေစရန္။

 Drawings မ်ားတြင္ Object snaps အသံုးျပဳျပီး Point မ်ားကုိ တိတိက်က် သတ္မွတ္တတ္လာေစရန္။

About Object Snap

Objects တိုင္းတြင္ ၎တုိ႕နွင့္ သက္ဆိုင္ေသာ Object snaps မ်ားရိွပါသည္။ Objects မ်ားကို တစ္ခုနွင့္တစ္ခု

ခ်ိတ္ဆက္ေရးဆြဲရာတြင္ တိက်ေစရန္အတြက္ ကြဲျပားျခားနားေသာ Object snapsမ်ားကို လုိအပ္သလို အသုံးျပဳ ႏိုင္ပါသည္။

Object Snaps Defined
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အေျခခံအက်ဆုံးေသာ Objects မ်ားျဖစ္သည့္ line, circle န႕ဲ arc တုိ႕တြင္ ကြဲျပားျခားနားေသာ Object snaps

မ်ားရိွေနသည္ကုိ ေအာက္ပါပုံတြင္ ေလ့လာႏိုင္ပါသည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ Line ပုံတြင္ snap type (၂)

မ်ိဳးရိွျပီး၊ Object snaps mode ျဖင့္ select ႏိုင္ေသာ ေနရာ (၃)ေနရာ ရိွပါသည္။ Circle တြင္လည္း snap type (၂) မ်ိဳးရိွျပီး၊

Object snaps mode ျဖင့္ select ႏိုင္ေသာ ေနရာ (၅)ေနရာ ရိွပါသည္။ Arc တြင္လည္း snap type (၃) မ်ိဳးရိွျပီး၊ Object

snaps mode ျဖင့္ select ႏိုင္ေသာ ေနရာ (၄)ေနရာ ရိွပါသည္။

1. Endpoint

2. Midpoint

3. Center point

4. Quadrant

Effect of Using Object Snaps

ေအာက္ေဖာ္ျပပုံတြင္ ေလ့လာၾကည့္ပါ။ Circle အေသး၏ Center Pointကုိ Circle အၾကီး၏ Center Pointသုိ႕

ထပ္တူက်ရန္ ေရြ႕လုိလွ်င္ Object snaps က center point mode ကုိအသုံးျပဳျပီး တိတိက်က် ေျပာင္းေရြ႕ နိုင္ပါသည္။
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Effect of Not Using Object Snaps

ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံကုိထပ္မံေလ့လာၾကည့္ပါ။ Users သည္ Vertical line နွင့္ Horizontal line တို႕ကို Object

snap အသံုးမျပဳပဲ ခ်ိတ္ဆက္ေရးဆြဲ ေပးထားေသာ ပုံျဖစ္ပါသည္။ သာမန္ View ျဖင့္ၾကည့္လွ်င္ မသိသာေပမ႕ဲ Zoom ျဖင့္

ခ်႕ဲၾကည့္လွ်င္ Line နွစ္ခု ခ်ိတ္ဆက္ထားေနျခင္း မရိွသည္ကုိ ေတြ႕ရေပမည္။

Object Snaps

Object snaps ကုိအသုံးျပဳရာတြင္ နည္းလမ္းအမ်ိဳးမ်ိဳးျဖင့္ အသုံးျပဳ ႏိုင္ပါသည္။ Status Bar မွ Object snaps setting ကို

ON ျပီးျဖစ္ေစ၊ Shift+Right–click ကုိနိွပ္ကာ shortcut menu မွ မိမိတုိ႕ အသံုးျပဳလိုေသာ Object snaps ကုိ click

ျပီးျဖစ္ေစ၊ command line မွျဖစ္ေစ နည္းအမ်ိဳးမ်ိဳးျဖင့္ ေခၚယူအသံုးျပနိုင္ပါသည္။

Object snaps တစ္မ်ိဳးတည္းကုိ အၾကိမ္ၾကိမ္ အသံုးျပဳလိုပါက Status bar မွ Object snaps mode ကုိ Right–click

ႏိွပ္ျပီး setting တြင္မိမိတုိ႕ အသုံးျပဳလုိေသာ Object snaps ကုိ Select ေပးလုိက္ျခင္းျဖင့္ အသံုးျပဳ ႏိုင္ပါသည္။ ဥပမာ -

End point တစ္ခုတည္းကုိသာ အၾကိမ္ၾကိမ္ အသုံးျပဳလုိပါက၊ Statu bar က Object snaps mode button ကို Right –

click ျပီး၊ Shortcut menu မွ setting ကုိ click ကာ Drafting Setting box ကုိေခၚလုိက္ပါ။ Drafting Setting box မွ End

Point ကို Select လုပ္ျပီး Ok ေပးလိုက္ ပါက Objects တိုင္း၏ End point မ်ားကုိ ေဖာ္ျပေပးေနပါလိမ့္မည္။ (

ထုိနည္းလမ္းကုိ Auto snap ဟုေခၚပါသည္။)

Running Object Snap

Command Line: OSNAP

Menu Bar: Tools > Drafting Settings > Object Snap Tab

Keyboard Shortcut: F3
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Toolbar: Object Snap

Status Bar: Object Snap

Object Snap Settings

Status bar မွ Object snaps ကို Click ယံုျဖင့္ Object snaps mode ကုိလ်င္လ်င္ျမန္ျမန္ ON ႏိုင္ပါသည္။ Object snaps

button ကုိ right – click ျပီး Drafting Settings dialog box မွ snap options မ်ားကို Select လုပ္ျပီးေရြးခ်ယ္ အသံုးျပဳ

နိုင္ပါသည္။ မိမိတို႕ အသုံးျပဳလုိေသာ Object snap ကုိေရြးခ်ယ္ျပီး ပါက ထို Object snap သည္ အေရာင္တင္ထားေပးမည္

ျဖစ္သည္။

Status bar မွ Shortcut menu သည္ ေအာက္ေဖာ္ျပပါ Drafting Settings dialog box ျဖင့္ တူညီပါသည္။
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မိမိတုိ႕ အၾကိမ္ၾကိမ္ အသုံးျပလိုေသာ Objects snap ကိုအလိုအေလ်ာက္ ေပၚေနေစလုိ ပါက Autosnap ကိုအသံုးျပဳ

နိုင္ပါသည္။ Autosnap ကုိ ON ထားပါက Objects မ်ားအေပၚသို႕ cursor ျဖတ္သြားတုိင္း Drafting Settings dialog box

တြင္ မိမိတို႕ Selected ထားေသာ Object snap ေလးအလိုအေလ်ာက္ ေဖာ္ျပေပးေနမည္ ျဖစ္သည္။ သုိ႕ေသာ္ Drafting

Settings dialog box တြင္ Object snapsမ်ား အားလုံးကို တစ္ခါတည္း select ေပးျပီး အသံုးမျပဳသင့္ပါ။ အမ်ားအားျဖင့္

Endpoint, Midpoint န႕ဲ Intersection တုိ႕ကုိသာ အျမဲတေစ select ထားသင့္ျပီး၊ အျခားမိမိတို႕ အသုံးျပဳလုိေသာ Object

snaps မ်ားကို အသံုးျပဳလိုေသာ အခါမွ Select သင့္ပါသည္။

Cursor ျဖတ္သြားယံုျဖင့္ Object snaps ကုိအလုိအေလ်ာက္ ေဖာ္ျပေပးေသာပုံ

Object Snap Override

Object Snap Override ဆုိသည္မွာ Users မ်ားအေနျဖင့္ လက္ရိွအမွတ္မွ ေနာက္တစ္မွတ္သုိ႕ မကူးမခ်င္း Object snaps

အက်ိဳးသက္ေရာက္မွဳ႕ ရိွေနျခင္းကုိ ဆုိလုိပါသည္။ ေနာက္တစ္မွတ္ မသတ္မွတ္ခင္ shortcut menu (သုိ႕မဟုတ္) object

snap toolbar မွ Object snap ကိုေခၚယူအသံုးျပဳကုိ Object Snap Override mode လုိ႕ေခၚပါသည္။

Object Snap Toolbar



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

120

Command Line: Prompt တြင္ select point ဆိုေသာ အေနအထားတြင္ မိမိတုိ႕ အသုံးျပဳလုိေသာ object snap ၏

ပထမစာလံုး (၃) လံုးကုိ ရိုက္ထည့္ျပီး Enter ႏိွပ္ကာ ေခၚယူအသုံးျပဳ နိုင္ပါသည္။ (i.e. MID, INT, NEA)

Menu Browser: Tools > Toolbars > ACAD > Object Snap

Toolbar: Object Snap (Menu Browser မွရယူႏိုင္ပါသည္)

Shortcut Menu: SHIFT + right-click (Drawing area အတြင္းတြင္)

Object Snap Modes

Object snap override mode ကုိ cancel ျဖစ္ေစႏိုင္ေသာ အခ်က္မ်ား -

 Object snap အမွတ္သို႕ Click ရာတြင္ လြဲေခ်ာ္သြားျခင္း။

 Point ကို Selected မလုပ္ရေသးခင္ Object snap ကုိ Select ျခင္း။

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ဥပမာ မ်ားကုိေလ့လာၾကည့္ပါ -

End Point : Arc, elliptical arc, line, multiline, polyline segment, spline, region, or ray, solid ( သုိ႕မဟုတ္)

3D face စသည္ Objects မ်ား၏ စ/ဆံုး မ်ားပိုင္းျဖတ္သတ္မွတ္ျခင္း။
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Mid Point : arc, elliptical arc, line, multiline, polyline segment, region,solid, spline (သို႕မဟုတ္) xline

တုိ႕၏ အလယ္မွတ္မ်ား သတ္မွတ္ ပိုင္းျဖတ္ျခင္း။

Center: Circles, arcs, (သုိ႕မဟုတ္) ellipses Objects တို႕၏ center points မ်ားကုိ သတ္မွတ္ ပိုင္းျဖတ္ျခင္း။

Node:Point object, dimension definition point (သို႕မဟုတ္) dimension text origin တို႕ကို သတ္မွတ္

ပိုင္းျဖတ္ျခင္း။
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Quadrant: Circle, arc, (သို႕မဟုတ္) ellipse objects မ်ား၏ quadrant points မ်ားကုိ သတ္မွတ္ ပိုင္းျဖတ္ျခင္း။

Intersection: Arc, circle, ellipse, elliptical arc,line, multiline, polyline, ray, region, spline, (သုိ႕မဟုတ္)

xline စသည့္ objects တုိ႕အၾကား တစ္ခုခုနွင့္ တစ္ခု ဆံုျဖတ္သြားေသာ ဆံုမွတ္မ်ားကို သတ္မွတ္ ပိုင္းျဖတ္ျခင္း။

Extended Intersection : လမ္းေၾကာင္းတစ္ခုစီ သြားေနေသာ Objects ႏွစ္ခု တုိ႕၏ ဆံုသင့္ေသာ ေနရာကုိ ခန္႕မွန္းျဖင့္

သတ္မွတ္ ပုိင္းျဖတ္ေပးျခင္း။

Extension: Objects ၏ End Point ကုိ Cursor ျဖတ္သြားေသာ အခ်ိန္တြင္ ထိုမ်ဥ္းကို တစ္ေနရာရာသုိ႕

ဆက္လက္ေရးဆြဲ ႏိုင္သည္ကို temporary line ျဖင့္ျပေပးသည္။ လမ္းေၾကာင္း အလုိက္သြားေနေသာ Object နွစ္ခု ဆံုမည့္

Object snap ကိုလည္း ရွာေဖြႏိုင္ပါသည္။
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Insertion: attribute, a block, a shape (သုိ႕မဟုတ္) text တုိ႕၏ Insertion အမွတ္ ကိုသတ္မွတ္

ပိုင္းျဖတ္ေပးျခင္း။

Perpendicular: Arc, circle, ellipse, elliptical arc, line, multiline,polyline, ray, region, solid, spline,

(သုိ႕မဟုတ္) xline Objects တို႕၏ ေထာင့္မွန္က်ေသာ အမွတ္ကို သတ္မွတ္ပိုင္းျဖတ္ျခင္း။

Tangent: Arc, circle, ellipse, elliptical arc, polyline arc segment (သို႕မဟုတ္) spline Objects မ်ားေပၚက

tangent အမွတ္ကုိ သတ္မွတ္ပိုင္းျဖတ္ျခင္း။
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Nearest: Arc, circle, ellipse, elliptical arc, line, multiline, point, polyline, ray, spline (သို႕မဟုတ္) xline

စသည့္ Objects မ်ားေပၚက အနီးစပ္ဆုံး အမွတ္ကုိ သတ္မွတ္ပိုင္းျဖတ္ျခင္း။

Apparent Intersection: Arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline

(သုိ႕မဟုတ္) xline စသည့္ Objects မ်ားတြင္ တစ္မွတ္နွင့္တစ္မွတ္ ဆုံႏုိင္မည့္ အမွတ္ကုိ ရွာေဖြ သတ္မွတ္ ေပးသည္။ (3D

space တြင္မူ Interset လုပ္လို႕ရမည္ မဟုတ္ေပ။)

Parallel: ေရးဆြဲထားေသာ Object ႏွင့္အျပိဳင္ Object တစ္ခုကုိ ေရးဆြဲလိုပါက Objects ႏွစ္ခုအျပိဳင္ ျဖစ္ေစမည့္

အမွတ္ကုိ သတ္မွတ္ညႊန္ျပေပးသည္။
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None : လက္ရိွ မိမိတို႕ အသုံးျပဳေနေသာ Object snaps မ်ားကို Cancel လုပ္လုိပါက အသံုးျပႏိုင္သည္။

Using Object Snap

Running object snaps မ်ားကို ၁ခုထက္ပို ဖြင့္ထားျပီး Objects မ်ားေရးဆြဲပါက၊ object သည္ Cursor နွင့္ အနီးဆံုး

object snaps တြင္သာ Point သတ္မွတ္ေပးသြားမည္ ျဖစ္သည္။ ထုိ႕ေၾကာင့္ Object snap ကို မိမိတို႕ အသံုးျပဳလိုေသာ

snaps ကိုသာ ဖြင့္ထားသင့္ပါသည္။ မိမိတုိ႕ အသုံးျပဳလုိေသာ Object snaps မ်ားကုိသာ အျမဲ တေစဖြင့္ထားလုိပါက Statu

bar က Osnap ကို Right-click ႏိွပ္ျပီး setting ကို select လုိက္ပါ။ Drafting Setting မွ Object snaps tab တြင္ မိမိတုိ႕

အသုံးျပလိုေသာ object snaps မ်ားကို select ေပးျပီး Add လိုက္ပါ၊ မလုိအပ္ေသာ object snaps မ်ားကို

remove လုပ္ကာ Ok ေပးလုိက္ပါ။

ေအာက္ေဖာ္ျပပါပုံတြင္ ေလ့လာၾကည့္ပါ။ Object snaps (၂) မ်ိဳးကို တစ္ျပိဳင္တည္း ဖြင့္ထားေသာေၾကာင့္ Cursorသည္၊

၎ႏွင့္နီးေသာ Object snaps ဆီကုိသာ သြားမည္ျဖစ္သည္။ ဘယ္ဖက္ပုံတြင္ Cursor သည္ Midpoint နွင့္ နီးေသာေၾကာင့္၊

Midpoint ဆီကိုသာ သြားျပီး၊ ညာဖက္ပုံသည္ Endpoint ႏွင့္ နီးေသာေၾကာင့္ Endpoint ဆီကုိသာ သြားသည္ကို

ေတြ႕ရေပမည္။

Procedure: Using Running Object Snaps

Running Object snaps အသုံးျပဳပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ ေလ့လာၾကည့္ပါ။

၁) Status bar ေပၚတြင္ရိွေသာ Object snaps ကုိ right –click ေပးလိုက္ကာ၊ ေပၚလာေသာ shortcut menu မွ setting

ကုိ click ပါ။
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၂) Drafting Settings dialog box တြင္ Object snaps တစ္ခ်ိဳ႕နွင့္ Object Snap On(F3) option တို႕ကို selected

ျပီးသား ေတြ႕ရမည္ ျဖစ္သည္။ ျပီးလွ်င္ Ok ကုိ click လုပ္ပါ။

၃) Home tab, Draw panel > Line ကို Click လုိက္ပါ။ Cursor ကုိ Drawing ထရိွဲ တစ္ျခားေသာ geomentry

နားကပ္ထားၾကည့္လိုက္ပါ။ Cursor သည္ Autosnap ေၾကာင့္ snap point နားကုိ အလုိအေလ်ာက္ ေရာက္သြား

ပါလိမ္႕မည္။

၄) Snap point ေနရတြင္ပင္ Click လိုက္ပါ။ ထို႕ေနာက္ Cursor ကို Screen မွာရိွတဲ႕ ေနာက္တစ္မွတ္ သို႕ေရြ႕လိုက္ပါ။

Cursor သည္ geomentry နားေရာက္သြားသည္နွင့္ Autosnap အမွတ္အသားေနရာသုိ႕ အလိုအေလ်ာက္ ေရာက္သြား

ေပလိမ္႕မည္။ Snap point ေနရာတြင္ Click လိုက္ပါ။

မွတ္ခ်က္။ ။ Wheel Mouse ေလးကိုအသံုးျပဳ၍လည္း Object snap shortcut menu ကုိေခၚယူႏိုင္ပါသည္။

ထုိသို႕ Wheel Mouse ေလးကုိ တစ္ခ်က္ ဖိျပီး Object snap shortcut menu ကုိေခၚယူလုိပါက MBUTTONPAN ရ႕ဲ

system variable တန္ဖိုးကို ေျပာင္းေပးရပါမည္။

 Command line တြင္ MBUTTONPAN ဟုရိုက္ထည့္ျပီး Enter နိွပ္လုိက္ပါ။

 System variable ကုိ 0 ဟုရိုက္ထည့္လိုက္ပါ။
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 ျပီးလွ်င္ Enter ႏိွပ္လုိက္ပါ။

Procedure: Using Object Snap Overrides

Object Snap Overrides ကုိမည္သုိ႕ အသံုးျပဳသည္ကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Geomentry ကို Creating နဲ႕ Editing ေလးလုပ္ၾကည့္ပါ။

၂) Software prompt က Point ကုိ select လုပ္ရန္ ေဖာ္ျပေသာအခါ shortcut menuမွ object snaps ကို select

ေပးလုိက္ပါ။

၃) ထုိ႕ေနာက္ snap point ရိွေသာ Objects အနားသုိ႕ Cursor ကိုေနရာေရြ႕လိုက္ပါ။

၄) Autosnap အမွတ္အသားေလးသည္ snap point (1) ေနရာတြင္ ေဖာ္ျပေပးလိမ္႕မည္။ Point သတ္မွတ္ရန္

Click လိုက္ပါ။

၃) SHIFT + right click နိွပ္ျပီး ေပၚလာေသာ Shortcut menu မွ Object snaps ကို select လိုက္ပါ။

၄) Cursor ကုိေနာက္ Object ဆီသုိ႕ေရြ႕လုိက္ပါ။ Autosnap အမွတ္အသားေလးဟာ ေနာက္ snap point ေလးတစ္ခုတြင္

ေရာက္ေနေပလိမ္႕မည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

128

AutoSnap Aperture

ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံသည္ AutoSnap Aperture box ျဖစ္ပါသည္။ Aperture box ၏ အစိတ္အပိုင္း

တစ္ခုသည္ မွန္ကန္ေသာ snap point ရိွတ႕ဲObject တစ္ခုကို ထိေတြ႕လိုက္သည္နွင့္ AutoSnap အမွတ္အသားက snap

point သို႕ေရာက္ရိွလာမည္ ျဖစ္သည္။

Options Dialog Box: Drafting Settings Tab

AutoSnap Setting တြင္ရိွေသာ Display AutoSnap Aperture box ေနရာကုိ အမွတ္သားေလး check ေပးလိုက္ပါ။

Aperture size ေအာက္တြင္ aperture box အရြယ္အစား သတ္မွတ္ေပးရန္ အတြက္ slider ေလးကို ဘယ္/ညာ ေရြ႕ေပး၍

ျပဳလုပ္ႏိုင္ပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

129

Practice Exercise: Running Object Snap and Object Snap Overrides

Running object snap န႕ဲ object snap overrides ေလးအသံုးျပဳျပီးေတာ႕ ေအာက္ပါ လက္ေတြ႕ ေလ့က်င့္ခန္းကို လုိက္ပါ

ေလ့က်င့္ၾကည့္ပါ။ Object snap Options (၂) မ်ိဳးန႕ဲ Drawing (၂) ခုကို ေရးဆြဲ ေလ့က်င့္သြား ရမည္ျဖစ္ပါသည္။ ပထမ

Drawing ကုိ Running object snap option ဖြင့္ျပီး ေရးဆြဲရမည္ ျဖစ္ျပီး၊ ဒုတိယ Drawing ကုိ Running object snap

option ပိတ္ျပီး၊ object snap overrides ဖြင့္ျပီး ေရးဆြဲ ရမည္ ျဖစ္သည္။

၁) New Drawing ဖြင့္လုိက္ပါ။

၂) Statu bar က object snap ကုိ ON လုိက္ပါ။
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Object snap ကို Right – click နိွပ္ျပီး shortcut menu မွ Endpoint, Midpoint န႕ဲ Intersection ကုိ select လိုက္ပါ။

၃) Rectangle (မိမိတုိ႕ စိတ္ၾကိဳက္ အရြယ္အစား) တစ္ခုကို ေရြးဆြဲလိုက္ပါ။

 Home tab, Draw panel > Rectangle ကို click လုိက္ပါ။

 First point သတ္မွတ္ေပးလုိက္ပါ။

 Mouse ကုိ drag ျပီး ဆန္႕က်င္ဘက္ ေထာင့္တြင္ အမွတ္တစ္မွတ္ သတ္မွတ္လုိက္ပါ။

၄) Rectangle ၏ ေထာင့္ေလးေထာင့္ကို Centerpoint အျဖစ္သတ္မွတ္ျပီး အရြယ္အစားတူ စက္၀ိုင္း (၄) ခုကုိေရြး

ဆြဲလုိက္ပါ။

 Home tab, Draw panel > Circle ကုိ click လိုက္ပါ။

 Circle အတြက္ Center point မ်ားကို Rectangle ၏ေထာင့္ End point (သုိ႕မဟုတ္) Intersection မ်ားတြင္

သတ္မွတ္ေပးလိုက္ပါ။

 Circle ၏ radius ကို မိမိတုိ႕ၾကိဳက္ သတ္မွတ္ျပီး Circle တစ္ခု ေရးဆြလုိဲက္ပါ။

 Circle command ျပန္ေခၚရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။

 Rectangle ၏ End point ေနာက္တစ္ခုတြင္ click လုိက္ပါ။

 Circle ၏ radius အတြက္ ပထမ Circle ျဖင့္ အရြယ္စားတူ ေရးဆြမဲည္ ျဖစ္ေသာေၾကာင့္ default တန္ဖိုး အတိုင္း

Enter ႏိွပ္လုိက္ပါ။

 က်န္ Circle ႏွစ္ခုကုိလည္း အထက္ပါနည္းအတိုင္း Rectangle ၏က်န္ေထာင့္ (၂) ေထာင့္တြင္ ေရးဆြဲ လိုက္ပါ။

၅) Rectangle ၏ Midpoint မွ line (၄) ေၾကာင္းကို ခ်ိတ္ဆက္ေရးဆြဲ ေပးရန္ -

 Home tab, Draw panel > Line ကုိ click လုိက္ပါ။

 Cursor ကုိ Rectangle line ၏ Midpoint ရိွရာသုိ႕ drag လိုက္ပါ။

 Midpoint အမွတ္အသား ေတြ႕လွ်င္ click လိုက္ပါ။

 ထုိနည္းအတုိင္း အျခား Rectangle line ၏ Midpoint မ်ားတြင္လည္း click ျပီး line မ်ားကုိ ပုံတြင္ ျပထားသည့္

အတိုင္း ေရးဆြဲလိုက္ပါ။

၆) Objects အားလုံးကုိ Erase လုပ္လိုက္ပါ။ Object snap ကုိ off လုိက္ျပီး Drawing မ်ားကို ျပန္လည္ေရးဆြဲ ပါမည္။
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၇) ပထမဆံုး မိမိတုိ႕ စိတ္ၾကိဳက္ အရြယ္စား Rectangle တစ္ခုကုိေရးဆြပဲါမည္။ ျပီးေနာက္ object snap overrides

အသုံးျပဳျပီး အထက္တြင္ ေရးဆြဲခ႕ဲေသာ ပုံအတိုင္း ထပ္မံေရးဆြဲပါမည္။ Circles မ်ားေရးဆြဲရန္ -

 Home tab, Draw panel > Circle ကုိ click လိုက္ပါ။

 Circle အတြက္ Center point မသတ္မွတ္ခင္ SHIFT + Right click ႏိွပ္ျပီး End point ကို click လိုက္ပါ။

 Rectangle ၏ေထာင့္တစ္ခု Endpoint တြင္ click လုိက္ပါ။

 Circle ၏ radius ကုိ မိမိတို႕ စိတ္ၾကိဳက္ သတ္မွတ္ေပးျပီး Enter ႏိွပ္လိုက္ပါ။ က်န္ေနေသာ Circles (၃)

ခုကိုလည္း ထုိနည္းအတုိင္း ဆက္ဆြဲလုိက္ပါ။

၈) Rectangle ၏ Midpoint မွ line (၄) ေၾကာင္းကို ခ်ိတ္ဆက္ေရးဆြဲ ေပးရန္ -

 Home tab, Draw panel > Line ကုိ click လုိက္ပါ။

 SHIFT + Right click ႏိွပ္ျပီး Midpoint ကို click လုိက္ပါ။

 Mouse ကုိ Midpoint ရိွရာသုိ႕ ေရြ႕လိုက္ျပီး၊ Midpoint အမွတ္အသား ဆီသုိ႕ေရာက္လွ်င္ click လိုက္ပါ။

 အထက္ပါ နည္းအတုိင္း က်န္ line (၃) ေၾကာင္းကုိ ဆက္လက္ေရးဆြေဲပးလုိက္ပါ။

 Object snap option နွစ္မ်ိဳးကုိ အသံုးျပဳျပီး အထက္တြင္ ပုံမ်ားေရးဆြဲျပီး ပါက Object snap န႕ဲပတ္သက္ျပီး

အနည္းငယ္ နားလည္သေဘာေပါက္လာမည္ ျဖစ္သည္။

၉) Files အားလံုးကို မ Save ပဲ ပိတ္လိုက္ပါ။

Exercise: Use Object Snaps

ဤေလ့က်င့္ခန္းတြင္ Running object snap န႕ဲ object snap overrides မ်ားအသံုးျပဳ၍ Geomentry မ်ားေရးဆြဲ

သြားပါမည္။ ေလ့က်င့္ခန္း ျပီးဆံုးသြားပါက ေလ့လာသူမ်ား အေနျဖင့္ Object snap အသံုးျပီး geomentry မ်ားကို

ေရးဆြျဲခင္း၊ ျပဳျပင္ျခင္းတုိ႕ကုိ ျပဳလုပ္ႏိုင္သြားမည္ ျဖစ္သည္။
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၁) M_Object-Snaps.dwg ကိုဖြင့္ပါမည္။

၂) Status bar ေပၚမွ ေအာက္ပါ Setting မ်ားကို ON ပါ။

 Object snap

 Dynamic input

၃) Objects snap မ်ားသတ္မွတ္ရန္ -

 Object snap ကို Right – click နိွပ္ျပီး shortcut menu မွ setting ကုိ click ပါ။

 Drafting Settings dialog box မွ Object Snap tab ကို click ျပီး running object snaps မ်ားကုိ ေအာက္ပါ

ပုံအတိုင္း သတ္မွတ္ေပးလုိက္ပါ။

 ညာဖက္ column မွ Object snaps အားလုံးကုိ clear ေပးလိုက္ပါ။

 ျပီးရင္ Ok ကုိ click လိုက္ပါ။
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၄) Line ေရးဆြဲရန္ -

 Home tab, Draw panel > Line ကုိ click လုိက္ပါ။

 ေအာက္ပါ ပုံတြင္ ေဖာ္ျပထားသည့္အတုိင္း Endpoint ကုိ select လုိက္ပါ။

 Line command ကုိ exit ေပးရန္ အတြက္ Enter ကုိနိွပ္ပါ။

၅) Line command ကုိျပန္ေခၚရန္ အတြက္ Enter နိွပ္လုိက္ပါ။ ပထမ click ခဲ႕ေသာ Endpoint ေနရာတြင္ပင္ ျပန္ျပီး click

လုုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

134

၆) Circle ေရးဆြဲရန္ -

 Home tab, Draw panel > Circle ကုိ click လိုက္ပါ။

 Circle ၏အျပင္ဖက္ျခမ္းကုိ Cursor ျဖင့္ ထိလိုက္ေသာအခါ Center snap အမွတ္ကုိ ေတြ႕ျမင္ရလိမ္႕မည္။ ထုိ

Center snap ကိုေတြ႕ျပီဆုိလွ်င္ Circle ၏ center point သတ္မွတ္ေပးရန္ အတြက္ click လိုက္ပါ။

 6 ဟုရိုက္ထည့္ျပီး Enter ကုိနိွပ္ပါ။ ထုိအခါ Circle သည္ေအာက္ပါ ပုံအတုိင္း ျဖစ္သြားေပလိမ္႕မည္။

၇) တျခားေသာ ေထာင့္ (၃) ေထာင့္အတြက္ Circle command ကုိျပန္ေခၚလိုက္ပါ။ ပထမ Circle ႏွင့္အရြယ္အစား တူ

Circles မ်ားထပ္မံ ေရးဆြဲမည္ ျဖစ္ေသာေၾကာင့္ Center point သတ္မွတ္ေပးျပီးပါက radius တန္ဖိုး ရိုက္ထည့္ရန္ Prompt

ေရာက္ေသာအခါ Enter ႏိွပ္လိုက္ပါက ပထမ Circle ၏အရြယ္အစား အတုိင္းသာ ရရိွလာမည္ ျဖစ္သည္။

၈) Line ေရးဆြဲရန္ -

 Home tab, Draw panel > Line ကုိ click လုိက္ပါ။

 SHIFT+right-click ႏိွပ္ျပီး shortcut menu မွ Quadrant ကို click လိုက္ပါ။

 ဘယ္ဖက္တြင္ ရိွေသာ Circle ၏ ေအာက္ဖက္ Quadrant ကုိ select လုိက္ပါ။

 SHIFT+right-click ႏိွပ္ျပီး shortcut menu မွ Perpendicular ကို click လုိက္ပါ။
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 ပုံ၏ Vertical line ကုိ select လုပ္လုိက္ပါ။ Line command ကုိ exit ရန္အတြက္ Enter ႏိွပ္လုိက္ပါ။

၉) ဘယ္ဖက္ျခမ္းတြင္ လုပ္ခ႕ဲေသာ နည္းအတိုင္း ညာဖက္အျခမ္းမွ အပိုင္းကုိ ကုိယ္တုိင္ စမ္းသပ္ ေလ့က်င့္ၾကည့္ပါ။

၁၀) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Using Polar Tracking and PolarSnap

ဤသင္ခန္းစာတြင္ Geomentry တစ္ခုမွ Polar tracking န႕ဲ PolarSnap အသုံးျပဳ၍ အျခား geomentry မ်ားကို

တိက်မွန္ကန္ေသာ distance နဲ႕ angle မ်ားကုိ အေသးစိတ္ေရးဆြဲျခင္းကုိ ေလ့လာသြားရမည္ ျဖစ္သည္။

Polar tracking န႕ဲ PolarSnap ကိုအျမတဲေစ အသံုးမျပဳပါနွင့္။ သုိ႕ေသာ္ Polar tracking န႕ဲ PolarSnap အသုံးျပဳ ျပီး

Objects မ်ားေရးဆြဲရာ၌ ပိုမိုတိက်မွန္ကန္ေသာ Drawing မ်ားရရိွလာသည္ ကုိေတာ႕ သိထားရန္ လုိအပ္ ေပသည္။
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ေအာက္တြင္ေဖာ္ျပေပးထားေသာ ပုံကိုေလ့လာၾကည့္ပါ။ Geomentry မ်ားကို တိက်မွန္ကန္ေသာ distance န႕ဲ angle

မ်ားျဖင့္ လြယ္ကူလ်င္ျမန္စြာ ေရးဆြဲႏိုင္သည္ကုိ ေတြ႕ရမည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာေလ့က်င့္ျပီးသြားပါက -

 Polar tracking နဲ႕ PolarSnap mode ကုိ ကၽြမ္းက်င္စြာ အသုံးျပဳတတ္သြားေစရန္၊ အက်ိဳးသက္ေရာက္

မွဳ႕ကိုလည္း ေကာင္းစြာသိရိွနားလည္လာေစရန္။

Using Polar Tracking and PolarSnap

Geomentry မ်ားကို တိက်စြာ ေရးဆြဲႏိုင္ႏိုင္ရန္ ၾကိဳးစားရာတြင္၊ degree မ်ားကို တိတိက်က် သိဖို႕ လြန္စြာမွ

အေရးပါလွသည္။ Absolute and relative coordinates ပုံစံျဖင့္ coordinate မ်ား ရိုက္ထည့္ျခင္း သင္ခန္းစာကို

အထက္တြင္ ရွင္းလင္းထားျပီး ျဖစ္သည္။ Polar tracking နဲ႕ PolarSnap တုိ႕ကုိ အသံုးျပဳျပီး geomentry မ်ားေရး ဆြဲျခင္း

နည္းလမ္းသည္ အေရးပါေသာ နည္းလမ္းတစ္ခုျဖစ္ေသာ္လည္း၊ အျမတဲစသံုးစြဲရန္ မသင့္ေတာေပ။

Polar tracking န႕ဲ PolarSnap အသံုးျပဳရန္ အတြက္ Status bar တြင္ ရိွေသာ Porlar Tracking ကုိ ON ထား

ရမည္ျဖစ္သည္။ ေအာက္တြင္ Polar tracking န႕ဲ PolarSnap တို႕ကိုအသံုးျပဳ ျပီးေရးဆြဲထားေသာ ပုံ ႏွစ္ပုံကုိ ေလ့လာ

ၾကည့္ပါ။ ညာဖက္၏ ေနာက္ဆံုး Line ေလးသည္ Relative Polar ကုိအသံုးျပဳျပီး ေရးဆြထဲားျခင္း ျဖစ္ပါသည္။

ဘယ္ဖက္ပုံတြင္ Polar tracking အသံုးျပဳကာ ထုိ line ျဖင့္အျပိဳင္ line တစ္ေၾကာင္း ေရးဆြဲရန္အတြက္ Cursor ကို

Relative Polar တြင္ ရိုက္ထည့္ထားေသာ distance န႕ဲ angle ရေအာင္ drag လုပ္ျပီး click လိုက္ယုံျဖင့္ ညာဖက္ပုံမွ

line န႕ဲအျပိဳင္ line တစ္ေၾကာင္းကို ေရးဆြဲထားျခင္း ျဖစ္သည္။
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Polar tracking နဲ႕ PolarSnap တုိ႕ကို အသံုးျပဳျခင္း အားျဖင့္ ပထမ ဆြဲခဲ႕ေသာ ပုံျဖင့္ ထပ္တူ တူညီေသာ ပုံမ်ားကို

coordinates မ်ားရိုက္ထည့္စရာမလိုပဲ Mouse ကို drag လုပ္ျပီး click လိုက္ယံုျဖင့္ လြယ္ကူလ်င္ျမန္စြာ ေရးဆြဲႏိုင္ပါသည္။

Command Access

Polar

Menu Bar: Tools > Drafting Settings > Polar Tracking tab

Keyboard Shortcut: F10

Status Bar: Polar Tracking; Right-click > Settings

Drafting Settings Dialog Box: Polar Tracking Tab

Drafting Setting Dialog Box တြင္ Polar tracking ကုိ မိမိတို႕စိတ္ၾကဳိက္ ျပဳျပင္ေျပာင္းလဲ မွဳ႕မ်ား လုပ္ႏုိင္ပါသည္။

Polar tracking ကို ON ရန္ select ျခင္း။ F10 ကုိႏိွပ္ ၍လည္း ON နိုင္ပါသည္။

Cursor သည္ Increment angle တြင္မိမိတို႕ Add လုိက္ေသာ angle ေရာက္တိုင္း လက္ရိွေရးဆြဲေနေသာ Objects ၏

အကြာအေ၀းကို Polar tracking tooltip တြင္ေဖာ္ျပေပးလိမ္႕မည္။
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Angle အတြက္ မိမိတုိ႕ စိတ္ၾကိဳက္ angle တန္ဖိုးမ်ား ေရြးခ်ယ္ခ်င္ပါက select လုပ္ရပါမည္။

Angle အတြက္ မိမိတို႕ စိတ္ၾကိဳက္ angle တန္ဖိုးအသစ္မ်ား Add ႏိုင္ပါသည္။

Additional Angles list ထကဲ မိမိတုိ႕ မႏွစ္သက္ေသာ တန္ဖိုးမ်ားကုိ Delete လုပ္ႏိုင္ပါသည္။

မိမိတုိ႕ လက္ရိွေရာက္ေနေသာ coordinates system ကုိ absolute angle ျဖင့္ေဖာ္ျပေစရန္။

မိမိတို႕ လက္ရိွေရာက္ေနေသာ coordinates system ကို relative angle ျဖင့္ေဖာ္ျပေစရန္။

Drafting Settings Dialog Box: Snap and Grid Tab

Drafting Setting Dialog Box ၏ Snap and Grid tab တြင္ Polar tracking အသုံးရာ၌ သင့္ေတာ္သလို snap setting ကို

စိတ္ၾကိဳက္ျပဳျပင္ ႏိုင္ပါသည္။

Cursor ကိုsnap လုပ္ရာတြင္ grid ကြက္အတုိင္း snap ျဖစ္ေတာ႕မည္ မဟုတ္ပဲ၊ မိမိတုိ႕ သတ္မွတ္လုိက္ေသာ

တန္ဖိုးေရာက္တုိင္း snap ျဖစ္ေနမည္။

Cursor ကုိမိမိတုိ႕ စိတ္ၾကိဳက္ အကြာအေ၀းတြင္ snap ျဖစ္ရန္အတြက္ တန္ဖိုးရိုက္ထည့္ရန္ Polar Snap ကုိ select

ေပးရသည္။ အထက္ပါ Snap အတြက္တန္ဖိုး သတ္မွတ္ေပးရာတြင္ Polarsnap ကို select ထားမွ သတ္မွတ္လို႕

ရမည္ျဖစ္သည္။

Procedure: Using Polar Tracking and PolarSnap
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Polar tracking and PolarSnap အသံုးျပဳျပီး geomentry မ်ားေရးဆြျဲခင္းကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး

ထားပါသည္။

၁) Status bar မွ Polar trackingေပၚတြင္ Right – click ႏိွပ္ျပီး setting ကုိ select လိုက္ပါ။ Drafting Setting Dialog

Box မွ Polar tracking tab ကုိ နိွပ္ျပီး Polar tracking ကို ON ႏိုင္သလို increment angle lists ထဲမွ မိမိတုိ႕ စိတ္ၾကိဳက္

angle ကုိေရြးခ်ယ္ သတ္မွတ္ေပးႏိုင္ပါသည္။

၂) ေအာက္ေဖာ္ျပပါ List အတုိင္း PolarSnap increment မ်ားကို ျပင္ဆင္သတ္မွတ္ ႏိုင္ပါသည္။

 Drafting Settings dialog box မွ Snap and Grid tab ကိုနိွပ္ျပီး Snap On (F9) option ကုိ select ပါ။

 Snap Type မွ PolarSnap ကုိ select လုပ္ပါ။

 Polar Spacing မွ Polar distance box ထဲတြင္ အကြာအေ၀းတန္ဖိုး ရိုက္ထည့္ရပါမည္။

 Ok ကို click လုိက္ပါ။
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၃) Lines (သုိ႕မဟုတ္) polylines ကဲ႕သို႕ေသာ geomentry ကို ေရးဆြဲလိုက္ပါ။ Drawing window တြင္ First

point အတြက္ တစ္ေနရာရာတြင္ click လိုက္ပါ။ ေနာက္တစ္မွတ္ သတ္မွတ္ရန္ အတြက္ Cursor ကုိ drag ၾကည့္လိုက္ပါ။

Polar tracking tooltip တြင္ polar distance and angle နွင့္ angle ကိုေဖာ္ျပေပးေနပါလိမ္႕မည္။

 ေနာက္တစ္မွတ္သတ္ရန္ အတြက္ click လုိက္ပါ။

၄) Point မ်ားေရးဆြဲရန္ တိက်ေသာ Polar distance န႕ဲ angle မ်ားရရိွရန္ အတြက္ polar tracking tooltips ကုိအသံုးျပဳ

သြားပါမည္။

Grid and Snap

Grid ကုိON လိုက္သည္နွင့္ Drawing area ၏ background တြင္ အစက္အေျပာက္မ်ား ျဖစ္သြားသည္ကုိ

ေတြ႕ျမင္ရေပလိမ္႕မည္။ Grid ကြက္မ်ားသည္ စေကးညီ ျဖစ္ေနေသာေၾကာင့္၊ coordinates အမွတ္မ်ား သတ္မွတ္ျခင္း မရိွပဲ
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Drawing မ်ားေရးဆြဲရာတြင္ ထုိGrid ကြက္မ်ား၏ အကူအညီျဖင့္ ျမန္ျမန္ဆန္ဆန္ ေရးဆြဲႏိုင္ ပါသည္။ Snap ကိုပါ ON

လိုက္ပါက Cursor ကုိ Drawing area သုိ႕ခ်လုိက္သည္နွင့္ Cursor သည္ Grid အစက္အေျပာက္ မ်ားတြင္သာ ရိွေနမည္ကို

ေတြ႕ရမည္။

ေအာက္တြင္ ေဖာ္ျပထားေသာ Rectangleပုံသည္ Grid န႕ဲ Snap ကုိ ON ျပီးေရးဆြဲထားျခင္းျဖစ္သည္။ Rectangle၏

စမွတ္န႕ဲ ဆံုးမွတ္သည္ Grid အစက္အေျပာက္မ်ား ေပၚတြင္သာ ရိွေနေၾကာင္း ေတြ႕ရမည္။

Status bar တြင္ရိွေသာ Grid န႕ဲ Snap button ကို click လိုက္ယံုျဖင့္ ON ႏိုင္ပါသည္။

Ortho Mode

Polar tracking အသုံးျပဳသက႕ဲသုိ႕ တစ္ျခားေသာ နည္းလမ္းခြဲမွာ Ortho mode ပျဲဖစ္ပါသည္။ Ortho mode ကုိ ON

ထားျပီး Objects မ်ားေရးဆြဲပါက Cursorသည္ X ၀င္ရိုး Y ၀င္ရိုးအတိုင္းသာ ေရြ႕လို႕ရမည္ျဖစ္သည္။ Ortho mode သည္ X

၀န္ရိုး၊ Y ၀င္ရိုး Line ေျဖာင့္မ်ားေရးဆြရဲာတြင္ အလြန္ထိေရာက္လွပါသည္။

ေအာက္ေဖာ္ျပပါပုံသည္ Ortho mode ကုိ ON ထားျပီး ေရးဆြဲထားေသာ ပုံျဖစ္ပါသည္။ ပုံတြင္ ျပထားေသာ Cursor

ကုိၾကည့္ပါ။ Cursor ကုိဘယ္ဖက္သို႕ ေရြ႕လိုက္ေသာ္လည္း Line object သည္လုိက္ပါျခင္း မရိွသည္ကုိ ေတြ႕ရမည္။
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Status bar ေပၚတြင္ ရိွေသာ Ortho ကို Click ျပီး Ortho mode ကုိ ON ႏိုင္ျပီး၊ keyboard မွ F8 key ကုိနိွပ္၍လည္း ON

နိုင္ပါသည္။ Line မ်ားေရးဆြဲစဥ္ SHIFT key ကို ဖိထားရင္းလည္း Ortho mode active ျဖစ္ေနသည္ ကုိေတြ႕ရမည္။

Exercise: Use Polar Tracking and PolarSnap

ဤသင္ခန္းစားတြင္ polar tracking and PolarSnap တို႕ကိုအသံုးျပဳျပီး Line မ်ားကုိေရးဆြဲသြားရပါမည္။ ဤ သင္ခန္းစာကုိ

ေလ့လာေလ့က်င့္ျခင္း ျပီးေျမာက္သြားပါက ေလ့လာသူမ်ား အေနျဖင့္ polar tracking and PolarSnap တို႕ကိုအသံုးျပဳျပီး၊

တိက်ေသာ Geomentry မ်ားကို ဖန္တီးလာႏိုင္မည္ ျဖစ္သည္။

၁) M_Roller.dwg ကုိဖြင့္လိုက္ပါ။

၂) Status bar ေပၚမွ ေအာက္ပါ Setting မ်ားကို ဖြင့္လိုက္ပါ။

 Snap

 Polar tracking
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 Object snap

 Model

 Polar tracking ေပၚ Right–click ျပီး Setting ကုိ click ပါ။

၃) Drafting Settings dialog box မွ Polar tracking tab ကုိႏိွပ္ပါ။

 Increment Angle list မွ 15 ကို select လုပ္လိုက္ပါ။

 Polar Angle Measurement ေအာက္မွ Absolute ကုိ click လုပ္ပါ။

၄) Snap and Grid tab မွ -

 PolarSnap ကို Click ပါ။

 Polar Distance field တြင္ 1 ဟုရိုက္ထည့္လိုက္ပါ။
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၅) Object Snap tab မွ -

 Endpoint and Node ကို select လိုက္ပါ။

 Ok ကို Click လုိက္ပါ။

၆) Polar tracking ကိုအသံုးျပဳျပီး Line ေရးဆြဲရန္ -

 Line command ကုိေခၚလိုက္ပါ။

 Node object snap override ကိုအသံုးျပဳျပီး Line ၏ First point ကုိသတ္မွတ္ေပးလုိက္ပါ။

 Cursor ကို Polar tracking tooltip တြင္ 25.00 < 0 ျပတ႕ဲအထိ ညာဖက္သို႕drag လုပ္လုိက္ပါ။ ျပီးလွ်င္ point

သတ္မွတ္ရန္ click လုိက္ပါ။

၇) Cursor ကို Polar angle tooltip တြင္ 15.00 < 45 ျပတဲ႕အထိ drag လုပ္လိုက္ပါ။ ထုိအကြာအေ၀း ေရာက္ျပီဆိုလွ်င္

Point သတ္မွတ္ရန္ အတြက္ click လုိက္ပါ။

၈) Cursor ကုိ Polar angle tooltip တြင္ 25.00 < 0 ျပတ႕ဲအထိ drag လုပ္ျပီး Click လုိက္ပါ။
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၉) Cursor ကုိ Polar angle tooltip တြင္ 15.00 < 315 ျပတဲ႕အထိ drag လုပ္ျပီး Click လိုက္ပါ။

၁၀) Cursor ကို Polar angle tooltip တြင္ 25.00 < 0 ျပတဲ႕အထိ drag လုပ္ျပီး Click လိုက္ပါ။

၁၁) Cursor ကို Polar angle tooltip တြင္ 70.00 < 90 ျပတ႕ဲအထိ အေပၚသို႕ drag လုပ္ျပီး Click လုိက္ပါ။

၁၂) ပုံ၏ အေပၚတစ္၀က္ အထက္တြင္ သတ္မွတ္ခ႕ဲေသာ Polar angle မ်ားကို ေျပာင္း၍ ပုံတူ ေရးဆြလုိဲက္ပါ။

ေရးဆြျဲပီးသြားပါက ေနာက္ဆုံး Endpoint အျဖစ္ Start point ေနရာတြင္ ျပန္ေရာက္ေအာင္ ေရးဆြဲလိုက္ပါ။ျပီးလွ်င္ line

command ကို exit ရန္ Enter ႏိွပ္လုိက္ပါ။
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၁၃) Line command ကို ျပန္ေခၚလိုက္ပါ။ ေအာက္တြင္ ျမွားနီျဖင့္ ျပထားေသာ အမွတ္မ်ားတြင္ Line မ်ားေရးဆြဲ လိုက္ပါ။

Line command ကုိ exit ေပးရန္ အတြက္ Enter ကုိနိွပ္လိုက္ပါ။

၁၄) Files အားလုံးကို မ Save ပဲ ပိတ္လုိက္ပါ။

Lesson: Using Object Snap Tracking

ဤသင္ခန္းစာတြင္ object snap tracking အသုံးျပဳျပီး Geomentry မ်ားေရးဆြဲရာတြင္ Geomentry မ်ားသုိ႕

အေထာက္အကူျပဳပုံကို ေလ့လာသြားရမည္ ျဖစ္သည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံကုိေလ့လာၾကည့္ပါ။ Object

snap tracking အသံုးျပဳလိုက္ျခင္းအားျဖင့္ Rectangle ၏ Center point ကိုလ်င္လ်င္ျမန္ျမန္ သိရိွႏိုင္သည္ကုိ

ေတြ႕ရေပမည္။
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About Object Snap Tracking

ေရးဆြျဲပီးသား Geomentry အတြင္းမွာပဲ ႏႈိင္းယွဥ္ရမ႕ဲ geomentry မ်ားေရးဆြျဲခင္းကုိ ေလ့လာသူမ်ား အေနျဖင့္ မၾကာခဏ

ၾကံဳေတြ႕ရမည္ျဖစ္သည္။ ထိုအေနအထားရိွေသာ geomentry မ်ားေရးဆြဲရာတြင္ Object snap tracking အသုံးျပဳျပီး

ေရးဆြျဲခင္းသည္ တိက်လ်င္ျမန္စြာ ေရးဆြႏိုဲင္မည္ကို ေတြ႕ရမည္။

Object snap tracking ကုိအသုံးျပဳ၍ စားပြဲကို အခန္း၏ အလယ္သုိ႕ ေရြ႕ထားေသာ ေအာက္ပါ ပုံတြင္ ေလ့လာ ၾကည့္ပါ။

စားပြဲကို အခန္း၏ အလယ္သုိ႕ ေရာက္ရန္အတြက္၊ ဘယ္ဖက္ နံရံ၏ Midpoint (1)၊ ေအာက္ဘက္တြင္ ရိွေသာ နံရံ၏

Midpoint (2) တြင္ရိွေနရန္ လိုအပ္ေပသည္။ စားပြဲ၏ အနီးတြင္ ခန္႕မွန္း ျဖတ္မွတ္ (3) ေနရာကိုပါ ေဖာ္ျပေပးထားသည္။

Dynamic Input interface တြင္ ဘယ္ဖက္မွ Midpoint အတြက္ 0 ဒီဂရီဟု ျပသေပးမည္ ျဖစ္ျပီး၊ ေအာက္နံရံ၏ Midpoint

အတြက္90 ဒီဂရီဟု ေဖာ္ျပေပးထားသည္ကုိ ေတြ႕ျမင္ရမည္ ျဖစ္သည္။
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Circle မဟုတ္ပဲ rectangle (သုိ႕မဟုတ္) polygon Objects မ်ား၏ Center point ကုိသိရိွလိုလွ်င္ Object snap tracking

ကုိအသံုးျပဳျခင္းျဖင့္ သိရိွႏိုင္မည္ ျဖစ္သည္။

Using Object Snap Tracking

Object snap tracking အသုံးျပဳရန္ အတြက္၊ drawing ထတဲြင္ running object snaps အသုံးျပဳျပီး geomentry မွ

acquire point ရိွရန္လိုအပ္ေပသည္။ Geomentry ေပၚမွ acquire point ဆုိသည္မွာ Point မ်ားေပၚတြင္ (+) ပုံသဏၭာန္

ေပၚလာျခင္းျဖစ္သည္။ ထုိကဲ႕သို႕ အမွတ္မ်ားေပၚတြင္ (+) ပုံသဏၭာန္ ကုိေတြ႕ရျပီဆုိလွ်င္ Object snap

tracking ကိုစတင္အသုံးႏိုင္ပါသည္။ ေအာက္ေဖာ္ျပပါပုံ၏ ဘယ္ဖက္ Midpoint သည္ Acquired ျပီးေသာ Point

ျဖစ္ပါသည္။ Cursor ကို Point ျဖင့္ထိလိုက္ရုံျဖင့္၊ Acquired ျဖစ္သြားမည္ကုိ ေတြ႕ရမည္ျဖစ္သည္။ ေအာက္ပါပုံ၏ ေအာက္

Midpoint ကုိ acquire လုပ္ရန္ Cursor ျဖင့္ထိေနသည္ကုိ ေတြ႕ရမည္။

Command Access
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Object snap tracking

Drafting Settings Dialog Box

Object snap tracking ကုိ ဖြင့္ရန္ အတြက္ Status bar ေပၚမွ Object snap tracking ကုိ clikck ပါ (သုိ႕မဟုတ္) Drafting

Settings Dialog Box မွ Object Snap tab တြင္ျဖစ္ေစ (သုိ႕မဟုတ္) F11 ႏိွပ္၍ျဖစ္ေစ နည္းအမ်ိဳးမ်ိဳးျဖင့္ ဖြင့္ႏိုင္ပါသည္။

Object snap နွင့္ Object snap tracking ႏွစ္ခုလံုးကုိ Selected ထားရပါမည္။

Polar Tracking tab တြင္ track Orthogonally Only (အရိုးရွင္း နည္းလမ္း) (သို႕မဟုတ္) Track using all polar angle

settings စသည္တို႕မွ တစ္ခုခုကုိ ေရြးခ်ယ္အသံုးျပဳ ႏိုင္ပါသည္။

Alignment paths သည္ ေရျပင္ညီနွင့္ ေထာင္လုိက္ မ်ားကိုသာ ျပေပးမည္ ျဖစ္သည္။

Alignment paths သည္ polar angles မ်ားအားလံုးကို ျပေပးမည္ ျဖစ္သည္။

Procedure: Using Object Snap Tracking

Object snap tracking ကိုအသံုးျပဳရန္ အတြက္ acquire point လုပ္နည္းကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပ

ေပးထားပါသည္။

၁) Status bar မွ Object snap နွင့္ Object snap tracking ကို ဖြင့္လိုက္ပါ။
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၂) Select point ဆုိေသာ Prompt ရရန္အတြက္ command line တြင္ Object တစ္ခုခု၏ command ကုိရိုက္ထည့္

လိုက္ပါ။

၃) Object snap tracking အသုံးျပဳျပီး Point သတ္မွတ္ေပးရန္ Curosor ျဖင့္ Point ကိုထိလိုက္ပါ။ ထိုသုိ႕ ထိလိုက္စဥ္

(+)သဏၭာန္္ေလး ေပၚလာလွ်င္ ထို point သည္ acquired ျဖစ္သြားျပီ ျဖစ္သည္။

၄) ထုိ ပုံတြင္းရိွ အျခားေသာ Point တစ္ခုကိုလည္း ထုိနည္းအတုိင္း acquire လုပ္လိုက္ပါ။

၅) အကယ္၍ Point ကုိ ႏွစ္ခုထက္ ပိုျပီး acquire လုပ္လုိပါက ထိုနည္းတိုင္း ဆက္လက္ လုပ္သြားႏိုင္ပါသည္။

၆) Point ႏွစ္ခု acquiredျဖစ္သြားခ်ိန္တြင္ cursor ကုိ Center သို႕ေရြ႕လိုက္ပါက dotted lines ႏွစ္ခု ျဖတ္သြားသည့္

ေနရာတစ္ခုကုိ ေတြ႕ရမည္။ ထိုေနရာသည္ Rectangle ၏ Center point ျဖစ္ပါသည္။ Point တစ္ခုခ်င္းကို Cursor

ျဖစ္ေထာက္ၾကည့္ပါ orthogonal (သို႕မဟုတ္) polar angle settings ေပၚမွာ မူတည္ျပီးေတာ႕ dotted lines

မ်ားေဖာ္ျပေပးမည္ကုိ ေတြ႕ရမည္။
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၇) Point သတ္မွတ္ရန္အတြက္ ထို dotted lines မ်ားျဖတ္ေနသည့္ Center point ကုိ select လုိက္ပါ။

Practice Exercise: Object Snap Tracking

Object snap tracking orthogonally အသံုးျပဳျပီးေတာ႕ လက္ေတြ႕ေလ့က်င့္ရန္ -

၁) New Drawing ေလးစဖြင့္လိုက္ပါ။

၂) Object Snap နဲ႕ Object SnapTracking နွစ္ခုလုံးကို Status bar ေပၚတြင္ click ျပီးဖြင့္လိုက္ပါ။

 Object Snap ကို Right – click ႏိွပ္ျပီး Midpoint ကုိ select ထားပါ။

၃) မိမိတို႕ ႏွစ္သက္ေသာ အရြယ္အစား တစ္ခုရိွတ႕ဲ Rectangle ကုိေရးဆြဲရန္ -

 Home tab, Draw panel >Rectangle ကို click ျပီး Rectangle command ကုိေခၚလုိက္ပါ။

 First point အျဖစ္တစ္ေနရာရာကုိ click ျပီး၊ ဆန္႕က်င့္ဘက္ corner တြင္ Second point အတြက္ click လုိက္ပါ။

၄) Rectangle ၏ center တြင္ သင့္ေတာ္ေသာ အရြယ္အစား တစ္ခုရိွသည့္ Circle ကုိေရးဆြဲရန္ -

 Home tab, Draw panel > Circle ကုိ click ျပီး Circle command ကိုေခၚလိုက္ပါ။

 Rectangle ၏ line တစ္ခုတြင္ရိွေသာ Midpoint တစ္ခုခုတြင္ (+)သဏၭာန္ မေပၚမခ်င္း curosor ကို drag လုပ္ပါ။

 နီးစပ္ေထာင့္မွ line ၏ Midpoint တစ္ခုခုတြင္ (+)သဏၭာန္ မေပၚမခ်င္း curosor ကို drag လုပ္ပါ။

 ျပီးလွ်င္ Cursor ကုိ Rectangle ၏အလယ္သို႕ drag လုပ္လိုက္ပါ။

 Horizontal နဲ႕ polar angles တုိ႕တြင္ ေပၚေနေသာ dotted lines ႏွစ္ခု ျဖတ္သည့္ေနရာကုိ click လိုက္ပါ။
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 Circle အတြက္ radius တစ္ခုခုကုိ drawing window မွာပဲ ျဖစ္ေစ၊ command line မွျဖစ္ေစ သတ္မွတ္ေပး

လိုက္ပါ။

၅) File အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။

Exercise: Use Object Snap Tracking

ဤေလ့က်င့္ခန္းသည္ Object snap tracking ကုိအသုံးျပဳ၍ ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံ၏ ေဘးတုိက္ ျမင္ကြင္းကို

ေရးဆြေဲလ့က်င့္သြားရမည္ ျဖစ္သည္။ ဤသင္ခန္းစာကုိ ျပီးဆံုးေအာင္ ေလ့လာေလ့က်င့္ ျပီးသြားပါက

ေလ့လာသူမ်ားအေနျဖင့္ Drawings မ်ားတြင္ Object snap tracking အသံုးျပဳပုံကုိ ေကာင္းစြာသိရိွ နားလည္

လာလိမ္႕မည္။

၁) M_Object-Tracking.dwg ကုိဖြင့္လိုက္ပါ။

၂) Status bar ေပၚမွ ေအာက္ပါ Settings မ်ားကိုဖြင့္လုိက္ပါ။

 Polar tracking

 Object snap

 Object snap tracking

 Dynamic input

၃) Object snap tracking ေပၚတြင္ Right – click ႏိွပ္ျပီး setting ကုိ click လိုက္ပါ။

၄) Drafting Settings dialog box မွ running object snaps မ်ားကို ေအာက္တြင္ျပထားေသာ ပုံမ်ားအတုိင္း

select လုိက္ပါ။ Ok ကို click လုိက္ပါ။
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၅) Rectangle ေရးဆြရဲန္ အတြက္ -

 Home tab, Draw panel >Rectangle ကုိ click လိုက္ပါ။

 လက္ရိွ Drawing area တြင္ ရိွေနေသာ ပုံ၏ညာဖက္ ေအာက္ေထာင့္ အမွတ္ကုိ acquire ေပးလုိက္ပါ။ Acquired

point ေပးျပီးလွ်င္ mouse ကုိ extension path ျဖင့္ ညာဖက္သို႕ drag လိုက္ပါ။

 Dynamic Input field မွ 40 ကုိရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။

 ျပီးလွ်င္ Cursor ကုိအေပၚသုိ႕ drag လိုက္ျပီး ညာဖက္သုိ႕ ထပ္မံ၍ drag လိုက္ပါ။

 31.75, 69.85 ကုိရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။

၆) Rectangle command ကိုျပန္ေခၚရန္ -

 Drawing window ေပၚတြင္ right – click ႏိွပ္ျပီး Repeat RECTANG ကုိ click လိုက္ပါ။

 အထက္တြင္ ေရးဆြဲထားေသာ Rectangle ၏ညာဖက္ေအာက္ေထာင့္ကုိ Start point အျဖစ္ သတ္မွတ္ရန္ select

လိုက္ပါ။
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 17.53, 25.4 ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။

၇) Line ေရးဆြဲရန္ -

 Home tab, Draw panel > Line ကို click ပါ။

 ပထမ ေရးဆြဲထားေသာ Rectangle ၏ညာဖက္ထိပ္ေထာင့္ကို select လိုက္ပါ။

 Cursor ကုိညာဖက္သို႕ 0 ဒီဂရီအတိုင္း ေရြ႕လိုက္ပါ။ 90.55 ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။

၈) ဒုတိယေရးဆြဲ ထားေသာ Rectangle ၏ညာဖက္ေအာက္ေထာင့္ အမွတ္ကုိ acquire point လုပ္ရန္ အတြက္ Cursor

ျဖင့္ထိလုိက္ပါ။ ျပီးလွ်င္ Cursor ကုိ ဆြဲထားေသာ line ေအာက္နားသုိ႕ 90 ဒီဂရီ ျပသည္အထိ ေရြ႕လုိက္ပါ။ 90 ဒီဂရီ

ျပျပီဆိုလွ်င္ Point သတ္မွတ္ရန္ အတြက္ click လိုက္ပါ။

၉) Cursor ကုိ ဘယ္ဖက္သို႕ ေရြ႕ျပီး၊ 46.1 ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။
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၁၀) Arc ႏွင့္ angled line တုိ႕ဆံုသည့္ အမွတ္ (1) ကုိ acquire point လုပ္လိုက္ပါ။ ျပီးေနာက္ Cursor ကိုလက္ရိွ

ေရးဆြထဲားေသာ tracking line (2) သို႕ျပန္ေရြ႕လုိက္ပါ။ Alignment paths တို႕၏ ဆံုမွတ္ကို select လိုက္ပါ။

၁၁) ဒုတိယေရးဆြဲထားေသာ rectangle ၊ ထိပ္ line ၏ Midpoint ကုိ acquire လုပ္ပါ။ Tracking lines ႏွစ္ခု ျဖတ္မွတ္

ေတြ႕သည္အထိ Cursor ကို drag လုပ္ပါ။ ျဖတ္မွတ္ေတြ႕လွ်င္ ထုိျဖတ္မွတ္ေနရာ၌ click လုိက္ပါ။

Lesson: Working with Units

ဤသင္ခန္းစာတြင္ Drawing မ်ားအတြက္ Units မ်ားကုိ မည္သို႕ျပင္ဆင္ သတ္မွတ္သည္ကုိ ေလ့လာသြားရမည္

ျဖစ္ပါသည္။ Drawing တစ္ခုကို ေရးဆြဲေတာ႕မည္ဆုိလွ်င္ ပထမဆံုးအေနန႕ဲ လက္ရိွအသုံးျပဳေနေသာ Units ကုိျပင္ဆင္

သတ္မွတ္ေပးရမည္ ျဖစ္သည္။ Dynamic input interface တြင္ လက္ရိွအသုံးျပဳေနေသာ Unitsကုိ ေဖာ္ ျပေပးထားမည္ကုိ

ေအာက္ပါပုံတြင္ ေလ့လာၾကည့္ပါ။
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About Units

Drawing area တြင္းတြင္ မိမိတုိ႕ ေရးဆြဲထားေသာ geomentry ၏ Units ကုိသိခ်င္လွ်င္ ထုိ geomentry အားလံုးတြင္

စတင္ေရးဆဲြခ႕ဲေသာ Baseline ၏ Unit ကုိၾကည့္ရႈ႕လုိက္ယုံျဖင့္ မိမိတို႕ ေရးဆြဲထားေသာ geomentry အားလုံး၏ Units

ကုိသိရိွႏိုင္မည္ ျဖစ္သည္။

Drawings မ်ားေရးဆြရဲန္ blank drawing ကုိစတင္ဖြင့္လုိက္သည္နွင့္ default unit သည္ decimal system ျဖစ္ပါသည္။

အဘယ့္ေၾကာင့္ဆိုေသာ္ Software သည္ inches နဲ႕ millimeters ကုိခြဲျခားႏိုင္ျခင္း မရိွေပ။ အကယ္၍ Users မ်ားအေနျဖင့္

1 ဟုရိုက္ထည့္လိုက္ပါက ထုိရိုက္ထည့္လိုက္ေသာ 1 သည္ 1inch (သုိ႕မဟုတ္) 1mm ျဖင့္ တူညီသည္ဟု ယူဆသြားမည္

ျဖစ္သည္။

Software သည္ မွန္ကန္ေသာ Unit-base system ၌ ရိွမေနလွ်င္၊ 1inch (သို႕မဟုတ္) 1mm တုိ႕အၾကားက

ကြာျခားခ်က္ကုိ နားလည္ေတာ႕မည္ မဟုတ္ေပ။ ထိုအခါ Imperial Architectural units (ဥပမာ1’-6") က႕ဲသုိ႕ေသာ

setting အေပၚမွာ သြားသက္ေရာက္ေနမည္ ျဖစ္သည္။

Unit Guidelines

ေလ့လာရန္ လုိအပ္ျပီး၊ Users မ်ားအေနနဲ႕ မျဖစ္မေန သိသင့္ေသာ Unit guidelines တစ္ခ်ိဳ႕မွာ -

 Software ၏ default unit သည္ decimal system ျဖစ္ပါသည္။

 Unit တစ္ခု၏ 1 သည္ 1 inch (သို႕မဟုတ္) 1 millimeter ျဖင့္တူညီေနပါသည္။
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 အကယ္၍ မိမိတုိ႕ အေနျဖင့္ အကြာအေ၀း အတြက္ imperial architectural units ကုိထည့္သြင္း လိုလွ်င္၊

architectural drawing units ကုိေရြးခ်ယ္ေပးရပါမည္။ Decimal system ျဖင့္ဆိုလွ်င္ software သည္ မိမိတုိ႕

ရိုက္ထည့္လုိက္ေသာ architectural units ပုံစံျဖစ္ေသာ 1’-6” ကိုနားလည္မည္ မဟုတ္ေပ။

 Architectural units ကိုအသံုးျပဳေသာ အခ်ိန္တြင္ မိမိတုိ႕ အေနျဖင့္ 16' -2" ဟုရိုက္ထည့္ ေပးရမည္ ျဖစ္သည္။

 အကယ္၍ မိမိတို႕ အေနျဖင့္ metric units ကုိအသံုးျပဳမည္ ဆိုလွ်င္၊ default units ျဖစ္ေသာ decimal setting

ကုိသာ အသံုးျပဳသင့္ပါသည္။

 AutoCAD တြင္ ဒသမ ၁၄ ေနရာ(1.00000000000000)သည္ တိက်ေသာ ဒသမ ကိန္းျဖစ္ပါသည္။

Units Example

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ Units ယူဆပုံကုိ ေလ့လာၾကည့္ပါ။ အဆုိပါ ပုံတြင္ Line ကို 18 units ျဖင့္

ေရးဆြထဲားျခင္း ျဖစ္ပါသည္။ Metric and imperial dimension style နွစ္မ်ိဳးလံုးျဖင့္ ထုိ line ကုိ တိုင္းတာၾကည့္ လိုက္လွ်င္

length မ်ားကုိ ကြဲျပားျခားနားစြာ ေဖာ္ျပေပးမည္ကို ေတြ႕ရမည္။ Dimensions တြင္ Length ကို ထုိကဲ႕သို႕ Units ခြဲပါ

ေဖာ္ျပရျခင္းမွာ default dimension styles တြင္ alternate units ကုိ display ရန္ select ထားေသာေၾကာင့္ ျဖစ္သည္။

ထုိ႕သုိ႕ Units ခြဲကုိ ေဖာ္ျပေပးရေတာ႕မည္ ျဖစ္ေသာေၾကာင့္ default units ကို ဆခြဲကိန္း ခြဲျပီး၊ Units ခဲြအျဖစ္ ေဖာ္ျပ

လိုက္ေသာေၾကာင့္ ျဖစ္သည္။

Setting Units

Units command ကိုအသုံးျပဳ၍ drawing setting မ်ားအတြက္ unit setting ကို ျပင္ဆင္သတ္မွတ္ ႏိုင္ပါသည္။ မိမိတုိ႕

ေရးဆြမဲည့္ drawings မ်ားအတြက္ units မ်ားကုိ အခ်ိန္မေရြး ျပင္ဆင္ေျပာင္းလဲ သတ္မွတ္ႏိုင္ပါသည္။ သုိ႕ေသာ္ ထုိ႕သုိ႕

ေျပာင္းလဲ သတ္မွတ္မည္ဆုိလွ်င္ drawing မစတင္မီ အခ်ိန္တြင္သာ ေျပာင္းလဲရမည္ ျဖစ္ပါသည္။ Drawing unit ကို

ေျမတုိင္း Unit အျဖစ္ angle input တြင္ လက္ခံေျပာင္းလဲ ထားေသာ ေအာက္ပါ ပုံကို ေလ့လာၾကည့္ပါ။

Command Access
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Units

Command Line: UNITS

Application menu: Drawing Utilities > Units

Drawing Units Dialog Box

Units command ကိုစတင္လိုက္သည္နွင့္ Drawing Units Dialog Box ေပၚလာသည္ကုိ ေတြ႕ရမည္။ Length, angle န႕ဲ

insertion scale တုိ႕ကို မိမိတို႕ စိတ္ၾကိဳက္ သင့္ေတာ္သလို ျပင္ဆင္သတ္မွတ္ ႏိုင္ပါသည္။

Procedure: Setting Drawing Units

Drawing units ၏ settings မ်ားကို ေအာက္တြင္ ျခံဳငုံေဖာ္ျပလိုက္ပါသည္။

၁) Command lineတြင္ units ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

၂) Drawing Units dialog box မွ length န႕ဲ angle unit types တို႕တြင္ ေအာက္ပုံတြင္ ေဖာ္ျပထားသည့္ အတုိင္း ျပင္ဆင္

သတ္မွတ္ေပးလိုက္ပါ။
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၃) Ok ႏိွပ္လိုက္ပါ။

၄) Length န႕ဲ angle တန္ဖုိးမ်ားအတြက္ မိမိတုိ႕ ျပင္ဆင္သတ္မွတ္ခ႕ဲေသာ Units မ်ားအတိုင္း ရိုက္ထည့္ သြားႏိုင္

ျပီျဖစ္ပါသည္။

Practice Exercise: Setting Units

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ blank drawing တစ္ခုဖြင့္ျပီး၊ Architectural drawing unit ေျပာင္းကာ Rectangle 54' 6"

x 34'2" ကိုေရးဆြဲ သြားရမည္ ျဖစ္သည္။ ေရးဆြဲျပီးသြားလွ်င္ Zoom all ျဖင့္ drawing ကုိ ေလ့လာၾကည့္ရႈ႕ သြားရမည္

ျဖစ္သည္။

၁) New drawing တစ္ခုကုိဖြင့္ လုိက္ပါ။ Template dialog box မွ acad drawing template ကုိ select လိုက္ပါ။

၂) Architectural drawing unit အျဖစ္ ျပင္ဆင္ေျပာင္းလဲရန္ -

 Command line မွ units ဟုရိုက္ျပီး Enter ႏိွပ္ပါ။

 Drawing Units dialog box မွ Length ေအာက္ရိွ type lists အတြင္းမွ Architectural ကုိ select ေပးလုိက္ပါ။

 Exit ရန္အတြက္ Ok ကုိနိွပ္ပါ။
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၃) Rectangle 54' 6" x 34'2" ကုိေရးဆြဲရန္ -

 Home tab, Draw panel >Rectangle ကုိ click ပါ။

 First point ကို သတ္မွတ္ေပးပါ။

 First point ၏ဆန္႕က်င့္ဘက္ corner အတြက္ - @54'6,34'2 ကုရိုိက္ထည့္ပါ။

မွတ္ခ်က္။ ။ inch အတြက္ ကုိယ္စားျပဳ သေကၤတ ရိုက္ထည့္ေပးရန္ မလုိ။

၄) ေရးဆြဲျပီးေသာ Rectangle ကုိ Zoom ျဖင့္ၾကည့္ရန္ -

 Command line တြင္ Z ဟုုရိုက္ျပီး Enter ကုိ ႏိွပ္ပါ။

 Command line တြင္ပင္ Aဟုုရိုက္ျပီး Enter ကုိ ႏိွပ္ပါ။

Exercise: Use Architectural Units

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Architectural units ကုိ အသံုးျပဳ သြားမည္ ျဖစ္သည္။ ျပီးေနာက္ dynamic input

interface ကုိအသံုးျပဳကာ ရိုးရိုးရွင္းရွင္း floor plan ေလးတစ္ခုကို ေရးဆြဲၾကည့္ ေလ့က်င့္သြား ရမည္ ျဖစ္သည္

၁) I_Architectural-Units.dwg ကို ဖြင့္လိုက္ပါ။

၂) Units ျပဳျပင္ေျပာင္းလဲရန္ -
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 Application button > Drawing Utilities > Units ကို click လုိက္ပါ။

 Length ေအာက္ရိွ type lists အတြင္းမွ Architectural ကို select ေပးလုိက္ပါ။

 Length ၏ Precision list မွ 0'-0 1/8" ကုိ select လုိက္ပါ။

 Angle ၏ Precision list မွ 0.0 ကို select လိုက္ပါ။

 Ok ကို click လုိက္ပါ။

၃) Line ေရးဆြဲရန္ -

 Home tab, Draw panel > Line ကို click ပါ။

 10',10' ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Cursor ကုိညာဖက္သို႕ ေရြ႕လိုက္ပါ။

 6'-8 ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္လုိက္ပါ။

 0 ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 Drawing area ထဲ တစ္ေနရာရာကုိ click လိုက္ပါ။

၄) ေနာက္တစ္မွတ္ အတြက္ -

 Cursor ကုိေအာက္သို႕ဆြဲခ်ျပီး၊ ညာဖက္သို႕ ေရြ႕လုိက္ပါ။

 2'4.25 ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။ 45 ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။
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၅) ေနာက္တစ္မွတ္ ဆက္လက္ ေရးဆြဲရန္္ -

 4' ကိုရိုက္ထည့္ျပီး Tab key ႏိွပ္လုိက္ပါ။

 0 ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 Cursor ကုိညာဖက္သို႕ ေရြ႕လိုက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၆) ေနာက္တစ္မွတ္ အတြက္ -

 Cursor ကုိအေပၚဖက္သုိ႕ တင္လုိက္ျပီး ညာဖက္သို႕ ေရြ႕လုိက္ပါ။

 2'4-1/4 ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 45 ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၇) ေနာက္တစ္မွတ္ ဆက္လက္ ေရးဆြဲရန္ အတြက္ -

 Cursor ကုိညာဖက္သို႕ ေရြ႕လိုက္ပါ။

 45'-8"ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 0 ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၈) ေနာက္တစ္မွတ္ အတြက္ -

 Cursor ကုိအေပၚဖက္သုိ႕ ေရြ႕ပါ။
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 42'-8"ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 90 ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၉) ေနာက္တစ္မွတ္ ဆက္လက္ ေရးဆြဲရန္ ္ -

 Cursor ကုိဘယ္ဖက္သုိ႕ ေရြ႕လိုက္ပါ။

 15'-3"ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 180 ကိုရိုက္ထည့္ျပီး Tab key ႏိွပ္လုိက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၁၀) ေနာက္တစ္မွတ္ အတြက္ -

 Cursor ကုိေအာက္သို႕ ေရြ႕လိုက္ပါ။

 6'-2"ကိုရိုက္ထည့္ျပီး Tab key ႏိွပ္လုိက္ပါ။

 90 ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၁၂) ေနာက္တစ္မွတ္ ဆက္လက္ ေရးဆြဲရန္ အတြက္ -

 Cursor ကုိဘယ္ဖက္သုိ႕ ေရြ႕လိုက္ပါ။

 44'-5"ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 180 ကိုရိုက္ထည့္ျပီး Tab key ႏိွပ္လုိက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၁၂) Right- click ႏိွပ္ျပီး close ကုိ click ေပးလုိက္ပါ (သို႕မဟုတ္) End point အျဖစ္ မိမိတုိ႕ စတင္ေရးဆဲြ ခဲ႕ေသာ Start

point ကို click လုိက္ပါ။

၁၃) Files အားလုံးကိုမ Save ပဲပိတ္လိုက္ပါ။

Exercise: Use Surveyor's Units
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ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Angle Input အတြက္ Surveyor's Units ကိုေျပာင္းျပီး၊ Dynamic Input Interface

ကုိအသံုးျပဳျပီး site boundary ေလးတစ္ခု ေလ့က်င့္ေရးဆြဲ သြားရမည္ ျဖစ္သည္။

၁) M_Survey-Units.dwg ကုိဖြင့္လိုက္ပါ။

၂) Units ကိုျပင္ဆင္သတ္ရန္ -

 Application button > Drawing Utilities > Units ကို click လုိက္ပါ။

 Angle type list မွ Surveyor'sUnits ကို select လိုက္ပါ။

 Angle Precision list မွ N0d00'00" E ကုိ select ပါ။

 Ok ကို click ပါ။

၃) Line ေရးဆြဲရန္ -

 Home tab, Draw panel > Line ကုိ click ပါ။

 4000,4000 ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။
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 17497 ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 N85d14' E ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၄) ေနာက္တစ္မွတ္ အတြက္ -

 Cursor ကုိ ပထမ ေရးဆြဲခ႕ဲေသာ အမွတ္၏ အေပၚသို႕တင္ျပီး ညာဖက္ကို ေရြ႕လိုက္ပါ။

 25498 ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 N2d57' E ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္လုိက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

၅) ေနာက္တစ္မွတ္ ဆက္လက္ ေရးဆြဲရန္ အတြက္ -

 Cursor ကုိ ဒုတိယ ေရးဆြဲခ႕ဲေသာ အမွတ္၏ အေပၚသို႕တင္ျပီး ဘယ္ဖက္ကုိ ေရြ႕လုိက္ပါ။

 19000 ကုိရိုက္ထည့္ျပီး Tab key ႏိွပ္လိုက္ပါ။

 N80d40' W ဟုရိုက္ထည့္ျပီး Tab key ႏိွပ္လုိက္ပါ။

 Point သတ္မွတ္ရန္ အတြက္ Drawing area ၏တစ္ေနရာရာကို Click လိုက္ပါ။

 Right- click ႏိွပ္ျပီး close ကုိ click ေပးလိုက္ပါ (သုိ႕မဟုတ္) End point အျဖစ္ မိမိတုိ႕ စတင္ေရးဆဲြ ခ႕ဲေသာ

Start point ကုိ click လိုက္ပါ။

 ေအာက္တြင္ ေဖာ္ျပထားသည့္အတုိင္း site boundary ေလးကိုေရးဆြဲျပီး ျဖစ္ေနမည္။
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၆) Files အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။

Challenge Exercise: Architectural

Metric Units

၁) M_ARCH-Challenge-CHP02.dwg ကို ဖြင့္လုိက္ပါ။

၂) ေအာက္ပုံတြင္ ျပထားသည့္အတိုင္း စမွတ္ကုိ ညာဖက္ေအာက္ေထာင့္မွ စတင္ျပီး floor plan ေလးတစ္ခု ေရးဆြဲၾကည့္ပါ။
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၃) တံခါးေပါက္ အထူကို 55mm ထားျပီး ေရးဆြဲပါ။

၄) File အားလံုးကို Save ျပီးမွ ပိတ္လုိက္ပါ။

Imperial Units

၁) I_ARCH-Challenge-CHP02.dwg ကိုဖြင့္လိုက္ပါ။

၂) ေအာက္ပုံတြင္ ျပထားသည့္အတိုင္း စမွတ္ကုိ ညာဖက္ေအာက္ေထာင့္မွ စတင္ျပီး floor plan ေလးတစ္ခု ေရးဆြဲၾကည့္ပါ။
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၃) တံခါးေပါက္ အထူကို 2” ထားျပီး ေရးဆြဲပါ။

၄) File အားလံုးကို Save ျပီးမွ ပိတ္လုိက္ပါ။

Challenge Exercise: Mechanical
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ဤသင္ခန္းစာတြင္ Chapter 2 ၌ မိမိတို႕ ေလ့လာထားသည္ မ်ားကို အသံုးျပဳျပီး Small mechanical assembly drawing

အတြက္ geomentry ေလးတစ္ခု ေရးဆြဲၾကည့္ပါ။

၁) M_MECH-Challenge-CHP02.dwg ကုိဖြင့္လိုက္ပါ။

၂) Start point ရိွေနေသာ ေနရာကို (Start Point 1) ဟု label တပ္ထားေပးပါသည္။ အေျခခံ drawing

command မ်ားအသံုးျပဳ၍ ေအာက္ပါပုံၾကမ္းမ်ားကုိ ေရးဆြဲၾကည့္ပါ။ Dimensions န႕ဲ Centerlines မ်ားကို သတ္မွတ္

ေပးရန္လိုအပ္ေပ။

မွတ္ခ်က္။ ။ ပုံတြင္တစ္ခ်ိဳ႕ Circle ကုိ diameter တန္ဖိုးျဖင့္ေရးဆြထဲားျပီး၊ တစ္ခ်ိဳ႕ေသာ Circle ကို radius တန္ဖိုးျဖင့္

ေရးဆြထဲားျခင္း ျဖစ္ပါသည္။
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၃) Start point ရိွေနေသာ ေနရာကို (Start Point 2) ဟု label တပ္ထားေပးပါသည္။ အေျခခံ drawing

command မ်ားအသံုးျပဳ၍ ေအာက္ပါပုံၾကမ္းမ်ားကုိ ေရးဆြဲၾကည့္ပါ။ Dimensions န႕ဲ Centerlines မ်ားကို သတ္မွတ္

ေပးရန္လိုအပ္ေပ။

၄) Start Point 1 နဲ႕ Start Point 2 ဟုေရးထားေသာ စာမ်ားကုိ Erase လုပ္လိုက္ပါ။

၅) Files အားလံုးကို Save ျပီးမွ ပိတ္ပါ။

Chapter Summary

ဤchapter ကုိေလ့လာျပီးေျမာက္သြားပါက -

 နဂိုမူလ Coordinate system နွင့္ Dynamic input အသံုးျပဳပုံ၊ Shortcut Menus အေၾကာင္း

သိရိွနားလည္လာမည္။

 Drawings မ်ားတြင္ Geomentry မ်ားကုိ Line, Circle, Arc, Erase, Rectangle, နဲ႕ Polygon commands မ်ား

အသုံးျပဳျပီး Creat ျခင္းႏွင့္ မလုိအပ္ေသာ Objects မ်ားကို Erase လုပ္တတ္လာမည္။

 Object snaps အသုံးျပဳကာ Drawings မ်ားတြင္ Objects မ်ားကုိ လိုအပ္သလို တိတိက်က် Create ႏိုင္လာမည္။

 မတူညီေသာ Angles မ်ားျဖင့္ Drawings မ်ားတြင္ Geomentry မ်ားကို Polar Tracking and PolarSnap modes

တုိ႕ျဖင့္ အမွားအယြင္းမရိွပဲ တိတိက်က် Create နိုင္လာမည္ ျဖစ္ပါသည္။
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CHAPTER: 3 Manipulating Objects

Editing commands မ်ားသည္ Design တိုင္းတြင္ ပုံမွန္အသုံးျပဳ သြားရမည့္ commands မ်ားျဖစ္ပါသည္။ Design

ေတြကိုေျပာင္းလဲဖို႕ျဖစ္ေစ၊ ရႈပ္ေထြးလွေသာ Objects မ်ားကို ေရးဆြရဲာတြင္ ျဖစ္ေစ၊ မိမိတုိ႕ ေရးဆြလဲိုက္ျပီးေသာ Objects

မ်ားကို လုိအပ္သလို ျပန္လည္ ျပဳျပင္သြားဖို႕အတြက္ Editing commands မ်ားသည္ မရိွမျဖစ္ လုိအပ္ပါ သည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျပီးစီးသြားပါက -

 Drawing ထမွဲ Objects မ်ားကို နည္းအမ်ိဳးမ်ိဳးျဖင့္ select လာႏိုင္ေစရန္။

 Drawing ထဲမွ Objects မ်ားကုိ object snaps, object tracking နဲ႕ coordinate မ်ားရိုက္ထည့္ျပီး လိုခ်င္ေသာ

ေနရာကုိ အတိအက် ေရြ႕လာႏိုင္ေစရန္။

 လက္ရိွ drawing မွ Copy commands (သို႕မဟုတ္) Grip မ်ားအသုံးျပဳျပီး အျခားေသာ drawings မ်ားကို

ေရးဆြလဲာႏိုင္ေစရန္။
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 Rotate command (သုိ႕မဟုတ္) grips ျဖင့္ drawing ထမွဲ Objects မ်ားကို လိုအပ္သလို ေျပာင္းလဲ

တတ္လာေစရန္။

 Mirror command (သုိ႕မဟုတ္) grips ျဖင့္ drawing ထမွဲ Objects မ်ားကုိ Mirror လုပ္တတ္ လာေစရန္။

 Array command ကိုအသံုးျပဳ၍ drawing မ်ားတြင္ rectangular (သို႕မဟုတ္) circular အပိုင္းခြဲ မ်ားကုိ

ေရးဆြတဲတ္လာေစရန္။

 Drawing မ်ားထဲမွ Objects မ်ား၏ အရြယ္အစားကုိ ေျပာင္းလဲတတ္လာေစရန္။

 ဤ modifying objects ကိုေလ့လာျပီးသြားပါက floor plan မ်ားကို modify လုပ္တတ္လာေစရန္။

 ဤ modifying objects ကိုေလ့လာျပီးသြားပါက Geomentry မ်ားကုိ modify လုပ္တတ္လာ ေစရန္။

Lesson: Selecting Objects in the Drawing

ဤသင္ခန္းစာတြင္ ကြဲျပားျခားနားေသာ နည္းလမ္းအမ်ိဳးမ်ိဳးျဖင့္ Drawings တြင္းမွ Objects မ်ားကို select လုပ္ျခင္း

အပိုင္းကို ေလ့လာသြားရမည္ ျဖစ္သည္။

Objects တစ္ခုကုိ modify နဲ႕ manipulate လုပ္ေတာ႕မည္ဆုိလွ်င္ မိမိတုိ႕ အေနျဖင့္ ထုိ Objects မ်ားကုိ select လုပ္ရမည္

ျဖစ္သည္။ Drawing ထဲမွ ရႈပ္ေထြးမ်ားျပားလွေသာ(ေအာက္တြင္ ျပထားေသာ ပုံက႕ဲသို႕) Objects မ်ားကုိ Select

လုပ္ရာတြင္ မိမိတုိ႕ အေနန႕ဲ Objects မ်ားကုိ ထိထိမိမိ select လုပ္ႏိုင္ရန္အတြက္ ကြဲျပားျခားနားေသာ select

လုပ္နည္းမ်ားကို အသံုးျပဳသြားရမည္ ျဖစ္ပါသည္။

Using a Window to Select Objects

မိမိတုိ႕ select ထားေသာ Object (သို႕မဟုတ္) Group objects မ်ားကုိ selection set ဟုေခၚပါသည္။ မ်ားျပားလွေသာ

Select လုပ္နည္းမ်ားျဖင့္ select လုပ္ျပီး၊ ထုိ select လုပ္ျပီးသား selection set ထမွဲ Objects မ်ားကို မိမိတုိ႕အေနျဖင့္

Modify အမ်ိဳးမ်ိဳး ျပဳလုပ္ႏိုင္ပါသည္။ Selection set အရင္လုပ္ျပီးမွ မိမိတုိ႕ modify လုပ္ခ်င္ေသာ

command မ်ားကိုေခၚျပီးမွလည္း modify လုပ္ႏိုင္ပါသည္။

အကယ္၍ မိမိတုိ႕ အေနျဖင့္ Object တစ္ခုခ်င္းစီကုိသာ select လုပ္ခ်င္လွ်င္ ထိုobject ေပၚတြင္ click လုိက္ယုံျဖင့္

ရိုးရွင္းလြယ္ကူစြာ ျပဳလုပ္ႏိုင္ပါသည္။ Objects မ်ားကို selection လုပ္ရာတြင္ မ်ားျပားလွေသာ နည္းေပါင္းစုံကို

မိမိတုိ႕အေနျဖင့္ တစ္ျပိဳင္နက္တည္း အသုံးျပဳႏုိင္ပါသည္။
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Implied Window Selection

Implied Window Selection ဆိုသည္မွာ မိမိတုိ႕ select လုပ္လိုေသာ Objects မ်ား၏ အနီးတြင္ Selection window

ေလးျပဳလုပ္ေပး Objects မ်ားကို select လုပ္ရေသာ နည္းလမ္းျဖစ္ပါသည္။ မိမိတုိ႕ select လုပ္လိုေသာ Objects အနီး

လြတ္ေနေသာ တစ္ေနရာကို click လုိက္ပါ။ (မွတ္ခ်က္။ ။ထိုသုိ႕ click ရာတြင္ Objects မ်ား၏ အစိတ္အပိုင္းမ်ားကို

မထိေတြ႕ပါေစနွင့္။) ျပီးလွ်င္ လက္ရိွ click လုိက္ေသာ ေနရာႏွင့္ဆန္႕က်င္ ဖက္ corner သို႕ မိမိတုိ႕ select လုပ္လိုေသာ

Objects မ်ားေပၚကုိ ျဖတ္ျပီး Cursor ကို ဘယ္မွညာ ေရြ႕လိုက္ပါ။ Selection Window အတြင္းတြင္ အစိတ္အပိုင္းအားလုံး

ပါ၀င္ေသာ Objects မ်ားကုိ selected ျပီးသား အျဖစ္ ေတြ႕ရမည္ ျဖစ္သည္။

 Object တစ္ခု၏ အစိတ္အပိုင္းအားလုံးသည္ ထိုSelection window ထဲေရာက္သြားခါမွ Object သည္

selected ျဖစ္မည္ ျဖစ္သည္။

 Object ၏ တစ္စိတ္တစ္ပုိင္းသည္ selection window ၏အျပင္ဖက္သို႕ ေရာက္ေနပါက ထုိ object သည္

selected ျဖစ္မည္ မဟုတ္ေပ။

 First point အျဖစ္ ပထမေနရာကုိ click ျပီးပါက ဘယ္မွညာသို႕ ဆန္႕က်င္ဘက္ကို ေရြ႕ရမည္ဆုိေသာ အပိုင္းတြင္၊

အေပၚေထာင့္ (သုိ႕မဟုတ္) ေအာက္ေထာင့္ကို ေရြ႕ရမည္ကုိ ဆုိလုိျခင္း ျဖစ္ပါသည္။

 Selection window သည္ တစ္ေျပးညီမ်ဥ္းမ်ားျဖင့္ ဖြဲ႕စည္းေသာ Rectangle ပုံသ႑န္ ျဖစ္မည္ ျဖစ္မည္ ျဖစ္သည္။

Implied Crossing Selection

Implied Window Selection ကဲ႕သို႕ပင္ Objects မ်ားကို select လုပ္ရပါသည္။ သုိ႕ေသာ္ Objects မ်ားကုိ Selection set

လုပ္ရာတြင္ Implied Window Selection ၏ ဆန္႕က်င္ဘက္ ညာမွဘယ္သို႕ select ရသည္။ (မွတ္ခ်က္။ ။ Selection set

ျပဳလုပ္ရန္ First point အတြက္ Objects မ်ားအနီး တစ္ေနရာရာကုိ click ရာတြင္ Objects မ်ားကို မထိေတြ႕ပါေစနွင့္။)

Implied Window Selection တြင္ Objects မ်ား၏ အစိတ္အပိုင္း အားလုံးကို Select မိမွ selected ျဖစ္မည္

ျဖစ္ေသာ္လည္း၊ ဤ Implied Crossing Selection တြင္မူ Selection Set လုပ္ေသာ Rectangle နွင့္ထိသမွ် Objects

အားလုံးသည္ selected ျဖစ္သြားမည္ ျဖစ္သည္။ Selection set ၏ Rectangle သည္ dotted lines ျဖင့္ ဖြဲ႕စည္းထားေသာ

Rectangle ျဖစ္ေနသည္ကုိ ေတြ႕ရမည္။
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 Selection Set လုပ္ေသာ Rectangle နွင့္ထိသမွ် Objects အားလံုးသည္ selected ျဖစ္သြားမည္ ျဖစ္သည္။

 First point အျဖစ္ ပထမေနရာကုိ click ျပီးပါက ညာမွ ဘယ္ဖက္သို႕ ဆန္႕က်င္ဘက္ကုိ ေရြ႕ရမည္ ဆုိေသာ

အပိုင္းတြင္၊ အေပၚေထာင့္ (သို႕မဟုတ္) ေအာက္ေထာင့္ကုိ ေရြ႕ရမည္ကို ဆိုလိုျခင္း ျဖစ္ပါသည္။

 Selection window သည္ တစ္ေျပးညီမ်ဥ္းမ်ားျဖင့္ ဖြဲ႕စည္းေသာ Rectangle ပုံသ႑န္ ျဖစ္ေသာ္လည္း၊ Implied

Crossing Selection တြင္မူ dotted lines ျဖင့္ ဖြဲ႕စည္းထားေသာ Rectangle ျဖစ္ေနသည္။

Object Selection with Grips

Objects မ်ားကုိ တစ္ခုခ်င္းစီ Editing လုပ္လိုပါက Cursor ျဖင့္ ရိုးရွင္းစြာ ထုိ object ကို click လုိက္ပါက လိုအပ္သလုိ

Editing လုပ္ႏိုင္ပါသည္။

Grips Defined

Grips ျဖင့္ selected ထားျပီးေသာ Objects မ်ားကို color box ေလးမ်ားျဖင့္ ျပထားေပးမည္ျဖစ္သည္။ အကယ္၍ Cursor

ကုိထို color box မ်ားေပၚသုိ႕ တင္လိုက္လွ်င္ ထုိ color box သည္ အေရာင္ေျပာင္းသြား မည္ျဖစ္သည္။ ထုိသို႕ cursor

သည္ ထို color box ေပၚသို႕ တင္လိုက္ယုံျဖင့္ အေရာင္ေျပာင္းသြားေသာ grip ကို Hover grip ဟုေခၚပါသည္။

ထုိ color box ေနရာမ်ားကုိ click လိုက္ပါက ထုိ color box မ်ားသည္ အျခားေသာ အေရာင္သို႕ ထပ္မံျပီး ေျပာင္းလဲ

သြားသည္ကုိ ေတြ႕ရမည္ ျဖစ္သည္။ ထုိအခါ Objects မ်ားကုိ move, mirror, rotate, scale န႕ဲ stretch စသည္ Editing
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command မ်ားကုိ click ျပီး Editing ျပဳလုပ္ႏိုင္ပါသည္။ ေအာက္တြင္ေဖာ္ျပထားေသာ ပုံမ်ားသည္ grips ျပထားေသာ

Objects မ်ား၏ ပုံသ႑ာန္ ျဖစ္ပါသည္။

Unselected grip ျဖစ္ပါသည္။ မူလအေရာင္သည္ အျပာေရာင္ ျဖစ္ပါသည္။

Selected grip ျဖစ္ပါသည္။ မူလအေရာင္သည္ အနီေရာင္ ျဖစ္ပါသည္။

Hover grip ျဖစ္ပါသည္။ မူလအေရာင္သည္ အပန္းေရာင္ ျဖစ္ပါသည္။

Using Hover Grips

Cursor ကို grips ေပၚတြင္ select ျခင္းမျပဳပဲ တင္လိုက္ယုံျဖင့္ အေရာင္ေျပာင္းသြားသည္ကုိ Hover Grips ဟုေခၚပါသည္။

Hover Grips ကုိအသံုးျပဳျခင္း အားျဖင့္ Drawings မ်ားတြင္ ေရးဆြဲထားေသာ Lines, angle နွင့္ circle မ်ား၏ အကြာအေ၀း၊

ေထာင့္တန္ဖိုးမ်ား၊ အခ်င္း၀က္ တန္ဖိုးမ်ားကုိ Dynamic Input မွ တစ္ဆင့္ အလြယ္တကူ သိႏိုင္ပါသည္။ ေအာက္ေဖာ္

ျပပါပုံမ်ားကုိ ေလ့လာၾကည့္ပါ။
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Using Selected grip

Grips မ်ားကို selected ျပီသည္နွင့္ Dynamic Input ပါ Turn ON ျဖစ္လာမည္ျဖစ္ျပီး၊ ထုိ Dynamic Input မွ မိမိတုိ႕

ေျပာင္းလလုိဲေသာ တန္ဖိုးအသစ္မ်ား ရိုက္ထည့္ျပီး၊ ေျပာင္းလသဲြားႏိုင္ပါသည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ

ဘယ္ဖက္ပုံသည္ Grip ကို selected ျပီး Dynamic Input မွတန္ဖိုးအသစ္မ်ား ရိုက္ထည့္ေသာ ပုံျဖစ္ကာ၊ ညာဖက္ပုံသည္

တန္ဖိုးအသစ္ရိုက္ထည့္ လိုက္ေသာေၾကာင့္ ပုံစံေျပာင္းသြားေသာ ပုံျဖစ္ ပါသည္။

Display Grip Editing Options

Selected ျပီးထားေသာ Grips တြင္ right – click ႏိွပ္လိုက္ပါက၊ shortcut menu ေပၚလာမည္ျဖစ္ျပီး၊ ထို shortcut menu

မွ drawing ကို မိမိတို႕ စိတ္ၾကိဳက္ editing လုပ္ႏိုင္ပါသည္။
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Guidelines for Grip Editing

 Command line တြင္ blank ျဖစ္ေနေသာ အခါမ်ိဳးတြင္ Objects မ်ားကို selected ျပီးပါက Grips

ကုိေတြ႕ျမင္ရမည္ ျဖစ္သည္။

 Objects မ်ားကုိအရင္ select ျပီးခါမွ မိမိတုိ႕ အသံုးျပဳလိုေသာ modify command ကုိေခၚျပီး

modify လုပ္ႏိုင္ပါသည္။

 Grips မ်ားကုိ selected ျပီသည္နွင့္ Dynamic Input ပါ Turn ON ျဖစ္လာမည္ျဖစ္ေသာေၾကာင့္၊ မိမိတုိ႕ selected

ထားေသာ length, angle, radius န႕ဲ coordinates စသည္တို႕၏ တန္ဖိုးအသစ္မ်ားကို Dynamic Input

မွရိုက္ထည့္ျပင္ဆင္ ႏိုင္ပါသည္။

 Unselected grip ျဖင့္ right-click ႏိွပ္ျပီး၊ shortcut menu မွ Rotate rotating (သို႕မဟုတ္) scaling

မ်ားကိုလည္း စိတ္ၾကိဳက္ ျပင္ဆင္သတ္မွတ္ ႏိုင္ပါသည္။

Select Objects Options

Command line မွ Select Objects Prompt ေသာအခါတြင္ keyboard မွလည္း ရိုက္ထည့္ျပီး ေရြးခ်ယ္ သတ္မွတ္

နိုင္ပါသည္။ ထုိ Options တြင္ Window Polygon, Crossing Polygon, Fence, All, Last နဲ႕ Previous

တုိ႕ပါ၀င္ေနပါသည္။ ထုိ Options မ်ားမွ စာလံုးအၾကီးျဖင့္ ေရးသားထားေပးေသာ စာလံုးတစ္လံုးတည္းကုိ ရိုက္ထည့္

လိုက္ယံုျဖင့္ Option ကုိေရြးခ်ယ္ အသံုးျပႏိုင္ပါသည္။

Select object options lists ကုိျပသထားျခင္း မရိွေသာေၾကာင့္၊ မိမိတုိ႕အေနျဖင့္ Options မ်ားကို အလြတ္နီးပါး

မွတ္သားထားႏိုင္ပါက တကယ္ကုိ အသံုး၀င္လွပါသည္။ Select object options lists မ်ားကို ၾကည့္ရန္အတြက္ Select
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Objects Prompt ေပၚေသာအခါတြင္ lists တြင္ မပါ၀င္ႏိုင္ေသာ စာလုံးတစ္လံုးကုိ ရိုက္ထည့္ လိုက္ပါက command line

တြင္ Select Objects Options lists ကိုေဖာ္ျပေပးလိမ္႕မည္။ ေအာက္တြင္ ဥပမာ ျပထားေသာ ပုံကုိ ေလ့လာၾကည့္ပါ။

Selecting with a Window Polygon

Rectangle window ျဖင့္ အသံုးမျပဳပဲ Window Polygon အသံုးျပဳလို သူမ်ားအတြက္ ေအာက္တြင္ အဆင့္ဆင့္

ေဖာ္ျပေပးထားေသာ ပုံစံ အတုိင္း လိုက္ပါလုပ္ေဆာင္ ႏိုင္ပါသည္။

 Select Objects Prompt တြင္ wp ( Window Polygon အတြက္) ဟုရိုက္ထည့္လိုက္ပါ။

 Select လုပ္ခ်င္ေသာ objects မ်ားရိွေသာ area ကုိ Select လုပ္ရန္ point မ်ားသတ္မွတ္လိုက္ပါ။

 မိမိတုိ႕ စိတ္ၾကိဳက္ selected ျပီးပါက Polygon selection ျပီးသြားေစရန္ Enter နိွပ္လို္က္ပါ။

Practice Exercise: Windows Polygon Selection

Polygon selection အသံုးျပဳျပီး၊ ေအာက္ေဖာ္ျပ ပုံမွ Rectangle ေလးမ်ားကို Select လုပ္ၾကည့္ရေအာင္။
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၁) Polar Tracking ကုိဖြင့္ျပီး Outer shape ပုံကုိ ေအာက္ပါအစီစဥ္အတိုင္း ေရးဆြဲလိုက္ပါ။ ( သင့္ေတာ္ေသာ

အရြယ္အစားတစ္ခု)

 Line command ကုိ ေခၚလုိက္ပါ။

 ေအာက္တြင္ ျပထားေသာ ဘယ္ဖက္ေထာင့္ (1) ေနရာမွ အစီလုိက္ line ကုိေရးဆြလုိဲက္ပါ။

 (1) ကေန စတင္ေရးဆြဲသြားျပီး၊ (6) သို႕ေရာက္ေသာ အခါ C ဟုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။ (သုိ႕မဟုတ္) (1) ကုိပဲ

End point အျဖစ္သတ္မွတ္ျပီး click လိုက္ပါ။

၂) ထုိ ေရးဆြျဲပီးသြားေသာ Oute shape အတြင္းတြင္ Rectangle မ်ားကုိေရးဆြရဲေအာင္ -

 ပထမဆံုးအေနန႕ဲ Object snap ကုိ turn off လုပ္လိုက္ပါ။

 Rectangle command ကို စတင္လိုက္ပါ။

 First corner ကုိ သတ္မွတ္ေပးျပီး ဆန္႕က်င္ဘက္ corner တြင္ End point သတ္မွတ္လိုက္ပါ။

 Rectangles မ်ားကို ပုံတြင္ ျပထားသည့္ အတုိင္း သင့္ေတာ္သလို ျဖည့္စြက္ျပီး ဆက္လက္ေရးဆြဲ သြားလိုက္ပါ။

၃) Polygon selection ကိုအသံုးျပဳျပီး၊ Rectangle မ်ားကုိ erase လုပ္ၾကည့္ရေအာင္ -

 Object snap ကို turn off ထားျခင္း ရိွ/မရိွေသခ်ာ စစ္ေဆးလိုက္ပါ။ (turn off ထားရမည္)

 Erase command ကိုစတင္လိုက္ပါ။
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 Select Objects Prompt တြင္ wp ဟုရိုက္ထည့္လုိက္ပါ။

 Window Polygon ကို Start point ျဖစ္ေသာ (1) ကေန စတင္ျပီး Rectangle မ်ားအားလံုး ပါႏိုင္ေအာင္ select

ျပီး (1) မွာပဲ End point ျပန္လည္အဆံုးသတ္ ရပါမည္။

 Start point (1) မွာပဲ End point အတြက္ click ျပီးလွ်င္ Enter နိွပ္လုိက္ပါ။ Selected ထားေသာ Objects မ်ားကို

Erase ရန္ Enter ထပ္ႏိွပ္လိုက္ပါ။ ေအာက္ပါ ပုံၾကမ္းကုိ ေလ့လာၾကည့္ပါ။ Window Polygon ျဖင့္ select

လုပ္ရာတြင္ Objects မ်ား၏ အနီးဆုံးေနရာမ်ားတြင္သာ select သြားသည္ကို ေတြ႕ရမည္ ျဖစ္သည္။

မိမိတုိ႕အေနျဖင့္လည္း Window Polygon ျဖင့္ select လုပ္မည္ဆိုလွ်င္ ထုိက႕ဲသို႕ပင္ လိုက္နာလုပ္ေဆာင္

သြားသင့္ပါသည္။

၄) Undo ျပန္လုပ္လုိက္ပါ။ ျပီးလွ်င္ ပုံကုိ Saveျပီး ပိတ္လုိက္ပါ။ အဘယ္႕ေၾကာင့္ ဆုိေသာ္ ထုိပုံျဖင့္ Crossing

 Polygon option ကို လက္ေတြ႕ေလ့က်င့္သြားရအံုးမည္ ျဖစ္သည္။

Selecting with Crossing Polygon

Window Polygon ကုိအသုံးမျပဳပဲ Crossing Polygon ကုိအသံုးျပဳလို သူမ်ားအတြက္ ေအာက္တြင္ အဆင့္ဆင့္

ေဖာ္ျပေပးထားေသာ ပုံစံ အတုိင္း လိုက္ပါလုပ္ေဆာင္ ႏိုင္ပါသည္။

 Select Objects Prompt တြင္ cp (Crossing Polygon အတြက္) ဟုရိုက္ထည့္လိုက္ပါ။

 မိမိတုိ႕ select လုိေသာ Objects မ်ားေပၚသို႕ Crossing Polygon ျဖင့္ cross လိုက္ျပီး Point မ်ား

သတ္မွတ္ေပးလိုက္ပါ။

 Point မ်ားသတ္မွတ္ေပးျပီးပါက Polygo selection area ကုိ ပိတ္ရန္ Enter ႏိွပ္ပါ။ Select ပုံကုိ ေအာက္ပါပုံတြင္

ဥပမာ ေဖာ္ျပေပးထားပါသည္။
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Practice Exercise: Crossing Polygon Selection

Window Polygon ကုိေလ့က်င့္စဥ္က အသုံးျပဳခဲ႕ေသာ drawing ကုိ saved သူမ်ားအေနျဖင့္ ေအာက္တြင္

ေဖာ္ျပေပးထားေသာ အဆင့္ (၃) မွစတင္ႏ္ိုင္ပါသည္။ Crossing Polygon ကုိအသုံးျပဳျပီး ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ

အဆင့္မ်ား အတိုင္း Rectangles မ်ားကုိ Erase လုပ္ျခင္းသင္ခန္းစာကုိ လိုက္ပါေလ့က်င့္ၾကည့္ပါ။

၁) Polar Tracking ကုိဖြင့္ျပီး Outer shape ပုံကုိ ေအာက္ပါအစီစဥ္အတိုင္း ေရးဆြဲလိုက္ပါ။ ( သင့္ေတာ္ေသာ

အရြယ္အစားတစ္ခု)

 Line command ကုိ ေခၚလုိက္ပါ။

 ေအာက္တြင္ ျပထားေသာ ဘယ္ဖက္ေထာင့္ (1) ေနရာမွ အစီလုိက္ line ကုိေရးဆြလုိဲက္ပါ။

 (1)ကေန စတင္ေရးဆြဲသြားျပီး၊ (6) သုိ႕ေရာက္ေသာ အခါ C ဟုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။ (သို႕မဟုတ္) (1) ကုိပဲ

End point အျဖစ္သတ္မွတ္ျပီး click လိုက္ပါ။
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၂) ထုိ ေရးဆြျဲပီးသြားေသာ Oute shape အတြင္းတြင္ Rectangle မ်ားကုိေရးဆြရဲန္ -

 ပထမဆံုးအေနန႕ဲ Object snap ကုိ turn off လုပ္လိုက္ပါ။

 Rectangle command ကို စတင္လိုက္ပါ။

 First corner ကုိ သတ္မွတ္ေပးျပီး ဆန္႕က်င္ဘက္ corner တြင္ End point သတ္မွတ္လိုက္ပါ။

 Rectangles မ်ားကို ပုံတြင္ ျပထားသည့္ အတုိင္း သင့္ေတာ္သလို ျဖည့္စြက္ျပီး ဆက္လက္ေရးဆြဲ သြားလိုက္ပါ။

၃) Crossing Polygon ကုိအသံုးျပဳျပီး၊ Rectangle မ်ားကုိ erase လုပ္ရန္ -

 Object snap ကို turn off ထားျခင္း ရိွ/မရိွေသခ်ာ စစ္ေဆးလိုက္ပါ။ (turn off ထားရမည္)

 Erase command ကိုစတင္လိုက္ပါ။

 Select Objects Prompt တြင္ cp ဟုရိုက္ထည့္လိုက္ပါ။

 Window Polygon ကို Start point ျဖစ္ေသာ (1) ကေန စတင္ျပီး Rectangle မ်ားအားလံုး ပါႏိုင္ေအာင္ select

ျပီး (1) မွာပဲ End point ျပန္လည္အဆံုးသတ္ ရပါမည္။

 Start point (1) မွာပဲ End point အတြက္ click ျပီးလွ်င္ Enter နိွပ္လုိက္ပါ။ Selected ထားေသာ Objects မ်ားကို

Erase ရန္ Enter ထပ္ႏိွပ္လိုက္ပါ။

မွတ္ခ်က္။ ။ Rectangle သည္ Polyline (တဆက္တည္းမ်ဥ္း) ျဖစ္ေသာေၾကာင့္ Rectangle ၏ အစိတ္အပိုင္း တစ္ခုကို

Crossing Polygon ထိယံုျဖင့္ Rectangle တစ္ခုလုံးကို selected ျဖစ္သြားမည္ ျဖစ္သည္။
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၄) Undo ျပန္လုပ္လုိက္ပါ။ ျပီးလွ်င္ ပုံကို Saveျပီး ပိတ္လိုက္ပါ။ အဘယ္႕ေၾကာင့္ ဆိုေသာ္ ထုိပုံျဖင့္ Crossing Polygon

window ကို ေနာက္တစ္ခန္းတြင္ လက္ေတြ႕ေလ့က်င့္သြားရအုံးမည္ ျဖစ္သည္။

Selecting with a Fence

Objects မ်ားကုိ Fence ျဖင့္ selection လုပ္ရန္အတြက္ objects အနီးတြင္ Start point ေပးျပီး ေပၚလာေသာ dotted

line ျဖင့္ မိမိတုိ႕ select လုပ္ခ်င္ေသာ Objects မ်ားေပၚသုိ႕ ျဖတ္ဆြလဲိုက္ပါ။ ထိုသုိ႕ dotted line ျဖတ္သြား ျခင္းခံရေသာ

Objects မ်ားသည္ selected ျပီးသား ျဖစ္သြားပါလိမ္႕မည္။

Fence ျဖင့္ select လုပ္ရန္ အတြက္ -

 Select Objects prompt ဟုျပထားေသာ command line တြင္ f ဟုရိုက္ျပီး Enter ႏိွပ္ပါ။

 Objects အနီးတြင္ Start point ေပးျပီး ေပၚလာေသာ dotted line ျဖင့္ မိမိတုိ႕ select လုပ္ခ်င္ေသာ

Objects မ်ားေပၚသုိ႕ ျဖတ္ဆြဲလိုက္ပါ။

 Selection fence command ျပီးဆံုးေစရန္ အတြက္ Enter ႏိွပ္လုိက္ပါ။

Practice Exercise: Fence Selection

Fence selection option ကုိလက္ေတြ႕ေလ့က်င့္သြား ရမည္ျဖစ္ပါသည္။ ပထမဆံုး အေနန႕ဲ ေအာက္တြင္ ေဖာ္ျပ

ေပးထားသည့္ အတိုင္း Line ႏွင့္ Circle တစ္ခ်ိဳ႕ကို ေရးဆြဲလိုက္ပါ။ ျပီးလွ်င္ Line မ်ားကုိ Fence selection option ျဖင့္

Erase လုပ္သြားရမည္ ျဖစ္သည္။

၁) Line ႏွင့္ Circle တစ္ခ်ိဳ႕ကို ေရးဆြရဲန္ (သင့္ေတာ္ေသာ အရြယ္အစား တစ္ခုခု) –
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 Line command ကုိေခၚျပီး Lines မ်ားကုိ ပုံတြင္ ျပထားသည့္ အတုိင္းေရးဆြဲလိုက္ပါ။

 ျပီးလွ်င္ Lines မ်ား၏ Intersection point မ်ားတြင္ Circles မ်ားကုိ ေရးဆြဲလိုက္ပါ။

၂) Fence selection option ကိုအသံုးျပဳျပီး Lines မ်ားကုိ Erase လုပ္ရန္ -

 Erase command ကိုစတင္လိုက္ပါ။

 Select Objects prompt ဟုျပထားေသာ command line တြင္ f ဟုရိုက္ျပီး Enter ႏိွပ္ပါ။

 Fence အတြက္ First point ကုိ (1) ေနရာတြင္ click ေပးလိုက္ပါ။

 Fence အတြက္ Second point ကုိ (2) ေနရာတြင္ click ေပးလိုက္ပါ။

 Fence အတြက္ Third point ကို (3) ေနရာတြင္ click ေပးလိုက္ျပီး၊ Enter ႏိွပ္လိုက္ပါ။

 Erase command ကို exit ရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။

Selecting with the All Option

Command line တြင္ Select Objects prompt ဟုျပေနေသာ အခ်ိန္တြင္ all ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ ျခင္းျဖင့္

Drawing area ထမွဲ Objects မ်ားကုိ selected ျပီးသား ျဖစ္သြားပါလိမ္႕မည္။ Erase all ကုိအသုံးျပဳ ရာတြင္ drawing area

မွ objects အားလုံးကိုသာမက layer ကုိ turned off, thawed (သုိ႕မဟုတ္) unlocked ေပးထားေသာ Objects

မ်ားအတြက္ပါ အက်ိဳးသက္ ေရာက္မွဳ႕ ရိွေၾကာင္းကုိ အထူးသတိျပဳရပါမည္။

All option ကုိအသုံးျပဳပုံ -

 Command line တြင္ Select Objects prompt ဟုျပေနေသာ အခ်ိန္တြင္ all ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Drawing area မွ objects အားလုံးကုိသာမက layer ကို turned off, thawed (သို႕မဟုတ္) unlocked

ေပးထားေသာ Objects မ်ားအတြက္ပါ အက်ိဳးသက္ ေရာက္မွဳ႕ရိွပါသည္။

 Selection ျပီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္လုိက္ပါ။

Selecting with the Last Option

မိမိတုိ႕ ေရးဆြဲထားေသာ Drawing တြင္ ေနာက္ဆံုးေရးဆြဲ ခ႕ဲေသာ Object ကို select လုပ္ရန္ Select Objects prompt

ဟုျပေနေသာ အခ်ိန္၌ L ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။ ထိုအခါ မိမိတုိ႕ေနာက္ဆံုး ေရးဆြဲခ႕ဲေသာ Object သည္

selected ျဖစ္ေနသည္ကုိ ေတြ႕ရိွရေပမည္။

Last Option ကုိအသုံးျပဳပုံ -

 Select Objects prompt ဟုျပေနေသာ အခ်ိန္၌ L ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။
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 ေနာက္ဆံုးေရးဆြဲ ခဲ႕ေသာ Object သည္ selected ျဖစ္ေနသည္ကုိ ေတြ႕ရိွရေပမည္။

 Selection ျပီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္လုိက္ပါ။

Selecting with the Previous Option

Selection လုပ္ထားသည္မ်ားကို software က memory တြင္ သိမ္းထားေပးသည္။ Command line တြင္ Select Objects

prompt ဟုျပေနေသာ အခ်ိန္၌ P ရိုက္ထည့္ျပီး၊ ေနာက္ဆံုး Selected လုပ္ခဲ႕ေသာ selection ကုိအလြယ္တကူ ျပန္ျပီး

select လုပ္ႏိုင္ပါသည္။

 Select Objects prompt ဟုျပေနေသာ အခ်ိန္၌ P ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။

 ေနာက္ဆံုးအၾကိမ္က Selection လုပ္ခ႕ဲေသာ အပိုင္းကုိ ျပန္ျပီး select လုပ္ေပးသြားမည္ ျဖစ္သည္။

 Selection ျပီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္လုိက္ပါ။

Practice Exercise: Other Selection Options

ဤ လက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Selection Options မ်ားျဖစ္သည့္ Last, Previous, All နဲ႕ Remove Options မ်ားကို

ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။ ပထမဆုံးအေနနဲ႕ ေအာက္တြင္ ေဖာ္ျပထားသည့္ အတိုင္း lines န႕ဲ circles တစ္ခ်ိဳ႕ကို

ေရးဆြလဲိုက္ပါ။

၁) Lines နဲ႕ Circles ေရးဆြဲရန္ -

၂) Last selection option ကုိအသုံးျပဳျပီး ေလ့က်င့္ၾကည့္ၾကရေအာင္ -

 Erase command ကိုစတင္လိုက္ပါ။

 Select Objects prompt ဟုျပေနေသာ အခ်ိန္၌ L ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

 မိမိတုိ႕ ေနာက္ဆုံးေရးဆြဲခဲ႕ေသာ Object သည္ hightlight ျဖစ္သြားသည္ကုိ ေတြ႕ရမည္။

 Selected ထားေသာ Object ကို Erase ရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။
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၃) ေအာက္ပါပုံတြင္ ျပထားသည့္အတိုင္း Objects မ်ားကို Copy လုပ္ျပီး Circle အနီးတစ္၀ိုက္တြင္ Paste လုပ္လိုက္ပါ။

၄) Copy command ကုိျပန္ေခၚျပီး Previous select option ကိုေလ့က်င့္ရန္ -

 Copy command ကုိစတင္လုိက္ပါ။

 Select Objects prompt ျပေနေသာ အခ်ိန္၌ P ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လိုက္ပါ။

 ထုိအခါ မိမိတုိ႕ ေနာက္ဆံုး ေရးဆြဲခ႕ဲေသာ Object သည္ selected ျဖစ္ေနသည္ကို ေတြ႕ရေပမည္။

 Copy command ကုိ cancel လုပ္ရန္အတြက္ Esc key ကုိႏိွပ္လိုက္ပါ။

၅) Select all option ကိုေလ့က်င့္ျပီး၊ ထုိ selected ထားေသာ Objects မ်ားထမွဲ Object တစ္ခ်ိဳ႕ကို Unselected

ျဖစ္ေအာင္ Remove option ကုိပါ ေလ့က်င့္ရန္ -

 Erase command ကိုစတင္လိုက္ပါ။

 Select Objects prompt ျပေနေသာ အခ်ိန္၌ all ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။ (Enter ကို

တစ္ၾကိမ္တည္းသာ ႏိွပ္ရန္)

 ျပီးေနာက္ SHIFT key ကုိဖိထားျပီး Selected ျဖစ္သြားေသာ Objects မ်ားထဲမွ Circle ကုိ cursor ျဖင့္

click လိုက္ပါ။ ထုိအခါ Circle သည္ unselected ျဖစ္သြားေသာေၾကာင့္ hightlight ျဖစ္ေနေတာ႕မည္ မဟုတ္ပ၊ဲ

မူလအေရာင္အတိုင္းပဲ ျပန္ျဖစ္သြားမည္ကို ေတြ႕ရမည္။
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 Erase command ကိုဆက္လက္လုပ္ေဆာင္ ေစရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။

မွတ္ခ်က္။ ။ Selected ျဖစ္ေနေသာ Objects မ်ားထဲမွ တစ္ခ်ိဳ႕ေသာ Objects ကို unselected ျပန္လုပ္လိုလွ်င္ command

line တြင္ R ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။ ျပီးလွ်င္ မိမိတုိ႕ unselected လုပ္လိုေသာ Object ကုိ click လုိက္ပါ။

Objects မ်ားကို Select လုပ္ထားေသာ Objects group ထဲသုိ႕ထပ္မံ Add လိုလွ်င္ A ဟုရိုက္ထည့္ ျပီး Enter ႏိွပ္လိုက္ပါ။

Objects group ထဲသုိ႕ ပို႕လိုေသာ Objects မ်ားကုိ Cursor ျဖင့္ လိုက္လံ click လုိက္ပါ။

Exercise: Select Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ drawings မ်ားအတြင္းမွ Objects မ်ားကုိ Selection method မ်ားအသံုးျပဳျပီး Erase

လုပ္ျခင္းမ်ားကုိ ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။

၁) M_Selecting-Objects.dwg ကိုဖြင့္လုိက္ပါ။

၂) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံကုိ Zoom ခ်႕ဲလိုက္ပါ။
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၃) Implied Window selection option ကုိအသုံးျပဳျပီး Objects မ်ားကုိ Erase လုပ္သြားရမည္ ျဖစ္ျပီး၊ Objects တစ္ခ်ိဳ႕ကို

Selected လုပ္ထားျခင္းမွ Remove လုပ္ေပးရမည္ ျဖစ္သည္။

 Erase command ကိုစတင္လိုက္ပါ။

 ပုံတြင္ ျပထားေပးသည့္အတုိင္း Point (1) အနီးတြင္ တစ္ခ်က္ Point (2) အနီးတြင္ တစ္ခ်က္ Click လိုက္ပါ။

 Selected ျဖစ္သြားေသာ geomentry မ်ားသည္ အေရာင္မိွန္သြားမည္ ျဖစ္သည္။ သုိ႕ေသာ္ Select window

ထတဲြင္ အစိတ္အပိုင္းအားလုံး ပါေသာ Objects မ်ားသာ အေရာင္မိွန္သြားမည္ ျဖစ္သည္။

၄) Selected ထားျခင္းမွ တစ္ခ်ိဳ႕ေသာ Objects ကိုျပန္ျပီး remove လုပ္ရန္ -

 ပုံတြင္ ျမွားနီျဖင့္ ျပထားေသာ Line (3) ခုကုိ SHIFT key ႏိွပ္ထားျပီး Cursor ျဖင့္ click လိုက္ပါ။ ထိုအခ်ိန္တြင္

click လုိက္ေသာ Line (3) ခုသည္ unselected အျဖစ္ မူလအေရာင္ ျပန္ေျပာင္းသြား သည္ကို ေတြ႕ရမည္

ျဖစ္သည္။

 Erase command ကိုဆက္လက္လုပ္ေဆာင္ ေစရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

189

၅) Implied crossing window ကုိအသုံးျပဳျပီး Erase လုပ္ရန္ -

 Erase command ကိုစတင္လိုက္ပါ။

 ပုံတြင္ ျပထားေပးသည့္အတိုင္း Point (1) အနီးတြင္ တစ္ခ်က္ Point (2) အနီးတြင္ တစ္ခ်က္ Click လိုက္ပါ။

Cursor ကုိညာမွဘယ္သုိ႕ ေရြ႕ရသည္ကို သတိထားပါ။ Crossing window ျဖတ္သြားေသာ Objects မွန္သမွ်သည္

hightlights ျဖစ္သြားျပီး selected ျဖစ္သြားမည္ ျဖစ္သည္။

 Erase command ကိုဆက္လက္လုပ္ေဆာင္ ေစရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။

၆) Crossing Polygon selection option ကိုအသံုးျပဳ၍ Erase လုပ္ရန္ -

မွတ္ခ်က္။ ။ ပုံတြင္ေဖာ္ျပထားေသာ အပိုင္းကုိ သင့္ေတာ္သေလာက္ Zoom ခ်ဲ႕လုိက္ပါ။

 Erase command ကိုစတင္လိုက္ပါ။

 Select Objects prompt ျပေနေသာ အခ်ိန္၌ CP ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။

 Crossing Polygon selection အတြက္ Point သတ္မွန္ရန္ ေအာက္ပါပုံတြင္ ျပထားသည့္ အတုိင္း Click လိုက္ပါ။

 Point (1) မွစတင္ျပီး Point (6) အထိဆက္တိုက္ အစဥ္လိုက္ဆက္ျပီး click သြားပါ။ ျပီးလွ်င္ Enter ကိုႏိွပ္လုိက္ပါ။

 Polygon window ျဖတ္သြားေသာ Objects အားလုံးသည္ အေရာင္မိွန္သြားျပီး selected ျဖစ္သြားမည္ ျဖစ္သည္။

 Erase command ကိုဆက္လက္လုပ္ေဆာင္ ေစရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။
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၇) Window Polygon ကုိအသုံးျပဳျပီး Objects မ်ားကုိ Erase လုပ္ရန္ -

 Erase command ကိုစတင္လိုက္ပါ။

 Select Objects Prompt တြင္ wp ( Window Polygon အတြက္) ဟုရိုက္ထည့္လုိက္ပါ။ ျပီးလွ်င္ Enter

ႏိွပ္လိုက္ပါ။

 Window Polygon selection အတြက္ Point သတ္မွန္ရန္ ေအာက္ပါပုံတြင္ ျပထားသည့္ အတိုင္း Click လိုက္ပါ။

 Point (1) မွ စတင္ျပီး Point (8) အထိဆက္တုိက္ အစဥ္လုိက္ ဆက္ျပီး click သြားပါ။ ျပီးလွ်င္ Enter

ကုိႏိွပ္လိုက္ပါ။

 Select window ထတဲြင္ အစိတ္အပိုင္းအားလံုး ပါေသာ Objects မ်ားသာ အေရာင္မိွန္သြားမည္ ျဖစ္သည္။

 Erase command ကိုဆက္လက္လုပ္ေဆာင္ ေစရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။

၈) Fence selection option ကိုအသံုးျပဳျပီး Lines မ်ားကုိ Erase လုပ္ရန္ -

မွတ္ခ်က္။ ။ ပုံတြင္ေဖာ္ျပထားေသာ အပိုင္းကို သင့္ေတာ္သေလာက္ Zoom ခ်ဲ႕လိုက္ပါ။

 Erase command ကိုစတင္လိုက္ပါ။

 Select Objects Prompt တြင္ f ဟုရိုက္ထည့္လုိက္ပါ။ ျပီးလွ်င္ Enter ႏိွပ္လိုက္ပါ။

 ပုံတြင္ ျပထားသည့္ အတိုင္း Point (1) မွအမွတ္မ်ား စတင္သတ္မွတ္ရန္ click လိုက္ပါ။

 Point (1) မွစတင္ကာ Point (7) အထိ click ျပီးသြားလွ်င္ selection ျပီးဆံုးေၾကာင္း အသိေပးရန္ Enter

နိွပ္လိုက္ပါ။

 Erase command ကိုဆက္လက္လုပ္ေဆာင္ ေစရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။

၉) Last selection option ကုိအသုံးျပဳျပီး ေအာက္ေဖာ္ျပပုံမွ ေနာက္ဆုံး ေရးဆြဲခ႕ဲေသာ Object ကို Erase လုပ္ရန္ -

 ေအာက္တြင္ ေဖာ္ျပထားေသာ အပိုင္းကုိ Zoom ခ်ဲ႕ လုိက္ပါ။

 Erase command ကိုစတင္လိုက္ပါ။
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 Select Objects Prompt တြင္ L ဟုရိုက္ထည့္လိုက္ပါ။ ျပီးလွ်င္ Enter ႏိွပ္လိုက္ပါ။

 ဘယ္ဖက္ကို သြားေနေသာ arrow ေလး အေရာင္မိွန္သြား သည္ကုိေတြ႕ရမည္။ ထို Object မွာအဆိုပါ ပုံတြင္

ေနာက္ဆံုး ေရးဆြဲခဲ႕ေသာ Object ျဖစ္ပါသည္။

 Erase command ကိုဆက္လက္လုပ္ေဆာင္ ေစရန္အတြက္ Enter ႏိွပ္လိုက္ပါ။

၁၀) Select all option ကိုအသံုးျပဳျပီး Drawing area ထမွဲ Objects အားလုံးကို Erase လုပ္ရန္ -

 Command line တြင္ Z ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 ထုိ႕ေနာက္ Command line တြင္ပင္ E ဟုရိုက္ျပီး Enter ႏိွပ္ပါ။ Zoom Etents လုပ္သည္ကို အထက္တြင္

ရွင္းလင္းျပီးသား ျဖစ္ပါသည္။

 Erase command ကိုစတင္လိုက္ပါ။

 Select Objects Prompt တြင္ all ဟုရိုက္ထည့္လိုက္ပါ။ ျပီးလွ်င္ Enter ႏိွပ္လိုက္ပါ။

 Drawing area တြင္းမွ Objects အားလံုး အေရာင္မိွန္သြားမည္ ျဖစ္သည္။

 Command line တြင္ U ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။ Undo လုပ္ရန္ ျဖစ္ပါသည္။

၁၁) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Changing an Object's Position

ဤသင္ခန္းစာတြင္ Move command ကိုအသုံးျပဳျပီး Objects မ်ားကို ေနရာ ေရြ႕ေျပာင္းျခင္းႏွင့္ Grip ကုိအသံုးျပဳျပီး

Objects မ်ားကုိ ေနရာေရြ႕ေျပာင္းျခင္း အပိုင္းကုိ ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Drawings အတြင္းရိွ Objects မ်ားကို

တစ္ေနရာမွ တစ္ေနရာသုိ႕ ေရြ႕ေျပာင္းျခင္းကို Users မ်ားအေနန႕ဲ မၾကာခဏ ျပဳလုပ္ေလ့ ရိွပါသည္။ Drawing အတြင္းရိွ

Objects မ်ားကုိ တစ္ရာမွ တစ္ေနရာ ေရြ႕ေျပာင္းရာတြင္ အသုံးျပဳေသာ နည္းလမ္းေပါင္း မ်ားစြာရိွရာ Move command

သည္လည္း ထုိနည္းလမ္းမ်ားစြာထမွဲ နည္းလမ္း တစ္ခုပင္ ျဖစ္ပါသည္။
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Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Grip န႕ဲ Move command မ်ားကို object snaps, coordinate entry၊ object snap tracking တုိ႕ျဖင့္ေပါင္းစပ္

အသုံးျပဳျပီး Objects မ်ားကို တစ္ေနရာမွ တစ္ေနရာသို႕ ေရြ႕ေျပာင္းျခင္းကို နားလည္ လာမည္ ျဖစ္သည္။

Moving Objects

Drawing အတြင္းရိွ Objects မ်ားကို Move command ျဖင့္ basepoint သတ္မွတ္ျပီး မိမိတုိ႕စိတ္ၾကိဳက္ တစ္ေနရာမွ

တစ္ေနရာသုိ႕ ေရြ႕ေျပာင္းႏိုင္ပါသည္။ Move command ေခၚျပီးပါက ေရြ႕ေျပာင္း လုိေသာObjects ကုိ select ျပီး

basepoint အျဖစ္ တစ္ေနရာရာကုိ click ျပီး မိမိတုိ႕ ေရြ႕ေျပာင္းလိုေသာ ေနရာသုိ႕ cursor ျဖင့္ေရြ႕လုိက္ျခင္းပင္ ျဖစ္သည္။

Grip ျဖင့္ေရြ႕ေျပာင္းလိုေသာ Object ကုိ click ျပီးမွ Move command ကိုေခၚ၍လည္း ေျပာင္းေရြ႕ျခင္း ျပဳလုပ္ႏိုင္ပါသည္။
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Command Access

Move

Command Line: MOVE, M

Ribbon: Home tab > Modify Panel > Move

Menu Bar: Modify > Move

Shortcut Menu: ေရြ႕ေျပာင္းလိုေသာ Object ကုိ select လုပ္ျပီး Right–click ႏိွပ္ကာ shortcut menu မွ Move ကို

click လိုက္ပါ။

Procedure: Moving Objects with the Move Command

Drawing area ထတဲြင္ Move command ကိုအသံုးျပဳျပီး Objects မ်ားကို တစ္ေနရာမွ တစ္ေနရာသို႕ ေရြ႕ေျပာင္းျခင္း

ကုိေအာက္တြင္ အဆင့္ဆင့္ေဖာ္ျပ ေပးထားပါသည္။
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၁) Ribbon,Home tab > Modify panel > Move ကို click ပါ။

၂) ေရြ႕ေျပာင္းလုိေသာ Object ကို select လုပ္ျပီး၊ object selection ျပီးဆံုးေၾကာင္း အသိေပးရန္ Enter ႏိွပ္လုိက္ပါ။

၃) Base point သတ္မွတ္ေပးလိုက္ပါ။ ( Base point = Object ကို ဤေနရာမွ အေျခတည္ျပီး သယ္ယူသြား ပါမည္။)

၄) Second point သတ္မွတ္ပါမည္။ (Second point = Object ကုိဤေနရာတြင္ ထားပါမည္။)

၅) ယခင္အမွတ္မွ အမွတ္အသစ္သုိ႕ ေျပာင္းေရြ႕ျပီးသြားေသာ Object.
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Procedure: Moving Objects Using Grips

Drawing area ထဲတြင္ grip ကိုအသံုးျပဳျပီး Objects မ်ားကုိ တစ္ေနရာမွ တစ္ေနရာသို႕ ေရြ႕ေျပာင္းျခင္း ကုိေအာက္တြင္

အဆင့္ဆင့္ေဖာ္ျပ ေပးထားပါသည္။

 Grip activate ျဖစ္ေစရန္ Object ကုိ select လုိက္ပါ။

 Grip Activated ျဖစ္လွ်င္ Object တြင္ color box ေလးေပၚလာမည္။ ထုိ grip (color box) ကုိ click လိုက္ပါက

Edit mode သည္လည္း activated ျဖစ္သြားမည္ ျဖစ္သည္။

 ထုိ႕ေနာက္ Drawing area တြင္ Right–click ႏိွပ္ျပီး shortcut menu မွ Move ကုိ click လိုက္ပါ။ Grip (color

box) ကုိ click ခ႕ဲေသာ အမွတ္သည္ base point ျဖစ္ပါသည္။

 ျပီးလွ်င္ ထုိ Object ကုိမိမိတို႕ နွစ္သက္ေသာ ေနရာသုိ႕ ေရြ႕လုိက္ပါ။

Practice Exercise: Move Objects

ဤသင္ခန္းစာတြင္ သင့္ေတာ္ေသာ Rectangle ႏွစ္ခုကို ေရးဆြဲျပီး၊ ထုိ Rectangle ႏွစ္ခုမွ တစ္ခုကို က်န္တစ္ခု၏ ညာဖက္

Midpoint ကုိ Move command အသုံးျပျပီး ေရြ႕ေျပာင္းေပးရမည္ ျဖစ္သည္။

မွတ္ခ်က္။ ။ Move နည္း method နွစ္မ်ိဳးလံုးကုိ အသုံးျပဳေလ့က်င့္ပါ။
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၁) Acad.dwt template ကုိအသုံးျပဳျပီး blank drawing တစ္ခုကုိ ဖြင့္လိုက္ပါ။

၂) Drawing drafting settings ျပင္ဆင္သတ္မွတ္ရန္ -

 Polar tracking န႕ဲ object snap ကုိဖြင့္ထားရပါမည္။

 Object snap ၏ Midpoint mode ကုိ select ထားပါ။

၃) Drawing window ထတဲြင္ သင့္ေလ်ာ္ေသာ အရြယ္အစား ရိွသည့္ Rectangle နွစ္ခုကို ေရးဆြဲရန္ -

 Home tab,Modify Panel >Move ကုိ click ပါ။

 ညာဖက္မွ Rectangle ကို select ျပီး Enter ႏိွပ္ပါ။

 Base point prompt ျပေသာအခါ select ထားေသာ ညာဖက္ rectangle ၏ Midpoint ကုိ select လိုက္ပါ။

၄) ေအာက္ပါပုံတြင္ ျပထားသည့္အတိုင္း ဘယ္ဖက္တြင္ ရိွေသာ Rectangle ၏ Midpoint သုိ႕ ေရြ႕လုိက္ပါ။
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၅) Rectangle ကုိ grip အသံုးျပဳျပီး ေရြ႕ရန္ -

 Rectangle ကို select လိုက္ပါ။ (Command line သည္ blank အေနထားတြင္ ရိွေနရမည္။)

 Grip (color box) ကုိ select ျပီး Right–click ႏိွပ္ပါ။

 Shorcut menu မွ Copy ကုိ click ပါ။

၆) ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း Rectangle ၏ Midpoint ကို select လုိက္ပါ။

 Grip (color box) ကုိ ထပ္မံ၍ select ပါ။

 Right – click ႏိွပ္ျပီး၊ Move ကို select ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

198

 Rectangle ကိုညာဖက္သုိ႕ Polar angle 0 ဒီဂရီ ျဖစ္သည္ အထိေရြ႕ပါ။

 1 ဟုရိုက္ျပီး Enter ႏိွပ္လုိက္ပါ။

Exercise: Move Objects

ဤသင္ခန္းစာတြင္ Drawing area တြင္းမွ Objects မ်ားကုိ Move command အသံုးျပဳျပီး တစ္ေနရာမွ တစ္ေနရာသုိ႕

ေရြ႕ေျပာင္း ရမည္ျဖစ္သည္။ ဤသင္ခန္းစာ ျပီးဆံုးသြားပါက ေလ့လာသူမ်ား အေနျဖင့္ Move command ကုိ object

snaps, coordinate entry၊ object snap tracking တို႕ျဖင့္ေပါင္းစပ္ အသုံးျပဳျပီး Objects မ်ားကို တစ္ေနရာမွ

တစ္ေနရာသုိ႕ ေရြ႕ေျပာင္းျခင္းကို နားလည္လာမည္ ျဖစ္သည္။

Exercise: Move Objects (Metric Units)

အထက္တြင္ ေဖာ္ျပေပးထားေသာ Designated rooms အတြင္းမွ ပရိေဘာဂမ်ားကို Move command န႕ဲ grip

အသံုးျပဳျပဳျပီး ေရြ႕ေျပာင္းျခင္းကုိ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ Polar Tracking, Object Snapန႕ဲ Object Snap

Tracking modes မ်ားကို ဖြင့္ထားေပးရပါမည္။
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၁) M_Moving-Objects.dwg ကိုဖြင့္လုိက္ပါ။

၂) Drawing ရ႕ဲ ဘယ္ဖက္ေအာက္ေထာင့္ အပိုင္းကို Zoom ခ်ဲ႕ လိုက္ပါ။ (ေအာက္ေဖာ္ျပ ပုံအတိုင္း)

၃) ပန္းကန္ေဆးစင္ကုိ select ျပီး မီးဖိုထသဲုိ႕ ေရြ႕ရန္ -

 ပန္းကန္ေဆးစင္ကုိ select လုိက္ပါ။ ( command line သည္ blank အေနထားျဖစ္ရပါမည္။)

 ပန္းကန္ေဆးစင္သည္ single object ျဖစ္ေသာေၾကာင့္ grip သည္ Midpoint တြင္ရိွေနသည္ကို ေတြ႕ရေပမည္။

(ပန္းကန္ေဆးစင္ကုိ block ျဖင့္ေရးဆြဲထားေသာေၾကာင့္ ျဖစ္သည္။ ေနာက္ပိုင္း သင္ခန္းစာတြင္block

အေၾကာင္းကို ဆက္လက္ ေလ့လာသြားရမည္ ျဖစ္သည္။)

 ပန္းကန္ေဆးစင္ကုိ cursor ျဖင့္ drag ျပီး၊ မီးဖိုေခ်ာင္၏ ေအာက္နံရံ Midpoint တြင္ click လုိက္ပါ။

 ပန္းကန္ေဆးစင္ကုိ ေနရာသစ္သုိ႕ ေရြ႕ေျပာင္းရန္ အတြက္ click လုိက္ပါ။

၄) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ အပိုင္းကို Zoom ခ်႕ဲလိုက္ပါ။

၅) ႏွစ္ေယာက္ထုိင္ ဆိုဖာကုိ ေအာက္ပါ ပုံအတုိင္း ေနရာေရြ႕ရန္ -
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 ဆုိဖာ ကို select လုပ္ပါ။ ( command line သည္ blank အေနထားျဖစ္ရပါမည္။)

 ဆုိဖာ အမီွနံရံတြင္ grip ေပၚေနသည္ကုိ ေတြ႕ရမည္။ ထုိ grip ေပၚတြင္ click ျပီး ေအာက္ပါပုံတြင္ ျပထားသည့္

အတိုင္း အခန္းနံရံ၏ Midpoint သုိ႕ေရြ႕လိုက္ပါ။ (shortcut menu မွျဖစ္ေစ၊ command line မွျဖစ္ Move

command ကိုေခၚယူအသံုးျပဳပါ)

၆) Move command ကုိအသုံးျပဳ၍ အေပၚက ဆိုဖာကုိ အခန္းတြင္းသို႕ ေရြ႕ရန္ -

 Move command ကုိေခၚလိုက္ပါ။

 ဆုိဖာကုိ select လုပ္ျပီး Enter ႏိွပ္ပါ။

 ဆုိဖာ၏ Midpoint ကို base point အျဖစ္သတ္မွတ္လုိက္ပါ။

 ထုိဆိုဖာ သယ္လာေသာ Cursor ကုိ အခန္းအတြင္းနံရံ၏ Midpoint တြင္ select လိုက္ပါ။
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၇) Move command ကုိျပန္ေခၚျပီး စားပြဲန႕ဲ ကုလားထိုင္ကုိ ေရြ႕ရန္ -

 Move command ကုိေခၚလိုက္ပါ။

 Selection window ကုိအသုံးျပဳျပီး စားပြဲန႕ဲကုလားထုိင္ကုိ ေအာက္ပါပုံအတိုင္း select ေပးလိုက္ပါ။

 Selection set ကုိျပီးစီးေၾကာင္း အတည္ျပဳေပးရန္ Enter ႏိွပ္ပါ။

၈) စားပြဲႏွင့္ ကုလားထုိင္ကုိ ေရြ႕ရန္ -

 စားပြဲရဲ႕ Midpoint ကုိ click လိုက္ပါ။

 ေအာက္တြင္ေဖာ္ျပထားေသာ ပုံအတိုင္း စားပြနဲ႕ဲ ကုလားထုိင္ကုိ အခန္းနံရံသုိ႕ ေရြ႕လုိက္ပါ။

၉) မိမိတို႕၏ drawing area တြင္ ေအာက္ပါျမင္ကြင္းအတုိင္း ရေအာင္ျပင္ရန္ -
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၁၀) ထမင္းစား စားပြဲႏွင့္ ကုလားထုိင္ကုိ အခန္းတြင္းသုိ႕ ေရြ႕ရန္ -

 ထမင္းစား စားပြႏွဲင့္ ကုလားထုိင္ကို select လုပ္ပါ။ ( command line သည္ blank အေနထား ျဖစ္ရပါမည္။)

 Center မွ grip ကုိ select လုပ္ပါ။

 စားပြဲႏွင့္ ကုလားထိုင္ကုိ အခန္းတြင္းသုိ႕ drag လုပ္လိုက္ပါ။

 ပထမနံရံ၏ Midpoint ကုိ စားပြဲႏွင့္ ကုလားထုိင္ကို drag လုပ္လာေသာ cursor ျဖင့္ Hover လုပ္ပါ။ ထပ္မံ၍

ေဘးနံရံ၏ Midpoint ကုိပါ cursor ျဖင့္ Hover လုပ္လိုက္ပါ။ ထိုအခါ အခန္း၏ Polar tracking က အခန္း၏

အလယ္မွတ္ကုိ ေဖာ္ျပေပးပါလိမ္႕မည္။

 ထုိ tracking lines (၂) ၏ ဆံုမွတ္ေနရာ အလယ္မွတ္ကုိ click လိုက္ပါ။

၁၁) ေဘစင္ကုိ အျခားနံရံသုိ႕ေရြ႕ေျပာင္းရန္ -

 ေဘစင္ကို select လုပ္ပါ။ ( command line သည္ blank အေနထား ျဖစ္ရပါမည္။)
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 Grip ကုိ select ျပီး အေပၚသို႕ drag လိုက္ပါ။

 650 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

၁၂) ပုံအားကို ျမင္ေတြ႕ႏိုင္ေသာ အေနထားသို႕ ျပန္ေရာက္ေအာင္ Zoom ျပန္ခ်ဲ႕လုိက္ပါ။

၁၃) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Exercise: Move Objects (Imperial Units)

Designated rooms အတြင္းမွ ပရိေဘာဂမ်ားကို Move command န႕ဲ grip အသံုးျပဳျပဳျပီး ေရြ႕ေျပာင္းျခင္းကို

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ Polar Tracking, Object Snapန႕ဲ Object Snap Tracking modes မ်ားကုိ ဖြင့္ထားေပးရ

ပါမည္။

၁) M_Moving-Objects.dwg ကိုဖြင့္လုိက္ပါ။

၂) Drawing ရ႕ဲ ဘယ္ဖက္ေအာက္ေထာင့္ အပိုင္းကို Zoom ခ်ဲ႕ လိုက္ပါ။ (ေအာက္ေဖာ္ျပ ပုံအတိုင္း)

၃) ပန္းကန္ေဆးစင္ကုိ select ျပီး မီးဖိုထသဲုိ႕ ေရြ႕ရန္ -

 ပန္းကန္ေဆးစင္ကုိ select လုိက္ပါ။ ( command line သည္ blank အေနထားျဖစ္ရပါမည္။)

 ပန္းကန္ေဆးစင္သည္ single object ျဖစ္ေသာေၾကာင့္ grip သည္ Midpoint တြင္ရိွေနသည္ကို ေတြ႕ရေပမည္။

(ပန္းကန္ေဆးစင္ကုိ block ျဖင့္ေရးဆြဲ ထားေသာေၾကာင့္ ျဖစ္သည္။ ေနာက္ပိုင္း သင္ခန္းစာတြင္ block အေၾကာင္း

ကုိ ဆက္လက္ ေလ့လာသြားရမည္ ျဖစ္သည္။)
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 ပန္းကန္ေဆးစင္ကုိ cursor ျဖင့္ drag ျပီး၊ မီးဖိုေခ်ာင္၏ ေအာက္နံရံ Midpoint တြင္ click လုိက္ပါ။

 ပန္းကန္ေဆးစင္ကုိ ေနရာသစ္သုိ႕ ေရြ႕ေျပာင္းရန္ အတြက္ click လုိက္ပါ။

၄) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ အပိုင္းကို Zoom ခ်႕ဲလိုက္ပါ။

၅) ႏွစ္ေယာက္ထုိင္ ဆိုဖာကုိ ေအာက္ပါ ပုံအတုိင္း ေနရာေရြ႕ရန္ -

 ဆုိဖာ ကို select လုပ္ပါ။ ( command line သည္ blank အေနထားျဖစ္ရပါမည္။)

 ဆုိဖာ အမီွနံရံတြင္ grip ေပၚေနသည္ကုိ ေတြ႕ရမည္။ ထုိ grip ေပၚတြင္ click ျပီး ေအာက္ပါပုံတြင္ ျပထားသည့္

အတိုင္း အခန္းနံရံ၏ Midpoint သို႕ေရြ႕လိုက္ပါ။ (shortcut menu မွျဖစ္ေစ၊ command line မွျဖစ္ေစ Move

command ကိုေခၚယူအသံုးျပဳပါ)
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၆) Move command ကုိအသုံးျပဳ၍ အေပၚက ဆိုဖာကုိ အခန္းတြင္းသို႕ ေရြ႕ရန္ -

 Move command ကုိေခၚလိုက္ပါ။

 ဆုိဖာကုိ select လုပ္ျပီး Enter ႏိွပ္ပါ။

 ဆုိဖာ၏ Midpoint ကို base point အျဖစ္သတ္မွတ္လုိက္ပါ။

 ထုိဆိုဖာ သယ္လာေသာ Cursor ကုိ အခန္းအတြင္းနံရံ၏ Midpoint တြင္ select လိုက္ပါ။

၇) Move command ကုိျပန္ေခၚျပီး စားပြဲန႕ဲ ကုလားထိုင္ကုိ ေရြ႕ရန္ -

 Move command ကုိေခၚလိုက္ပါ။

 Selection window ကုိအသုံးျပဳျပီး စားပြဲန႕ဲ ကုလားထုိင္ကို ေအာက္ပါပုံအတုိင္း select ေပးလိုက္ပါ။

 Selection set ကုိျပီးစီးေၾကာင္း အတည္ျပဳေပးရန္ Enter ႏိွပ္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

206

၈) စားပြဲႏွင့္ ကုလားထုိင္ကုိ ေရြ႕ရန္ -

 စားပြဲရဲ႕ Midpoint ကုိ click လိုက္ပါ။

 ေအာက္တြင္ေဖာ္ျပထားေသာ ပုံအတိုင္း စားပြနဲ႕ဲ ကုလားထုိင္ကုိ အခန္းနံရံသုိ႕ ေရြ႕လုိက္ပါ။

၉) မိမိတို႕၏ drawing area တြင္ ေအာက္ပါျမင္ကြင္းအတိုင္း ရေအာင္ျပင္ရန္ -

၁၀) ထမင္းစား စားပြဲႏွင့္ ကုလားထုိင္ကုိ အခန္းတြင္းသုိ႕ ေရြ႕ရန္ -
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 ထမင္းစား စားပြႏွဲင့္ ကုလားထုိင္ကို select လုပ္ပါ။ ( command line သည္ blank အေနထား ျဖစ္ရပါမည္။)

 Center မွ grip ကုိ select လုပ္ပါ။

 စားပြဲႏွင့္ ကုလားထိုင္ကုိ အခန္းတြင္းသုိ႕ drag လုပ္လိုက္ပါ။

 ပထမနံရံ၏ Midpoint ကုိ စားပြဲႏွင့္ ကုလားထုိင္ကို drag လုပ္လာေသာ cursor ျဖင့္ Hover လုပ္ပါ။ ထပ္မံ၍

ေဘးနံရံ၏ Midpoint ကုိပါ cursor ျဖင့္ Hover လုပ္လုိက္ပါ။ ထုိအခါ Polar tracking က အခန္း၏ အလယ္မွတ္ကို

ေဖာ္ျပေပးပါလိမ္႕မည္။

 ထုိ tracking lines (၂) ၏ ဆံုမွတ္ေနရာ အလယ္မွတ္ကုိ click လိုက္ပါ။

၁၁) ေဘစင္ကုိ အျခားနံရံသုိ႕ေရြ႕ေျပာင္းရန္ -

 ေဘစင္ကို select လုပ္ပါ။ ( command line သည္ blank အေနထား ျဖစ္ရပါမည္။)

 Grip ကုိ select ျပီး အေပၚသို႕ drag လိုက္ပါ။

 650 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

၁၂) ပုံအားကို ျမင္ေတြ႕ႏိုင္ေသာ အေနထားသို႕ ျပန္ေရာက္ေအာင္ Zoom ျပန္ခ်ဲ႕လုိက္ပါ။

၁၃) Files အားလုံးကို မSave ပဲပိတ္လိုက္ပါ။
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Lesson: Creating New Objects from Existing Objects

ဤသင္ခန္းစာတြင္ Copy command ကိုအသုံးျပဳျပီး drawing ထမွဲ geomentry မ်ားကုိ ပုံတူေရးဆြဲျခင္း အပိုင္းကို

ေလ့လာသြားရမည္ ျဖစ္သည္။ Drawing အတြင္းမွ ပုံတူ geomentry မ်ားကုိ အခ်ိန္ကုန္ခံကာ ထပ္မံေရးဆြဲ စရာမလိုပဲ

ပုံတူကူးယူႏိုင္သည့္ copy command သည္ computer aided design (CAD) ကနဦးစကတည္းက တြင္တြင္က်ယ္က်ယ္

သံုးလာေသာ command ျဖစ္ပါသည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးပါက -

 Grips (သို႕မဟုတ္) Copy command အသံုးျပဳျပီး drawing အတြင္းမွ Objects မ်ားကုိ copy လုပ္တတ္

လာေစရန္။

Copying Objects

Drawings မ်ားတြင္ ပုံတူ Objects မ်ားေရးဆြဲ ရာတြင္ အသံုးျပဳရလြယ္ကူျပီး၊ မိမိတုိ႕ အလုပ္တြင္ အခ်ိန္ကုန္ျခင္း

သက္လာမည္ ျဖစ္သည္။ Copy command ကိုေခၚျပီးပါက ေရြ႕ေျပာင္း လိုေသာObjects ကုိ select ျပီး basepoint အျဖစ္

တစ္ေနရာရာကို click ျပီး မိမိတုိ႕ ပံုတူကူးလုိေသာ ေနရာသို႕ cursor ျဖင့္ေရြ႕ လိုက္ျခင္းပင္ျဖစ္သည္။
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Command Access

copy

Ribbon: Draw tab > Modify panel > Copy

Command Line: COPY, CO

Menu Bar: Modify > Copy

Shortcut Menu: ေရြ႕ေျပာင္းလိုေသာ Object ကုိ select လုပ္ျပီး Right –click ႏိွပ္ကာ shortcut menu မွ Copy

Procedure: Copying Objects with the Copy Command

Drawing အတြင္းမွ Objects မ်ားကုိ copy command အသံုးျပဳျပီး Copying လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပ

ေပးထားပါသည္။ ေလ့လာၾကည့္ပါ။

၁) Ribbon,Home tab > Modify panel > Copy ကုိ click လိုက္ပါ။

၂) Copy လုပ္မည့္ Object (s) ကုိ Select ျပီး Enter ႏိွပ္ပါ။

၃) Copy လုပ္ရန္အတြက္ base point သတ္မွတ္ေပးပါ။
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၄) Selected ထားေသာ Object(s) ကုိ သယ္လာေသာ Cursor ကုိမိမိတို႕ ထားမည့္ Second point ေနရာတြင္

click လိုက္ပါ။

၅) Copy command ကုိဆံုးရန္ Enter မႏွိပ္မခ်င္း copied လုပ္ထားေသာ object(s) မိမိတို႕ အလုိရိွ သေလာက္ copy

လုပ္ႏိုင္ပါသည္။ ထို႕ေၾကာင့္ ထပ္မံ၍ copy လုပ္လိုပါက မိမိတုိ႕ ထားမည့္ေနရာကို select လိုက္ပါ။

Procedure: Copying Objects Using Grips

Drawing အတြင္းမွ Objects မ်ားကုိ grip မွ Copying လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Grip activate ျဖစ္ေအာင္ Object(s) ကို select လုိက္ပါ။

၂) Grip (color box) ကုိ click လိုက္ပါက Edit mode သည္လည္း activated ျဖစ္သြားမည္ ျဖစ္သည္။ ထို click လုိက္ေသာ

အမွတ္သည္ copying လုပ္ရန္ base point ျဖစ္သြားမည္ ျဖစ္သည္။

၃) Drawing area ၏ တစ္ေနရာရာတြင္ Right–click ႏိွပ္ျပီး Move ကုိ select ပါ။

၄) Drawing area ၏ တစ္ေနရာရာတြင္ Right–click ႏိွပ္ျပီး Copy ကို select ပါ။

5) Copy လုပ္ရန္ selected ထားေသာ Object ကုိ မိမိတို႕ ထားလုိေသာ အမွတ္တြင္ click လုိက္ပါ။
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Practice Exercise: Copy Objects

ဤေလ့က်င့္ခန္း Copy command နဲ႕ grip ကိုအသံုးျပဳျပီး Objects မ်ားကို Copying လုပ္ရပါမည္။ ပထမဆံုး အေနန႕ဲ

ေအာက္္တြင္ ျပထားေသာဘယ္ဖက္ ပုံအတုိင္း Circle န႕ဲ Line မ်ားကုိေရးဆြလဲိုက္ပါ။

၁) Circle ကုိေရးဆြဲလိုက္ပါ။ (သင့္ေတာ္ေသာ အရြယ္အစား တစ္ခုခု)

 Line ကုိေရးဆြဲလိုက္ပါ။ (သင့္ေတာ္ေသာ အရြယ္အစား တစ္ခုခု)

၂) Circle န႕ဲ Line ကိုညာဖက္သုိ႕ copy လုပ္ရန္ -

 Home tab, Modify panel >Copy ကို click ပါ။

 Circle န႕ဲ Line ကို select ျပီး Enter ႏိွပ္ပါ။

 Base point သတ္မွတ္ရန္ Prompt လာလွ်င္ Line အနီးနားတြင္ပင္ သတ္မွတ္ေပးလိုက္ပါ။

 Cursor ကုိညာဖက္သို႕ drag ျပီး click လုိက္ပါ။

 Copy command ကုိ ျပီးဆံုးသြားေစရန္ Enter ႏိွပ္ပါ။

၃) Grips ျဖင့္ Circle ကို copy လုပ္ရန္ -
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 ညာဖက္ Circle ကုိ select လုိက္ပါ။

 ျပီးေနာက္ Circle ၏ ညာဖက္ quadrant grips ကုိ select လိုက္ပါ။

 ထုိ grip ေပၚတြင္ Right–click ႏိွပ္ျပီး Copy ကုိ select လိုက္ပါ။

 ထုိ copy လုပ္ထားေသာ Circle ကုိ ၾကီးလာေအာင္ cursor ကုိ drag လုပ္လိုက္ပါ။

 ထုိနည္းအတုိင္း အထက္ပါ ပုံတြင္ျပထားေသာ Circle အေရအတြက္နွင့္ အရြယ္အစားမ်ား ကုိဆက္လက္

ေရးဆြလဲိုက္ပါ။

 Grip copy procedure ကို ျပီးဆံုးေစရန္ Esc ႏိွပ္ပါ။

 Circle selection ကို ျပီးဆုံးေစရန္ Esc ႏိွပ္ပါ။

၄) Grips ျဖင့္ Line ကုိ copy လုပ္ရန္ -

 Line ကုိ select လုပ္ပါ။ ( command line သည္ blank အေနထား ျဖစ္ရပါမည္။)

 End point တြင္ရိွေသာ grip ကုိ select လုပ္ပါ။

 ထုိ grip ေပၚတြင္ Right – click ႏိွပ္ျပီးMove ကုိ select လိုက္ပါ။

 ထုိ grip ေပၚတြင္ Right – click ႏိွပ္ျပီး Copy ကုိ select လုိက္ပါ။

 ထုိနည္းအတုိင္း အထက္ပါ ပုံတြင္ ျပထားေသာ Line အေရအတြက္ရေအာင္ ဆက္လက္ေရးဆြဲလိုက္ပါ။

 Grip copy procedure ကို ျပီးဆံုးေစရန္ Esc ႏိွပ္ပါ။

 Circle selection ကို ျပီးဆုံးေစရန္ Esc ႏိွပ္ပါ။
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Exercise: Copy Objects

ဤေလ့က်င့္ခန္း Copy command ကိုအသံုးျပဳျပီး Objects မ်ားကုိ Copying လုပ္ရပါမည္။ လက္ေတြ႕ေလ့က်င့္ ခန္းကို

ေလ့က်င့္ျခင္းျပီးဆံုးပါက ေလ့လာသူမ်ားအေနျဖင့္ drawings မ်ားတြင္ ပုံတူ geomentry မ်ားကို copy command ျဖင့္

ပြားယူျခင္းကုိ နားလည္လာႏိုင္မည္။

၁) M_Copy-Objects.dwg ကိုဖြင့္ပါ။

၂) ပုံ၏ အေပၚဘယ္ဖက္အပိုင္းကုိ Zoom ခ်ဲ႕လုိက္ပါ။

 Status bar ေပၚရိွ Object Snap ကုိ Right – click ႏိွပ္ျပီး၊ Center နဲ႕ Intersection mode ကုိ select လိုက္ပါ။

၃) အနီေရာင္ ၀က္အူေခါင္းမ်ားကုိ Copy လုပ္ရန္ -

 Home tab, Modify panel >Copy ကို click ပါ။

 ေအာက္တြင္ ျပထားသည့္ အတုိင္း ၀က္အူကုိ select လုပ္ကာ Enter ႏိွပ္လိုက္ပါ။

 Center object snap အမွတ္ေလး ျပလာေအာင္ ၀က္အူ circle ကို Cursor ျဖင့္ ထိလိုက္ပါ။

 Circle ၏ center ကို base point အျဖစ္သတ္မွတ္ click လုိက္ပါ။
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၄) Circle ၏ center point ကုိ ေအာက္ပုံတြင္ ျပထားသည့္ အတိုင္း select လိုက္ပါ။

၅) ထပ္မံ၍ အေပၚထိပ္ေထာင့္တြင္ ရိွေသာ circle ၏ center point ကုိ ေအာက္ပါ ပုံတြင္ ျပထားသည့္ အတုိင္း click

လိုက္ပါ။ Copy command ကုိ ျပီးဆံုးသြားေစရန္ Enter ႏိွပ္လိုက္ပါ။

၆) ၀က္အူကုိ ေဘးတိုက္ျမင္ကြင္းမွ copy လုပ္ရန္ -

 Enter ႏိွပ္ျပီး copy command ကုိျပန္ေခၚလိုက္ပါ။

 ေအာက္ပါပုံတြင္ ျပထားသည့္အတိုင္း ၀က္အူ၏ ေခါင္းပိုင္းကို select လုပ္ျပီး Enter ႏိွပ္လိုက္ပါ။

 Center object snap ကုိအသံုးျပဳျပီး ၀က္အူ၏ ဦးေခါင္းပိုင္းကုိ base point အျဖစ္ သတ္မွတ္မည္

ျဖစ္ေသာေၾကာင့္ ellipse ၏ center ကိုselect လုပ္ပါ။

၇) ထပ္မံ၍ Copy လုပ္ရန္ -
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 Intersection object snap option ကိုအသံုးျပဳျပီး၊ ေအာက္ပါပုံတြင္ ျပထားေသာ Intersections အမွတ္မ်ားကို

select လုပ္ပါ။

 Copy command ကုိျပီးဆုံးသြားေစရန္ Enter ႏိွပ္ပါ။

၈) Geomentry ကို ေဘးတိုက္ျမင္ကြင္းျဖင့္ ၾကည့္ရန္ Zoom (သို႕မဟုတ္) Pan ကိုအသံုးျပဳပါ။

၉) ေဘးတုိက္ျမင္းကြင္းမွ ေတြ႕ရေသာ Geomentry ကုိ window selection ျဖင့္ copy လုပ္ရန္ -

 Command line တြင္ co ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Window selection အတြက္ အမွတ္ ႏွစ္မွတ္သတ္မျပီး select လုပ္လိုက္ပါ။ Enter ႏိွပ္လုိက္ပါ။

၁၀) Selected ထားေသာ geomentry ကုိေနရာသတ္မွတ္ေပးရန္ -

 Selected ထားေသာ circle မွ center point ကို base point အျဖစ္သတ္မွတ္ရန္ ပုံတြင္ျပထားသည့္ အတိုင္း

select လုိက္ပါ။

 Ortho (သုိ႕မဟုတ္) Polar Tracking mode ကုိ ဖြင့္လ္ုိက္ပါ။

 Cursor ကုိ ညာဖက္သို႕ drag ျပီး 50 ဟုုရိုက္ထည့္ကာ Enter ႏိွပ္လိုက္ပါ။

 Copy command ကုိျပီးဆုံးသြားေစရန္ Enter ႏိွပ္ပါ။
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၁၁) File အားလုံးကုိ မSave ပဲပိတ္လိုက္ပါ။

Lesson: Changing the Angle of an Object' s Position

ဤသင္ခန္းစားတြင္ Drawing အတြင္းရိွ Objects မ်ားကို Rotate command အသုံးျပဳျပီး Rotate လုပ္ျခင္းကို

ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Rotate command ၏ default option အေနျဖင့္ လည္းေကာင္း၊ Reference Option

အေနျဖင့္လည္းေကာင္း၊ Copy option အေနျဖင့္ လည္းေကာင္း အသီးသီးေလ့လာ သြားရမည္ ျဖစ္ပါသည္။ ထို႕အျပင္

Objects မ်ားကို grip ျဖင့္ Rotate လုပ္ပုံကုိလည္း ေလ့လာသြားရမည္ ျဖစ္ပါသည္။

Drawings မ်ားတြင္ Objects မ်ားကို ေရးဆြျဲပီးသြားပါက၊ ထုိ Objects မ်ား၏ angle ကုိ Rotate command (သုိ႕မဟုတ္)

Grip ျဖင့္ လုိအပ္သလို လြယ္ကူစြာ ျပင္ဆင္သတ္မွတ္ႏိုင္ပါသည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Drawing အတြင္းမွ Objects ၏angle ကုိ မိမိတို႕ လုိအပ္သလို Rotate command (သုိ႕မဟုတ္) Grip ျဖင့္

Rotate လုပ္ျခင္းကို နားလည္သေဘာေပါက္ လာေစရန္။

Rotating Objects
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Drawing အတြင္းရိွ Objects မ်ားကုိ Rotate command အသံုးျပဳျပီး Rotate ျပဳလုပ္ႏိုင္ပါသည္။ Command options အရ

drawing အတြင္းမွ Objects မ်ား၏ angle တန္ဖိုးမ်ားကုိ ရိုက္ထည့္လိုက္ယံုျဖင့္ လြယ္ကူစြာ အသုံးျပဳႏိုင္ပါသည္။ Objects

မ်ားကို Rotate လုပ္ေနရင္းျဖင့္ Copy လုပ္ခ်င္လွ်င္ Copy option ကိုလည္း အလြယ္ တူေျပာင္းလဲ ေရြးခ်ယ္ႏိုင္ပါသည္။

Copy option ကုိေရြးခ်ယ္ျပီးသြားပါက၊ copy လုပ္ထားေသာ object သည္ မူရင္း Object ကုိလက္ရိွေနရာတြင္ ခ်န္ခ႕ဲျပီး

Rotated ျဖစ္သြားမည္ျဖစ္သည္။

ေအာက္တြင္ေဖာ္ျပထားေသာ ကုလားထိုင္ ႏွစ္လုံးသည္ Copy option ျဖင့္ Rotated ျဖစ္သြားျခင္း ျဖစ္သည္။

Command Access

Rotate

Command Line: ROTATE, RO

Ribbon: Home tab > Modify panel > Rotate

Menu Bar: Modify > Rotate

Shortcut Menu: ေရြ႕ေျပာင္းလိုေသာ Object ကုိ select လုပ္ျပီး Right –click ႏိွပ္ကာ shortcut menu မွ Rotate

Procedure: Rotating Objects
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Drawing အတြင္းမွ Objects မ်ားကုိ Rotate command ျဖင့္ Rotate လုပ္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပ

ေပးထားပါသည္။

၁) Ribbon, Home tab > Modify panel > Rotate ကုိ click လိုက္ပါ။

၂) Rotate လုပ္မည့္ Object မ်ားကို select လုပ္ျပီး Enter ႏိွပ္ပါ။

၃) Objectကုိ Rotate လုပ္ရန္ base point သတ္မွတ္ေပးလိုက္ပါ။ Object သည္ထုိ base point အနီးတြင္ Rotate

လုပ္ႏိုင္မည္ကုိ ေတြ႕ရမည္။

၄) Cursor ကုိလွည့္ျပီး (သို႕မဟုတ္) angle တန္ဖိုးရိုက္ထည့္ျပီး rotate angle ကိုသတ္မွတ္ေပးႏိုင္ ပါသည္။

Procedure: Rotating Objects Using Grips

Drawing အတြင္းမွ Objects မ်ားကုိ Grip ျဖင့္ Rotate လုပ္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပ ေပးထားပါသည္။
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 Grip activate ျဖစ္ေအာင္ မိမိတို႕ rotate လုပ္လုိေသာ Object ကို select လိုက္ပါ။

 Grip (color box) ကုိ click လိုက္ပါက Edit mode သည္လည္း activated ျဖစ္သြားမည္ ျဖစ္သည္။ ထို

click လိုက္ေသာ အမွတ္သည္ Rotate လုပ္ရန္ base point ျဖစ္သြားမည္ ျဖစ္သည္။

 Drawing area ၏ တစ္ေနရာရာတြင္ Right – click ႏိွပ္ျပီး Rotate ကို select ပါ။

 Rotate လုပ္ရန္အတြက္ angle ကိုသတ္မွတ္ေပးလုိက္ပါ။

Practice Exercise: Rotate Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ rectangle တစ္ခုကုိ ေရးဆြဲျပီး၊ ထို rectangle ကုိ grip နဲ႕ Rotate command မ်ားကို

အသုံးျပဳျပီး rotate လုပ္ျခင္းကုိ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

၁) Rectangle တစ္ခုကို ေရးဆြဲလိုက္ပါ။ ( သင့္ေတာ္ေသာ အရြယ္အစား)

၂) Object ကုိ grip အသံုးျပဳျပီး rotate လုပ္ရန္ -

 Object ကုိ select လုပ္ပါ။ ( command line သည္ blank အေနထား ျဖစ္ရပါမည္။)

 Grip တစ္ခုကို select လိုက္ပါ။

 Active ျဖစ္ေနေသာ grip ေပၚတြင္ Right – click ႏိွပ္ျပီး၊ Rotate ကုိ select လိုက္ပါ။
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 Selected ထားေသာ grip point ကုိအေျခတည္ျပီး၊ ထို အနီးနားတြင္ Object ကို mouse ျဖင့္လွည့္ ႏိုင္မည္

ျဖစ္သည္။

 မိမိတုိ႕ လုိခ်င္ေသာ angle ျဖစ္ေအာင္ လွည့္ျပီး drawing window တြင္ click လိုက္ပါ။

 Grip deactivate ျဖစ္ေအာင္ Esc key ႏိွပ္လိုက္ပါ။

၃) Object ကုိ Rotate command အသံုးျပဳျပီး rotate လုပ္ရန္ -

 Ribbon, Home tab > Modify panel > Rotate ကို click လုိက္ပါ။

 Select object prompt လွ်င္ rectangle ကို select လိုက္ပါ။

 Specify base point prompt လွ်င္ ဘယ္ဖက္ေအာက္ေထာင့္ကုိ base point အျဖစ္သတ္မွတ္ ေပးလိုက္ပါ။

 Rotate angle အတြက္ 10 ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္လုိက္ပါ။

 Rectangle သည္ နာရီလက္တံ ေျပာင္းျပန္လမ္းေၾကာင္း အတုိင္ 10 ဒီဂရီ တိမ္းေစာင္းသြားသည္ကုိ ေတြ႕ရ

မည္ျဖစ္သည္။
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၄) Reference option ကုိအသံုးျပဳျပီး Rectangle ကုိ 0 ဒီဂရီ အေနအထားသုိ႕ ျပန္ေရာက္ေစရန္ Rotate

လုပ္ရန္ -

 Ribbon, Home tab > Modify panel > Rotate ကို click လုိက္ပါ။

 Select object prompt လွ်င္ rectangle ကို select လိုက္ပါ။

 ဘယ္ဖက္ေအာက္ေထာင့္ကုိ base point အျဖစ္သတ္မွတ္ လုိက္ပါ။

 Right – click ႏိွပ္ျပီး Reference ကုိ click လိုက္ပါ။

၅) ေအာက္တြင္ ေဖာ္ျပထားသည့္ အတုိင္း Reference angle ကုိ point သတ္မွတ္ေပးရန္ -

 ဘယ္ဖက္ေအာက္ေထာင့္ မွ Endpoint (1) ကို click ပါ။

 Second point သတ္မွတ္ေပးရန္ Endpoint (2) ကို click ပါ။

 Angle အသစ္သတ္မွတ္ေပးရန္ 0 ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။
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၆) ထိုအခါ Rectangle သည္ အတည့္ျပန္ျဖစ္သြား ပါလိမ္႕မည္။

Exercise: Rotate Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Rotate command ၏ default option အေနျဖင့္ လည္းေကာင္း၊ Reference Option

အေနျဖင့္လည္းေကာင္း၊ Copy option အေနျဖင့္ လည္းေကာင္း Objects မ်ားကို Rotate လုပ္ျခင္းကို ေလ့က်င့္သြားရမည္

ျဖစ္သည္။ ေလ့က်င့္ျခင္း ျပီးစီးသြားပါက အျခားေသာ drawing မ်ားလည္း လက္ေတြ႕ အသုံး ခ်တတ္သြား ႏုိင္မည္

ျဖစ္သည္။

၁) C_Rotate-Objects.dwg ကိုဖြင့္လုိက္ပါ။

၂) ကြန္ပ်ဴတာကုိ Rotate လုပ္ရန္ -

 Rotate command ကိုလိုက္ပါ။

 ကြန္ပ်ဴတာ Object ကို select ျပီး Enter ႏိွပ္လိုက္ပါ။

 Drawing area ထမွဲာ Right – click ႏိွပ္ျပီး Insert ကုိ click လိုက္ပါ။
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 Insert Object Snap အမွတ္ေပၚလာေစရန္ ကြန္ပ်ဴတာ block ကုိ cursor ျဖင့္ထိလိုက္ပါ။ အမွတ္ကုိ ေတြ႕လွ်င္

select လုိက္ပါ။

၃) ကြန္ပ်ဴတာ block ကုိ ကုလားထိုင္ျဖင့္ မ်က္နွာခ်င္းဆုိင္ အေနထားသို႕ လွည့္ရန္ -

 Polar setting ကုိဖြင့္ လိုက္ပါ။

 Polarsnap တြင္ 315 ဒီဂရီ ျပသည္အထိ cursor ကို နာရီလက္တံ လမ္းေၾကာင္း အတိုင္းလွည့္လိုက္ပါ။

 မ်က္ႏွာခ်င္းဆုိင္ အေနထားသို႕ ေရာက္လွ်င္ point သတ္မွတ္ေပးလိုက္ပါ။

၄) ကုလားထိုင္းကုိ select ရန္ -

 Ribbon, Home tab > Modify panel > Rotate ကို click လုိက္ပါ။

 စားပြဲခုံအထက္ အရပ္တြင္ ရိွေသာ ကုလားထိုင္ကုိ click လိုက္ပါ။

 Drawing area ထမွဲာ Right – click ႏိွပ္ျပီး Insert ကုိ click လိုက္ပါ။

 Insert Object Snap အမွတ္ေပၚလာေစရန္ ကုလားထုိင္ ကုိ cursor ျဖင့္ထိလုိက္ပါ။ အမွတ္ကုိ ေတြ႕လွ်င္ select

လိုက္ပါ။
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၅) ကုလားထိုင္ကုိ စားပြဲႏွင့္ မ်က္ႏွာခ်င္းဆုိင္ အေနထားသုိ႕ လွည့္ရန္ -

- 90 ဟုရိုက္ထည့္လိုက္ပါ။

 ကုလားထိုင္ကုိ နာရီလက္တံ ေျပာင္းျပန္လမ္းေၾကာင္း အတုိင္း 90 ဒီဂရီလမ္းေၾကာင္း အတုိင္း လွည့္သြားေစရန္

Enter ႏိွပ္လိုက္ပါ။

 ကုလားထိုင္သည္ စားပြဲခုံျဖင့္ မ်က္ႏွာခ်င္းဆုိင္ အေနထားသုိ႕ ေရာက္သြားေပလိမ္႕မည္။

၆) ကုလားထိုင္ႏွင့္ base point ကို select ရန္ -

 Rotate command ကိုျပန္ေခၚရန္ Enter နိွပ္လိုက္ပါ။

 ကုလားထိုင္ object ကို select ျပီးေနာက္ စားပြဲ၀ိုင္းကုိ ေအာက္ပါပုံတြင္ ျပထားသည့္ အတုိင္း click လိုက္ပါ။

၇) Reference option အသုံးျပဳျပီး ကုလားထုိင္ကို စားပြဲအနီးတြင္ Rotate လုပ္ရန္ -

 Drawing area ထမွဲာ Right – click ႏိွပ္ျပီး Reference ကုိ click လိုက္ပါ။

 Reference angle သတ္မွတ္ရန္ အတြက္ စားပြ၀ိုဲင္း၏ Center ကုလားထုိင္၏ Midpoint တုိ႕ကုိ select လုိက္ပါ။

 90 ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။
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၈) စားပြဲအနီးတြင္ ကုလားထိုင္ Rotate လုပ္ေနစဥ္ ကုလားထိုင္ကုိ Copy လုပ္ရန္ -

 Command line တြင္ RO ဟုရိုက္ျပီး Enter ႏိွပ္ပါ။

 ကုလားထိုင္ Object ကုိ select လုပ္ျပီး Enter ႏိွပ္ပါ။

 Base point အျဖစ္သတ္မွတ္ရန္ စားပြဲ၀ိုင္း၏ Center ကုိ click လိုက္ပါ။

 Drawing area ထမွဲာ Right – click ႏိွပ္ျပီး Copy ကုိ click လိုက္ပါ။

 Polar angle တြင္ 90 ဒီဂရီ ျပသည္အထိ Cursor ကုိလွည့္ျပီး point သတ္မွတ္ေပးရန္ click လိုက္ပါ။

 Copy လုပ္ေသာ ကုလားထိုင္ Rotated ျဖစ္သြားမည္။

၉) စားပြဲ၀ိုင္းအနီးတြင္ ကုလားထုိင္ ေလးလုံးျဖစ္သြားေအာင္ လက္ရိွ ကုလားထုိင္ နွစ္လုံးလုံးကို Copy option ျဖင့္ Rotate

လုပ္ရန္ -

 Rotate command ကို ျပန္ေခၚရန္ Enter ႏိွပ္ပါ။

 ကုလားထိုင္ နွစ္လုံးလုံးကို select ျပီး Enter ႏိွပ္ပါ။

 Base point အျဖစ္သတ္မွတ္ရန္ စားပြဲ၀ိုင္း၏ Center ကုိ click လိုက္ပါ။

 Drawing area ထမွဲာ Right – click ႏိွပ္ျပီးCopy ကို click လုိက္ပါ။

 Polar angle တြင္ 180 ဒီဂရီ ျပသည္အထိ Cursor ကုိလွည့္ျပီး point သတ္မွတ္ေပးရန္ click လိုက္ပါ။
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၁၀) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Creating a Mirror Image of Existing Objects

ဤသင္ခန္းစာတြင္ Drawings မ်ားတြင္ ေရးဆြဲျပီးထားေသာ Objects မ်ားကို Mirror လုပ္ျခင္းကုိ ေလ့လာသြား

ရမည္ျဖစ္သည္။ Mirror သည္မိမိတို႕ ဖန္တီးေနေသာ designs မ်ားတြင္ Objects မ်ားကို နွစ္ဖက္ညီျဖစ္သြားေစရန္

ေျပာင္းျပန္လွည့္ရန္ အေကာင္းဆံုး အကူအညီ ေပးႏိုင္ပါသည္။ ေအာက္ပါပုံတြင္ ေဖာ္ျပေပးထားေသာ နွစ္ဖက္ညီ floor

plans ေရးဆြဲရာတြင္ တစ္ဖက္ကိုသာ ေရးဆြဲျပီး Mirror အကူအညီျဖင့္ ျပန္းေျပာင္လွည့္ လိုက္ပါက နွစ္ဖက္ညီ ပုံစံကို

အခ်ိန္ကုန္သက္သာျပီး လြယ္ကူလ်င္ျမန္စြာ ေရးဆြျဲပီးသား ျဖစ္သြားလိမ္႕မည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -
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 Drawing အတြင္းမွ Objects မ်ားကုိ Mirro command (သုိ႕မဟုတ္) Grip ျဖင့္ ကူးယူျခင္းကုိ နားလည္

သေဘာေပါက္ လာေစရန္။

Mirroring Objects

Mirror command ကိုအသံုးျပဳ၍ Objects မ်ားကို Drawing အတြင္း နွစ္ဖက္ညီျမင္ကြင္း အသြင္ျဖင့္ ၾကည့္ႏိုင္

ေအာင္ျပဳလုပ္ႏိုင္ပါသည္။ Mirror command ကိုေခၚျပီးသည္ႏွင့္ Mirror လုပ္မည့္ Object ကိုေရြးခ်ယ္ခိုင္းျပီး၊ mirror

line ကုိပါ သတ္မွတ္ခိုင္းပါလိမ္႕မည္။ Mirror line ဆုိသည္မွာ selected ထားျပီးေသာ Object ကုိ mirror လုပ္ရန္

အေျခတည္မ်ဥ္း သတ္မွတ္ျခင္း ျဖစ္ပါသည္။ Mirror line သတ္မွတ္ေပးျပီးပါက မူရင္း Object ကို Erase လုပ္မလား/

မလုပ္ဘူးလား ဆုိသည္ကုိ ေမးလာပါလိမ္႕မည္။ လုပ္လိုပါက (Y)၊ မလုပ္လိုပါက (N) ဟုရိုက္ထည့္ေပးလိုက္ပါ။ Grip

ျဖင့္လည္း Mirror command ကုိ ထိန္းခ်ဳပ္သြားႏိုင္ပါသည္။

Mirror သည္ Objects အမ်ိဳးအစား ေရြးျပီး အလုပ္လုပ္ခ်င္းမ်ိဳး မဟုတ္ေသာေၾကာင့္ Objects တုိင္းကို Mirror ျဖင့္

အလုပ္လုပ္ႏိုင္ပါသည္။

Command Access

Mirror

Command Line: MIRROR, MI

Ribbon: Home tab > Modify panel > Mirror
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Menu Bar: Modify > Mirror

Mirroring Text

Mirror action တြင္ Object ေပၚမွ စာလံုးမ်ားကိုပါ ေျပာင္းျပန္ လုပ္ခ်င္လွ်င္ Mirrortext အတြက္ system variable

ေျပာင္းေပးရပါသည္။ မူရင္း system variable မွာ 0 ျဖစ္ျပီး၊ ထုိမူရင္း အေျခအေနတြင္ Text မ်ားကုိ ေျပာင္းျပန္

လုပ္၍မရေပ။ Text မ်ားကိုပါ ေျပာင္းျပန္ လုပ္လိုလွ်င္ MIRRTEXT ၏ system variable ကို 1 ေျပာင္းေပး ရပါမည္။

Procedure: Mirroring Objects

MIRRTEXT ၏ system variable 0 ျဖင့္ Mirror လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ ေလ့လာ

ၾကည့္ပါ။

၁) Mirror command ကုိေခၚလုိက္ပါ။

၂) Mirror လုပ္မည့္ Object ကုိ select ျပီး Enter ႏိွပ္လုိက္ပါ။

၃) Mirror line သတ္မွတ္ရန္ အမွတ္ႏွစ္မွတ္ သတ္မွတ္ေပးလုိက္ပါ။
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၄) မူရင္း Object ကို Erase လိုလွ်င္ Y ဟုရိုက္ထည့္ျပီး၊ Erase မလုပ္လိုလွ်င္ N ဟုရိုက္ထည့္လိုက္ပါ။ System variable 0

ျဖစ္ေသာေၾကာင့္ Text အေနအထား ေျပာင္းသြားမည္ မဟုတ္ေပ။

Procedure: Mirroring Text

MIRRTEXT ၏system variable 1 ျဖင့္ Mirror လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ ေလ့လာ

ၾကည့္ပါ။

၁) MIRRTEXT ၏ system variable 1 ေျပာင္းျပီး MIRRTEXT ကို ON ရန္ -

 Command line တြင္ MIRRTEXT ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 ျပီးလွ်င္ variable တန္ဖိုးအတြက္ 1 ဟုရိုက္ထည့္ေပး လိုက္ပါ။

၂) Mirror command ကုိေခၚလုိက္ပါ။

၃) Mirror လုပ္မည့္ Object ကုိ select လိုက္ပါ။
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၄) Mirror line အတြက္ အမွတ္ႏွစ္မွတ္ကုိ သတ္ကုိသတ္မွတ္ေပးလိုက္ပါ။

၅) မူရင္း Object ကို Erase လုိလွ်င္ Y ဟုရိုက္ထည့္ျပီး၊ Erase မလုပ္လုိလွ်င္ N ဟုရိုက္ထည့္လုိက္ပါ။

Procedure: Mirroring Objects Using Grips

ေအာက္တြင္ Objects မ်ားကုိ Grip အသံုးျပဳျပီး Mirror လုပ္ပုံ အဆင့္ဆင့္ကုိ ေဖာ္ျပေပးထားပါသည္။

၁) Grip activate ျဖစ္ရန္ Mirror လုပ္မည့္ Object ကုိ click လိုက္ပါ။

၂) Grip (color box) ကုိ click လိုက္ပါက Edit mode သည္လည္း activated ျဖစ္သြားမည္ ျဖစ္သည္။ ထို click လုိက္ေသာ

အမွတ္သည္ Mirror line အတြက္ first point ျဖစ္သြားမည္ ျဖစ္သည္။

၃) Drawing area ၏ တစ္ေနရာရာတြင္ Right–click ႏိွပ္ျပီး Mirror ကို select ပါ။

၄) Mirror line သတ္မွတ္ရန္ အတြက္ Mouse ကိုေရြ႕လိုက္ပါ။ ျပီးလွ်င္ အမွတ္တစ္မွတ္ သတ္မွတ္ေပးလိုက္ပါ။
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Practice Exercise: Mirror Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Objects မ်ားကို Mirror command ႏွင့္ grip အသုံးျပဳျပီး Mirror လုပ္ျခင္း ေလ့

က်င့္ခန္းမ်ားကုိ လက္ေတြ႕လုိက္ပါ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ ပထမဆုံး အေနနဲ႕ ေအာက္တြင္ ေဖာ္ျပေပး ထားေသာ

ပုံအတိုင္း Mirror လုပ္ရန္ ေရးဆြဲလိုက္ပါ။

၁) Command line အသံုးျပ၍ အထက္ပါ ပုံအတုိင္းေရးဆြဲလိုက္ပါ။

၂) Object ကုိ Mirror လုပ္ရန္ -

 Ribbon, Home tab > Modify panel > Mirror ကုိ click လိုက္ပါ။

 Mirror လုပ္မည့္ Object ကုိ select ျပီး Enter ႏိွပ္ပါ။

 Mirror line အတြက္ First point သတ္မွတ္ေပးလိုက္ပါ။

 ျပီးေနာက္ Mirror line အတြက္ Second point သတ္မွတ္ေပးလိုက္ပါ။
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 မူရင္းObject ကုိ Erase မလုပ္လို ေသာေၾကာင့္ Default ျဖစ္ေသာ <N> ကုိပဲေရြးခ်ယ္ရန္ Enter ႏိွပ္လုိက္ပါ။

၃)Mirror လုပ္ထားေသာ ပုံကို Zoom In လုပ္လိုက္ပါ။ ထုိ Object ကို grip သံုးျပီး Mirror လုပ္ရန္ -

 Object ကုိ select လုပ္ပါ။ ( command line သည္ blank အေနထား ျဖစ္ရပါမည္။)

 ေအာက္ပါပုံ၌ (1) ျပထားေသာ grip ေပၚတြင္ Right – click ႏိွပ္ပါ။ Mirror (2)ကုိ click လိုက္ပါ။

 Right–click ထပ္တစ္ၾကိမ္ click ျပီး Copy (3) ကုိ click လိုက္ပါ။

၄) Object ကုိ Mirror လုပ္ရန္ base point ကို ေျပာင္းလရဲန္ -

 Grip ေပၚတြင္ Right–click ႏိွပ္ပါ။ Basepoint ကုိ click ပါ။
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၅) ေအာက္ပါပုံတြင္ ျပထားသည့္အတုိင္း Object ကုိ Mirror လုပ္ရန္ Mirror line အတြက္ First point န႕ဲ Second

point သတ္မွတ္ေပးလုိက္ပါ။

၆) Command ကုိျပီးေျမာက္ သြားေစရန္ Enter ႏိွပ္လိုက္ပါ။ Selected ထားေသာ Objects မ်ားကုိ Deselect ျဖစ္ေစရန္

Esc ႏိွပ္လုိက္ပါ။
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Exercise: Mirror Objects in the Drawing

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Mirror command ကုိအသုံးျပဳျပီး Drawing အတြင္းမွ geomentry ကိုႏွစ္ဖက္ညီ ပုံတူ

အျဖစ္ တစ္ဖက္သုိ႕ လွည့္ရမည့္ ေလ့က်င့္ခန္းကုိ လက္ေတြ႕ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ ေအာက္တြင္ ေဖာ္ျပထားေသာ

ပုံအတြင္းမွ Object တစ္ခုကုိ Erase လုပ္ျပီး Mirror command ကုိ ေလ့က်င့္သြားၾကည့္ပါ။

၁) M_Mirror-Object.dwg ကိုဖြင့္လုိက္ပါ။

၂) Mirror လုပ္မည့္ Object ကုိ select ရန္ -

 Ribbon, Home tab > Modify panel > Mirror ကုိ click လိုက္ပါ။

 Command line တြင္ wp ဟုရိုက္ျပီး Enter ႏိွပ္လုိက္ပါ။

 ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံအတိုင္း Window polygon ျဖင့္ Object ကုိ click လုိက္ပါ။ Object အနီး

လြတ္ေနေသာ ေနရာမ်ိဳးကုိ (1) မွ (4) အထိ click သြားလုိက္ပါ။
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 Object ကုိ selection window ျဖင့္ selected ျပီးသြားပါက Enter ႏိွပ္လိုက္ပါ။

 Object ကုိ selection လုပ္ျခင္း ျပီးစီးေအာင္ Enter ထပ္တစ္ၾကိမ္ ႏိွပ္လုိက္ပါ။

၃) Mirror line အတြက္ First point သတ္မွတ္ရန္ Circle line ၏ End point ကုိ click လုိက္ပါ။

၄) Cursor ကုိ First point အျဖစ္ သတ္မွတ္ထားေသာ ေနရာ၏ အထက္သို႕ drag လုပ္ရန္ -

 Polar tarcking တြင္ 90 ဒီဂရီျပသည္အထိ Cursor ကို drag လုပ္ပါ။

 Right – click ႏိွပ္ျပီး၊ မူရင္း Object ကုိထားရန္ shortcut menu မွ No ကို select လိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

236

၅) Files အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။

Lesson: Creating Object Patterns

ဤသင္ခန္းစာတြင္ Array command ကုိအသုံးျပဳျပီး Objects မ်ားကို X,Y coordinate အတိုင္း ပုံတူပြားျခင္း Rectangle

Array နဲ႕ Center point တစ္မွတ္မွ စက္၀ိုင္းသ႑ာန္ ပုံတူပြားျခင္း Circular Array စသည္တုိ႕ကုိ ေလ့လာသြား ရမည္

ျဖစ္သည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ Circular Array(Polar) ႏွင့္ Rectangle Array ကုိေလ့လာၾကည့္ပါ။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -
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 Drawing အတြင္းမွ Objects မ်ားကုိ အေရအတြက္ အေျမာက္အျမားကုိ တစ္ျပိဳင္ ပြားျခင္းကို နားလည္ လာေစရန္။

Creating an Array of Objects

Array command ကုိအသံုးျပဳျပီး Objects မ်ားကုိ Rectangle Array နဲ႕ Circular Array(Polar) ပုံစံတုိ႕ျဖင့္ ပြားျခင္းကို

ေလ့လာသြားရမည္ ျဖစ္သည္။ အသုံးျပဳမည့္ array အမ်ိဳးအစားကုိ Array dialog box ေရြးခ်ယ္ႏိုင္ပါသည္။

Rectangular (သို႕မဟုတ္) Polar option ကို select ျပီး၊ ပြားမည့္ အေရအတြက္၊ အကြာအေ၀းနွင့္ အမွတ္မ်ား

ကုိေရြးခ်ယ္သြားရမည္ ျဖစ္သည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ Rectangle Array နဲ႕ Circular Array(Polar) ပုံကို

ေလ့လာၾကည့္ပါ။

Command Access

array

Command Line: ARRAY, AR

Ribbon: Home tab > Modify panel > Array

မွတ္ခ်က္။ ။ 3D array command ျဖင့္ မေရာေထြးပါေစနွင့္။
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Menu Browser: Modify > Array

Array Dialog Box: Rectangular Array

Array လုပ္မည့္ Object ကို select ရန္ click ပါ။

Array လုပ္မည့္ Row အေရအတြက္ သတ္မွတ္ရန္။ (ေရျပင္ညီအတုိင္း ပုံေဖာ္ရန္)

Array လုပ္မည့္ Column အေရအတြက္ သတ္မွတ္ရန္။ (ေဒါင္လိုက္အတုိင္း ပုံေဖာ္ရန္)

Array လုပ္ထားေသာ Row မွ Objects တစ္ခုနွင့္တစ္ခု၏ အကြာအေ၀း။

Array လုပ္ထားေသာ Column မွ Objects တစ္ခုနွင့္တစ္ခု၏ အကြာအေ၀း။

ပုံေဖာ္ရန္ အတြက္ angle တန္ဖိုး။

လုပ္ထားေသာ Array ကိုအတည္မျပဳခင္ အစမ္းသေဘာ ၾကည့္သည္။ အထက္ပါ အခ်က္မ်ားကုိ select မလုပ္ေသးပါက

Preview ၾကည့္၍ ရမည္ မဟုတ္ေပ။

Array Dialog Box: Polar Array
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Array လုပ္မည့္ Object ကုိ select ရန္ click ပါ။

Center point အတြက္ coordinate အမွတ္ကုိ X,Y တြင္ ရိုက္ထည့္ေပးရသည္။ (သုိ႕မဟုတ္) Select Point icon ကို

clickျပီး drawing area ထဲတြင္ center point သတ္မွတ္ရန္ ႏွစ္သက္ရာ ေနရာကို click ပါ။

Polar array အတြက္ တြက္ခ်က္ရမည့္ နည္းလမ္းကို ေရြးခ်ယ္ပါ။

 Total number of items and angle to fill. ( ပြားမည့္အေရအတြက္နွင့္ ေထာင့္တန္ဖိုး)

 Total number of items and angle between items .(ပြားမည့္အေရအတြက္ ႏွင့္ ပြားမည့္ အရာ၀တၳဳတုိ႕

အၾကား တြင္ေထာင့္သတ္မွတ္ရန္ )

 Angle to fill and angle between items.(ေထာင့္တန္ဖိုးနွင့္ အရာ၀တၳဳတုိ႕ အၾကား တြင္ေထာင့္သတ္မွတ္ရန္)

Array လုပ္မည့္ အရာ၀တၳဳအေရအတြက္။ မူရင္း အရာ၀တၳဳပါ ထည့္တြက္ရမည္။

Array အတြက္ angle တန္ဖိုး ထည့္ရန္။ အႏုတ္တန္ဖိုး ျဖစ္ပါက Array သည္ နာရီလက္တံတုိင္း သြားမည္ ျဖစ္သည္။

Array ထဲမွ Objects မ်ားတစ္ခုခ်င္းစီ rotate လုပ္ခ်င္လွ်င္ select ေပးရမည္။

Procedure: Creating a Rectangular Array of Objects

Rectangular Array ျပဳလုပ္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, Home tab > Modify Panel > Array ကုိclick ပါ။

၂) Array dialog box တြင္ Rectangle option ကုိ click ပါ။ Select Objects Icon ကိုႏိွပ္ျပီး၊ Array လုပ္မည့္ Object ကို

select လုပ္ပါ။
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၃) Row နဲ႕ column ၏အေရအတြက္ကို ရိုက္ထည့္ပါ (သုိ႕မဟုတ္) Pick Offset ကုိ click ျပီး Row န႕ဲ column တုိ႕၏

Offset တန္ဖိုးကို သတ္မွတ္ေပးပါ။

၄) Array အတြက္ angle လုိအပ္ရင္ ထည့္ေပးပါ။

၅) မိမိတုိ႕ သတ္မွတ္ထားေသာ Array ကုိ မိမိတို႕ လုိခ်င္ေသာ ပုံစံမ်ိဳးျဖစ္ မျဖစ္ အစမ္းသေဘာၾကည့္ရန္ Preview ကို

click ျပီး ၾကည့္ႏိုင္ပါသည္။

၆) Preview ကို click ျပီး စိတ္ၾကိဳက္ျဖစ္ျပီဆိုလွ်င္ Enter ႏိွပ္ျပီး အတည္ျပဳႏိုင္ပါသည္။ (သုိ႕မဟုတ္) စိတ္တိုင္း

မက်ေသးလွ်င္ Esc key ကုိႏိွပ္ျပီး Array dialog box ဆီသုိ႕ျပန္သြားႏိုင္ပါသည္။

Procedure: Creating a Polar Array of Objects

Polar array ျပဳလုပ္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, Home tab > Modify Panel > Array ကုိclick ပါ။

၂) Array dialog box တြင္ Polar option ကို click ပါ။ Select Objects Icon ကိုႏိွပ္ျပီး၊ Array လုပ္မည့္ Object ကုိ select

လုပ္ပါ။
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၃) Center point အတြက္ coordinate အမွတ္ကုိ X,Y တြင္ ရိုက္ထည့္ေပးရသည္။ (သုိ႕မဟုတ္) Select Point icon ကို

clickျပီး drawing area ထဲတြင္ center point သတ္မွတ္ရန္ ႏွစ္သက္ရာ ေနရာကို click ပါ။

၄) Method list ထဲတြင္ array လုပ္ရာတြင္ အသံုးျပဳမည့္ နည္းလမ္းကုိ ေရြးခ်ယ္ပါ။

၅) မိမိတို႕ ေရြးခ်ယ္ခ႕ဲေသာ နည္းလမ္းအလိုက္ ျဖည့္စြက္ေပးရမည့္ တန္ဖိုးမ်ားကို ျဖည့္စြက္ေပးပါ။

၆) မိမိတုိ႕ သတ္မွတ္ထားေသာ Array ကုိ မိမိတို႕ လုိခ်င္ေသာ ပုံစံမ်ိဳးျဖစ္ မျဖစ္ အစမ္းသေဘာၾကည့္ရန္ Preview ကို

click ျပီး ၾကည့္ႏိုင္ပါသည္။

၇) Preview ကို click ျပီး စိတ္ၾကိဳက္ျဖစ္ျပီဆိုလွ်င္ Enter ႏိွပ္ျပီး အတည္ျပဳႏိုင္ပါသည္။ (သုိ႕မဟုတ္ ) စိတ္တိုင္း

မက်ေသးလွ်င္ Esc key ကုိႏိွပ္ျပီး Array dialog box ဆီသုိ႕ျပန္သြားႏိုင္ပါသည္။

Practice Exercise: Creating an Array of Objects

ဤသင္ခန္းစာတြင္ Rectangle နဲ႕ Polar array options တို႕ကို အသံုးျပဳျပီး 1x1 Rectangle ကုိ Array လုပ္ျခင္းကို

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။
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၁) Rectangle ကုိ ေရးဆြဲရန္ -

 Rectangle command ကိုစတင္လိုက္ပါ။

 Drawing window တြင္ First corner အတြက္ select လုိက္ပါ။

 ေနာက္ corner အတြက္ D ဟုရိုက္ျပီး Enter ႏိွပ္လုိက္ပါ။

 Length အတြက္ 1 ႏွင့္ width အတြက္ 1 ဟုရိုက္ထည့္လိုက္ပါ။

 Rectangle ကိုေနရာသတ္မွတ္ေပးရန္ click လိုက္ပါ။

၂) Polar array ျပဳလုပ္ရန္ -

 Ribbon, Home tab > Modify Panel > Array ကုိclick ပါ။

 Array dialog box တြင္ Polar array (1) ကုိ click လိုက္ပါ။

 Select Objects Icon(2) ကိုႏိွပ္ျပီး၊ Rectangle ကို click ကာ Array dialog box သုိ႕ ျပန္လည္ရန္ Enter ႏိွပ္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

243

 Center point button (3) ကို click ကာ၊ polar object snap tracking ကုိအသံုးျပဳျပီး Rectangle ၏

Midpoint ေအာက္ 2 Units အကြာတြင္ ပုံတြင္ ျပထားသည့္ အတုိင္း click လိုက္ပါ။

 Total number of items (4) ေနရာတြင္ 6 ဟုရိုက္ထည့္လုိက္ပါ။

 Angle to fill (5) ေနရာတြင္ 360 ဟုရိုက္ထည့္လိုက္ပါ။

 Ok (6) ကုိ Click လိုက္ပါ။

 ေအာက္တြင္ ျပထားသည့္ ပုံအတိုင္း ျဖစ္ေအာင္ Zoomကုိ ျပင္လိုက္ပါ။

၃) Rectangular array ျပဳလုပ္ရန္ -

 1x1 Rectangle ကို ထပ္မံေရးဆြဲလုိက္ပါ။

 Ribbon, Home tab > Modify Panel > Array ကုိclick ပါ။
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 Array dialog box တြင္ Rectangular array (1)ကုိ click လိုက္ပါ။

 Select Objects Icon(2) ကိုႏိွပ္ျပီး၊ Rectangle ကို click ကာ Array dialog box သုိ႕ ျပန္လည္ရန္ Enter ႏိွပ္ပါ။

 Rows (3) နဲ႕ Columns (4) ေနရာတြင္ 12 ဟုရိုက္ထည့္လုိက္ပါ။

 Row offset (5) န႕ဲ Column offset (6) တြင္ 2 ဟုရိုက္ထည့္လိုက္ပါ။

 OK (7) ကုိ Click လုိက္ပါ။

 ေအာက္တြင္ ျပထားသည့္ ပုံအတိုင္း ျဖစ္ေအာင္ Zoom ကိုျပင္လိုက္ပါ။

Exercise: Array Objects in the Drawing

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ office floor plan တြင္ရိွေသာ ပရိေဘာဂ မ်ားကို polar န႕ဲ rectangular arrays တုိ႕ျဖင့္

ေရးဆြေဲလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။ ေလ့က်င့္ခန္းကို လုိက္ပါေလ့က်င့္မွဳ႕ ျပီးစီးသြားပါက Array ျဖင့္ အျခားေသာ

drawing မ်ားတြင္လည္း အသံုးခ်တတ္ လာမည္ျဖစ္သည္။

Exercise: Array Objects in the Drawing (Metric Units)
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၁) M_Creating-Arrays.dwg ကိုဖြင့္လုိက္ပါ။

၂) Polar array ျပဳလုပ္ေတာ႕မည္ ျဖစ္ေသာေၾကာင့္၊ ျပဳလုပ္မည့္ ေအာက္ပုံတြင္ ျပထားေသာ အပိုင္းကုိ Zoom ခ်ဲ႕ လုိက္ပါ။

၃) စားပြဲပတ္လည္တြင္ ကုလားထုိင္မ်ားကုိ array လုပ္ရန္ -

 Ribbon, Home tab > Modify Panel > Array ကုိclick ပါ။

 Array dialog box တြင္ Polar array (1)ကို click လုိက္ပါ။

 Select Objects Icon(2) ကိုႏိွပ္ျပီး၊ ကုလားထိုင္ကုိ select ပါ။

 Array dialog box သို႕ ျပန္လည္ရန္ Enter ႏိွပ္ပါ။
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 Center point button (3) ကို click ပါ။

 Object snap tracking ကုိအသုံးျပဳျပီး စားပြဲခုံ ၏ Center Point ကို click လုိက္ပါ။

 Total number of items (4) ေနရာတြင္ 6 ဟုရိုက္ထည့္လုိက္ပါ။

 Angle to fill (5) ေနရာတြင္ 360 ဟုရိုက္ထည့္လိုက္ပါ။

 Preview (6) ကုိ Click ျပီး အစမ္းသေဘာ ၾကည့္ၾကည့္လိုက္ပါ။

 Enter မႏိွပ္ပ၊ဲ Esc ႏိွပ္ကာ Array dialog box ဆီသုိ႕ ျပန္သြားလိုက္ပါ။

၄) Total number of items ကိုေျပာင္းရန္ -

 Array dialog box မွ Total number of items (4) ေနရာတြင္ 8 ဟုရိုက္ထည့္လိုက္ပါ။

 Polar array ကိုျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Ok ကို click လုိက္ပါ။

 ကုလားထိုင္ ၈လံုးသည္ စားပြဲေဘးတြင္ ေအာက္ပါပုံအတိုင္း ပတ္လည္၀ိုင္းေနမညက္ုိ ေတြ႕ရမည္။
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၅) ေအာက္ပုံတြင္ ျပထားေသာ ျမင္ကြင္းအတုိင္း ပုံကုိ Zoom ျဖင့္ခ်ဲ႕လိုက္ပါ။ ညာဖက္ေဘးမွ နံရံပါ ပါေအာင္ ခ်ဲ႕လိုက္ ပါ။

၆) Rectangular array ကုိအသံုးျပဳျပီးအထက္တြင္ ေဖာ္ျပေပးထားေသာ ရုံးခန္းတြင္းန႕ဲ ပရိေဘာဂမ်ားကို array လုပ္ရန္ -

 Ribbon, Home tab > Modify Panel > Array ကုိclick ပါ။

 Array dialog box တြင္ Rectangular array ကုိ click လိုက္ပါ။

 Select Objects Icon ကိုႏိွပ္လိုက္ပါ။

 ေအာက္ပါပုံတြင္ ျပထားသည့္အတိုင္း Objects မ်ားကုိ select လုပ္ျပီး Enter ႏိွပ္ပါ။

မွတ္ခ်က္။ ။ Objects မ်ားကုိ select ရန္အတြက္ crossing windows ျဖင့္ႏွစ္ခုခြျဲပီး select ပါ။
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၇) မိမိတို႕ နွစ္သက္ေသာ rows န႕ဲ columns အေရအတြက္ကုိ ထည့္ရန္ -

 Array dialog box တြင္ Rows အတြက္ 4 န႕ဲ Columns အတြက္ 2 ဟုရိုက္ထည့္လိုက္ပါ။

 Offset Distance and Direction ေအာက္မွ Both Offsets button ကိုႏိွပ္ပါ။

၈) ရံုးခန္း၏ အကန္႕ေလးကုိ offset အတြက္သတ္မွန္ရန္ -

 ဘယ္ဖက္ေအာက္ေထာင့္ အတြင္းနံရံမ်ဥ္း၏ Entpoint ကုိ click လိုက္ပါ။

 အျခားေထာင့္ အတြက္ ညာဖက္ အထက္နံရမ်ဥ္း၏ Endpoint ကို click လုိက္ပါ။

 Preview ကို click လုိက္ပါ။

 Rectangle သည္ ေအာက္တြင္ေဖာ္ျပေပးထားေသာ ပုံအတိုင္း ျဖစ္သြားမည္။

 Enter ကုိမႏိွပ္ေသးပါႏွင့္။

 Wheel Mouse ကိုအသံုးျပဳျပီး ပုံကို စစ္ေဆးၾကည့္ပါ။ စိတ္ၾကိဳက္မေတြ႕လွ်င္ Esc key ႏိွပ္ျပီး Array dialog box

သုိ႕ျပန္သြားကာ offset ကိုျပန္လည္ျပင္ဆင္ သတ္ႏိုင္ပါသည္။ (သုိ႕မဟုတ္) စိတ္ၾကိဳက္ ျဖစ္ျပီဆုိလွ်င္ Enter ႏိွပ္ျပီး

array ကုိအဆုံးသတ္ေပးလုိက္ပါ။

၉) Files အားလံုးကိုမ Save ပဲပိတ္လိုက္ပါ။
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Exercise: Array Objects in the Drawing (Imperial Units)

၁) I_Creating-Arrays.dwg ကိုဖြင့္လိုက္ပါ။

၂) Polar array ျပဳလုပ္ေတာ႕မည္ ျဖစ္ေသာေၾကာင့္၊ ျပဳလုပ္မည့္ ေအာက္ပုံတြင္ ျပထားေသာ အပိုင္းကုိ Zoom ခ်ဲ႕ လိုက္ပါ။

၃) စားပြဲပတ္လည္တြင္ ကုလားထုိင္မ်ားကုိ array လုပ္ရန္ -

 Ribbon, Home tab > Modify Panel > Array ကုိclick ပါ။

 Array dialog box တြင္ Polar array (1)ကို click လုိက္ပါ။

 Select Objects Icon(2) ကိုႏိွပ္ျပီး၊ ကုလားထိုင္ကုိ select ပါ။

 Array dialog box သို႕ ျပန္လည္ရန္ Enter ႏိွပ္ပါ။
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 Center point button (3) ကို click ပါ။

 Object snap tracking ကုိအသုံးျပဳျပီး စားပြဲခုံ ၏ Center Pointကုိ click လုိက္ပါ။

 Total number of items (4) ေနရာတြင္ 6 ဟုရိုက္ထည့္လုိက္ပါ။

 Angle to fill (5) ေနရာတြင္ 360 ဟုရိုက္ထည့္လိုက္ပါ။

 Preview (6) ကုိ Click ျပီး အစမ္းသေဘာ ၾကည့္ၾကည့္လိုက္ပါ။

 Enter မႏိွပ္ပ၊ဲ Esc ႏိွပ္ကာ Array dialog box ဆီသုိ႕ ျပန္သြားလိုက္ပါ။

၄) Total number of items ကိုေျပာင္းရန္ -

 Array dialog box မွ Total number of items (4) ေနရာတြင္ 8 ဟုရိုက္ထည့္လိုက္ပါ။

 Polar array ကိုျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Ok ကို click လုိက္ပါ။

 ကုလားထိုင္ ၈လံုးသည္ စားပြဲေဘးတြင္ ေအာက္ပါပုံအတိုင္း ပတ္လည္၀ိုင္းေနမည္ကို ေတြ႕ရမည္။
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၅) ေအာက္ပုံတြင္ ျပထားေသာ ျမင္ကြင္းအတုိင္း ပုံကုိ Zoom ျဖင့္ခ်ဲ႕လိုက္ပါ။ ညာဖက္ေဘးမွ နံရံပါ ပါေအာင္ ခ်ဲ႕လိုက္ ပါ။

၆) Rectangular array ကုိအသံုးျပဳျပီးအထက္တြင္ ေဖာ္ျပေပးထားေသာ ရုံးခန္းတြင္းန႕ဲ ပရိေဘာဂမ်ားကို array လုပ္ရန္ -

 Ribbon, Home tab > Modify Panel > Array ကုိclick ပါ။

 Array dialog box တြင္ Rectangular array ကုိ click လိုက္ပါ။

 Select Objects Iconကုိႏိွပ္လိုက္ပါ။

 ေအာက္ပါပုံတြင္ ျပထားသည့္အတိုင္း Objects မ်ားကုိ select လုပ္ျပီး Enter ႏိွပ္ပါ။

မွတ္ခ်က္။ ။ Objects မ်ားကုိ select ရန္အတြက္ crossing windows ျဖင့္ႏွစ္ခုခြျဲပီး select ပါ။

၇) မိမိတို႕ နွစ္သက္ေသာ rows န႕ဲ columns အေရအတြက္ကုိ ထည့္ရန္ -

 Array dialog box တြင္ Rows အတြက္ 4 န႕ဲ Columns အတြက္ 2 ဟုရိုက္ထည့္လိုက္ပါ။

 Offset Distance and Direction ေအာက္မွ Both Offsets button ကိုႏိွပ္ပါ။

၈) ရံုးခန္း၏ အကန္႕ေလးကုိ offset အတြက္သတ္မွန္ရန္ -
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 ဘယ္ဖက္ေအာက္ေထာင့္ အတြင္းနံရံမ်ဥ္း၏ Entpoint ကုိ click လိုက္ပါ။

 အျခားေထာင့္ အတြက္ ညာဖက္ အထက္နံရံမ်ဥ္း၏ Endpoint ကို click လုိက္ပါ။

 Preview ကို click လုိက္ပါ။

 Rectangle သည္ ေအာက္တြင္ေဖာ္ျပေပးထားေသာ ပုံအတိုင္း ျဖစ္သြားမည္။

 Enter ကုိ မႏိွပ္ေသးပါႏွင့္။

 Wheel Mouse ကိုအသံုးျပဳျပီး ပုံကို စစ္ေဆးၾကည့္ပါ။ စိတ္ၾကိဳက္မေတြ႕လွ်င္ Esc key ႏိွပ္ျပီး Array dialog box

သုိ႕ျပန္သြားကာ offset ကုိ ျပန္လည္ျပင္ဆင္ သတ္ႏိုင္ပါသည္။ (သုိ႕မဟုတ္) စိတ္ၾကိဳက္ ျဖစ္ျပီဆုိလွ်င္ Enter

ႏိွပ္ျပီး array ကိုအဆံုးသတ္ေပးလိုက္ပါ။

၉) File အားလံုးကို မSave ပပိဲတ္လိုက္ပါ။

Lesson: Changing an Object's Size

ဤသင္ခန္းစာတြင္ drawing ထဲမွ Objects မ်ားကုိ Scale command အသုံးျပဳျပီး Increase (သို႕မဟုတ္) Decrease

လုပ္ျခင္း အပိုင္းကို ေလ့လာသြားရမည္ ျဖစ္သည္။

Objective
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ဤသင္ခန္းစာကုိ ေလ့လာအျပီးတြင္ -

 Scale command (သို႕မဟုတ္) grips ကိုအသံုးျပဳျပီး drawing အတြင္းမွ Objects မ်ားကုိ Increase (သုိ႕မဟုတ္)

Decrease လုပ္ႏိုင္လာေစရန္။

Scaling Objects

ေရးဆြျဲပီးသား Drawing အတြင္းမွ Objects မ်ား၏ အရြယ္အစားကုိ ျပန္လည္ျပင္ဆင္လုိလွ်င္ Scale

command ကိုအသံုးျပဳျပီး လြယ္ကူလ်င္ျမန္စြာ ျပဳျပင္သြားနိုင္မည္ ျဖစ္သည္။ Scale command သည္ မိမိတို႕ selected

ထားေသာ Objects မ်ားကုိသာ ျပဳျပင္ႏိုင္မည္ ျဖစ္သည္။ Scaling ကို grips ကုိအသုံးျပဳ၍လည္း အသံုးျပဳႏိုင္ပါသည္။

Command Access

Scale

Command Line:

SCALE, SC

Ribbon: Home tab > Modify panel > Scale

မွတ္ခ်က္။ ။ 3D Scale command န႕ဲ မေရာေထြးပါေစနွင့္။

Menu Bar: Modify > Scale

Shortcut Menu: drawing အတြင္းမွ object ကုိ select ျပီး၊ Right – click ေထာက္ကာ shortcut menu မွ Scale .
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Procedure: Scaling Objects

Objects မ်ား၏ အရြယ္အစားကုိ Scale command ျဖင့္ ျပန္လည္ျပဳျပင္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး

ထားပါသည္။

၁) Ribbon,Home tab > Modify panel > Scale ကုိ click ပါ။

၂) Scaled လုပ္မည့္ Object ကုိ select ပါ။ Selection ျပီးဆုံးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၃) Base point သတ္မွတ္ေပးပါ။

၄) Scale factor ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

Procedure: Scaling Objects Using Grips

Objects မ်ား၏ အရြယ္အစားကို Grip အသုံးျပဳျပီး ျပန္လည္ျပဳျပင္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါသည္။

၁) Grip activate ျဖစ္သြားေအာင္ Object ကုိ select လုိက္ပါ။

၂) Grip (color box) ကုိ click လိုက္ပါက Edit mode သည္လည္း activated ျဖစ္သြားမည္ ျဖစ္သည္။ ထို click လုိက္ေသာ

အမွတ္သည္ base point ျဖစ္သြားမည္ ျဖစ္သည္။

၃) Drawing area တြင္ Right – click ႏိွပ္ျပီး Scale ကုိ select လုိက္ပါ။

၄) Scale factor ကုိသတ္မွတ္ပါမည္။
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Practice Exercise: Scaling Objects

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ ေရးဆြဲထားေသာ Object ကုိ Scale command ကုိ Reference option ျဖင့္ လည္းေကာင္း၊

grips ကုိ Copy option ျဖင့္လည္းေကာင္း ျပဳျပင္ျခင္းကို လက္ေတြ႕ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ Rectangle

ကုိေရးဆြဲျပီး၊ Scale ျဖင့္ အရြယ္အစား တစ္ခုကုိ ျပန္လည္ျပင္ဆင္ သတ္မွတ္သြားရမည္ျဖစ္ျပီး၊ ျပီးေနာက္ grips

ကုိအသံုးျပဳျပီး Scale နဲ႕ Copy ျပဳလုပ္သြားရမည္ ျဖစ္သည္။

၁) Rectangle တစ္ခုကို ေရးဆြဲရန္ (သင့္ေတာ္ေသာ အရြယ္အစား တစ္ခုခု) –

 Rectangle command ကိုစတင္လိုက္ပါ။

 First corner အတြက္ အမွတ္ တစ္ခု သတ္မွတ္ေပးလိုက္ပါ။

 ဆန္႕က်င္ဖက္ corner အတြက္ အမွတ္တစ္ခု သတ္မွတ္ေပးလုိက္ပါ။

၂) Rectangle ကုိ Reference option ျဖင့္ Scale လုပ္ရန္ -

 Ribbon,Home tab > Modify panel > Scale ကို click ပါ။

 Rectangle ကို select ျပီး Enter ႏိွပ္ပါ။

 Rectangle အနီးတြင္ basepoint သတ္မွတ္ေပးလိုက္ပါ။

 Right – click ႏိွပ္ျပီး Reference ကုိ select လိုက္ပါ။

 Reference length ကိုသတ္မွတ္ေပးရန္ ေအာက္ပါ ပုံတြင္ ျပထားသည့္ အတုိင္း object snap ျဖင့္ endpoints ကို

click လိုက္ပါ။
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 Length အသစ္သတ္မွတ္ေပးရန္ အတြက္ 2 ဟုရိုက္ျပီး Enter ႏိွပ္လိုက္ပါ။

၃) Rectangle ကိုမူလ အရြယ္အစားမွ .5 scale ၊ ျပီးေနာက္ .25 scale သုိ႕ grips ကို အသုံးျပဳျပီး scale နဲ႕copy

လုပ္သြားမည္ ျဖစ္သည္။ Basepoint အတြက္ rectangle ၏အလယ္ဗဟုိကုိ ေရြးခ်ယ္ရမည္ ျဖစ္သည္။

 Rectangle ကို select လုပ္ပါ။ ( command line သည္ blank အေနထားတြင္ ရိွေနရမည္။)

 Rectangle ၏ grip တစ္ခုခုတြက္ Right–click ႏိွပ္ျပီး Scale ကုိ select လုိက္ပါ။

 Object snap tracking ကုိအသုံးျပဳျပီး Rectangle၏ အလယ္ဗဟုိကို ေရြးကာ basepoint သတ္မွတ္ ေပးပါ။

၄) Scale factors သတ္မွတ္ေပးရန္ -

 .5 ရိုက္ထည့္ျပီး ENTER ႏိွပ္ပါ။

 .25 ရိုက္ထည့္ျပီး ENTER ႏိွပ္ပါ။

 Scale procedure ကို ျပီးဆံုးသြားေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။
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 Rectangle selection ကို ျပီးဆံုးသြားေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 ေနာက္ဆံုး ထြက္လာေသာ ပုံသည္ ေအာက္တြင္ ေဖာ္ျပထားသည့္ ပုံတိုင္း ျဖစ္ေနသည္ကုိ ေတြ႕ရမည္။

Exercise: Scale Objects Using the Copy Option

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Scale command မွ Copy option ကုိအသုံးျပဳျပီး၊ link-arm ကုိမူရင္း Object ပုံစံ အတိုင္း

မေျပာင္းလဲေစပဲ Copy လုပ္ရမည္။ ျပီးေနာက္ မူရင္း geomentry ႏွင့္ dimension မ်ားကုိ ေအာက္ေဖာ္ျပပါ ပုံတြင္

ျပထားသည့္အတုိင္း လွည့္ေပးရမည္။

၁) M_Scale-Copy.dwg ကုိဖြင့္ပါ။

၂) Ribbon,Home tab > Modify panel > Scale ကုိ click ပါ။

 Window select ျဖင့္ drawing အတြင္းမွ geometry န႕ဲ dimensions အားလုံးကုိ select လုပ္ပါ။
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၃) Selection ကိုလက္ခံေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၄) Circle အၾကီး၏ Center point ကုိ basepoint အျဖစ္သတ္မွတ္ရန္ click လုိက္ပါ။

၅) Drawing အတြင္း တစ္ေနရာရာတြင္ Right-click နိွပ္ျပီး Copy ကို click လုိက္ပါ။

၆) Scale factor အတြက္ 1.25 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

၇) မူရင္း Object ကို Rotate လုပ္ရန္ -

 Rotate command ကိုစတင္လိုက္ပါ။

 P ဟုရိုက္ထည့္လိုက္ပါ။ Previous selection set ကိုျပန္ေခၚရန္ Enter ႏိွပ္လုိက္ပါ။
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 Selection set ကုိလက္ခံေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၉) Circle အၾကီး၏ Center point ကုိ select ပါ။

၁၀) 90 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

၁၀) File အားလုံးကုိ မSave ပဲ ပိတ္လိုက္ပါ။

Challenge Exercise: Grips

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ grip ကိုအသံုးျပဳျပီး Drawing အတြင္းမွ Objects မ်ားကို Edit လုပ္ျခင္းကို

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ ေလ့က်င့္ခန္းမ်ားကုိ လိုက္ပါေလ့က်င့္ျပီးသြားပါက objects မ်ားကုိ standard editing

commands မ်ား၏ အကူအညီကို ရယူရန္ မလိုေတာ႕ပဲ grip ျဖင့္ ကၽြမ္းက်င္စြာ ျပဳလုပ္ႏိုင္မည္ ျဖစ္သည္။
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၁) M_Grips-Exercise.dwg ကုိဖြင့္ပါ။

၂) Door ကို grip ျဖင့္ အတြင္းသုိ႕ေရြ႕ရန္ -

 Door ကို select ပါ။

 Grip activate ျဖစ္ေစရန္ တစ္ခ်က္တည္းသာ click ပါ။

 Right- click ႏိွပ္ျပီး Move ကုိ select ပါ။

 Door ကုိအတြင္းသုိ႕ ေရြ႕ပါ။ နံရံ၏ Endpoint တြင္ Click ပါ။ Endpoint ကို click ျပီးေသာ္လည္း door သည္

selected ပဲ ျဖစ္ေနမည္။

၃) Grip အသံုးျပဳျပီး door ကုိတစ္ျခားခန္း အတြက္ Copy လုပ္ရန္ -

 Selected grip ျဖစ္ရန္ grip ကုိ ထပ္မံ၍ click လိုက္ပါ။

 Right- click ႏိွပ္ျပီး Move ကုိ select ပါ။

 Right- click ႏိွပ္ျပီး Copy ကုိ select ပါ။

 Door ကိုညာဖက္ အခန္းသို႕ drag လိုက္ပါ။ နံရံ၏ Endpoint တြင္ Click ပါ။

 Copy ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 Unselected ျဖစ္ရန္ Esc key ကုိႏိွပ္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

261

၄) Plant ကို grip ျဖင့္ အတြင္းသို႕ ေရြ႕ရန္ -

 Plant ကို select ပါ။

 Grip ကုိ selected ျဖစ္ေအာင္ click လိုက္ပါ။

 Right- click ႏိွပ္ျပီး Move ကုိ select ပါ။

 Plant ကို ပုံတြင္ ျပထားသည့္ အတုိင္း အေပၚ ဘယ္ဖက္ေထာင့္သုိ႕ drag လိုက္ပါ။

၅) Grip အသံုးျပဳျပီး Plant ကုိ Copy လုပ္ရန္ -

 Plant ၏ grip ကုိ selected ျဖစ္ေစရန္ click လိုက္ပါ။

 Right- click ႏိွပ္ျပီး Move ကုိ select ပါ။

 Right- click ႏိွပ္ျပီး Copy ကုိ select ပါ။

 ဒုတိယ Plant ပုံတြင္ ျပထားသည့္ အတုိင္း ညာဖက္ေအာက္ေထာင့္သုိ႕ drag လိုက္ပါ။

 Copy ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 Unselected ျဖစ္ရန္ Esc key ကုိႏိွပ္ပါ။
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၆) Credenza န႕ဲ keyhole desk ကုိ grip အသုံးျပဳျပီး ေရြ႕ရန္ -

 Move grip mode ကိုအသံုးျပဳျပီး ေအာက္ပုံတြင္ ျပထားသည့္ အတိုင္း Credenza ကိုအတြင္းသို႕ ေရြ႕ပါ။

 Move grip mode ကိုအသံုးျပဳျပီး ေအာက္ပုံတြင္ ျပထားသည့္ အတိုင္း keyhole desk ကုိအတြင္းသုိ႕ ေရြ႕ပါ။

၇) File cabinet ကုိ grip အသုံးျပဳျပီး ေရြ႕ရန္ -

 File cabinet ကုိ select ပါ။

 Grip ကုိ select ပါ။

 Right- click ႏိွပ္ျပီး Move ကုိ select ပါ။

 Object ကုိ ပုံတြင္ ျပထားသည့္ အတိုင္း ဘယ္ဖက္ေအာက္ေထာင့္သုိ႕ dragပါ။ ဘယ္ဖက္နံရံမွ လာလွ်င္

ေအာက္နံရံကုိ ေရာက္ခါနီး 4 units ခန္႕ကြာတြင္ click လိုက္ပါ။
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8) File cabinet ကို grip အသုံးျပဳျပီး Rotate လုပ္ရန္ -

 File cabinet ၏ grip ကုိ selected ျဖစ္ေစရန္ ထပ္မံ၍ click လိုက္ပါ။

 Right- click ႏိွပ္ျပီး Rotate ကုိ select ပါ။

 90 ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Unselected ျဖစ္ရန္ Esc key ကုိႏိွပ္ပါ။
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၉) Move နဲ႕ Rotate grip modes ကုိအသံုးျပဳ၍ ေအာက္ပုံတြင္ ျပထားသည့္ အတုိင္း computer နဲ႕ phone ကို

desk ေပၚသို႕ေရြ႕ရန္ -

 Computer ကို 45 ဒီဂရီ ျဖစ္ေအာင္ Rotate လုပ္ပါ။

 Phone ကုိ 90 ဒီဂရီ ျဖစ္ေအာင္ Rotate လုပ္ပါ။

10) Move, Rotate, န႕ဲ Copy grip modes ကုိအသံုးျပဳျပီး ေအာက္ပုံတြင္ ျပထားသည့္ အတုိင္း chair ကုိ office ထဲသုိ႕

ေရြ႕ရန္ -

 Desk chair -45 ဒီဂရီ rotated ျဖစ္ျပီး၊ conference table chair ကုိ 45 ဒီဂရီ rotated ျဖစ္ပါသည္။ လက္က်န္ 2

chairs မွာ 90 ဒီဂရီ rotated ျဖစ္ပါသည္။

 Office ၏ Layout မွာ ေအာက္ပုံတြင္ ျပထားသည့္ အတုိင္းျဖစ္ပါသည္။
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၁၁) Copy န႕ဲ Base Point grip modes ကုိအသုံးျပဳျပီး Objects အေျမာက္အျမားကုိ Copy လုပ္ကာ ညာဖက္တြင္ ရိွေသာ

Office သို႕ေရြ႕ေျပာင္းရန္ -

 Objects အားလုံးကုိ ေအာက္တြင္ေဖာ္ျပထားသည့္ ပုံအတိုင္း select လုပ္လုိက္ပါ။

 ထုိ selected ထားေသာ Objects မ်ား၏ grips မ်ားထဲမွ grip တစ္ခုကုိ select လုိက္ပါ။

 Right- click ႏိွပ္ျပီး Move ကုိ select ပါ။

 Right- click ႏိွပ္ျပီး Copy ကုိ select ပါ။

 Right- click ႏိွပ္ျပီး Basepoint ကို select ပါ။

 Basepoint အတြက္ အခန္း၏ ဘယ္ဖက္ထိပ္ေထာင့္ အတြင္းပိုင္း (1) ကုိ click ပါ။

 Movepoint အတြက္ ညာဖက္ အခန္း၏ ဘယ္ဖက္ထိပ္ေထာင့္ အတြင္းပိုင္း (2) ကုိ click ပါ။

 Copy command ျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏွိပ္ပါ။

 Unselected ျဖစ္ရန္ Esc key ကုိႏိွပ္ပါ။
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၁၂) Mirror နဲ႕ Copy grip modes ကုိအသုံးျပဳျပီး၊ ေနာက္ Office တစ္ခု၏ ညာဖက္သုိ႕ ေရြ႕ရန္ -

 ေအာက္ေဖာ္ျပပါ ပုံတြင္ ျပထားသည့္ အတုိင္း Objects မ်ားကို select ပါ။

 Right- click ႏိွပ္ျပီး Mirror ကုိ select ပါ။

 Right- click ႏိွပ္ျပီး Copy ကုိ select ပါ။

 Right- click ႏိွပ္ျပီး Basepoint ကို select ပါ။

 တံခါးနွစ္ခုအၾကား နံရံအျပင္ပိုင္း (1) Midpoint ကုိ Basepoint အျဖစ္သတ္မွတ္ေပးပါ။

 Mouse ကုိအေပၚသုိ႕ 90 ဒီဂရီေထာင္ျပီး ေနာက္တစ္မွတ္ (2) သတ္မွတ္ေပးလိုက္ပါ။

 Copy command ျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏွိပ္ပါ။

 Unselected ျဖစ္ရန္ Esc key ကုိႏိွပ္ပါ။
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၁၃) Files အားလုံးကို မSave ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Architectural

ဤေလ့က်င့္ခန္းတြင္ အထက္၌ ေလ့လာျပီးခ႕ဲေသာ modify command မ်ားျဖင့္ floor plan ကုိ modify လုပ္ၾကည့္ပါ။

The completed exercise
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Metric Units

၁) M_ARCH-Challenge-CHP03.dwg ကိုဖြင့္ပါ။

၂) အေဆာက္အဦး၏ ေလွကားအျဖစ္ ကိုယ္စားျပဳ geomentry တစ္ခုကို ေရးဆြဲလုိက္ပါ။ မိမိတုိ႕ နွစ္သက္ေသာ ေနရာတြင္

ေလွကားကုိ ေရးဆြဲျပီး၊ Rotate လုပ္ကာ အေဆာက္အဦး အတြင္းသုိ႕ ေရြ႕လိုက္ပါ။

 Single line (1) တစ္ခုကုိ အရင္ေရးဆြဲလိုက္ပါ။

 ထုိ Single line ကုိ ဘယ္ဖက္တြင္ ေလွကားသဖြယ္ ျဖစ္ေအာင္ array လုပ္လိုက္ပါ။

 ဘယ္ဖက္ႏွင့္ ညာဖက္တြင္ vertical lines မ်ား Add လိုက္ပါ။

 ညာဖက္တြင္လည္း ေလွကား လုပ္ရန္အတြက္ ဆြဲျပီးသား Objects မ်ားကို Mirror လုပ္လိုက္ပါ။

 Otrack န႕ဲ direct distance entry အသံုးျပဳျပီး က်န္ရိွေနေသးေသာ Lines မ်ားကုိ ေရးဆြလုိဲက္ပါ။

 ေလွကားအၾကားတြင္ ျမင္ေတြ႕ေနရေသာ Center line ကုိေရးဆြဲရန္ မလုိအပ္ေပ။ Dimension အတြက္သာ

ရည္ရြယ္ျပီး ေရးဆြထဲားျခင္း ျဖစ္ပါသည္။

၃) ေလွကားကုိ ေအာက္ေဖာ္ျပပါ ပုံတြင္ ျပထားသည့္ အတုိင္း ေနရာသတ္မွတ္ေပးလိုက္ပါ။
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( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )
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၄) ေလ့က်င့္ခန္းအတြက္ ေဖာ္ျပေပးထားေသာ ပုံအတိုင္း ျပီးျပည့္စုံ သြားေစရန္ ေလွကားကို ေအာက္တြင္ ေရးဆြဲထားေသာ

ပုံကို အထက္သို႕ Mirror လုပ္လုိက္ပါ။
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( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )
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၅) Save ျပီး drawing ကုိ ပိတ္လုိက္ပါ။

Imperial Units

၁) M_ARCH-Challenge-CHP03.dwg ကိုဖြင့္ပါ။

၂) အေဆာက္အဦး၏ ေလွကားအျဖစ္ ကိုယ္စားျပဳ geomentry တစ္ခုကို ေရးဆြဲလုိက္ပါ။ မိမိတုိ႕ နွစ္သက္ေသာ ေနရာတြင္

ေလွကားကုိ ေရးဆြဲျပီး၊ Rotate လုပ္ကာ အေဆာက္အဦး အတြင္းသုိ႕ ေရြ႕လိုက္ပါ။

 Single line (1) တစ္ခုကုိ အရင္ေရးဆြဲလိုက္ပါ။

 ထုိ Single line ကုိ ဘယ္ဖက္တြင္ ေလွကားသဖြယ္ ျဖစ္ေအာင္ array လုပ္လိုက္ပါ။

 ဘယ္ဖက္ႏွင့္ ညာဖက္တြင္ vertical lines မ်ား Add လိုက္ပါ။

 ညာဖက္တြင္လည္း ေလွကား လုပ္ရန္အတြက္ ဆြဲျပီးသား Objects မ်ားကို Mirror လုပ္လိုက္ပါ။

 Otrack န႕ဲ direct distance entry အသံုးျပဳျပီး က်န္ရိွေနေသးေသာ Lines မ်ားကုိ ေရးဆြလုိဲက္ပါ။

 ေလွကားအၾကားတြင္ ျမင္ေတြ႕ေနရေသာ Center line ကုိေရးဆြဲရန္ မလုိအပ္ေပ။ Dimension အတြက္သာ

ရည္ရြယ္ျပီး ေရးဆြထဲားျခင္း ျဖစ္ပါသည္။

၃) ေလွကားကုိ ေအာက္ေဖာ္ျပပါ ပုံတြင္ ျပထားသည့္ အတုိင္း ေနရာသတ္မွတ္ေပးလိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )
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၄) ေလ့က်င့္ခန္းအတြက္ ေဖာ္ျပေပးထားေသာ ပုံအတိုင္း ျပီးျပည့္စုံ သြားေစရန္ ေလွကားကို ေအာက္တြင္ ေရးဆြဲထားေသာ

ပုံကို အထက္သို႕ Mirror လုပ္လုိက္ပါ။

၅) Save ျပီး drawing ကုိ ပိတ္လုိက္ပါ။

Challenge Exercise: Mechanical

ဤေလ့က်င့္ခန္းတြင္ အထက္၌ ေလ့လာျပီးခ႕ဲေသာ modify command မ်ားျဖင့္ geometry မ်ားကို modify လုပ္ၾကည့္ပါ။

The completed exercise



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )
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၁) M_MECH-Challenge-CHP03.dwg ကိုဖြင့္လုိက္ပါ။

၂) ညာဖက္ ရႈ႕ေထာင့္မွ ၾကည့္ေသာ အေနထားျဖစ္ေစရန္ 90 ဒီဂရီ Rotate လုပ္လိုက္ပါ။

၃) Main view မွ Circles အၾကီး၏ Center point ကို အထက္တြင္ရိွေသာ Rectangle ၏ Midpoint ျဖင့္ ညီေအာင္

Move လုပ္ပါ။ ညာဖက္တြင္ ရိွေသာ Objects၏ Base line ခ်င္းညီသြားေအာင္ Move command ျဖင့္ ညိွေပးလိုက္ပါ။

Move လုပ္ျပီးသြားေသာအခါ ေအာက္တြင္ေဖာ္ျပထားေသာ ပုံအတုိင္း ျမင္ေတြ႕ရမည္ ျဖစ္သည္။

၄) Copy (သုိ႕မဟုတ္) mirror command ကုိအသံုးျပဳျပီး ထိပ္ဆုံးမွ ျမင္ေတြ႕ရေသာ Object ၏ စက္၀ိုင္းကုိ ေအာက္တြင္

ေဖာ္ျပထားေသာ ပုံအတိုင္းျဖစ္ေအာင္ modify လုပ္ေပးလိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )
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၅) လက္က်န္ Objects မ်ားကုိေအာက္ပါပုံအတိုင္း Rotate လုပ္ျပီး၊ base line မ်ား ညွိေပးလိုက္ပါ။

၆) ေအာက္ေဖာ္ျပပါ ပုံက႕ဲသုိ႕ ျဖစ္လာေအာင္ Mirror command ကုိအသံုးျပဳျပီး Object ကို modify လုပ္ေပးလိုက္ပါ။

၇) Files အားလံုးကို Save ျပီးမွ ပိတ္လုိက္ပါ။

Chapter Summary

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -
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( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )
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 Drawing ထမွဲ Objects မ်ားကို နည္းအမ်ိဳးမ်ိဳးျဖင့္ select လာႏိုင္မည္။

 Drawing ထဲမွ Objects မ်ားကုိ object snaps, object tracking နဲ႕ coordinate မ်ားရိုက္ထည့္ျပီး လိုခ်င္ေသာ

ေနရာကုိ အတိအက် ေရြ႕လာႏိုင္မည္။

 လက္ရိွ drawing မွ Copy commands (သို႕မဟုတ္) Grip မ်ားအသုံးျပဳျပီး အျခားေသာ drawings မ်ားကို

ေရးဆြလဲာႏိုင္မည္။

 Rotate command (သုိ႕မဟုတ္) grips ျဖင့္ drawing ထမွဲ Objects မ်ားကို လိုအပ္သလို ေျပာင္းလဲ

တတ္လာမည္။

 Mirror command (သုိ႕မဟုတ္) grips ျဖင့္ drawing ထမွဲ Objects မ်ားကုိ Mirror လုပ္တတ္ လာမည္။

 Array command ကိုအသံုးျပဳ၍ drawing မ်ားတြင္ rectangular (သို႕မဟုတ္) circular အပိုင္းခြမဲ်ားကို

ေရးဆြတဲတ္လာမည္။

 Drawing မ်ားထဲမွ Objects မ်ား၏ အရြယ္အစားကုိ ေျပာင္းလဲတတ္လာေစမည္။

 ဤ modifying objects ကိုေလ့လာျပီးသြားပါက floor plan မ်ားကို modify လုပ္တတ္ လာမည္။

 ဤ modifying objects ကိုေလ့လာျပီးသြားပါက Geomentry မ်ားကုိ modify လုပ္တတ္လာ မည္။
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CHAPTER: 4 Drawing Organization and
Inquiry Commands

ဤ Chpater တြင္ drawing ထမွဲ objects မ်ားကုိ organize လုပ္ပုံ၊ layers ႏွင့္ linetypes တုိ႕သည္ မိမိတို႕၏ designs

မ်ားကို အေကာင္းဆံုး အေထာက္အကူ ျပဳပုံ၊ electronic design နယ္ပယ္ အတြက္ မည္သုိ႕အက်ိဳးျပဳပုံ စသည္တို႕ကို

ေလ့လာသြားရမည္ ျဖစ္ပါသည္။

Objectives

ဤ chaper ကုိေလ့လာျခင္း ျပီးေျမာက္သြားပါက -

 Drawing အတြင္းမွ Objects မ်ား layer ျဖင့္ organize လုပ္တတ္လာေစရန္။

 Objects မ်ား၏ Properties မ်ားကုိ ေျပာင္းလဲပုံႏွင့္ ခြဲျခားပုံတုိ႕ကို သိရိွလာေစရန္။

 Quick Properties panel ကုိအသံုးျပဳျပီး Objects မ်ား၏ Properties မ်ားကို ျမန္ျမန္ဆန္ဆန္ ေျပာင္းလဲ

တတ္လာေစရန္။

 Match Properties command ကုိအသုံးျပဳျပီး မူရင္းObjects ၏ Properties အတုိင္း အျခား Objects မ်ား၏

Properties ကိုအလြယ္တကူ ကူးေျပာင္းေပးတတ္လာေစရန္။

 Properties palette ကုိအသံုးျပဳျပီး Objects မ်ား၏ Properties မ်ားကုိ ေျပာင္းလဲေပးတတ္လာေစရန္။

 Drawing အတြင္းရိွ Objects မ်ားကုိ linetypes ျဖင့္ ခြဲျခားေပးတတ္လာေစရန္။

 Inquiry commands (Distance, Radius, Angle, Area, List, and ID) ျဖင့္ drawing အတြင္းမွ Objects မ်ား၏

informations မ်ားကုိ သိရိွႏိုင္ေစရန္။
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Lesson: Using Layers

ဤသင္ခန္းစားတြင္ Layer ဆုိတာဘာလဲ၊ Layer အသံုးျပဳျပီး Objects မ်ားကုိ ဘယ္လုိ Organize လုပ္မလဲ စသည္

တုိ႕ကုိေလ့လာသြားရမည္ ျဖစ္ပါသည္။ ဥပမာ အားျဖင့္ ေအာက္တြင္ေဖာ္ျပေပးထားေသာ ပုံကိုေလ့လာ ၾကည့္ပါ။ Objects

မ်ားကို ကြဲျပားျခားနားေသာ Layer မ်ားျဖင့္ အမ်ိဳးတူစု ထားျခင္းျဖစ္ပါသည္။

Dimensions မ်ား အတြက္ layer တစ္ခု, hidden lines အတြက္ layer တစ္ခု နဲ႕ object တြင္ပါေသာ hole မ်ားအတြက္

အတြက္ layer တစ္ခု စသည္ျဖင့္ organize လုပ္ထားပါသည္။ ထို object ၏ layer မ်ားတြင္ color, linetype န႕ဲ

lineweight စသည္ျဖင့္ တစ္ခုျခင္းစီတြင္ Property ကုိယ္စီ ရိွၾကပါသည္။ Layer တစ္ခုစီကို မတူညီေသာ color linetype

န႕ဲ lineweight တို႕ျဖင့္ ခြဲျခားထားဖို႕က လြန္စြာမွ အေရးပါလွပါသည္။

Objectives
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ဤသင္ခန္းစာကုိ ေလ့လာျခင္းျပီးစီးပါက -

 Drawing အတြင္းတြင္ Objects မ်ားကုိ organize လုပ္တတ္လာေစရန္။

 Properties Manager မွ (သို႕မဟုတ္) အျခား commands မ်ားျဖင့္ Layer မ်ားကို Manage လုပ္တတ္ လာေစရန္။

Organizing Objects with Layers

Designs မ်ားေရးဆြဲရာတြင္ objects မ်ားရႈပ္ေထြးလာသည္နွင့္ အမွ် အမ်ိဳးတူ Objects မ်ားကို Layer တြင္ organization

လုပ္ေပးျခင္းအားျဖင့္ မိမိတုိ႕၏ drawings မ်ားသည္ တိက်မွန္ကန္ျပီး အရည္အေသြးျမွင့္မား လာမည္ ျဖစ္သည္။

ေအာက္ေဖာ္ျပပါ Layout တြင္ layer ကုိအသံုးျပဳျပီး separate walls, partition walls, furniture, textနဲ႕ quipment

မ်ားကို organize လုပ္ေပးရမည္။

About Layers

Layer သည္ drawings အတြင္းမွ Objects မ်ားကုိ အပိုင္းလိုက္ ခြဲျခားျပီး၊ မိမိတို႕ ၾကည့္လိုေသာ အပိုင္းကိုသာ သီးသန္႕

ခြဲထုတ္ၾကည့္ရာတြင္ အသုံးျပဳပါသည္။ Objects မ်ားကုိ Layer သုိ႕ Add လိုက္ျပီဆုိသည္နွင့္ ထုိ Add ထားေသာ Objects
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မ်ားကို တစ္ခုခ်င္းစီ ဖြင့္ျပီး မိမိတုိ႕ စိတ္ၾကိဳက္ ၾကည့္ရႈ႕ျခင္း၊ ျပဳျပင္ျခင္းတုိ႕ကုိ ျပဳလုပ္ႏိုင္သည္။ Drawing တစ္ခုလံုးတြင္

မိမိတုိ႕ သီးသန္႕ Print ထုတ္လိုေသာ အပိုင္းကို ခြဲထုတ္ရာတြင္လည္း Layer တြင္ group အလိုက္ Add ျပီး

ထုတ္ယူႏိုင္ပါသည္။

Default Layer

Default layer ျဖင့္ ေရးဆြဲထားေသာ drawings အားလုံးကုိ layer 0 ဟုေခၚပါသည္။ Layer 0 ကုိ Rename ေပးျခင္း (သို႕မ

ဟုတ္) Delete လုပ္ျခင္းတုိ႕ကုိ လုပ္ေဆာင္ ႏိုင္မည္မဟုတ္ေပ။ မိမိတုိ႕ ေရးဆြလုိဲက္ေသာ drawing တိုင္းသည္ အနည္းဆံုး

layer တစ္ခုေအာက္တြင္ ရိွေနမွာ အေသအခ်ာပင္။

ေအာက္ပုံတြင္ ေဖာ္ျပေပးထားေသာ ပုံသည္ acad.dwt drawing တြင္ပါ၀င္ေသာ Layer Properties Manager dialog

box ျဖစ္ပါသည္။ Layer 0 တစ္ခုတည္းသာ ပါ၀င္ေနမည္ ျဖစ္သည္။

Layer Tools

Ribbon တြင္ရိွေသာ Layer Properties Manager န႕ဲ Layer Control list မွ Drawing မ်ားအတြက္ Layer မ်ားကုိ Manage

လုပ္ႏိုင္ပါသည္။ ထို commands န႕ဲ tools တုိ႕သည္ Objects မ်ားကုိ Organize လုပ္ရန္ Layer add ရာတြင္ အေကာင္းဆံုး

အကူအညီေပးသြား ပါလိမ္႕မည္။

Layers Panel
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Command Access

Layer Properties Manager ကုိအသုံးျပဳျပီး Layer မ်ားဖန္တီးျခင္း၊ Layer တစ္ခုခ်င္းစီ၏ color, linetype န႕ဲ lineweight

မ်ားကို ထိန္းခ်ဳပ္ႏ္ိုင္ပါသည္။

Layer Properties Manager

Command Line: LAYER, LA

Ribbon: Home tab > Layers panel > Layer Properties

Menu Bar: Format > Layer...

လက္ရိွေရးဆြဲေနေသာ Object ကုိ ျမန္ျမန္ဆန္ဆန္ Layer လုပ္ခ်င္လုပ္ ေအာက္ပါ command ကိုအသံုးျပဳရသည္။

Make Objects Layer Current

Command Line: LAYMCUR

Ribbon: Home tab > Layers panel > Make Objects Layer Current
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Menu Bar: Format > Layer Tools > Make Object's Layer Current

Previous layer settings ကုိျပန္သြားခ်င္လွ်င္ ေအာက္ပါ command ကုိအသုံုးျပဳရပါသည္။

Layer Previous

Command Line: LAYERP

Ribbon: Home tab > Layers panel > Previous

Menu Bar: Format > Layer Tools > Layer Previous

Layer Properties Manager Dialog Box

Properties Manager Dialog Box သည္ Layers မ်ားကုိ managing လုပ္မည့္ tool ျဖစ္ပါသည္။ ထုိ Dialog Box

ကုိအသံုးျပဳျပီး Layers မ်ားကုိ Creating နွင့္ managing လုပ္သြားရမည္ ျဖစ္သည္။
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Command Options

ေအာက္တြင္ ေဖာ္ျပ ေပးထားေသာ Options မ်ားသည္ Properties Manager Dialog Box ၌ Layers မ်ားကို

management ေပးသည့္ options မ်ားျဖစ္ပါသည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

282

Layer Status
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Layers မ်ား ပိတ္ျခင္း၊ ဖြင့္ျခင္းတို႕ကို Layer status တြင္သြားေရာက္ ထိန္းခ်ဳပ္ႏိုင္ပါသည္။ Layer status တြင္

လုပ္ႏိုင္ေသာ အရာမ်ားကုိ ေအာက္တြင္ ေဖာ္ျပေပးထားပါသည္။

Layer Control List

Layer Control List သည္ Layers panel တြင္တည္ရိွပါသည္။

Drawings အတြက္ အသံုးျပဳထားေသာ Layer list ကုိၾကည့္လိုပါက down arrow ကုိႏိွပ္ပါ။
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Practice Exercise: Layer Tools

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Properties Manager dialog box တြင္ Layers မ်ားကုိ ဖန္တီးကာ၊ color အလုိက္

drawing တြင္ objects မ်ားကို ေရးဆြဲျပီး၊ ထုိ Objects မ်ားကို select ျပီး Layer Control list တြင္ Add သြားရမည္

ျဖစ္သည္။

၁) Layer ဖန္တီးရန္ -

 Ribbon, Home tab > Layers panel > Layer Properties ကုိ click ပါ။

 Dialog box မွ New ကုိ click ပါ။

 Layers မ်ားကို ေအာက္ပါအတိုင္း ဖန္တီးလိုက္ပါ။

 Layer Name: Circle, Color: Red

 Layer Name: Line, Color: Blue

 Layer Name: Rectangle, Color: Green

၂) Layer Properties Manager dialog box ကို close ပါ။
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၃) Circle ကုိ layer add ရန္အတြက္၊ circle ကုိ select ျပီး Layer Control list မွ circle အတြက္ လုပ္ထားေသာ layer ကုိ

click လုိက္ပါ။

Exercise: Work with Layers

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Layers မ်ားကို freeze and thaw နဲ႕ lock and unlock တို႕ျပဳလုပ္ေပးသြား ရမည္

ျဖစ္သည္။ Layer အသစ္ဖန္တီးျပီး၊ ထို Layer ကုိ current layer ေပးကာ၊ geomentry အသစ္တစ္ခုကုိ ထို Layer တြင္

ဖန္တီးသြားရမည္။

The completed exercise

၁) M_Create-Layers.dwg ကုိဖြင့္ပါ။

၂) Drawing တြင္ရိွေသာ Objects မ်ား၏ color နဲ႕ linetype တုိ႕ကို တစ္ခုခ်င္းစီကုိ သတိထား ျပီးေလ့လာၾကည့္ပါ။

Dimensions layer ကုိျမင္ကြင္းမွ ေပ်ာက္သြားေအာင္ Off လုပ္လိုက္ျပီး၊ drawing တြင္ geomentry ေပၚလာေအာင္

လုပ္ရန္ -

 Home tab, Layers panel >Layer Control list .
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 Dimensions layer ကို freeze ရန္ Sun icon ကုိ click လိုက္ပါ။ ထုိ အခါ Sun icon သည္ snowflake အသြင္သုိ႕

ေျပာင္းသြားျပီး drawing တြင္ dimensions မ်ားေပ်ာက္သြားလိမ္႕မည္။

၃) Hidden layer ကုိ Current layer ျဖစ္ေစရန္ -

 Home tab, Layers panel >Layer Control list .

 Hidden layer ကုိ Current layer ျဖစ္လာေစရန္ select လုိက္ပါ။

၄) ေအာက္တြင္ ျပထားသည့္ အတုိင္း ပုံကို Zoom ခ်ဲ႕ျပီး၊ Hidden layer တြင္ Lines မ်ားေရးဆြဲရန္ -

 Line command ကုိအသံုးျပဳျပီး၊ ေအာက္ေဖာ္ျပပါ ပံုအတုိင္း Point (1) မွPoint (2) သုိ႕ေရးဆြဲ ေပးလုိက္ျပီး၊

Point (3) မွ Point (4) ကိုပါ ထပ္မံေရးဆြဲလိုက္ပါ။

 မိမိတုိ႕ ေရးဆြဲလိုက္ေသာ Lines မ်ားအမွတ္တစ္မွတ္န႕ဲ တစ္မွတ္ တိတိက်က် ခ်ိတ္ဆက္မိျခင္း ရိွမရိွ စစ္ေဆး

ၾကည့္ပါ။
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၅) Center layer တြင္ Object ၏အလယ္ကုိ ျဖတ္သြားေသာ Line ေရးဆြဲရန္ -

 ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံတစ္ခုတည္း ေကာင္းေကာင္းျမင္နိုင္ေအာင္ Zoom ျပင္လုိက္ပါ။

 Home tab, Layers panel >Layer Control list . Center layer ကုိ select ပါ။

 Line command ကုိစတင္လုိက္ပါ။

 Circle အၾကီး၏ 180 ဒီဂရီ အတုိင္း quadrant point ကို acquire လုပ္ျပီး၊ extension path ျဖင့္ mouse ကို

ဘယ္ဖက္သို႕ drag လိုက္ပါ။

 Dynamic input field တြင္ 5 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 ျပီးလွ်င္ Cursor ကုိ Circle ၏ အျပင္ ညာဖက္သုိ႕ extension path ျဖင့္ drag လိုက္ပါ။

 Dynamic input field တြင္ 85 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Line command ကုိအဆုံးသတ္ရန္ Enter ႏိွပ္ပါ။
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၆) Object ၏အလယ္ကုိ ျဖတ္သြားေသာ Line တစ္ေၾကာင္း ထပ္မံ ေရးဆြဲရန္ -

 Line command ကုိျပန္ေခၚရန္ Enter ႏိွပ္ပါ။

 Circle အၾကီး၏ 270 ဒီဂရီ အတုိင္း quadrant point ကို acquire လုပ္ျပီး၊ extension path ျဖင့္ mouse ကို

ေအာက္ဖက္သုိ႕ drag လုိက္ပါ။

 Dynamic input field တြင္ 5 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 ျပီးလွ်င္ Cursor ကုိ Circle ၏ အျပင္ အထက္သုိ႕ extension path ျဖင့္ drag လုိက္ပါ။

 Dynamic input field တြင္ 85 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Line command ကုိအဆုံးသတ္ရန္ Enter ႏိွပ္ပါ။
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၇) Rotate command ကိုအသုံးျပဳျပီး၊ ေရးဆြဲထားေသာ Centerlines ၂ေၾကာင္း စလံုးကုိ 30 ဒီဂရီ Rotate လုပ္ပါ။ Circle

အၾကီး၏ Center point ကုိ Baepoint အျဖစ္ အသုံးျပဳပါ။

၈) Dimension Layer ကုိျပန္ Thaw ရန္ -

 Home tab, click Layers panel >Layer Control list. Dimension Layer ကိုျပန္ Thaw ရန္အတြက္ snowflake

icon ကို click လုိက္ပါ။

 Drawing ကုိ Zoom Extents လုပ္လိုက္ပါ။

၉) Layer Control list တြင္ Objects မ်ား၏ Properties ကုိၾကည့္ရန္ -

 Command line ကုိ Blank အေနအထားျဖင့္ Dimension တစ္ခုကုိ select လုိက္ပါ။

 ထုိ Dimension Layer သည္ Layer Control list တြင္ေရာက္လာမည္ကုိ သတိထား ၾကည့္ၾကည့္ပါ။
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 Command line ကုိ Blank ျဖစ္ေစရန္ Esc key ကုိႏိွပ္လိုက္ပါ။

 Cursor ကုိ Visible layer ၏ Objects တစ္ခုခုေပၚသုိ႕ drag လိုက္ပါ။ (ပုံတြင္ ျပထားသည့္အတိုင္း) Padlock Icon

ေလး display ျဖစ္သည္ကုိ ေတြ႕ရမည္။ Visible layer မွ Objects မ်ားကို locked ထားေသာေၾကာင့္ Modified

လုပ္၍ရမည္ မဟုတ္ေပ။ သို႕ေသာ္လည္း ထို locked ထားေသာ layer သို႕ Objectsမ်ား ထပ္မံ၍ add ႏိုင္ပါသည္။

 Visible layer မွ Object တစ္ခုကုိ select လုိက္ပါ။ Layer Control list တြင္ Layer အမည္ မည္သုိ႕ေပၚလာ

မည္ကုိ သတိထား ၾကည့္ၾကည့္ပါ။

 Dimension က႕ဲသို႕ Objects မ်ားကုိ select ၾကည့္ပါ။ Layer Control field တြင္ Blank ျဖစ္လာမည္ကို

သတိထား ၾကည့္ၾကည့္ပါ။ အဘယ့္ေၾကာင့္ ဆုိေသာ္ Layer Control list သည္ တစ္ၾကိမ္တည္း multiple

properties ကုိမေဖာ္ျပႏုိင္ ေသာေၾကာင့္ ျဖစ္သည္။
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 Deselected ျဖစ္ေအာင္ Esc key ကုိႏိွပ္လိုက္ပါ။

၁၀) Locked layer ထတဲြင္ပါ၀င္ေသာ Objects တစ္ခ်ိဳ႕ကုိ Moveရန္ -

 Move command ကုိစတင္လိုက္ပါ။

 Auxiliary view မွ Objects အားလံုးကို select လုိက္ပါ။ Enter ႏိွပ္ပါ။

 Drawing အတြင္းက Point တစ္ Point ကုိ click လိုက္ပါ။ 25 ကုိရိုက္ျပီး Enter ႏိွပ္ပါ။ Tab key ကိုႏိွပ္ပါ။

 Angle field တြင္ 30 ကိုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။ Tab key ကိုႏိွပ္ပါ။

 Move command ကုိ ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ တစ္ေနရာရာကို Click လိုက္ပါ။ သတိထား ၾကည့္ၾကည့္ပါ။

တစ္ခ်ိဳ႕ေသာ Objects မ်ား ေရြ႕သြားျခင္း မရွိသည္ကုိ ေတြ႕ရမည္။

 Move Command ကို Undo လုပ္ပါ။

၁၁) Objects မ်ား ထပ္မံ၍ Move ၾကည့္ပါမည္။ သို႕ေသာ္ ပထမဆံုး အေနန႕ဲ တစ္ခ်ိဳ႕ေသာ Object ပါ၀င္ေသာ Layer ကို

Unlock လုပ္ပါမည္။

 Home tab, click Layers panel >Layer Control list. Visible layer မွ padlock icon ကုိ Click ပါ။ Visible

layer Unlocked ျဖစ္သြားလိမ္႕မည္။

 Previous step က move command ကုိျပန္ေခၚလုိက္ပါ။ Objects မ်ား moved သြားပုံကုိ သတိထား

ၾကည့္ၾကည့္ပါ။

 Visible layer ကို Relock ျပန္လုပ္ပါ။

၁၂) Layer အသစ္ဖန္တီးရန္ -

 Home tab, Layers panel >Layer Properties ကုိ click ပါ။

 Layer Name field တြင္ Visible ကို click ပါ။ Visible layer ၏ properties သည္ New layer အတြက္ default

properties ျဖစ္သြားပါလိမ္႕မည္။

 Layer Properties Manager dialog box တြင္ (1) ကို click ပါ။
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 Layer Name field (2) တြင္ Title Block ဟုရိုက္ထည့္ပါ။

 Color field (3) ကုိ click ျပီး အျဖဴေရာင္ကုိ select လိုက္ပါ။

၁၃) Layer ထပ္မံ Add ရန္ -

 New layer ကို ထပ္ click လိုက္ပါ။

 Layer Name field တြင္ Viewport ဟုရိုက္ထည့္ လိုက္ပါ။

 Color field ကို click ျပီး Cyan ကုိ select လုိက္ပါ။ Ok ကုိ click ပါ။

 Plot field ကုိ click လိုက္ပါ။ ဖန္တီးလိုက္ေသာ Viewport layer ကုိ nonplotting အျဖစ္သတ္ မွတ္ေပးလုိက္ပါ။

 Title Block layer ကုိ click လိုက္ပါ။

 Right – click နိွပ္ျပီး Set current ကုိ select ေပးလုိက္ပါ။

 Layer Properties Manager dialog box ကိုပိတ္ရန္ ( X ) ကုိႏိွပ္လုိက္ပါ။

၁၄) Drawing ကုိ Zoom Extents လုပ္လိုက္ပါ။

၁၅) Rectangle ေဘာင္တစ္ခု ေရးဆြရဲန္ -

 Rectangle command ကို စတင္လုိက္ပါ။

 0 ကုိရိုက္ျပီး Enter ႏိွပ္ပါ။

 Right – click ႏိွပ္ျပီး Dimensions ကုိ Clickလိုက္ပါ။
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 Length အတြက္ 400 ရိုက္ထည့္လိုက္ပါ။ Enter နိွပ္ပါ။

 Width အတြက္ 277 ရိုက္ထည့္လိုက္ပါ။ Enter နိွပ္ပါ။

 Command ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ တစ္ေနရာရာတြင္ click တစ္ခ်က္ႏိွပ္လိုက္ပါ။

၁၆) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Changing Object Properties

ဤသင္ခန္းစာတြင္ object properties ဆိုတာဘာလဲ၊ drawing ထကဲ object ေတြရဲ႕ properties ေတြကုိ ဘယ္လုိ

ေျပာင္းမလဆဲုိ စသည္တို႕ကို ေလ့လာသြားရမည္ ျဖစ္သည္။ Drawing area ထဲတြင္ ေရးဆြဲထားေသာ Objects

မွန္သမွ်တြင္ Properties ရိွပါသည္။ ဥပမာ အားျဖင့္ - Line ဆုိေသာ Object တြင္ ေအာက္ပါ ပုံတြင္ ေဖာ္ျပထားသည့္

အတိုင္း color, layer, linetype န႕ဲ length စသည္ properties မ်ားၾကပါသည္။

Drawing area ထဲတြင္ မိမိတို႕ေရးဆြဲလိုက္ေသာ Objects မ်ား၏ Properties ကုိ Properties palette တြင္ စိတ္ၾကိဳက္

ေျပာင္းလဲ သတ္မွတ္ေပးႏိုင္ပါသည္။ မိမိတုိ႕ ေျပာင္းလဲလိုေသာ Properties ကုိေျပာင္းလဲျပီးပါက Objects က္ို ထိုသုိ႕

ေျပာင္းလလုိဲက္သည့္အတိုင္း drawing area တြင္ ေတြ႕ရိွရမည္ ျဖစ္သည္။ ေအာက္ပါပုံကုိ ေလ့လာၾကည့္ပါ။ Circle ကုိ

selected ျပီး Properties ကုိၾကည့္ရန္ Properties palette ကုိ ေခၚထားျခင္း ျဖစ္သည္။
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Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျပီးသြားပါက -

 Object properties ဆိုတာဘာလ၊ဲ သူတုိ႕ကုိ ဘယ္လိုအသုံးျပဳသလဲ စသည္တုိ႕ကုိ သိလာေစရန္။

 Object မ်ား၏ properties ကို Properties palette ကေန ေျပာင္းလဲတတ္လာေစရန္။

About Object Properties

သာမန္အားျဖင့္ Object properties တြင္ အမ်ားဆံုး ပါ၀င္ေသာ properties မ်ားမွာ Layer, Color, Linetype န႕ဲ

Lineweight စသည္တို႕ ပါ၀င္ၾကပါသည္။ Objects မ်ားဖန္တီးရာတြင္ မိမိတုိ႕ အသံုးျပဳေသာ layer ၏ Properties အေပၚမွာ

မူတည္ျပီး ဖန္တီးလုိက္ေသာ Objects မ်ား၏ color, linetypeနဲ႕ lineweight စသည့္ properties မ်ားသည္ Layer ၏

Properties အတိုင္း ျဖစ္ေနမည္။ New drawing တစ္ခုကို ေရးဆြဲေတာ႕မည္ဆုိလွ်င္ အသံုးျပဳထားေသာ Layer

setting ကိုအရင္ဆံုး စစ္ေဆးသင့္ပါသည္။
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ေရးဆြျဲပီးေသာ Objects မ်ား၏ Properties မ်ားကို Properties palette ေခၚျပီး လြယ္ကူလ်င္ျမန္စြာ ျပင္ဆင္ေျပာင္းလဲ

ႏိုင္ပါသည္။

Object Properties - Line

Definition of Object Properties

Screen မွာေကာ၊ Print ထုတ္ေသာ အခ်ိန္တြင္ မိမိတို႕ ေရးဆြဲလုိက္ေသာ Drawing မ်ားကို ၾကည့္ရ အဆင္ေျပ ေအာင္

Object Properties ျဖင့္ လိုအပ္သလုိ ထိန္းခ်ဳပ္ ျပင္ဆင္ႏိုင္ပါသည္။ ေအာက္ေဖာ္ျပ ပါပုံသည္ Objects မ်ား၏ Linetype,

Lineweight န႕ဲ Color properties တုိ႕ကို ျပင္ဆင္ေျပာင္းလဲ ထားေသာပုံ ျဖစ္ပါသည္။ ေလ့လာၾကည့္ပါ။

Example of Object Properties
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ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံသည္ hidden linetype မ်ားျဖင့္ ေရးဆြထဲားျပီး Lintype ျဖင့္ Object မ်ားကို

ခြဲျခားေပးထားေသာ ေလ့က်င့္ခန္း ျဖစ္ပါသည္။ ျပီးေနာက္ ရႈပ္ေထြးမ်ားျပားလွေသာ Objects မ်ားကို color ျဖင့္ ခြျဲခား

ေပးထားပါသည္။

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံကိုေလ့လာၾကည့္ပါ။ Continuous linetype ျဖင့္ေရးဆြဲထားေသာ Objects မ်ားကို

ပုံတြင္ ရွင္းလင္းစြာ ျမင္ေတြ႕ရမည္ ျဖစ္သည္။ ေအာက္တြင္ ကြဲျပားျခားနားေသာ Lines မ်ားျဖင့္ ေရးဆြဲ ထားေသာေၾကာင့္

အပိုင္းလိုက္ကို ေကာင္းမြန္စြာ ျမင္ေတြ႕ႏိုင္မည္သည္ကုိ ေတြ႕ရသည္။

Continuous linetype ျဖင့္ေရးဆြဲထားေသာ Objects lines.

Hole centerlines ကုိ Center linetype ျဖင့္ေရးဆြထဲားပါသည္။

Hidden edge lines မ်ားကို Hidden linetype ျဖင့္ ေရးဆြဲထားပါသည္။

Section line ကုိ Phantom linetype ျဖင့္ေရးဆြထဲားပါသည္။

ByLayer Property

Ribbon Home tab တြင္ display ထားေသာ Properties panel တြင္ မိမိတုိ႕ လက္ရိွေရးဆြဲေနေသာ drawing ၏

Properties မ်ားကုိ ေဖာ္ျပေပးထားမည္ ျဖစ္သည္။ Default settings Bylayer တြင္ေဖာ္ျပေပး ထားေသာ

Properties မ်ားျဖစ္သည့္ color, linetype နဲ႕ lineweight တုိ႕သည္ လက္ရိွ ေရးဆြဲေနေသာ drawing မ်ား၏ Properties

မ်ားျဖစ္ပါသည္။

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံသည္ Default settings Bylayer ၏ Properties panel ျဖစ္ပါသည္။
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Example of Changing Object Properties from the ByLayer Default

ယခုေလ့လာသြားမည့္ ဥပမာတြင္ centerlines အားလံုးအတြက္ Layer တစ္ခု၊ object lines အားလုံးသည္ သူတို႕၏ layer

မ်ားတြင္ ရိွေနမည္ ျဖစ္သည္။ ေအာက္ေဖာ္ျပပါ ပုံတြင္ object lines, centerlines နဲ႕ hidden lines တုိ႕၏ Properties

မ်ားသည္ Bylayer အတုိင္း ရိွေနမည္ ျဖစ္သည္။

အကယ္၍ object lines ၏ layer တြင္ lineweight ကုိေျပာင္းလုိက္မည္ ဆိုပါက၊ ထုိ layer တြင္ရိွေသာ Objects

အားလုံးသည္ ထိုေျပာင္းလိုက္ေသာ layer setting အတုိင္းျဖစ္သြားမည္။

Changing Object Properties

Changing Object Properties ေနာက္တစ္နည္း အျဖစ္ Ribbon တြင္ရိွေသာ Layers and Properties မွလည္း Objects

မ်ား၏ Properties မ်ားကုိ ထိန္းခ်ဳပ္ေျပာင္းလဲ ႏိုင္ပါသည္။ Objects မ်ားကုိ select လုိက္ယုံျဖင့္ ထုိ Objects မ်ား၏

Properties ကို ေဖာ္ျပေပးလိမ္႕မည္။ ထုိေဖာ္ျပေပးေသာ Properties မ်ားကို လြယ္ကူစြာ သြားေရာက္ ေျပာင္းလဲႏိုင္ပါသည္။
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Layers (သုိ႕မဟုတ္) Properties panels ကို turn on လုပ္ရန္ အတြက္ Home tab ကုိ Right–click ႏိွပ္ျပီး၊ panels ကို

select လုိက္ပါ။ ျပီးေနာက္ Panels list မွ Layers န႕ဲ Properties ကုိ select လိုက္ပါ။

Layers Panel - Layer Control List

ေအာက္တြင္ ျပထားေသာ ပုံသည္ Layers panel ျဖစ္ပါသည္။ Object ကို selected ျပီးပါက ထို object ပါ၀င္ေသာ Layer

ကုိဖြင့္ျပီး modify မ်ားလုပ္ႏိုင္ပါသည္။

Properties Panel - Select a Linetype
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ေအာက္တြင္ ေဖာ္ျပထားေသာ ပုံသည္ Properties panel မွ linetype list ကုိ selected ထားေသာ ပုံျဖစ္သည္။ ထို

Panel ကုိအသံုးျပဳျပီး object မ်ား၏ color, linetype န႕ဲ lineweight တုိ႕ကုိ ၾကည့္ရႈ႕ျပဳျပင္ႏိုင္ပါသည္။

Show/Hide Lineweight

Drawing ထတဲြင္ ျပဳျပင္ထားေသာ lineweight မ်ားကုိ ျမင္ေတြ႕ႏိုင္ရန္ Status bar တြင္ရိွေသာ Show/Hide Lineweight

ကုိ turn on လုပ္ရပါသည္။

Show/Hide Lineweight Right- click ႏိွပ္ျပီး Setting ၀င္ကာ display scale ကုိလည္း ျပဳျပင္ႏိုင္ပါသည္။

Procedure: Changing an Object's Layer Property

Layers panel မွ Layer Control list ကုိအသုံးျပဳျပီး Objects မ်ား၏ layer property ကုိ မည္သုိ႕ျပဳျပင္ေျပာင္းလဲ ရမည္ကို

ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။
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၁) တစ္ျခား Layer သို႕Move ရန္အတြက္ drawing အတြင္းမွ Objects မ်ား တစ္ခု (သို႕မဟုတ္) တစ္ခုထက္ပိုျပီး Select

လိုက္ပါ။

၂) Home tab,Layers panel > Layer Control list ကုိ click လိုက္ပါ။ Selected ထားေသာ Objects မ်ားကုိ တျခားေသာ

Layer သုိ႕ေရြ႕ရန္ မိမိတို႕ ေရြ႕မည့္ Layer ကုိ select လုိက္ပါ။

၃) Deselected ျဖစ္ေစရန္ Esc key ကိုနိွပ္လုိက္ပါ။

Procedure: Changing an Object's Color Property

Properties panel တြင္ရိွေသာ Color list မွ မိမိတို႕ ေျပာင္းလုိေသာ color ကုိ select ျပီး Objects မ်ား၏ Color Property

ေျပာင္းလဲပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) မိမိတို႕ color ေျပာင္းခ်င္ေသာ drawing မွ objects မ်ားကုိ တစ္ခု (သုိ႕မဟုတ္) တစ္ခုထက္ ပိုျပီး Select လိုက္ပါ။
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၂) Ribbon, Home tab > Properties panel > Object Color တြင္ မိမိတုိ႕ သေဘာက်ေသာ color ကုိ select လိုက္ပါ။

၃) Deselected ျဖစ္ေစရန္ Esc key ကိုနိွပ္လုိက္ပါ။

Procedure: Changing an Object's Linetype Property

Properties panel တြင္ရိွေသာ Linetypes list မွ မိမိတုိ႕ ေျပာင္းလုိေသာ Linetype ကုိ select ျပီး Objects မ်ား၏

Linetype ေျပာင္းလဲပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ Linetypes list တြင္ မိမိတို႕ ႏွစ္သက္ ေသာ

Linetype မပါ ပါကထပ္မံ၍ Load linetype setting တြင္ ၀င္ေရာက္ Load လုပ္ႏိုင္ပါသည္။

၁) မိမိတို႕ Linetype ေျပာင္းခ်င္ေသာ drawing မွ objects မ်ားကို တစ္ခု (သုိ႕မဟုတ္) တစ္ခုထက္ ပိုျပီး Select လုိက္ပါ။

၂) Ribbon, Home tab > Properties panel > Linetype List မွ မိမိတုိ႕ ေျပာင္းလိုေသာ Lintype ကုိ select လိုက္ပါ။
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၃) Deselected ျဖစ္ေစရန္ Esc key ကိုနိွပ္လုိက္ပါ။

Procedure: Changing an Object's Lineweight Property

Properties panel တြင္ရိွေသာ Lineweight list မွ မိမိတုိ႕ ေျပာင္းလိုေသာ Linetype ကုိ select ျပီး Objects မ်ား၏

Linetype ေျပာင္းလဲပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) မိမိတို႕ Linetype ေျပာင္းခ်င္ေသာ drawing မွ objects မ်ားကို တစ္ခု (သုိ႕မဟုတ္) တစ္ခုထက္ ပိုျပီး Select လုိက္ပါ။

၂) Ribbon, Home tab > Properties panel > Lineweight List မွ မိမိတုိ႕ ေျပာင္းလိုေသာ Lineweight ကုိ select

လိုက္ပါ။
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၃) Deselected ျဖစ္ေစရန္ Esc key ကိုနိွပ္လုိက္ပါ။

Practice Exercise: Changing Object Properties

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ layer 0 ျဖင့္ Simple drawing မ်ားေရးဆြဲျပီး၊ ထုိ drawing မ်ား အတြက္ Layer မ်ားကို

တည္ေဆာက္ေပးရမည္ ျဖစ္သည္။ Objects မ်ားကုိ တည္ေဆာက္ ထားေသာ Layer မ်ားဆီသုိ႕ Add ျပီးေနာက္၊ Layers န႕ဲ

Properties panels မွ List မ်ားကုိ အသုံးျပဳျပီး Objects မ်ား၏ Properties ကုိ ျပင္ဆင္ေျပာင္းလဲ ေပးရမည္။

၁) Acad.dwg template ျဖင့္ New drawing ဖြင့္ကာ layer 0 ၌ lines, circles နဲ႕ rectangles တစ္ခ်ိဳ႕ကုိ ေရးဆြဲ လိုက္ပါ။

၂) Home tab,Layers panel > Layer Properties. Layer Properties Manager တြင္ ေအာက္တြင္ ေဖာ္ျပေပးထား

ေသာနာမည္မ်ားျဖင့္ Layer ဖန္တီးရန္ -

 Circles - red

 Lines - blue

 Rectangles - cyan
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၃) Hidden linetype ကုိ Lines layer တြင္ Add ရန္ -

 Layer Properties Manager မွ Lines layer အတြက္ linetype column ေအာက္မွ Continuous ကုိ click ပါ။

 Linetype dialog box ကုိ select ျပီး၊ Load ကုိ click ပါ။

 Load or Reload Linetypes dialog box တြင္ Scroll bar ဆြဲျပီး HIDDEN ကုိရွာျပီး select လိုက္ပါ။

 Dialog boxes ကုိ exit ေပးရန္ Ok ကို click လုိက္ပါ။

၄) Lineweight 0.35 ကုိ Rectangles ဟုနာမည္ေပးထားေသာ Layer သုိ႕ Add ရန္ -

 Layer Properties Manager dialog box တြင္ Rectangles Layer အတြက္Default lineweight ကို click

လိုက္ပါ။

 Lineweight dialog box တြင္ lineweight 0.35 mm ကို select လိုက္ပါ။
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 Dialog boxes ကုိ exit ေပးရန္ Ok ကို click လုိက္ပါ။

 Layer Properties Manager ကုိ Close လိုက္ပါ။

၅) Object Properties ကိုေျပာင္းလရဲန္ -

 Command line blank အေနအထားျဖင့္ Circles အားလုံးကုိ Select လိုက္ပါ။ Home tab, Layers panel>

Layer တြင္ Circle layer ကုိ select လုပ္လိုက္ပါ။ Objects မ်ားကုိ deselect ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။

 အထက္ပါ အဆင့္အတုိင္း lines န႕ဲ rectangles တုိ႕အတြက္လည္း ျပဳလုပ္ျပီး၊ ၎တို႕အတြက္ သတ္မွတ္

ေပးထားေသာ Layer မ်ားသုိ႕ အသီးသီး Add လိုက္ပါ။

 Objects မ်ားအားလုံးကုိ deselect ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။

 လက္ရိွ drawing area အတြင္းမွ drawing မ်ားသည္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ျဖစ္ေနရမည္။

၆) Status bar ေပၚမွ Show Lineweight setting ကို trun on လုပ္လုိက္ပါ။

၇) Object Properties မ်ားကုိ ထပ္မံေျပာင္းလရဲန္ -

 Command line blank အေနအထားျဖင့္ Objects အားလုံးကုိ Select လုိက္ပါ။
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 Home tab, Properties panel >Linetype(1) > Hidden ကုိ select လိုက္ပါ။

 Lineweight list (2) မွ 0.40 ကို click လုိက္ပါ။

 Color list (3) မွ White ကုိ select လုိက္ပါ။

 Drawing area ထတဲြင္ ေရးဆြဲထားေသာ Objects မ်ား၏ color, linetype န႕ဲ lineweight တုိ႕သည္

ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း အားလုံး ဆင္တူ ျဖစ္သြားမည္ ျဖစ္သည္။

 ရုတ္တရက္ၾကည့္လုိက္လွ်င္ မည္သည့္ Object က မည္သည့္ Layer ျဖစ္ေၾကာင္း သိႏိုင္မည္ မဟုတ္ေပ။

၈) Object Properties မ်ားကုိ Layer အလုိက္ျပန္ေျပာင္း ေပးရန္ -

 Command line blank အေနအထားျဖင့္ Objects အားလုံးကုိ Select လုိက္ပါ။

 Home tab, Properties panel >ByLayer အလိုက္ (1) Color, (2) Linetype နဲ႕ (3)Lineweight တို႕ကို

ျပန္ေျပာင္းေပးလုိက္ပါ။

 Objects မ်ားအားလုံးကုိ deselect ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။

 Properties အားလုံးသည္ အဆင့္ (၅) အတုိင္း ျပန္ျဖစ္သြားရမည္။

Exercise: Change Object Properties
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ဤေလ့က်င့္ခန္းတြင္ Layers နဲ႕ Properties toolbars တို႕ကို အသံုးျပဳျပီး၊ Objects မ်ား၏ layer, linetype န႕ဲ lineweight

တုိ႕ကုိ ေျပာင္းေပးရမည္။

The completed exercise

၁) I_Change-Properties.dwg ကိုဖြင့္ပါ။

၂) Doors ၏ Linetype ကုိ Bylayer သုိ႕ေျပာင္းေပးရန္ -

 ပုံတြင္ ျမွားျဖင့္ ျပထားေပးေသာ door ကို select လုပ္ပါ။

 Home tab, click Properties panel >Linetype.

 Bylayer ကို select လုပ္ပါ။ Objects မ်ားအားလုံးကုိ deselect ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။

၃) Machine labels တစ္ခ်ိဳ႕ကို အျခားေသာ Layer သို႕ Move ရန္ -

 Command line blank အေနအထားျဖင့္ Machine နံပါတ္ 47 မွ 54 အထိကို select လိုက္ပါ။

 Home tab, click Properties panel > Layer.
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 Machine နံပါတ္ 47 မွ 54 မ်ားကို machine labels layer သို႕ Move ရန္ machine labels layer ကုိ select

လိုက္ပါ။

 Objects မ်ားအားလုံးကုိ deselect ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။

၄) စားပြဲ တစ္ခ်ိဳ႕ကို အျခားေသာ Layer သို႕ Moveရန္ -

 ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း စားပြဲ၀ိုင္း ၃လံုးကို select လိုက္ပါ။

 Home tab, Properties panel > Layer.

 စားပြဲ၀ိုင္း ၃လံုးကုိ furniture layer သို႕ Move ရန္အတြက္ furniture layer ကုိ click လိုက္ပါ။

 Objects မ်ားအားလုံးကုိ deselect ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။

၅) Objects မ်ား၏ lineweight ကို ေျပာင္းရန္ -

 Lineweight ကုိ turn on ရန္ Status bar မွ Show/Hide Lineweight ကို click လုိက္ပါ။
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 Drawing မွ stairwell ကို Zoom ခ်႕ဲၾကည့္ လုိက္ပါ။

 Stairwell အတြင္းနံရံမွ stair treads န႕ဲ the door lines အားလံုးကုိ select လိုက္ပါ။

 Home tab, Properties panel >Lineweight.

 Bylayer ကုိ select ျပီး၊ Unselected ျဖစ္ရန္ Esc key ကိုႏိွပ္လုိက္ပါ။

၆) Objects မ်ား၏ Color ကုိေျပာင္းရန္ -

 Drawing အတြင္းမွ ညာဖက္အေပၚပိုင္းကို Zoom ခ်႕ဲ လိုက္ပါ။

 ေအာက္ေဖာ္ျပပါ ပုံမွ Lines မ်ားကို select လိုက္ပါ။

 Home tab, Properties panel > Color.

 Objects မ်ား၏ color ၎တုိ႕၏ Layer အလုိက္ color ျဖစ္သြားေအာင္ Bylayer ကို select လိုက္ပါ။

 Objects မ်ားအားလုံးကုိ deselect ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။
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၇)Machines အခ်ိဳ႕ကုိ အျခားေသာ Layer သုိ႕ Move ရန္ -

 Machines labeled 5 ကေန 10 အထိကုိ နံပါတ္မ်ား မပါပဲ select လိုက္ပါ။

 Home tab, Properties panel > Layer.

 Machines labeled မ်ားကုိ Machines Layer ထဲသုိ႕ Move ရန္ အတြက္ Machines Layer ကုိ select လိုက္ပါ။

 Objects မ်ားအားလုံးကုိ deselect ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။

၈) Files အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။
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Lesson: Quick Properties

ဤသင္ခန္းစာတြင္ မတူညီေသာ objects မ်ား၏ properties မ်ားျပဳျပင္ျခင္း အပိုင္းကို ေလ့လာသြားရမည္ ျဖစ္ပါသည္။

ပထမဆံုးအေနန႕ဲ Quick Properties panel အေၾကာင္းကို အရင္ဆံုး ေလ့လာသြားရမည္ျဖစ္ျပီး၊ ၎ panel ကို

access လုပ္ပံုႏွင့္ ၎ panel မွ objects မ်ား၏ properties ကုိ လိုအပ္သလို ျပဳဆင္သတ္ေပးသြားရမည္

ျဖစ္သည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Quick Properties panel and settings အေၾကာင္းကို သိရိွနားလည္ လာေစရန္။

 Quick Properties panel ကုိအသုံးျပဳျပီး objects မ်ား၏ properties မ်ားကို ၾကည့္တတ္ေစရန္။

About Quick Properties

Quick Properties panel သည္ Objects မ်ား၏ Properties မ်ားကုိ ၾကည့္ရန္ႏွင့္ Modify လုပ္ေပးႏိုင္ေသာ panel

တစ္ခုျဖစ္ပါသည္။ အထက္တြင္ ေလ့လာျပီး ျဖစ္ေသာ Objects Properties နွင့္ လုပ္ေဆာင္ခ်က္ျခင္း တူညီေသာ္လည္း၊

Objects Properties ရဲ႕ Properties palette ေလာက္မၾကီးေသာေၾကာင့္၊ ေနရာယူျခင္းမွ ကင္းေ၀းေစပါသည္။ Quick

Properties panel သည္ Object ကုိ select လိုက္သည္နွင့္ panel သည္အလိုေလ်ာက္ display သြားမည္ ျဖစ္ျပီး၊

unselected လိုက္ပါက အလိုအေလ်ာက္ ျပန္လည္ေပ်ာက္ကြယ္ သြားပါသည္။

Quick Properties Panel

ေအာက္ေဖာ္ျပပါပုံသည္ Quick Properties panel ျဖစ္ပါသည္။
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Object Type: Selected ထားေသာ Object ၏ type ကိုေဖာ္ျပေပးပါသည္။

Object Properties: Lists object properties.

Customize: Customize User Interface (CUI) dialog box တြင္ မိမိတို႕ Selected ထားေသာ Object ၏

အျခားေသာ Properties မ်ားကုိ Quick Properties panel တြင္ ထပ္မံေဖာ္ျပေပးႏိုင္သည္ Lists မ်ားကုိ display

ေပးပါသည္။

Options: Close, customize, နဲ႕ Quick Properties settings မ်ားကို display ေပးပါသည္။

Quick Properties Settings

Quick Properties panel ကို display လုပ္ရန္ အတြက္ Drafting Settings dialog box ၏ Quick Properties tab တြင္

Enable Quick Properties Palette ကုိ select လုပ္ေပးရပါသည္။ (သို႕မဟုတ္) Status bar ေပၚတြင္ရိွေသာ Quick

Properties ကို click ျပီး turn on ႏိုင္ပါသည္။ Setting မွာေအာက္ပါ အတိုင္း ျဖစ္ပါသည္။
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Enable Quick Properties Palette: Selected ထားေသာ Object ၏ type ကုိ ေဖာ္ျပေပးပါသည္။

Palette Display: Quick Properties panel တြင္ Objects အားလုံး၏ Properties ကုိေဖာ္ျပ ေပးမွာလား (သုိ႕မဟုတ္)

Customize User Interface (CUI) အတြင္းမွ Quick Properties အတြက္ သတ္မွတ္ေပးထားေသာ Object သာလွ်င္

စသည္တုိ႕ကုိ ေရြးခ်ယ္ရသည္။

Palette Location: Quick Properties panel ေပၚမည့္ေနရာကုိ သတ္မွတ္ရမည့္ ေနရာ။

Palette Behavior: Default Height အတြက္သတ္မွတ္ ေပးထားေသာ Properties အေရအတြက္ ကုိသာလွ်င္ Quick

Properties panel တြင္ေဖာ္ျပေပးရန္ ေရြးခ်ယ္ရမည့္ ေနရာ။

Using Quick Properties

Quick Properties panel သည္ Object ကုိ select လိုက္သည္နွင့္ panel သည္အလိုေလ်ာက္ display သြားမည္ ျဖစ္ျပီး၊

unselected လိုက္ပါက အလိုအေလ်ာက္ ျပန္လည္ေပ်ာက္ကြယ္သြားပါသည္။ Quick Properties panel ကုိ display

လုပ္ရန္ အတြက္ Drafting Settings dialog box ၏ Quick Properties tab တြင္ Enable Quick Properties Palette ကို

select လုပ္ေပးရပါသည္။ (သို႕မဟုတ္) Status bar ေပၚတြင္ ရိွေသာ Quick Properties ကုိ click ျပီး turn on ႏိုင္ပါသည္။
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Command Access

Quick Properties

Keyboard Shortcut: CTRL+SHIFT+P

Object Shortcut Menu: Quick Properties

Status Bar: Quick Properties

Procedure: Using Quick Properties

Quick Properties အသံုးျပဳပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Status bar ေပၚတြင္ ရိွေသာ Quick Properties ကုိ click ျပီး turn on ႏိုင္ပါသည္။

၂) Object ကုိ select ပါ။

၃) Quick Properties panel မွ Objects မ်ား၏ Properties မ်ားကို ၾကည့္ႏိုင္သလုိ၊ ျပန္လည္ ျပင္ဆင္သတ္မွတ္

နိုင္ပါသည္။

၄) Quick Properties panel ကို exit ေပးရန္ Esc key ႏိွပ္ရပါသည္။

Exercise: Use Quick Properties

ဤေလ့က်င့္ခန္းတြင္ Quick Properties Palette ကုိအသုံးျပဳျပီး အမ်ိဳးမ်ိဳး Objects မ်ား၏ Properties မ်ားကို ၾကည့္ျခင္းကို

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။ Customize User Interface (CUI) dialog box အတြင္းမွ သက္ဆိုင္ရာ Objects မ်ား

အျခားေသာ properties မ်ားကို Quick Properties Palette တြင္ေဖာ္ျပေပးရန္ သြားေရာက္ Add ျခင္းကုိပါ

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) c_quick properties.dwg ကုိဖြင့္ပါ။

၂) Status bar ေပၚရိွ Quick Properties ေပၚတြင္ Right – click ႏိွပ္ျပီး Setting ကုိ clickပါ။

၃) Drafting Settings dialog box မွ Quick Properties tab:

Enable Quick Properties Palette option ကုိ check ေပးလိုက္ပါ။

Palette Display အတြက္ All Objects ကုိ select လုိက္ပါ။

၄) Palette Location တြင္ -

 Cursor-dependent ကို click ပါ။

 Quadrant တြင္ Bottom-Right ကုိ select ေပးလုိက္ပါ။

 Distance in Pixels တြင္ 20 ဟုရိုက္ထည့္လိုက္ပါ။
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၅) Palette Behavior တြင္ -

 Collapse Palette Automatically ကုိ select ေပးလိုက္ပါ။

 Minimum number of rows အတြက္ 2 ဟုရိုက္ထည့္လုိက္ပါ။

 Ok ကို Click လိုက္ပါ။

၇) Drawing ထမွဲ Line ကုိ select ပါ။ Quick Properties Palette သည္ Cursor ၏ ညာေအာက္တြင္ အလိုအေလ်ာက္

ေပၚလာပါလိမ္႕မည္။

၈) Cursor ကုိ Quick Properties panel ၏အေပၚသုိ႕ Move ေပးလိုက္ပါ။ Panel သည္ အျခားေသာ Properties မ်ားကုိပါ

ေဖာ္ျပေပးလာပါလိမ္႕မည္။

၉) Deselected ျဖစ္သြားေစရန္ Esc key ႏိွပ္လိုက္ပါ။

၁၀) Drawing ထဲမွ dimensions အားလုံးကို select ပါ။ အတန္းနွစ္တန္း ျဖင့္ Quick Properties panel သည္

အလုိအေလ်ာက္ ေပၚလာပါလိမ္႕မည္။
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၁၀) Status bar ေပၚရိွ Quick Properties ေပၚတြင္ Right–click ႏိွပ္ျပီး Setting ကုိ clickပါ။

၁၁) Drafting Settings dialog box မွ Quick Properties tab ရိွ Palette Behavior ေအာက္တြင္ check ေပးထားေသာ

Collapse Palette Automatically ကုိ uncheck ျပန္လုပ္လုိက္ပါ။

၁၃) Drawing အတြင္းမွ Dimension ကို select ပါ။ Quick Properties panel သည္ အလုိအေလ်ာက္ ျပန္႕ကား

လာပါလိမ့္မည္။

၁၄) Deselected ျဖစ္သြားေစရန္ Esc key ႏိွပ္လုိက္ပါ။

၁၅) File အားလုံးကုိ မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Matching Object Properties

ဤသင္ခန္းစာတြင္ Match Properties command ကိုအသံုးျပဳျပီး Objects တစ္ခု၏ Properties ကို အျခား Objects ၏

Properties အျဖစ္ကူးေျပာင္းသည့္ သင္ခန္းစာကုိ ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ ဤသင္ခန္းစာ ကုိေလ့လာျခင္း

ျပီးစီးသြားပါက Match Properties command ျဖင့္ drawings မ်ားတြင္ Properties မ်ား ကူးေျပာင္းေပးျခင္းကုိ နားလည္

သေဘာေပါက္ လာမည္ျဖစ္သည္။
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Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Match Properties command ကုိအသုံးျပဳျပီး မူရင္း object ၏ properties မ်ားကို အျခားေသာ object သုိ႕

ကူးေျပာင္းေပးျခင္းကုိ နားလည္သေဘာေပါက္ လာေစရန္။

Matching an Object's Properties

Object တစ္ခု၏ properties ကုိအျခားေသာ object တစ္ခုသုိ႕ အလြယ္တကူ လ်င္ျမန္စြာ ကူးေျပာင္းေပးႏိုင္ရန္ Match

Properties command ကုိအသုံးျပဳသြားရမည္ ျဖစ္ပါသည္။

ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံသည္ မူရင္း hatch object (1) ၏ properties ကုိအျခားေသာ hatch object (2) သုိ႕

Match Properties command ျဖင့္ applied လုပ္ထားေသာ ပုံျဖစ္ပါသည္။
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Command Access

Match Properties

Command Line: MATCHPROP

Ribbon: Home tab > Clipboard panel > Match Properties

Menu: Modify > Match Properties

Property Settings Dialog Box

Property Settings dialog box တြင္ မိမိတို႕ select ထားေသာ properties မ်ားအတုိင္း မူရင္း object မွ properties

မ်ားသည္ match လုပ္လုိက္ေသာ objects မ်ားသို႕ ကူးေျပာင္းသြားမည္ ျဖစ္သည္။ Match Properties command ကို

active လုပ္ျပီးပါက Match Properties settings တြင္ မိမိတုိ႕ select လုိေသာ properties မ်ားကို select ကာ၊ drawing

တစ္ေနရာ၌ right–click ေထာက္၍ မူရင္း object ကုိ select ရပါမည္။
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Property Settings dialog box တြင္ Basic Properties and Special Properties ဟူ၍ နွစ္ပိုင္းခြဲထားပါသည္။

Basic Properties သည္သာမန္ objects ၏ properties မ်ားျဖစ္ပါသည္။

Special Properties သည္ object ၏ types မ်ားကုိ ေရြးခ်ယ္သတ္မွတ္ေပး ရေသာ properties မ်ားအတြက္

ျဖစ္ပါသည္။

Procedure: Matching Object Properties

မူရင္း object ၏ properties မ်ားကုိ အျခားေသာ objects မ်ားသို႕ ကူးေျပာင္းျခင္းကို Match Properties command

အသုံးျပဳျပီး ျပဳလုပ္သြားပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, click Home tab > Clipboard Panel > Match Properties.

၂) မူရင္း object ကုိ select ပါ။
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၃) အျခားေသာ object သုိ႕ properties ကူးေျပာင္းျခင္း လုပ္ရန္ အတြက္၊ drawing တစ္ေနရာရာကို right–click ႏိွပ္ပါ။

ထုိ႕ေနာက္ setting ကုိ click ပါ။ Properties Settings dialog box မွ properties ကုိ select ပါ။

Practice Exercise: Match an Object's Properties

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ rectangle ကုိ layer 0 ေပၚတြင္ ဖန္တီးေပးရမည္ ျဖစ္သည္။ Properties မ်ား select ျပီး

new layer တစ္ခုကို တည္ေဆာက္ကာ၊ ထုိ layer ေပၚတြင္ rectangle ကုိ ဖန္တီးလိုက္ပါ။

၁) New drawing တစ္ခုကုိ စတင္လိုက္ပါ။

၂) Default Layer 0 ေပၚတြင္ rectangle ကုိေရးဆြဲလုိက္ပါ။

၃) New layer ဖန္တီးရန္ -

 Layer Properties dialog box တြင္ ေအာက္ေဖာ္ျပပါ object properties မ်ားသတ္မွတ္ေပးျပီး new layer

ကုိဖန္တီးရန္ -

 Name: Test

 Color: blue

 Linetype: Hidden (hidden linetype ကုိ the drawing အတြင္းသုိ႕ အရင္ဆုံး load လုပ္ပါ။)

 Lineweight: 0.35 (Lineweight ကုိ show ရန္အတြက္ status bar တြင္ရိွေသာ Show

Lineweight ကုsိelect ပါ)

 Current layer လုပ္လိုက္ပါ။

 Dialog box ကုိ exit လုပ္ပါ။

၄) ျပီးလွ်င္ properties မ်ားကူးေျပာင္းခံမည့္ objects မ်ားကို new setting layer ျဖင့္ rectangle ဖန္တီးလုိက္ပါ။ Default
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object properties မ်ားကိုသာ အသုံးျပဳသင့္ပါသည္။

မွတ္ခ်က္ ။ ။ lineweight ေပၚရန္ အတြက္ status bar မွ Show lineweight ကုိ select ရန္ မေမ႕ပါနွင့္။

၅) Properties မ်ားကုိ match လုပ္ရန္ -

 Home tab, click Clipboard Panel > Match Properties.

 New layer တြင္ေရးဆြဲထားေသာ rectangle မ်ားမွ rectangles (1) တစ္ခုကုိ select လုိက္ပါ။

 ထုိ႕ေနာက္ Layer 0 တြင္ ဖန္တီးထားေသာ rectangle မ်ားကို crossing window ဖန္တီးျပီး select လုိက္ပါ။

 Match Properties command ကုိ exit လုပ္ရန္ ENTER ႏိွပ္လိုက္ပါ။

၆) Rectangle ၏ object properties မ်ားသည္ ေအာက္ေဖာ္ျပပါ အတုိင္း match လုပ္ျပီး ျဖစ္သြားပါလိမ္႕မည္။

Exercise: Match Object Properties
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ဤသင္ခန္းစာတြင္ မူရင္း object ၏ properties မ်ားကုိ အျခားေသာ object သုိ႕ ကူးေျပာင္းျခင္းကို ေလ့က်င့္သြားရမည္

ျဖစ္ပါသည္။ ဤေလ့က်င့္ခန္းကို ေလ့က်င့္ျခင္း ျပီးဆုံးသြားပါက Match properties ၏ အားသာခ်က္ကို သိရိွနားလည္

လာမည္ျဖစ္သည္။

The completed exercise

၁) C_Match-Properties1.dwg ကုိဖြင့္လိုက္ပါ။

၂) Window block တစ္ခုကို Match Properties လုပ္ရန္ -

 Home tab, Clipboard Panel >Match Properties ကို click ပါ။

 Window block (1) ကုိ select ပါ။

 Properties မ်ားကူးေျပာင္း ေပးခ်င္ေသာ Window block (2) Window block (3) န႕ဲ Window block (4) ကို

select လုိက္ပါ။

 Command လုပ္ေဆာင္မွဳ႕ျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္လိုက္ပါ။
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၃) Single door ရဲ႕ Properties မ်ားကုိ double doors သုိ႕ကူးေျပာင္းေပးရန္ -

 Home tab, Clipboard Panel >Match Properties ကို click ပါ။

 Single door swing arc (1) ကို select ပါ။

 Drawing window အတြင္း တစ္ေနရာရာကို Right-click ႏိွပ္ပါ။ ျပီးလွ်င္ Setting ကုိ click ပါ။

 Property Settings dialog box မွ Basic Properties ေအာက္တြင္ ရိွေသာ Color (2) Option ကို uncheck

ေပးလုိက္ပါ။

 Drawing window သုိ႕ျပန္သြားရန္ Ok ကုိ click လိုက္ပါ။
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 Crossing window ျဖင့္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း (3) န႕ဲ (4) ဟုျပထားေပးေသာ double doors ကုိ select

လိုက္ပါ။

 Match Properties command ျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၄) Wall Hatches တစ္ခုမွ အျခားတစ္ခုသုိ႕ Properties ကူးေျပာင္းရန္ -

 Home tab, Clipboard Panel >Match Properties ကို click ပါ။

 Doors နွစ္ခုအၾကားက Wall Hatches (1) ကုိ ေအာက္ပုံတြင္ ေဖာ္ျပေပး ထားသည့္ အတိုင္းselect ပါ။

 Drawing window အတြင္း တစ္ေနရာရာကို Right-click ႏိွပ္ပါ။ ျပီးလွ်င္ Setting ကုိ click ပါ။
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 Property Settings dialog box မွ Basic Properties ေအာက္တြင္ ရိွေသာ Color (2) Option ကို check ေပးျပီး၊

Special Properties ေအာက္က Hatches ကုိ uncheck ေပးလိုက္ပါ။

 Drawing window သုိ႕ျပန္သြားရန္ Ok ကုိ click လိုက္ပါ။

 Wall Hatches (1) အထက္တြင္ ရိွေသာ Wall Hatches (2) ကို select ပါ။

၅)Wall hatches မ်ား၏ hatches style ကုိ Match လုပ္ရန္ -

 Home tab, Clipboard Panel >Match Properties ကုိ click ပါ။ Drawing window အတြင္း တစ္ေနရာရာကို

Right-click ႏိွပ္ျပီး၊ Property Settings dialog box ကုိေခၚလိုက္ပါ။

 Hatche Option ကုိ select ျပီး Ok ကို Click ပါ။

 Drawing window အတြင္းမွ တူညီေသာ Hatches မ်ားကုိ select လိုက္ပါ။

 ထုိအခါ Hatches အားလုံးသည္ basic properties အတိုင္း ေျပာင္းလဲသြားမည္ ျဖစ္သည္။

 အနားယူခန္းႏွင့္ ကပ္လ်က္ရိွေသာ Wall Hatche ကို ထပ္မံ၍ select လုိက္ပါ။

 Command ျပီးဆံုးသြားေစရန္ Enter ႏိွပ္ပါ။

၆) Across dimensions မ်ား၏ Propertiesကို Match ရန္ -
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 Home tab, Clipboard Panel >Match Properties ကို click ပါ။

 Drawing ရ႕ဲ ေအာက္ေျခနားတြင္ ရိွေသာ Dimensions အားလုံးကုိ select လိုက္ပါ။

 Drawing ရ႕ဲ အထက္တြင္ ရိွေသာ Dimensions အားလံုးကို select လိုက္ပါ။

 Match Properties command ကိုျပီးဆံုးသြားေစရန္ Enter ႏိွပ္ပါ။

၇) Objects မ်ား၏ Properties ကုိ တစ္ခုျဖင့္ တစ္ခု Matches လုပ္ရန္ အျခားေသာ Drawing မ်ားဖြင့္ျခင္း -

 C_Match-Properties2.dwg ကုိဖြင့္လိုက္ပါ။

 Drawing တစ္ခုခ်င္းစီကုိ ယွဥ္ၾကည့္ႏိုင္ရန္ View tab, Window panel > Tile Vertically ကုိ click ပါ။

 Drawing တစ္ခုကုိ Zoom Extents လုပ္လိုက္ပါ။

 ေနာက္မွ ဖြင့္လုိက္ေသာ drawing ၏ CONFERENCE ROOM ပါ၀င္ေသာ ညာဖက္ ေအာက္ေထာင့္ကုိ Zoom

ခ်႕ဲလုိက္ပါ။
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၈) Objects မ်ား၏ Properties ကုိ တစ္ခုျဖင့္ တစ္ခု Match လုပ္ရန္ -

 Home tab, Clipboard Panel >Match Properties ကို click ပါ။

 LG. CONFERENCE text ကို select လုပ္ပါ။

 C_Match-Properties1.dwg ကုိ Drawing window တြင္ Activate ျဖစ္ရန္ Click လုိက္ပါ။

 လက္ရိွဖြင့္လိုက္ေသာ drawing မွ Text တစ္ခုကုိ select လုိက္ပါ။

 ဆက္လက္ျပီး လက္ရိွ drawing မွ Objects အားလုံး၏ Text ကို select လုပ္ပါ။

 Command ကို ျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၉) Object တစ္ခုမွ တစ္ခုသို႕ Matches Properties လုပ္ျပီးသြားေသာအခါ၊ မူရင္း Object ၏ Properties (i.e. layer, text

style, linetype) အားလံုးသည္ Matches လုပ္လုိက္ေသာ Objects မ်ားဆီသုိ႕ ေရာက္သြားမည္ ျဖစ္သည္။
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၁၀) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Using the Properties Palette

ဤသင္ခန္းစာတြင္ Objects မ်ားကို Properties palette မွ မည္သို႕ Modify လုပ္ရမည္ကုိ ေလ့လာသြားရမည္ ျဖစ္သည္။

Drawing area တြင္ မိမိတုိ႕ စိတ္ၾကိဳက္ ေရြးခ်ယ္သတ္မွတ္ လုိက္ေသာ Properties မ်ားျဖင့္ Drawing မ်ားကို

ေရးဆြၾဲကပါသည္။ ထိုေရးဆြဲျပီးေသာ Objects မ်ား၏ Properties ကုိျပန္လည္ ၾကည့္ရႈ႕စစ္ေဆးျခင္း (သို႕မဟုတ္)

ျပန္လည္ျပင္ဆင္ သတ္မွတ္ျခင္းတို႕ကို Properties palette မွ ျပဳလုပ္သြားႏိုင္ပါသည္။

ဤသင္ခန္းစာ ကုိေလ့လာျခင္းျပီးဆုံးသြားပါက Objects မ်ား၏ Properties ကုိ ျပန္လည္ ၾကည့္ရႈ႕စစ္ေဆးျခင္း (သို႕မဟုတ္)

ျပန္လည္ျပင္ဆင္ သတ္မွတ္ျခင္းတို႕ကို နားလည္သေဘာေပါက္ သြားမည္ျဖစ္သည္။ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ

Drawing (၂) ခုတြင္ တူညီေသာ Properties မ်ားျဖင့္ ေရးဆြဲထားျခင္းျဖစ္သည္။ ထုိ Objects မ်ား၏ Properties မ်ားကို

မိမိတုိ႕ စိတ္ၾကိဳက္ Properties မ်ားျဖစ္ေအာင္ ျပန္လည္ ျပင္ဆင္ သတ္မွတ္ႏုိင္ပါသည္။

Objectives
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ဤသင္ခန္းစာ ကုိေလ့လာျခင္းျပီးဆုံးသြားပါက -

 Objects မ်ား၏ Properties ကုိ ျပန္လည္ ၾကည့္ရႈ႕စစ္ေဆး ျခင္း (သို႕မဟုတ္) ျပန္လည္ျပင္ဆင္ သတ္မွတ္ျခင္း

တုိ႕ကုိ ျပဳလုပ္တတ္လာေစရန္။

Using the Properties Palette

Properties Palette ကိုအသံုးျပဳ၍ ေရးဆြဲထားေသာ Drawing အတြင္းမွ Objects မ်ား၏ Properties (color, linetype,

lineweight, or layer) စသည္တို႕ကို ျပန္လည္ ျပင္ဆင္သတ္မွတ္ ႏိုင္ပါသည္။

Object Properties

Properties မ်ားကုိ General,Geometry န႕ဲ Misc အစရိွသည္ျဖင့္ အုပ္စုလိုက္ ခြဲျခားေဖာ္ျပ ေပးထားပါသည္။ Title တြင္ရိွ

arrow ကိုႏိွပ္ျပီး၊ အုပ္စုတစ္ခုခ်င္းစီ၏ အေသးစိတ္ Properties အခ်က္အလက္မ်ားကုိ အက်ယ္ခ်ဲ႕ ၾကည့္ ႏိုင္ပါသည္။

Read-only properties ကုိ Gray Background ျဖင့္ေဖာ္ျပေပးထားျပီး၊ ထုိတန္ဖိုးမ်ားကုိမူ အခ်ိန္းအေျပာင္း လုပ္၍ရမည္

မဟုတ္ေပ။ Read-write properties မ်ားကိုမူ select ျပီး၊ တန္ဖိုး အခ်ိန္းအေျပာင္းမ်ား ျပဳလုပ္ႏိုင္ပါသည္။

Command Access

Properties Palette

Command Line: PROPERTIES
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Ribbon: Home tab > Properties panel > Dialog Box Launcher

Menu: Modify > Properties; Tools > Palettes > Properties; right-click an object > Properties

Keyboard Shortcut: CTRL+1

Selecting Objects Using the Object Types List

မိမိတုိ႕ အေနျဖင့္ multiple object ကို select လုပ္ပါက၊ Object Types list တြင္လည္း Objects အားလုံးကို

ေဖာ္ျပေပးသြားပါလိမ္႕မည္။ ကြဲျပားျခားနား Objects မ်ားကုိ select ထားပါက Properties Palette တြင္

selected ထားေသာ Objects အားလုံး၏ ေရပူရ Properties မ်ားကုိသာ ေဖာ္ျပေပးသြားမည္ ျဖစ္သည္။ Objects တစ္ခုကို

select လိုက္ျပီ ဆိုသည္နွင့္ ထို Object ၏ နာမည္သည္ Lists box တြင္ အလုိအေလ်ာက္ေရာက္ လာမည္ ျဖစ္သည္။

ေအာက္ေဖာ္ျပပါပုံတြင္ polyline န႕ဲ a text object ကုိ selected ထားေသာေၾကာင့္ ထုိ Objects ႏွစ္ခု၏ နာမည္သည္ Lists

တြင္ ေရာက္ရိွလာသည္ကုိ ေဖာ္ျပေပးထားသည္။

Procedure: Using the Properties Palette to Change Object Properties

Objects မ်ား၏ Propertiesကို Properties Palette မွတစ္ဆင့္ ၀င္ေရာက္ေျပာင္းလဲ ျပင္ဆင္သတ္မွတ္ပုံကုိ ေအာက္တြင္

အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, Home tab > Properties panel > Dialog Box Launcher > Properties (သုိ႕မဟုတ္) CTRL+1 ကို ႏိွပ္ပါ။

၂) Properties ေျပာင္းခ်င္ေသာ Object ကုိ selectပါ။

၃) Read-write field တြင္ ရိွေသာ တန္ဖိုးမ်ား အားလံုးကို မိမိတုိ႕ စိတ္ၾကိဳက္ ေျပာင္းလဲျပင္ဆင္ သတ္မွတ္ႏိုင္ပါ သည္။

၄) Objects မ်ား select ျခင္းကုိ Cancel လုပ္ခ်င္လွ်င္ Esc key ကိုႏိွပ္ရပါမည္။ Cancel လုပ္ျပီးေသာအခါ၊ Properties

Palette သည္ပြင့္လ်က္ က်န္ေနမည္။

Exercise: Manipulate Object Properties
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ဤေလ့က်င့္ခန္းတြင္ Properties palette functions မ်ားကုိေလ့လာသြားရမည္ ျဖစ္ပါသည္။ ဤေလ့က်င့္ခန္းကို

ေလ့လာျခင္း ျပီးစီးသြားပါက Properties palette ကိုအသံုးျပဳျပီး Objects မ်ား Properties မ်ားကုိ ပိုင္ႏိုင္စြာ ေျပာင္းလဲ

ျပင္ဆင္တတ္လာမည္ ျဖစ္သည္။

၁) C_Properties-Palette.dwg ကိုဖြင့္လုိက္ပါ။

၂) Properties Palette ကုိဖြင့္ရန္ Ctrl+1 ကိုႏိွပ္ပါ။
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၃) ပုံတြင္ျပထားသည့္ အတိုင္း ဘယ္ဖက္အေပၚေထာင့္တြင္ ရိွေသာ Auto-hide button ကို click ပါ။

၄) Palette ကိုအသံုးျပဳျပီး Objects မ်ား၏ Properties ကိုအခ်ိန္အေျပာင္း လုပ္ရန္ -

 Drawing အတြင္းမွ Objects အားလုံးကို select လုပ္ပါ။

 Properties Palette တြင္ Linetype ႏွင့္ color ကုိ Bylayer သုိ႕ေျပာင္းပါ။

 Deselected ျဖစ္သြားေစရန္ Esc key ကိုနိွပ္ပါ။

၅) ပုံတြင္ ျပထားသည့္ အတုိင္း drawing အတြင္းမွ area တစ္ခုကို Zoom ခ်ဲ႕လိုက္ပါ။
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၆) Selected ထားေသာ polylines ကို color ေျပာင္းရန္ -

 Selection window ထမွဲ Objects မ်ားအားလုံးကို select လုပ္ပါ။

 Properties Palette တြင္ရိွေသာ Object Type list မွ polylines ကုိ select လုပ္ပါ။

 Color property ကုိ select လုပ္ျပီး color ကို Blue သို႕ေျပာင္းေပးလိုက္ပါ။

 Esc key ႏိွပ္လိုက္ပါ။ ထုိအခါ Selection window ထဲမွ polylines မ်ားသည္ အျပာေရာင္ အျဖစ္သုိ႕ ေျပာင္းသြား

သည္ကုိ ေတြ႕ရမည္။
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၇) Drawing ၏ display ကုိေျပာင္းရန္ -

 Drawing ကုိ Zoom Extents လုပ္ပါ။

 ေအာက္ပါပုံတြင္ ျပထားသည့္အတိုင္း area တစ္ခုကို Zoom ခ်႕ဲလိုက္ပါ။

၈) Properties ေျပာင္းမည့္ Objects မ်ားကုိ select ရန္ -

 Home tab, click Layers panel > Layer ကုိ click ပါ။ Layer list မွ Layer 1 ကုိ turn off လုပ္ပါ။

 ပုံတြင္ ျမင္ေတြ႕ရေသာ Circle အၾကီးကုိ select လုပ္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

336

၉) Palette ကိုအသံုးျပဳျပီး Circle ၏ diameter ကုိေျပာင္းရန္ -

 Properties palette မွ Diameter ကို 64 သုိ႕ေျပာင္းေပးလိုက္ပါ။

 Enter ႏိွပ္ပါ။

 Diameter ေျပာင္းလသဲြားမည္ကုိ ေတြ႕ရမည္။

၁၀) Window selection ျဖင့္ ေအာက္ပါပုံအတုိင္း Objects မ်ားကို select လုပ္ရန္-
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၁၁) Object properties မ်ားကုိ filtering ျဖင့္ ေျပာင္းရန္ -

 Properties palette ၏ ထိပ္တြင္ရိွေသာ Object List မွ Circle Object တစ္ခုတည္းကုိသာ filter လုပ္ပါမည္။

 Circle နွင့္ပတ္သက္ေသာ Properties အားလုံး Properties palette သုိ႕ေရာက္လာမည္ ျဖစ္သည္။

 Diameter ကို 32 သုိ႕ေျပာင္းလိုက္ပါ။

 Enter ႏိွပ္လုိက္ပါ။

 Circle ၏ Diameter သည္ 32 သုိ႕ေျပာင္းသြားမည္ ကိုေတြ႕ရမည္။
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၁၂) Files အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။

Lesson: Using Linetypes

ဤသင္ခန္းစာတြင္ Drawing မ်ား၌ Linetype ကုိမည္သုိ႕ေျပာင္းရမည္ကုိ ေလ့လာသြားရမည္ ျဖစ္သည္။ ဤသင္ခန္းစာကို

ေလ့လာျခင္း ျပီးစီးသြားပါက drawing မ်ားတြင္ Linetypes မ်ားကုိ မည္သို႕အသံုးျပဳရမည္နည္း၊ drawing အမ်ားတြက္

Linetype Manager တြင္ Linetype မ်ားမည္သို႕ Add ရမည္ ဆိုသည္တုိ႕ကုိ နားလည္ သေဘာေပါက္ လာမည္ျဖစ္သည္။

Drawing အတြင္းမွ Objects မ်ား တစ္ခုနဲ႕ တစ္ခုကြဲျပားမွဳ႕ ရိွေနေစရန္ Linetype ျဖင့္အသံုးႏိုင္ပါသည္။ ေအာက္တြင္

ေဖာ္ျပေပးထားေသာ ပုံကုိ ေလ့လာၾကည့္ပါ။ Geomentry အတြက္ solid linetype ကုိအသုံးျပဳထားျပီး၊ centerlines type

ကုိ centerlines အတြက္ျပဳကာ၊ hidden geometry အတြက္ dashed line ကုိအသုံးျပဳ ထားပါသည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Linetype ကုိမည္သုိ႕အသုံးျပဳ ရမည္ကုိ သိရိွနားလည္လာေစရန္။

 Linetype Manager တြင္ Linetype မ်ား Add ပုံကို သိရိွနားလည္ လာေစရန္။

About Linetypes

ရႈပ္ေထြးမ်ားျပားလွေသာ Drawing ထမွဲ Objects မ်ားကုိ အပိုင္းလုိက္သီးသန္႕ ခြဲျခားၾကည့္ရန္ အတြက္ အသံုးျပဳ

ၾကပါသည္။ ထုိသို႕ ခြလဲိုက္ျခင္းအားျဖင့္ Drawing အတြင္းမွ Objects မ်ားကို ေလ့လာၾကည့္ရႈ႕ရန္ ပိုမိုလြယ္ကူ သြားမည္

ျဖစ္သည္။
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ေအာက္တြင္ continuous, hidden နဲ႕ center linetypes တုိ႕ကုိအသံုးျပဳျပီး ေရးဆြဲထားေသာ ပုံကို ေလ့လာ ၾကည့္ပါ။

Linetype အမ်ိဳးအစားလိုက္ သူေနရာ၊ သူအဓိပၸါယ္နွင့္တူ စည္မ်ဥ္းစည္းကမ္း အတုိင္း ေရးဆြဲျပထားသည္။

Linetypes Defined

Linetype ကုိၾကည့္ျခင္းအားျဖင့္ မည္သုိ႕ေသာ Object အတြက္ ယူဆျပီး ေရးဆြထဲားသည္ကုိ ခြျဲခားသိႏိုင္ပါသည္။ ဥပမာ

အားျဖင့္ အေဆာက္အဦး designs မ်ားတြင္ HW linetype ကုိအသုံးျပဳထားလွ်င္ hot water line ကုိ ကုိယ္စားျပဳ

ေရးဆြထဲားမွန္း သိသာ ေစသလို၊ GASlinetype ကုိ အသုံးျပဳထားလွ်င္ gas line အတြက္မွႏ္း သိသာေစသည္။

ေအာက္ပါပုံတြင္ ေဖာ္ျပေပးထားေသာ Linetypes မ်ားကုိ ေလ့လာၾကည့္ပါ။

Linetype Examples

ေအာက္တြင္ Steel အစြန္းခ်င္းထပ္ေနေသာ ပုံကို ေလ့လာၾကည့္ပါ။ ယခုအတိုင္းဆုိလွ်င္ မည္သည့္ Steel ကအေပၚက

ဆုိသည္ကုိ ၾကည့္ယုံျဖင့္ ခြဲျခား သိႏိုင္မည္ မဟုတ္ေပ။
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Hidden lines ကုိအသုံးျပဳျပီး ေရးဆြဲလိုက္ေသာ အခါ ေအာက္ပုံတြင္ Vertical Steel က Horizontal Steel ၏ ေအာက္တြင္

တည္ရိွေနသည္ကို ကြဲကြဲျပားျပား သိလာမည္။

Adding Linetypes to Your Drawing

မိမိတုိ႕၏ drawingတြင္ Linetype Add ရန္အတြက္၊ Linetype ကို Layer တြင္အရင္အပ္ျပီးမွ၊ သက္ဆိုင္ရာ Layer တြင္

Objects မ်ားေရးဆြဲရမည္။ Default Linetype မွာမူ Continuous ျဖစ္ေသာေၾကာင့္ default အတုိင္း ေရးဆြဲလွ်င္

Continuous line အျဖစ္န႕ဲသာ ေရးဆြရဲမည္။ မိမိတို႕ အသံုးျပဳလိုေသာ Linetype ကုိ Properties panel တြင္ select

၍လည္း အသံုးျပဳႏိုင္ပါသည္။ မိမိတို႕ အသုံးလိုေသာ Linetype သည္ Properties panel တြင္ မရိွပါက Linetype Manager

သုိ႕သြားျပီး Load လုပ္ႏိုင္ပါသည္။

Command Access

Linetype Manager

Command Line: LINETYPE
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Ribbon: Home tab > Properties panel > Linetype list > Other

Menu Bar: Format > Linetype

About the Linetype Manager

Linetype Manager dialog box တြင္ လက္ရိွ Drawing တြင္ Load လုပ္ထားေသာ Linetype မ်ားကုိ ေတြ႕ရိွရ

မည္ျဖစ္သည္။ Load ကုိနိွပ္ျပီး၊ linetypes မ်ားကုိ additional လုပ္ႏိုင္ပါသည္။ linetypes မ်ားကုိ select ျပီး delete

လည္းလုပ္ႏိုင္ပါသည္။ လက္ရိွအသံုးျပဳေနေသာ linetypes ကုိမူ delete လုပ္၍ ရမည္မဟုတ္ေပ။

Loading Linetypes
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Linetype Manager dialog box တြင္ရိွေသာ linetypes list မွ လက္ရိွေရးဆြဲ drawing setting သုိ႕ linetype မ်ားကို

loadျပီး Add ႏိုင္ပါသည္။ linetypes list တြင္ရိွေသာ Scroll bar ကုိဆြဲျပီး မိမိတုိ႕ စိတ္ၾကိဳက္ Linetype မ်ား ကုိရွာေဖြ Add

ႏိုင္ပါသည္။

Controlling Linetype Scale

မိမိတုိ႕ ေရးဆြဲေနေသာ drawing ၏ Objects မ်ားေပၚမူတည္ျပီး၊ Lintype Scale ကိုမွန္မွန္ကန္ကန္ အသုံးျပဳႏိုင္ရန္

မွာလည္း အထူးလိုအပ္ပါသည္။ ဥပမာ အားျဖင့္ 12 units ရွည္ေသာ centerline တစ္ခု၏ အစိတ္အက်ဲ မ်ားကို ေကာင္းစြာ

ျမင္ႏိုင္ရန္အတြက္ linetype scale ကို 1.0 ထားေပးရမည္ ျဖစ္သည္။ အကယ္၍ centerline အရွည္က 240

Units ရိွမည္ဆုိလွ်င္ linetype scale ကုိ 10.0 ထားမွ မ်ဥ္း၏ အစိတ္အက်ဲ မ်ားကို ေကာင္းစြာ ျမင္ေတြ႕ႏိုင္မည္ ျဖစ္သည္။

ေအာက္တြင္ေဖာ္ျပေပးထားေသာ Line (၂) ခုလံုးသည္ centerline အမ်ိဳးအစားမ်ား ျဖစ္ေသာ္လည္း၊ ေအာက္ကမ်ဥ္းမွာ

အေပၚကမ်ဥ္းထက္ linetype scale ငယ္ေနသည္။

Linetype scale မ်ားကို Command line မွ LTSCALE ဟုရိုက္ထည့္ျပီး ျပင္ဆင္သတ္မွတ္ ႏိုင္သလုိ၊ Properties palette

တြင္ရိွေသာ Linetype Scale property တြင္လည္း ျပင္ဆင္သတ္မွတ္ ႏိုင္ပါသည္။
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Procedure: Adding Linetypes to a Drawings

Drawing မ်ားတြင္ Linetype မ်ား Add ပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, Home tab > Properties panel > Linetype list > Other ကို click လုိက္ပါ။

၂) ေပၚလာေသာ Linetype Manager မွ Load ကုိ click ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

344

၃) Load or Reload Linetypes dialog box တြင္ Linetypes ကို select ျပီး Ok ေပးပါ။

 Shift (သုိ႕မဟုတ္) Ctrl key ႏိွပ္ျပီး Linetypes မ်ားကုိ တစ္ခုထက္ပိုျပီး select ႏိုင္ပါသည္။

၄) Selected ထားေသာ Linetypes မ်ားသည္ Linetype Manager သို႕ေရာက္လာမည္ ျဖစ္သည္။ Ok ကုိ click လိုက္ပါ။
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၅) Linetypes မ်ားကုိ မိမိတုိ႕ ေရးဆြဲေသာ Objects မ်ားတြင္ စတင္အသံုးျပဳ ႏိုင္ျပီ ျဖစ္ပါသည္။

Practice Exercise: Add Linetypes to Your Drawing

ဤလက္ေတြ႕ေလ့က်င့္ခန္း အတြက္ ရိုးရွင္းေသာ Objects မ်ားကုိ ေရးဆြဲလုိက္ပါ။ Drawing သို႕ HIDDEN linetype ကို

Add လုိက္ျပီး ေရးဆြဲေနေသာ Objects သုိ႕ apply ေပးလိုက္ပါ။ ျပီးလွ်င္ LTSCALE ကိုေျပာင္းရမည္ ျဖစ္သည္။

၁) New Drawing ကုိဖြင့္ျပီး၊ Rectangle ကိုေရးဆြဲလုိက္ပါ။

၂) Linetype Manager ကုိေခၚရန္ -

 On the Home tab, click Properties panel > Linetype list > Other ကုိ click ပါ။

၃) Linetype ကုိ Load ရန္ -

 Linetype Manager dialog box မွ Load ကို click ပါ။

 Load or Reload Linetypes dialog box တြင္ Scroll bar ျဖင့္ ကုိရွာလိုက္ပါ။

 HIDDEN linetype ကုိေတြ႕လွ်င္ Select လိုက္ပါ။

 Dialog box ကုိexit ရန္နွင့္ linetype ကုိ Load ရန္အတြက္ Ok ကို click လုိက္ပါ။

၄) HIDDEN linetype ကုိ Objects သုိ႕ apply ရန္ -
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 Command line blank အေနထားျဖင့္၊ Rectangle ကုိ click ပါ။

 Home tab, Properties panel > Linetype list.

 HIDDEN ကုိ Click ပါ။

 Rectangle ကို deselect လုပ္ရန္ ႏွင့္ result ကုိၾကည့္ရန္ Esc key ကုိနိွပ္ပါ။

၅) Linetype scale ကို ျပင္ဆင္ေျပာင္းလဲရန္ -

 Command line တြင္ LTSCALE ဟုရိုက္ထည့္ျပီး၊ Enter ႏိွပ္လုိက္ပါ။

 New scale factor အျဖစ္ 2 ဟုရိုက္ထည့္ျပီး၊ Enter ႏိွပ္ပါ။

 Result ကုိၾကည့္လိုက္ပါ။
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Exercise: Use Linetypes

ဤသင္ခန္းစာတြင္ drawing သို႕ Linetypes မ်ား load ျပီး၊ layer မ်ားသုိ႕ Add ရပါမည္။ ျပီးလွ်င္ New drawing ကို New

linetype အသုံးျပဳျပီး ေရးဆြဲရပါမည္။

The completed exercise

၁) M_Using-Linetypes.dwg ကုိဖြင့္လိုက္ပါ။

၂) Linetypes ကုိ load ရန္ -

 Linetype Manager dialog box သုိ႕သြားရန္ Home tab, Properties panel > Properties ကို click ပါ။
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 Linetype Manager dialog box မွ Load ကို click ပါ။

 Load or Reload Linetypes dialog box တြင္ Scroll bar ျဖင့္ CENTER linetype ကုိ click လိုက္ပါ။

 CTRL key ကုိဖိထာျပီး HIDDEN linetype ကုိပါ Click လိုက္ပါ။

 Dialog box ကုိexit ရန္နွင့္ linetype ကုိ Load ရန္အတြက္ Ok ကို click လုိက္ပါ။

၃) Selected ထားေသာ Layer သို႕ Linetype ကုိ apply ရန္ -
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 Home tab, Layers panel > Layer Properties.

 Layer Properties Manager dialog box မွ CENTER layer တြင္ရိွေသာ linetype field ကုိ click ပါ။

 Select Linetype dialog box မွ CENTER linetype ကို Click လိုက္ပါ။ ျပီးလွ်င္ Ok ကုိ Click ပါ။

 CENTER linetype သည္ CENTER layer တြင္ applied ျဖစ္သြားမည္။

 အထက္ပါ အဆင့္တိုင္း HIDDEN linetype ကိုလည္း HIDDEN layer သို႕ applied ျဖစ္ေအာင္ လုပ္လုိက္ပါ။

 Dialog box ကုိ exit ရန္ Ok ကုိ click ျပီး၊ Layer Properties Manager ကို Close လုိက္ပါ။

၄) Drawing သုိ႕ apply လုပ္ထားေသာ CENTER linetype ကုိ linetype scale ေျပာင္းရန္ -

 Command line တြင္ LTSCALE ဟုရိုက္ျပီး၊ Enter ႏိွပ္ပါ။

 Scale factor အတြက္ .75 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 CENTER linetype သည္ linetype scale အသစ္ေျပာင္းသြားမည္ကို ေတြ႕ရမည္။

၅) Center line အသစ္ေရးဆဲြမည္။ ပထမဆံုး Center layer current လုပ္ရန္ -

 On the Home tab, click Layers panel > Make Object's Layer Current.
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 Drawing ထမွဲ Centerline တစ္ခုကုိ select လုိက္ပါ။ Current layer သည္ Center layer ျဖစ္ရပါမည္။

 Line command ကုိစတင္လုိက္ပါ။

 Object snap tracking ကုိအသံုးျပဳကာ center object snap အထက္နားမွ ပုံတြင္ ျပထားသည့္ အတိုင္း Line ကို

track လုပ္လာပါ။

၆) Hidden lines မေရးဆြဲခင္ HIDDEN layer ကုိ current လုပ္လိုက္ပါ။ HATCH layer ကုိ Freeze လုပ္ျပီး၊ object snap

settings ကိုဖြင့္ရန္ -

 Home tab, Layers panel> Layer list. HATCH layer ကို current layer အျဖစ္ သတ္မွတ္ေပးလိုက္ပါ။
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 Layer listကုိ ထပ္မံ select ျပီး၊ HATCH layer ကို Freeze လုပ္လုိက္ပါ။

 Status bar တြင္ရိွေသာ object snap၊ polar tracking န႕ဲ object snap tracking တုိ႕ကုိ ဖြင့္လိုက္ ပါ။

 Status bar တြင္ရိွေသာ object snap ကို Right- click ႏိွပ္ျပီး၊ Setting ကို click လုိက္ပါ။

 Endpoint, Quadrant, Intersection န႕ဲ Perpendicular object snap modes တုိ႕ကုိ Select လုိက္ပါ။

 Line commandကုိ အသံုးျပဳျပီး Line ဆြဲရန္ အတြက္ Circle အေသး၏ ဘယ္ဖက္ quadrants ကေန track

လုပ္လုိက္ပါ။ ေအာက္ပုံတြင္ ျပထားသည့္ Intersetion ေနရာ၊ ေအာက္ေျခ Line ျဖင့္ perpendicular က်ေနေသာ

ေနရာတြင္ မ်ဥ္းေစာင္းေလး တစ္ခုဆြဲလုိက္ပါ။
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၇) Hidden lines ကုိ technique တစ္ခ်ိဳ႕သုံးျပီး ဆြဲရန္ -

 Line command ကုိသုံးျပီး၊ End pint ရိွေသာ ေထာင့္ကေန (ပုံတြင္ျပထားေသာ အလယ္ျမွား) track လုပ္ပါ။( End

point ကို select မလုပ္ပါႏွင့္။)

 Cursor ကုိ Intersectin ေတြ႕သည္အထိ dragသြားပါ။ ညာဖက္အစြန္ဆံုး Vertical line ေဘးတြင္ ရိွေသာ

Intersection point (ပုံတြင္ ျပထားေသာ ညာဖက္အစြန္ဆံုးျမွား) ကုိ Click လိုက္ပါ။

 ညာဖက္ အစြန္ဆုံးတြင္ရိွေသာ Vertical line ေဘးတြင္ perpendicular မ်ဥ္းတစ္ေၾကာင္း ေရးဆြရဲန္ ေအာက္ပါ

ပုံတြင္ ျပထားသည့္ အတိုင္း Click လုိက္ပါ။

 Line command ျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္လိုက္ပါ။

 Line command ကိုျပန္ေခၚျပီး အထက္ပါ နည္းျဖင့္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း Horizontal Line ေရးဆြလဲိုက္ပါ။

၈) Hidden hole ကို အေသးစိတ္ refine လုပ္ရန္ -
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 ေအာက္တြင္ ျပထားေသာ area ကုိ Zoom ခ်ဲ႕လုိက္ပါ။

 ဘယ္ဖက္အစြန္ဆုံး အတြင္းေထာင့္ End point ေနရာကုိ Mouse တင္ျပီး track လုပ္ပါ။ ( End point ကုိ click ရန္

မလုိအပ္ပါ။)

 Vertical hidden line တြင္ Intesection Point ေတြ႕သည္အထိ Mouse ကိုညာဖက္သုိ႕ drag လိုက္ပါ။

 Vertical hidden line ျဖင့္ေထာင့္မွန္က်ျပီး၊ Intersection Point ကို ေတြ႕ျပီဆိုလွ်င္ Click လိုက္ပါ။

၉) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံမွ အတြင္းပိုင္း hidden hole detail ကုိ refine လုပ္ရန္၊ Lines မ်ားကုိ Copy ေပးျပီး၊

Modify လုပ္ရန္ -

 Copy command ကုိစတင္လုိက္ပါ။

 အတြင္းတြင္ျမင္ရေသာ hole detail ကုိ Window select ျဖင့္ ဘယ္မွညာ အတိုင္း select လုပ္လုိက္ပါ။

 Selection ျပီးစီးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 Bottom line ကို basepoint အျဖစ္သေဘာထားျပီး၊ Centerline ျဖင့္ Intersection ျဖစ္ေသာေနရာကို Click ပါ။
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 Copied လုပ္ထားေသာ Object ကုိ ညာဖက္သုိ႕ drag လုပ္ပါ။ ေအာက္ပုံတြင္ ျမင္ေတြ႕ရသည့္ အတိုင္း

Centerline ႏွင့္ Bottom line တုိ႕ Intersection ျဖစ္ေသာေနရာကို Click ပါ။

 Copy command ျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 ၁၀) Copied line ကုိ modify လုပ္ရန္ ႏွင့္ Linetype ကုိေျပာင္းရန္ -

 Command line ကုိ blank အေနအထားျဖင့္၊ copied လုပ္ထားေသာ line ကုိ select ပါ။

 ဘယ္ဖက္တြင္ရိွေသာ Line၏ ေအာက္ဆံုးမွ grip (ပုံတြင္ျမင္ေတြ႕ရသည္ အတိုင္း) ကုိ click ပါ။ ျပီးလွ်င္

horizontal line အတုိင္း ေထာင့္မွန္က်က် drag လုပ္လုိက္ပါ။

 Object ကုိ selected ျဖစ္ေနသည့္ အတိုင္းျဖင့္ Home tab, Layer Control list > Hidden ကို click လုိက္ပါ။
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 Lines အားလုံး deselect ျဖစ္ေစရန္ Esc key ကုိႏိွပ္လိုက္ပါ။

 ျပီးခ႕ဲေသာ တစ္ၾကိမ္က selectedထားေသာ Line သည္ HIDDEN layer တြင္ပင္ရိွေနမည္။

 Command line ကုိ blank အေနအထားျဖင့္၊ အေပၚက hidden horizontal line ကုိ select ပါ။

(ေအာက္ေဖာ္ျပပုံအတုိင္း)

 Line ၏ညာဖက္တြင္ ရိွေသာ End point ကို select ျပီး၊ vertical hidden line ၏ End point ျပသည္ အထိ drag

လိုက္ပါ။ (ပုံတြင္ေဖာ္ျပေပးထားသည္။) Intersection (သုိ႕မဟုတ္) perpendicular object snap mode

ကုိအသံုးျပဳပါ။

 ဆန္႕က်င္ဖက္ End point အတြက္ ထုိနည္းအတုိင္းပဲ ဆက္လုပ္သြားပါ။

၁၁) Selected ထားေသာ Line ၏ linetype scale ကုိေျပာင္းရန္ -

 Command line ကုိ blank အေနအထားျဖင့္၊ hidden line မ်ဥ္းတုိေလး ႏွစ္ေၾကာင္းကို select လုိက္ပါ။

(ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း)

 Right – click ႏိွပ္ျပီး၊ Properties ကုိ select ပါ။
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 Linetype scale field တြင္ 5 ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Selected ထားေသာ Line ကုိ ေျပာင္းထားသည့္ အတုိင္း ျဖစ္သြားေစရန္ Enter ႏိွပ္ပါ။

 Properties dialog box ကိုပိတ္ရန္ အေပၚဘယ္ေထာင့္တြင္ ရိွေသာ ( X) ကုိ click လိုက္ပါ။

 Lines ကုိ deselect လုပ္ရန္ Esc key ကုိ ႏိွပ္ပါ။

 ျပီးခ႕ဲေသာ အၾကိမ္က selected lines တို႕၏ linetype scale ေျပာင္းလသဲြားသည္ကုိ သတိထား ေလ့လာ

ၾကည့္ပါ။

၁၂) အျခား lines မ်ားကုိ HIDDEN layer ေျပာင္းရန္ -

 Command line ကို blank အေနအထားျဖင့္၊ ေအာက္ပုံတြင္ေဖာ္ျပေပးထားသည့္ အတုိင္း hole details မ်ားကုိ

select ပါ။
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 Layer Control list မွ HIDDEN layer ကုိ select ပါ။

 Lines မ်ားကုိ deselect ျဖစ္ေစရန္ Esc key ႏိွပ္ပါ။

၁၃) အျခားေသာ Lines မ်ားျဖင့္ လိုက္ေလ်ာညီေထြမွ ရိွေအာင္ ေအာက္ေဖာ္ျပပါ lines မ်ားကို Modify လုပ္ရန္ -

 Command line ကုိ blank အေနအထားျဖင့္၊ ေအာက္တြင္ျပထားသည့္ အတိုင္း vertical line ကို select လုပ္ပါ။

 ေအာက္က grip ကို select လုပ္ျပီး၊ အတြင္းေထာင့္သုိ႕ track လုပ္ပါ။

 Lines မ်ားကုိ deselect ျဖစ္ေစရန္ Esc key ႏိွပ္ပါ။

၁၄ ) Horizontal line ကိုညိုရန္ -

 Command line ကုိ blank အေနအထားျဖင့္၊ ေအာက္တြင္ျပထားသည့္ အတိုင္း line ကုိ select လုပ္ပါ။
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 ဘယ္ဖက္မွ grip ကုိ click ျပီး vertical line ၏ End point ျဖင့္ ထိေအာင္ drag လုပ္ပါ။

 Lines မ်ားကုိ deselect ျဖစ္ေစရန္ Esc key ႏိွပ္ပါ။ ျပီးေနာက္ ေအာက္တြင္ ေဖာ္ျပေပးသည့္ အတုိင္း horizontal

line ကုိ select လုပ္ပါ။

 ညာဖက္ End point မွ grip ကုိ select လုပ္ျပီး၊ ညာဖက္ Vertical line အထိ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း drag

လုပ္လိုက္ပါ။

၁၅) underlying line မ်ဥ္းပိုင္းေလးကို delete လုပ္ရန္ -
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 Command line ကို blank အေနအထားျဖင့္၊ window select ကုိအသံုးျပဳကာ ဘယ္မွညာသုိ႕ click ျပီး select

လုိက္ပါ။

 Erase command (သုိ႕မဟုတ္) delete key ကုိအသုံးျပီး delete လုပ္ႏိုင္ပါသည္။
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၁၆)မလုိအပ္ေသာ hatch pattern မ်ားကို Erase လုပ္ရန္ -

 Layer Control list မွ HATCH Layer ကုိ thaw လိုက္ပါ။

 Command line ကုိ blank အေနအထားျဖင့္၊ hatch pattern ကုိ select ပါ။

 Select ထားေသာ Objects မ်ား အေရာင္မိွန္သြားေသာ အခါ E ႏိွပ္ျပီး၊ Enter ႏိွပ္ပါ။

၁၇) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Using Inquiry Commands

Measuregeom ႏွင့္ အျခားေသာ inquiry commands မ်ားအသုံးျပဳျပီး objects မ်ား၏ geometric information

မ်ားၾကည့္ရႈျခင္း တုိ႕ကိုေလ့လာသြားရမည္ ျဖစ္သည္။ မိမိတုိ႕ဖန္တီးလိုက္ေသာ points န႕ဲ object types မ်ားကုိ software

က drawing database တြင္ သုိေလွာင္ေပးျပီးသားျဖစ္သည္။ Inquiry toolbar မွ commands မ်ားကို အသံုးျပဳျပီး

distances, angles, areas, object types, န႕ဲ objects မ်ားအတြက္ အေရးၾကီးေသာ data မ်ားကို ျပန္လည္ ထုတ္ယူ

ၾကည့္ရႈ႕ နိုင္ပါသည္။
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Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျပီးစီးသြားပါက -

 Distance, radius, angle, area န႕ဲ volume တုိ႕၏ အတုိင္းအတာ အကြာအေ၀းမ်ားကို measure tools မ်ားျဖင့္

တုိင္းတာ ၾကည့္ရႈတတ္လာေစရန္။

 Object type, location, dimensions န႕ဲ properties တို႕၏ information မ်ားကို ၾကည့္ရႈ႕တတ္လာ ေစရန္။

About Measuring

Objects မ်ားကုိ select ျပီး၊ ထုိ selected ေသာ Objects မ်ား၏ distance, radius, angle, area န႕ဲ volume တို႕ကို

တြက္ခ်က္ႏိုင္ပါသည္။ Measuring သည္အထူးသျဖင့္ building န႕ဲ manufacturing အတြက္ data မ်ား စုေဆာင္းရာတြင္

အလြန္ အသုံး၀င္ေသာ tool ျဖစ္ပါသည္။ ေအာက္ေဖာ္ျပပါ အုတ္ခမဲ်ား၏ အခ်င္း၀က္ကုိ ၾကည့္ရႈ႕ေနေသာ ပုံကို

ေလ့လာၾကည့္ပါ။
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Definition of Measuring

Measuring ကုိ objects မ်ားတြင္ ပါ၀င္ေသာ extent, dimensions နဲ႕ capacity တုိ႕ကုိစစ္ေဆးရာတြင္ အသုံးျပဳ ပါသည္။

Example of Area Measurement

ေအာက္ေဖာ္ျပပါပုံသည္ Area tool ကိုအသံုးျပဳျပီး floor plan ၏ total square ကုိၾကည့္ရႈ႕ စစ္ေဆးေသာ ပုံျဖစ္ပါသည္။
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Using Measure Tools

Measure tools မ်ားကုိ အသံုးျပဳျပီး objects မ်ားမွ data မ်ားကို ရယူၾကည့္ရႈ႕ ႏိုင္ပါသည္။ ၎တို႕သည္ foundation

တစ္ခုတြင္ concrete အေရအတြက္ မည္မွ် လိုအပ္မည္က အစ ရရိွလာေသာ informations မ်ားကုိ ၾကည့္ျပီး

တြက္ဆႏိုင္ပါသည္။ Measure tools command တြင္ မတူညီေသာ measurement options မ်ားပါ၀င္ျပီး လိုအပ္သလို

ေရြးခ်ယ္ အသုံးျပဳသြား ႏိုင္ပါသည္။

ေအာက္ေဖာ္ျပပါပုံသည္ 3D object ကုိ Volume option အသုံးျပဳျပီး တုိင္းတာျပထားေပးျခင္း ျဖစ္သည္။
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Command Access

Measuregeom

Command entry: measuregeom

Ribbon: Home tab > Utilities panel > Measure drop-down > Distance/Radius/Angle/Area/Volume

Menu: Tools > Inquiry > Distance/Radius/Angle/Area/Volume

Measure Command Options

ေအာက္ေဖာ္ျပပါပုံသည္ အမ်ိဳးမ်ိဳးေသာ measuring tools မ်ားျဖစ္ျပီး၊ မည္သည့္အတြက္ အသံုးျပဳ သည္ကို

ေဖာ္ျပေပးထားေသာ ပုံျဖစ္ပါသည္။
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Distance - အမွတ္ႏွစ္မွတ္အၾကားရွိ အကြာအေ၀းကုိ တုိင္းတာသည္။

Radius - arc (သုိ႕မဟုတ္) circle တို႕၏ အခ်င္း၀က္ကုိ တုိင္းတာသည္။

Angle - arc, circle, line (သုိ႕မဟုတ္) vertex တို႕၏ angle ကုိတိုင္းတာသည္။

Area - Objects မ်ား၏ ပတ္လည္ (သုိ႕မဟုတ္) area အက်ယ္ကုိ တုိင္းတာသည္။

Volume - area မ်ားသတ္မွတ္ေသာ အခါ (သို႕မဟုတ္) objects မ်ား၏ Volume ကုိတုိင္းတာသည္။

Measure Distance

Command line တြင္ Measuregeom ဟုရိုက္ထည့္ျပီး၊ Distance option ကုိ select လုိက္ပါ။ျပီးလွ်င္ drawing မွ objects ၏

အမွတ္ႏွစ္မွတ္ကို select လုိက္ယံုျဖင့္ အကြာအေ၀းကုိ command window တြင္ေဖာ္ျပ ေပးပါလိမ္႕ မည္။ F2 ႏိွပ္ျပီး

command window ကိုေခၚျပီးၾကည့္ ရႈ႕နိုင္ပါသည္။

ေအာက္ေဖာ္ျပပါ ပုံအတြက္ Distance command မွ ျပန္ၾကားေပးေသာ Information မ်ား ျဖစ္ပါသည္။

Distance = 157.1924, Angle in XY Plane = 34, Angle from XY Plane = 0Delta X = 130.3938, Delta Y

=87.7889, Delta Z = 0.0000 စသည္ျဖင့္ ေဖာ္ျပေပးပါလိမ္႕မည္။
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Process: Measuring Distance

Measuregeom command ကိုအသံုးျပဳျပီး object ၏ အမွတ္ႏွစ္မွတ္ အၾကား အကြာအေ၀း တိုင္းတာပုံကို ေအာက္တြင္

အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။ ေလ့လာၾကည့္ပါ။

၁) Rribbon, click Home tab > Utilities panel > Measure drop-down > Distance.

၂) First point သတ္မွတ္ေပးပါ။

၃) Multiple Points အတြက္ M ဟုရိုက္ထည့္ျပီး၊ Second point ကုိ select ပါ။
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၄) Starting point ကုိမေရာက္မခ်င္း ဆက္တိုက္ select သြားပါ။

၅) Right – click ႏိွပ္ျပီး command ကို ျပီးဆံုးေစရန္ Enter ႏိွပ္ပါ။

Process: Measuring Radius

Measuregeom command မွ Radius option အသံုးျပဳပုံကို ေအာက္တြင္အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Rribbon, click Home tab > Utilities panel > Measure drop-down > Radius.

၂) Arc ကုိselect ပါ။
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၃) Arc ၏ raidu နဲ႕ diameter ကုိေဖာ္ျေပးပါလိမ္႕မည္။

Procedure: Measuring an Angle

Measuregeom command မွ Angle option အသုံးျပဳျပီး Line (2) Lines ၏ angle တိုင္းတာၾကည့္ရႈ႕ပုံကုိ ေအာက္တြင္

အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Rribbon, click Home tab > Utilities panel > Measure drop-down > Angle.

၂) First line ကုိ select ပါ။

၃) Second line ကုိ select ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

369

၄) Angle ၏ result ကုိ ေဖာ္ျပေပးပါလိမ္႕မည္။

Process: Measuring Area

Measuregeom command မွ Area option အသံုးျပဳျပီး Space တစ္ခု၏ area တုိင္းတာၾကည့္ရႈ႕ပုံကုိ ေအာက္တြင္

အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Rribbon, click Home tab > Utilities panel > Measure drop-down > Area.

၂) Command line တြင္ Add ဟုရိုက္ထည့္ျပီး Enter ႏွိပ္ပါ။ First point ကုိ select ပါ။

၃)Space ၏ ပတ္လည္ရိွ End point မ်ားကို ဆက္တိုက္ select သြားပါ။ စမွတ္သည္ ေနာက္ဆုံး ဆံုးမွတ္ ျပန္ျဖစ္ သြားမည္။

ျပီးလွ်င္ Enter ႏိွပ္ပါ။
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၄) Command line တြင္ Subtract ဟုရိုက္ထည့္ျပီး Enter ႏွိပ္ပါ။ Subtract လုပ္မည့္ area ၏ First point ကုိ select ပါ။

၅) Subtract လုပ္မည့္ area ၏ ပတ္လည္ End point မ်ားကုိ ဆက္တုိက္ select သြားပါ။ စမွတ္သည္ ေနာက္ဆုံး ဆံုးမွတ္

ျပန္ျဖစ္ သြားမည္။ ျပီးလွ်င္ Enter ႏိွပ္ပါ။

ID Point

Command line တြင္ IDpoint ဟုရိုက္ထည့္ျပီး၊ drawing အတြင္းမွ Point (၁) Point ကို select လိုက္သည္ႏွင့္ ထို

Point ၏ တည္ေနရာ coordinate အမွတ္ကုိ သိရိွႏိုင္မည္ ျဖစ္သည္။ Command line တြင္ IDpoint ဟုရိုက္ထည့္

လိုက္သည္ႏွင့္ Specify a point ဟု Prompted ေပးပါလိမ္႕မည္။ ထိုအခါ မိမိတို႕ coordinate သိလုိေသာ Object ၏

Point ကို select လိုက္သည္နွင့္ coordinate မ်ားကို ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း ေဖာ္ျပေပးပါလိမ္႕မည္။

X = 624.3266 Y = 208.1684 Z = 0.0000

Command Access

ID Point

Command Line: ID

Ribbon: Home tab > Utilities panel > ID Point
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Menu bar: Tools > Inquiry > ID Point

Procedure: Identifying a Precise Location

ID point command ကိုအသံုးျပဳျပီး Drawing အတြင္းမွ point မ်ား၏ တည္ေနရာ coordinate အမွတ္မ်ား တုိင္းတာ

ၾကည့္ရႈ႕ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) ID command ကုိစတင္လိုက္ပါ။

၂) Drawing အတြင္းမွ မိမိတုိ႕ သိလိုေသာ Object ၏ Point ကုိ Object snap အသုံးျပီး select လိုက္ယံုျဖင့္ command

line တြင္ selected ထားေသာ Point ၏ coordinate တန္ဖိုးမ်ားကုိ ေဖာ္ျပေပးပါလိမ္႕မည္။

မွတ္ခ်က္။ ။ F2 ကိုႏိွပ္ကာ Command window ေခၚျပီး coordinate အမွတ္မ်ားၾကည့္ႏိုင္ပါသည္။

Practice Exercise: Acquiring Distance and Coordinates

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ ရိုးရွင္းေသာ ပုံမ်ားေရးဆြဲျပီး၊ ထုိေရးဆြဲထားေသာ ပုံႏွစ္ပုံ၏ Point (2) Point အကြာအေ၀း

တုိင္းတာပုံကုိ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

၁) Circle (2) ခုကုိေရးဆြဲလိုက္ပါ။

၂) Point (2) Point အၾကား အကြာအေ၀းကို acquire လုပ္ရန္ -

 Distance command ကိုစတင္လိုက္ပါ။

 Object Snap ကို ON ထားျပီး၊ Circle တစ္ခု၏ Center point ကို first point အျဖစ္သတ္မွတ္လုိက္ပါ။
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 အျခားေသာ Circle တစ္ခု၏ Center point ကုိ second point အျဖစ္သတ္မွတ္လိုက္ပါ။

 ထို Point (2) Point ၾကား အကြာအေ၀းကုိ command line တြင္ေဖာ္ျပေပးပါလိမ္႕မည္။ (သို႕မဟုတ္( F2) ႏိွပ္ျပီး

command window ကုိေခၚကာ ၾကည့္ရႈ႕ႏိုင္ပါသည္။

၃) သတ္မွတ္ထားေသာ Point ၏ X န႕ဲ Y coordinates အမွတ္ကုိ ၾကည့္ရန္ -

 ID command ကိုစတင္လိုက္ပါ။

 Object Snap ကို ON ထားျပီး၊ Circle တစ္ခု၏ Center point ကို select လိုက္ပါ။

 ထို Point X နဲ႕ Y coordinates အမွတ္ကုိ command line တြင္ေဖာ္ျပေပးပါလိမ္႕မည္။ (သို႕မဟုတ္( F2) ႏိွပ္ျပီး

command window ကုိေခၚကာ ၾကည့္ရႈ႕ႏိုင္ပါသည္။

Obtaining Object Information

List Command သည္ drawing အတြင္းမွ မိမိတို႕ select လိုက္ေသာ Object ၏ Information ကိုေဖာ္ျပေပး ပါလိမ္႕မည္။

ထုိInformations မ်ားကို text window မွ ေဖာ္ျပေပးသြားလိမ္႕မည္။ မိမိတို႕ select ေသာ Object

အမ်ိဳးအစားေပၚမူတည္ျပီး ေဖာ္ျပေပးသြားလိမ္႕မည္။ Objects မ်ားကို တစ္ခု (သို႕မဟုတ္) တစ္ခုထက္ ပိုျပီး select

လုပ္နိုင္ပါသည္။ Informations မ်ားကုိ Obtaing လုပ္ေပးနိုင္ေသာ အရာမ်ားမွာ ေအာက္ပါအတုိင္း ျဖစ္သည္။

 Object type

 Space (model or paper)

 Layer

 Handle

 Geometric data (location, size, etc.)

Command Access
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LIST

Command Line: LIST, LI

Ribbon: Home tab > Properties panel > List

Menu Bar: Tools > Inquiry > List

Procedure: Obtaining Information About Objects

List command ကုိအသုံးျပဳျပီး Objects မ်ား၏ Information ၾကည့္ရႈ႕ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး

ထားပါသည္။

၁) List command ကုိ စတင္လိုက္ပါ။

၂) မိမိတုိ႕ Informations မ်ားသိလုိေသာ Objects ကို select ျပီး Enter ႏိွပ္လိုက္ပါ။ ထိုအခါ text window တြင္ ထို

object နွင့္ ပတ္သက္ေသာ Information မ်ားကုိ ေဖာ္ျပေပးပါလိမ္႕မည္။

Practice Exercise: Obtaining Object Information

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ ေလ့လာျပီးသား ျဖစ္ေသာ circle, arc, line, rectangle commad တုိ႕ျဖင့္ Objects

မ်ားအသီးသီး ေရးဆြဲကာ၊ ထုိ Objects မ်ား Information ကုိ List command ျဖင့္ ၾကည့္ရႈ႕ပုံကုိ ေလ့လာသြားရမည္

ျဖစ္ပါသည္။

၁) ေအာက္ပါ Objects မ်ားကုိ ေရးဆြလုိဲက္ပါ။ (သင့္ေတာ္ေသာ အရြယ္အစား တစ္ခုခု)

 Circle

 Arc
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 Line

 Rectangle

၂) List command ျဖင့္ Object တစ္ခုခ်င္းစီ၏ Informaions မ်ားကိုၾကည့္ရႈ႕သြားရန္ -

 List command ကိုစတင္လိုက္ပါ။

 Circle ကုိ select ျပီး၊ Enter ႏိွပ္ပါ။

 Text window တြင္ Circle န႕ဲပတ္သက္ေသာ Information မ်ားကို ေဖာ္ျပေပးပါလိမ္႕မည္။

၃) အျခား Objects မ်ားကိုလည္း ထုိနည္းအတုိင္း ဆက္လုပ္ၾကည့္ပါ။

Exercise: Obtain Geometric Information

Inquiry commands ကုိအသုံးျပဳျပီး ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံမွ Objects မ်ားႏွင့္ Point ၏ Informations

မ်ားကို Obtain ၾကည့္ပါ။

Completing the Exercise

၁) M_Inquiry.dwg ကုိဖြင့္ပါ။

၂) Ribbon, Home tab > Utilities panel ကို click ပါ။

 အကယ္၍ Ribbon တြင္ Utilities panel ရိွမေနပါက ribbon ၏တစ္ေနရာရာကို right – click ႏိွပ္ကာ Panels >

Utilities panel ကုိ select လုိက္ပါ။
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၃) Utilities panel မွ Measure ကုိ click ျပီး Distance ကုိ select လိုက္ပါ။ object snap မွ End point mode

ကုိအသံုးျပဳျပီး Point (7) န႕ဲ Point (8) ကို select လိုက္ပါ။

 Distance ကုိ ေဖာ္ျပေပးပါလိမ္႕မည္။

 Angle ကုိေဖာ္ျပေပးပါလိမ္႕မည္။

၄) Utilities panel မွ Measure ကုိ click ျပီး Radius ကုိ select လိုက္ပါ။ Circle (2) ကုိ select ျပီး Enter ႏိွပ္ပါ။ Circle (3)

ကုိ select ျပီး Enter ႏိွပ္ပါ။ Circle (4) ကုိ select ျပီး Enter ႏိွပ္ပါ။

 Text window ကို F2 ႏိွပ္ျပီး ေခၚလိုက္ပါ။ ထုိ window တြင္ Circle (2)၊ Circle (3) န႕ဲ Circle (4) တို႕၏ Radius

မ်ားကို ေဖာ္ျပေပးပါလိမ္႕မည္။

၅) Command line တြင္ List command ကုိရိုက္ထည့္ျပီး Point (10) န႕ဲ Point (11) တြင္ရိွေသာ Rectangle ကုိ select

လုိက္ပါ။ Enter ႏိွပ္လုိက္ပါ။

 Object ၏အမ်ိဳးအစားကုိ ေဖာ္ျပေပးလိမ္႕မည္။

 Rectangle ၏ Layer ကုိေဖာ္ျပေပးလိမ္႕မည္။

 Rectangle ၏ area ကုိေဖာ္ျပေပးလိမ္႕မည္။

 Rectangle ၏ perimeter ကုိေဖာ္ျပေပးလိမ္႕မည္။

၆) Text window ကုိ ပိတ္လိုက္ပါ။
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၇) Utilities panel မွ Measure ကုိ click ျပီး Distance ကို select လုိက္ပါ။ Circle (2) န႕ဲCircle (3) တုိ႕၏ Center point

တုိ႕ကုိ select လုိက္ပါ။

၈) Distance command ကုိျပန္ေခၚျပီး Circle (2) နဲ႕Circle (4) တုိ႕၏ Center point တုိ႕ကုိ select လိုက္ပါ။

၉) Text window ကုိ F2 ႏိွပ္ျပီး ေခၚလိုက္ပါ။

 Circle (2) န႕ဲCircle (3) တို႕၏ Distance ကုိေဖာ္ျပေပးလိမ္႕မည္။

 Circle (2) န႕ဲCircle (4) တို႕၏ Distance ကုိေဖာ္ျပေပးလိမ္႕မည္။

 ၁၀) Text window ကိုပိတ္လုိက္ပါ။

၁၁) List command ကိုေခၚျပီး Line 5 ကုိ select ျပီး Enter ႏိွပ္ပါ။

 Line ၏ angle ကိုေဖာ္ျပေပးပါလိမ္႕မည္။

 X တန္ဖိုး ကိုေဖာ္ျပေပးပါလိမ္႕မည္။

 Y တန္ဖိုး ကိုေဖာ္ျပေပးပါလိမ္႕မည္။

၁၂) Text window ကို ပိတ္လုိက္ပါ။

၁၃) Utilities panel မွ ID point ကုိ click ျပီး၊ object snap မွ End point mode ျဖင့္ Point (1) ကို select လိုက္ပါ။

 ထုိ Point ၏ X,Y,Z coordinates အမွတ္မ်ားကို ေဖာ္ျပေပးပါလိမ္႕မည္။

၁၄) Utilities panel မွ Measure ကုိ click ျပီး Area ကုိ select လိုက္ပါ။
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 Drawing ၏ ေနရာလြတ္ တစ္ေနရာတြင္ right-click ျပီး Add ကုိ select လုိက္ပါ။

 Object snap မွ End point mode ျဖင့္ Point (1) ကိုအစျပဳကာ ပတ္လည္တစ္ေလွ်ာက္ select လုိက္ပါ။

 အားလုံးကုိ Select ျပီးသြားခ်ိန္တြင္ Enter ႏိွပ္လိုက္ပါ။

 Drawing ၏ ေနရာလြတ္ တစ္ေနရာတြင္ right – click ျပီး Subtract ကုိ select လိုက္ပါ။

 Drawing ၏ ေနရာလြတ္ တစ္ေနရာတြင္ right – click လုိက္ပါ။ Object ကို select လိုက္ပါ။

 Circles (3) ခုလံုးကုိတစ္ခုခ်င္းစီ select လုိက္ပါ။

 Rectangle ကိုပါ select လုိက္ပါ။

 Enter ႏိွပ္ပါ။

 Circles အားလုံးကုိ area မွ Subtract လုပ္အျပီး အသားတင္ area ကုိေဖာ္ျပေပးပါလိမ္႕မည္။

၁၅) Area command ကို exit ေပးလိုက္ပါ။

၁၆) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

အထက္တြင္ လုပ္ေဆာင္ခဲ႕ေသာ Exercise ၏ ရလဒ္ျဖစ္ပါသည္။

Step Answer

3. Distance = 55 mm

Angle = 212 degrees

4. Radius for circle 2 = 17.25

Mm

5. Radius for circle 4 = 10.00

mm

Object type =

LWPOLYLINE

Area = 1764.00

mmPerimeter = 318.00
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mm

9. Distance between circles

2 and 3 = 103.9447 mm

Distance between circles

2 and 4 = 105.6296 mm

11. Angle = 131 degrees

Delta Y = 44.9275 mm

13. X

= 253.1353Y

= 0.0000Z = 0.0000

14. Net area = 24255.3940

mm

Exercise: Measure Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ distance, radius, angle, area န႕ဲvolume တို႕ကုိ အသံုးျပဳျပီး floor plan မွ data မ်ားကို

ၾကည့္ရႈ႕စစ္ေဆးျခင္းကုိ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) I_Measure.dwg ကုိဖြင့္ပါမည္။

၂) Drawing ၏ညာဖက္တြင္ ရိွေသာ powder room ကုိ Zoom ခ်ဲ႕ပါ။

၃) Ribbon, click Home tab > Utilities panel > Measure drop-down > Distance.

၄) Powder room နံရံ၏ Length ကို acquire လုပ္ရန္ -

 Powder room တြင္ First point ကုိ select ေပးပါ။

 Multiple points option ကုိအသုံးျပဳရန္ Command line Prompted တြင္ M ဟုရိုက္ထည့္ျပီး Enter ကိုႏိွပ္ပါ။
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 အတြင္း ပတ္လည္တြင္ ရိွေသာ ေထာင့္တစ္ေလွ်ာက္ End point ကုိ Starting point ေနရာေရာက္သည္ အထိ

click လိုက္ပါ။

 Powder room နံရံ၏ Length ကို ေဖာ္ျပေပးလိမ့္မည္။

၅) Stairway wall ၏ radius ကုိ acquire လုပ္ရန္ -

 Ribbon, click Home tab > Utilities panel > Measure drop-down > Radius.

 Powder room ၏ဘယ္ဖက္တြင္ ရိွေသာ Stairway wall ၏အခုံးကို select လိုက္ပါ။
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 Wall ၏ radius ကုိ acquire လုပ္ရန္ Wall ကုိ click လိုက္ပါ။

၆) Angle option ကုိအသုံးျပဳျပီး၊ Wall သည္ ၉၀ ဒီဂရီ ရိွမရိွၾကည့္ရန္ -

 Ribbon, click Home tab > Utilities panel > Measure drop-down > Angle.

 Power room ၏ ေအာက္နံရံကုိ select ပါ။

 နံရံ၏ ေနာက္က ေအာက္နားကုိ select လုိက္ပါ။
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 နံရံႏွစ္ခုလံုး ၉၀ ဒီဂရီ ရိွမရိွစစ္ေဆးၾကည့္ပါ။

၇) Power room ၏ floor area ကုိရွာရန္ -

 Ribbon, click Home tab > Utilities panel > Measure drop-down > Area.

 Power room ၏အတြင္းေထာင့္မ်ားကို ပတ္လည္ select လိုက္ပါ။
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 ထုိသို႕ click ရာတြင္ End point သည္ Starting point တြင္ ရိွေနရမည္။

 Power room ၏ floor area ကိုၾကည့္ရန္ Enter ႏိွပ္ပါ။

၈) Power room ၏ Volume ကုိရွာရန္ -

 Ribbon, click Home tab > Utilities panel > Measure drop-down > Volume.

 Power room ၏အတြင္းေထာင့္မ်ား၏ ပတ္လည္ကုိ select လိုက္ပါ။

 Enter ႏိွပ္ပါ။ ထုိအခါ command line က height ရိုက္ထည့္ရန္ Prompt လုိက္မည္။

 Height အတြက္ 108 ကုိရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။
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 Power room ၏ Volume ကုိေဖာ္ျပေပးပါလိမ္႕မည္။

၉) Files အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။

Challenge Exercise: Architectural

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္တြင္ ေလ့လာခဲ႕ျပီး ျဖစ္ေသာ သင္ခန္းစာမ်ားကို အသံုးျပဳျပီး၊ Layer မ်ား

ဖန္တီးျခင္း၊ ဖန္တီးျပီးေသာ Layer မ်ားမွ Objects မ်ားကို အျခား Layer သို႕ေရြ႕ေျပာင္းျခင္း၊ စသည္တုိ႕ကုိ လက္ေတြ႕

ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

The completed exercise

Metric Units
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၁) M_ARCH-Challenge- CHP04.dwg ကုိဖြင့္လုိက္ပါ။

၂) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ names န႕ဲ color properties တို႕ကို အသံုးျပဳျပီး Layer (၉) ခုဖန္တီး လုိက္ပါ။

 Annotation = white

 Dimension = red

 Doors = 30

 Plumbing Fixtures = magenta

 Stairs = white

 Titleblock = red

 Wall-Interior = cyan

 Windows = blue

 Viewports = 9

၃) Stair geometry ကုိ Stairs layer တြင္ထားျပီး Door geometry ကို Doors layer တြင္ ထားပါ။

၄)Building - Apparatus Bay layer ကို Thaw လုပ္ပါ။

၅)Drawing ကုိ Save ျပီး ပိတ္လိုက္ပါ။

Imperial Units

၁) I_ARCH-Challenge- CHP04.dwg ကိုဖြင့္လုိက္ပါ။

၂) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ names န႕ဲ color properties တို႕ကို အသံုးျပဳျပီး Layer (၉) ခုဖန္တီး လုိက္ပါ။

 Annotation = white

 Dimension = red

 Doors = 30

 Plumbing Fixtures = magenta

 Stairs = white



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

386

 Titleblock = red

 Wall-Interior = cyan

 Windows = blue

 Viewports = 9

၃) Stair geometry ကုိ Stairs layer တြင္ထားျပီး Door geometry ကို Doors layer တြင္ ထားပါ။

၄)Building - Apparatus Bay layer ကို Thaw လုပ္ပါ။

၅)Drawing ကုိ Save ျပီး ပိတ္လိုက္ပါ။

Challenge Exercise: Mechanical

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္တြင္ ေလ့လာခဲ႕ျပီး ျဖစ္ေသာ သင္ခန္းစာမ်ားကို အသုံးျပဳျပီး၊ Drawing မ်ားသုိ႕

Layer န႕ဲ hidden geometry Add ျခင္း၊ ကို လက္ေတြ႕ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

The completed exercise

၁) M_MECH-Challenge- CHP04.dwg ကိုဖြင့္ပါ။

၂) Layer Properties Manager ကုိဖြင့္လိုက္ပါ။

 Hidden ဆိုေသာ နာမည္ျဖင့္ Layer အသစ္တစ္ခု လုပ္လိုက္ျပီး၊ ထုိ Layer ကို current အျဖစ္ ထားလိုက္ပါ။

 Color = 151
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 Linetype = Hidden

 Centerline ဆိုေသာ နာမည္ျဖင့္ Layer အသစ္တစ္ခု လုပ္လိုက္ပါ။

 Color = Magenta

 Linetype = Center

 Annotation ဆိုေသာ နာမည္ျဖင့္ Layer အသစ္တစ္ခု လုပ္လိုက္ပါ။

 Color = Magenta

 Linetype = Continuous

 Start Points layer ကို Freeze and lock လုပ္ပါ။

၃) LTSCALE ကုိ system variable 0.75 ထားလုိက္ပါ။

၄) Hidden layer current ျဖင့္ ပုံတြင္ ျပထားသည့္ အတုိင္း hidden geometry မ်ားေရးဆြဲလိုက္ပါ။ Centerline objects

မ်ားကိုလည္း ပုံတြင္ ျပထားသည့္ အတုိင္း ေရးဆြဲလိုက္ျပီး၊ Centerline layer တြင္ ထားလုိက္ပါ။

၅) Files မ်ားကို Save ျပီး ပိတ္လုိက္ပါ။

Chapter Summary

ဤ chaper ကုိေလ့လာျခင္း ျပီးေျမာက္သြားပါက -

 Drawing အတြင္းမွ Objects မ်ား layer ျဖင့္ organize လုပ္တတ္လာမည္။

 Objects မ်ား၏ Properties မ်ားကုိ ေျပာင္းလဲပုံႏွင့္ ခြဲျခားပုံတုိ႕ကို သိရိွလာမည္။
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 Quick Properties panel ကုိအသံုးျပဳျပီး Objects မ်ား၏ Properties မ်ားကို ျမန္ျမန္ဆန္ဆန္ ေျပာင္းလဲ

တတ္လာမည္။

 Match Properties command ကုိအသုံးျပဳျပီး မူရင္းObjects ၏ Properties အတုိင္း အျခား Objects မ်ား၏

Properties ကိုအလြယ္တကူ ကူးေျပာင္းေပးတတ္လာမည္။

 Properties palette ကုိအသံုးျပဳျပီး Objects မ်ား၏ Properties မ်ားကုိ ေျပာင္းလဲေပးတတ္လာေစရန္။

 Drawing အတြင္းရိွ Objects မ်ားကုိ linetypes ျဖင့္ ခြဲျခားေပးတတ္လာမည္။

 Inquiry commands (Distance, Radius, Angle, Area, List, and ID) ျဖင့္ drawing အတြင္းမွ Objects မ်ား၏

informations မ်ားကုိ သိရိွႏိုင္မည္္။
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CHAPTER: 5 Altering Objects
အားလုံးေသာ CAD design တြင္ editing objects ဆုိေသာ အလုပ္ကို Users မ်ား အမ်ားဆံုး လုပ္ေလ့ရိွေသာ အရာ

ျဖစ္ပါသည္။ Editing ကိုdrawing မ်ားေရးဆြဲတိုင္း အသံုးရန္ လုိအပ္သလို၊ design ေျပာင္းလဲရာတြင္ (သုိ႕မဟုတ္)

ရႈပ္ေထြးလွေသာ Objects မ်ားဖန္တီးရာတြင္ အလြန္အသံုးမ်ား ပါသည္။

Objectives

ဤ chapter ကိုေလ့လာျခင္း ျပီးစီးသြားပါက -

 Trim န႕ဲ Extend commands အသံုးျပီးျပီး objects မ်ား၏ length ကိုျပဳျပင္ေျပာင္းလဲ တတ္ေစရန္။

 Offset command ကုိအသုံးျပဳျပီး၊ geometry မ်ားကုိ parallel န႕ဲoffset လုပ္တတ္လာေစရန္။

 Join command ကိုအသံုးျပဳျပီး၊ objects နွစ္ခုကို Join ေပးျပီး object တစ္ခုတည္း ျဖစ္လာေအာင္ ဖန္တီး

တတ္လာေစရန္။

 Object တစ္ခုတည္းကို မိမိတို႕ လိုအပ္သေလာက္ အပိုင္းပိုင္း ျဖစ္ေအာင္ ဖန္တီးတတ္လာေစရန္။

 Stretch command ကုိအသုံးျပဳျပီး၊ drawing အတြင္းမွ Object မ်ား၏ ပုံသ႑ာန္ကုိ ေျပာင္းလဲ တတ္လာေစရန္။

Lesson: Trimming and Extending Objects to Defined Boundaries

ဤသင္ခန္းစာတြင္ drawing အတြင္းမွ Object မ်ားကုိ trim နဲ႕ extend ျပဳလုပ္ျခင္း အပိုင္းကို ေလ့လာသြား ရမည္

ျဖစ္သည္။ ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးေျမာက္သြားပါက trim န႕ဲ extend command ကိုအသံုးျပဳျပီး၊ drawing

အတြင္းမွ Object မ်ားကုိ modify လုပ္ျခင္း၊ cut edges လုပ္ျခင္း၊ extend boundaries လုပ္ျခင္း စသည္တို႕ကို

နားလည္သေဘာေပါက္ လာပါလိမ္႕မည္။

Trim လုပ္ရန္ လိုအပ္ေနေသာ ေအာက္ေဖာ္ျပပါပုံကုိ ေလ့လာၾကည့္ပါ။
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Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးေျမာက္သြားပါက -

 Trim န႕ဲ Extend commands အသံုးျပဳျပီး Drawing အတြင္းမွ geomentry မ်ားကုိ modify လုပ္တတ္

လာေစရန္။

Using the Trim and Extend Commands

Trim command သည္ Objects မ်ားျဖတ္ေတာက္ရာတြင္ အသုံးျပဳရျပီး၊ Extend command ကုိ Objects မ်ား

ဆြဲဆန္႕ရာတြင္ အသုံးျပဳပါသည္။ ဥပမာ အားျဖင့္ Line တစ္ေၾကာင္းနွင့္ တစ္ေၾကာင္း ခ်ိတ္ဆက္ရာတြင္

အစြန္းထြက္လာသည့္ အပိုင္းမ်ားကို ျဖတ္ေတာက္ ခ်င္လွ်င္ Trim command ကုိအသံုးျပဳရပါသည္။ Line တစ္ေၾကာင္းနွင့္

တစ္ေၾကာင္း ခ်ိတ္ဆက္ရာတြင္ Line တစ္ေၾကာင္း၏ အလ်ားမွာ မိမိတို႕ လိုခ်င္ေသာ ေနရာကို မေရာက္လွ်င္ Extend

command ကိုအသံုးျပဳျပီး ဆြဲဆန္႕ႏိုင္ပါသည္။

ေအာက္ေဖာ္ျပပါပုံကို ေလ့လာၾကည့္ပါ။ ျမွားျဖင့္ ျပထားေသာ Lines မ်ားမွ အစြန္းထြက္ေနေသာ အပိုင္းမ်ားကို Trim

command အသုံးျပဳျပီး ျဖတ္ေတာက္ေပးရမည္ ျဖစ္သည္။
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Extend command ကုိအသုံးျပဳေသာအခါ မိမိတို႕ ထိဆက္လိုေသာ boundary ကုိအရင္ဆုံး select ျပီးမွ ဆြဲဆန္႕မည့္

object ကုိ select ရသည္။ ေအာက္တြင္ေဖာ္ျပေပးထားေသာ ပုံကိုေလ့လာၾကည့္ပါ။ lines (1) ႏွစ္ေၾကာင္းကုိ ေအာက္မွ

boundary edge (2)ျဖင့္ တစ္ဆက္တည္းျဖစ္ေအာင္ ေရးဆြဲလိုပါက Extend command ျဖင့္၊ boundary edge (2) ကို

select ျပီး lines (1) ကို select လိုက္ပါ။ ထုိအခါ lines (1) ႏွစ္ေၾကာင္းသည္ boundary edge (2) ျဖင့္ ထိဆက္သြားမည္

ျဖစ္သည္။

Extend မလုပ္ခင္ Extend လုပ္အျပီး

Command Access

Trim
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Command Line: TRIM, TR

Ribbon:Home tab > Modify panel > Trim

Menu Bar: Modify > Trim

Command Access

Extend

Command Line: EXTEND, EX

Ribbon: Home tab > Modify panel > Extend

Menu Bar: Modify > Extend

Procedure: Trimming Objects

Trim command အသံုးျပဳျပီး Objects မ်ားတြင္ အစြန္းထြက္ေနေသာ အပိုင္းမ်ား ျဖတ္ေတာက္ပုံကုိ ေအာက္တြင္

အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Ribbon, Home tab > Modify panel > Trim ကို click ပါ။

၂) Objects တြင္ အစြန္းထြက္ေနေသာျမွားျဖင့္ ျပထားေသာ Line နွစ္ေၾကာင္း နွင့္ edges (1) ကိုျဖတ္ထုတ္မည္ ျဖစ္သည္။

ထုိ႕ေၾကာင့္ Objects အားလုံးကုိ select လုိက္ပါ။
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၃) ထုိ႕ေနာက္ ျဖတ္မည့္ Line နွစ္ေၾကာင္း နွင့္ edges (1) ကုိ select လုိက္ပါ။

၄) Line နွစ္ေၾကာင္း နွင့္ edges (1) ကိုျပတ္သြားသည္ကုိ ေတြ႕ရမည္။Trim command ကုိ end ရန္ Enter ႏိွပ္ပါ။

Procedure: Extending Objects

Lines မ်ားကုိ Boundary edgesသို႕ ထိစပ္လုိပါက Extend command အသံုးျပဳျပီး ဆြဲဆန္႕ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္

ေဖာ္ျပေပးထားပါသည္။
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၁) Ribbon, Home tab > Modify panel > Extend ကို click ပါ။

၂) Boundary edges (1) ကုိ select ျပီး Enter ႏိွပ္ပါ။

၃) Extend လုပ္မည့္ Line (2) ကုိ select လုိက္ပါ။

၄) Line (2) သည္ Boundary edges (1) ျဖင့္ ထိစပ္သြားမည္ကို ေတြ႕ရမည္။ Extend command ကုိ end ရန္ Enter

ႏိွပ္ပါ။

Practice Exercise: Trim and Extend
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ဤေလ့က်င့္ခန္းတြင္ Trim နဲ႕ Extend command အသုံးျပဳပုံကုိ ေလ့က်င့္ေလ့လာသြားရမည္ ျဖစ္သည္။ ပထမဆံုး အေနန႕ဲ

Rectangle နွစ္ခုအရင္ဆြလုိဲက္ပါ။ Rectangle တစ္ခုတြင္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း Across Lines မ်ား ေရးွဆြဲျပီး၊

က်န္တစ္ခုတြင္ series Lines မ်ားေရးဆြဲေပးလုိက္ပါ။ Across Lines မ်ားကုိ Rectangle ၏အျပင္ဖက္ သုိ႕

အစြန္းထြက္ေအာင္ ဆြဲေပးျပီး၊ series Lines မ်ားကုိ Rectangle ေဘာင္မ်ားျဖင့္ မထိေအာင္ ေရးဆြေဲပးပါ။ ထုိပုံႏွစ္ပုံျဖင့္

Trim န႕ဲ Extend command တို႕ကို ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။

၁) ေလ့က်င့္ခန္းကုိ စတင္ဖို႕ -

 Rectangle နွစ္ခုအရင္ဆြလုိဲက္ပါ။ (သင့္ေတာ္ေသာ အရြယ္အစား)

 Rectangle တစ္ခုတြင္ Across Lines မ်ားေရးွဆြျဲပီး၊ က်န္တစ္ခုတြင္ series Lines မ်ားေရးဆြဲေပး လုိက္ပါ။

၂) အရင္ဆံုး Trim command ကုိအသံုးျပဳျပီး အစြန္းထြက္မ်ားကို ျဖတ္ေတာက္ရန္ -

 Ribbon, Home tab > Modify panel > Trim ကို click ပါ။

 အစြန္းထြက္မ်ားကုိ ျဖတ္ရန္ Rectangle ကို select လိုက္ပါ။

 Enter ႏိွပ္ပါ။

၃) Lines မ်ားကို Trim ရန္ -
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 မိမိတုိ႕ ျဖတ္ေတာက္ခ်င္ေသာ အစြန္းထြက္အပိုင္းမ်ားကို select ရမည္ ျဖစ္သည္။

 ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း Rectangle ၏ဘယ္ဖက္တြင္ အစြန္းထြက္ေနေသာ အပိုင္းမ်ားကို select လုိက္ပါ။

၄) Fence option ကုိအသံုးျပဳျပီး၊ ဆက္လက္ Trim ရန္ -

 Graphics window တြင္ Right-click ႏိွပ္ျပီး Fence ကုိ Click လိုက္ပါ။

 Rectangle ၏ညာဖက္ အေပၚ (၁) အစြန္းထြက္ေနေသာ lines မ်ားျဖင့္ ကပ္လ်က္တြင္ first point သတ္မွတ္

လိုက္ပါ။

 Rectangle ၏ညာဖက္ ေအာက္နား (၂) အစြန္းထြက္ေနေသာ lines မ်ားျဖင့္ ကပ္လ်က္တြင္ second point

သတ္မွတ္ လိုက္ပါ။
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၅) Trim command ျပီးဆုံးေစရန္ -

 Fence selection option ကို ျပီးေျမာက္ေစရန္ Enter ႏိွပ္ပါ။

 Trim command ကိုျပီးဆံုးေၾကာင္း အတည္ျပဳေပးရန္ Enter ႏိွပ္ပါ။

၆) Extend command ကိုအသုံးျပဳရန္ အတြက္ boundary edges ကုိ အရင္ select လုပ္ရန္ -

 Ribbon, Home tab > Modify panel > Extend ကို click ပါ။

 Rectangle Boundary ကို select ျပီး Enter ႏိွပ္ပါ။
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၇) Lines မ်ားကုိ Extend လုပ္ရန္ အတြက္ မိမိတုိ႕ Extend လုပ္လုိေသာ Lines မ်ား၏ အစြန္းနား အနီးတြင္ click ေပးရန္ -

 Rectangle (1) ဘယ္ဖက္ သုိ႕ Extend လုပ္ရန္ Lines တစ္ေၾကာင္းခ်င္းစီကုိ select လုိက္လုပ္ပါ။

 Graphics window တြင္ Right-click ႏိွပ္ျပီး Fence ကုိ Click လိုက္ပါ။
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 Rectangle (1) ဘယ္ဖက္ သို႕ Extend လုပ္ရန္ Lines မ်ား၏ ညာဖက္အစြန္း အထက္တြင္(1) First point အျဖစ္

တစ္ခ်က္ click ေပးျပီး၊ Lines မ်ားကုိျဖတ္ျပီး ေအာက္နားတြင္ (2) second အျဖစ္ တစ္ခ်က္ click လိုက္ပါ။

၈) Extend command ကိုျပီးဆုံးသြားေစရန္ -

 Fence selection option ကို ျပီးေျမာက္ေစရန္ Enter ႏိွပ္ပါ။

 Extend command ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 Result ကုိ ၾကည့္လိုက္ပါ။

Exercise: Trim and Extend Objects

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Trim န႕ဲ Extend command မ်ားအသံုးျပဳျပီး၊ drawings အတြင္းမွ objects မ်ားကုိ Trim

န႕ဲ Extend ျပဳလုပ္ျခင္းမ်ားကုိ လက္ေတြ႕ေလ့က်င့္သြားရမည္ ျဖစ္သည္။
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The completed exercise

၁) M_Trim-Extend.dwg ကိုဖြင့္ပါ။

၂) ေအာက္ပါပုံတြင္ ေဖာ္ျပေပးထားေသာ အပိုင္းကို Zoom ခ်ဲ႕လိုက္ပါ။

၃) Trim command ကိုအသံုးျပဳျပီး အစြန္းထြက္ေနေသာ မ်ဥ္းမ်ားကို Trim ရန္ -

 Ribbon, Home tab > Modify panel > Trim ကို click ပါ။

 ေအာက္ေဖာ္ျပပါပုံတြင္ ျမွားျပထားျပီး အေရာင္မိွန္ေနေသာ အပိုင္းမ်ားကုိ select လုိက္ပါ။

 Enter နိွပ္ပါ။
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 Trim လုပ္မည့္ မ်ဥ္း၏ အစြန္းထြက္ အပိုင္းမ်ားကို ျဖတ္ရန္ ေအာက္ပါပုံတြင္ ျမွားျဖင့္ ျပထားေသာ ေနရာမ်ားကို

select လုိက္ပါ။

 အစြန္းထြက္မ်ားကုိ ျဖတ္ေတာက္ျပီးသြားပါက ေအာက္ပါပုံအတိုင္း ရရိွလာမည္ ျဖစ္သည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

402

၅) Drawing တစ္ခုလံုးကုိ ျမင္နိုင္ေသာ အေနထားျဖင့္ေအာင္ Zoom ကုိခ်ဲ႕လိုက္ပါ။

၆) Extend command ကိုအသုံးျပဳရန္ -

 Ribbon, Home tab > Modify panel > Extend ကို click ပါ။

 ေအာက္ေဖာ္ျပပါပုံတြင္ ျမွားျပထားျပီး အေရာင္မိွန္ေနေသာ အပိုင္းမ်ားကို boundary edges အျဖစ္သတ္မွတ္ရန္

select လုိက္ပါ။

 Enter နိွပ္ပါ။
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၇) ဘယ္ဖက္ပုံကုိ Extend ျပီးေျမာက္ေစရန္ -

 Drawing အတြင္း တစ္ေနရာရာတြင္ Right – click ႏိွပ္ျပီး၊ Edge ကုိ select လုိက္ပါ။

 Drawing အတြင္း တစ္ေနရာရာတြင္ Right – click ႏိွပ္ျပီး၊ Extend ကုိ select လုိက္ပါ။

 Extend လုပ္မည့္ Objects မ်ားကုိ ပုံတြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း select ပါ။

မွတ္ခ်က္။ ။ ထုိသုိ႕ select ရာတြင္ ေရျပင္ညီမ်ဥ္း တစ္ေၾကာင္းကို နွစ္ၾကိမ္ click မွဘယ္ဖက္တြင္ရိွေသာ ပုံေအာက္သုိ႕

ေရာက္ႏိုင္မည္ ျဖစ္သည္။

 ထုိသို႕selected ျပီးပါက ေအာက္ပါပုံအတိုင္း ရရိွလာမည္ ျဖစ္သည္။
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 လက္ရိွသင္ခန္းစာအတြက္ ေဖာ္ျပေပးထားေသာ ပုံရရန္ ပုံႏွစ္ပုံဆက္ေနေသာ မ်ဥ္းကုိ trim command ျဖင့္

ျဖတ္ေတာက္ေပးရမည္ ျဖစ္သည္။ ထုိမ်ဥ္းမ်ားကို ျဖတ္ေတာက္ရန္ Shift ႏိွပ္ထားျပီး ထုိဆက္ေနေသာ မ်ဥ္းကို

select လုိက္ပါ။

 Extend command ကုိျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၁၀) Construction lines ကို Remove လုပ္ရန္ -

 Erase command ကိုစတင္လိုက္ပါ။

 ေအာက္ပါပုံတြင္ ျမွားျဖင့္ ညြန္ျပထားေသာ မ်ဥ္းမ်ားကိုselect လိုက္ပါ။ Enter ႏိွပ္ပါ။

၁၁) သင္ခန္းစာအတြက္ လုပ္ရမည့္ အပိုင္းမ်ား ျပီးေျမာက္ေအာင္ လုပ္ေဆာင္ျပီးသြားပါျပီ။
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၁၂) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Creating Parallel and Offset Geometry

ဤသင္ခန္းစာတြင္ ေလ့လာသြားရမည့္ offset command ကို၊ drawing အတြင္းမွ geomentry မ်ားကုိ မိမိတုိ႕ နွစ္သက္ရာ

ေနရာတြင္ ပုံတူ (အရြယ္အစားကုိမူ စိတ္ၾကိဳက္သတ္မွတ္ ႏိုင္ပါသည္) ပြားလိုေသာအခါ အသံုးျပဳပါသည္။ မူရင္း geomentry

ရ႕ဲ အရြယ္အစားတူ (သို႕မဟုတ္) စိတ္ၾကိဳက္အရြယ္အစား သတ္မွတ္နိုင္ေသာ ျပီး ပုံတူ geomentry မ်ားကို

တစ္ခုေရးဆြဲယံုျဖင့္ အၾကိမ္ေပါင္းမ်ားစြာ ပြားနိုင္ေသာေၾကာင့္ modify command တြင္ users မ်ားအသံုးမ်ားေသာ

command တစ္ခုလည္း ျဖစ္ပါသည္။ ေအာက္ေဖာ္ျပပုံတြင္ offset command အသုံးျပဳျပီး အျပိဳင္ေရးဆြဲထားေသာ Lines

နွင့္ Circles မ်ားကုိ ေလ့လာၾကည့္ပါ။
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Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Drawing အတြင္းမွ geomentry မ်ားကုိ မိမိတို႕ နွစ္သက္ရာ ေနရာတြင္ ပုံတူ (အရြယ္အစားကုိမူ စိတ္ၾကိဳက္

သတ္မွတ္ ႏိုင္ပါသည္) ပြားျခင္းကို နားလည္လာေစရန္။

Offsetting Objects

Offset command ျဖင့္ selected ထားေသာ object မ်ား၏ ပုံစံတူ အျပိဳင္ (အရြယ္အစား စိတ္ၾကိဳက္ သတ္မွတ္ျပီး) ကူးယူ

ႏိုင္ပါသည္။ ေအာက္ေဖာ္ျပပါပုံကုိ ေလ့လာၾကည့္ပါ။ Offset command ျဖင့္ ပုံစံတူ ေရးဆြဲ ထားျခင္း ျဖစ္ပါသည္။

Command Access
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Offset

Command Line: OFFSET, O

Ribbon: Home tab > Modify panel > Offset

Application Menu: Modify > Offset

Command Options

Offset command တြင္ ေအာက္ေဖာ္ျပပါ Options မ်ားရိွပါသည္။ ထုိ Options မ်ားကို shortcut menu မွ (သို႕မဟုတ္)

command line မွ ေရြးခ်ယ္ႏိုင္ အသုံးျပဳနိုင္ပါသည္။

Through – Drawing area ထဲတြင္ ပံုတူပြားမည့္ object မ်ားကို မိမိတုိ႕ ပုိ႕လိုသည့္ အေနရာကုိ ေဖာ္ျပေပးျခင္း။

Erase - Objects မ်ားကို ပြားျပီးပါက မူရင္း object ကုိဖ်က္ျခင္း။

Layer - အသစ္ပြားယူထားေသာ Objects မ်ားကုိ မူရင္း object ၏ layer သုိ႕ပုိ႕ျခင္း။

Multiple - ပြားမည့္ Object အတြက္ Through point သတ္မွတ္ေပးျပီးပါ၊ Multiple options ျဖင့္ Object အေရအတြက္ကုိ

မိမိတုိ႕ သေဘာရိွ ပြားႏိုင္သည္။

Procedure: Offsetting Geometry a Specific Distance

Objects မ်ား Offset လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Ribbon, Home tab > Modify panel > Offset.

၂) Point (2) points ကုိ select ျပီး offset ကိုသတ္မွတ္ေပးပါ။

မွတ္ခ်က္။ ။ Selecting points အတြက္ တန္ဖိုးမ်ားရိုက္ထည့္၍လည္း သတ္မွတ္နိုင္ပါသည္။
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၃) Offset လုပ္ရန္ object ကို select ပါ။

၄) ပြားယူမည့္ Object အတြက္ မိမိတုိ႕ ပြားလိုသည့္ဘက္တြင္ point သတ္မွတ္ေပးပါ။

၅) Offset command ကုိအဆုံးသတ္ရန္ Enter ႏိွပ္ပါ။

Procedure: Offsetting Geometry Through a Point

Offset command မွ Through option ျဖင့္ objects မ်ား offset လုပ္ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး

ထားပါသည္။

၁) Ribbon, Home tab > Modify panel > Offset.

၂) Drawing တြင္ Right – click ႏိွပ္ျပီး shortcut menu မွ Through ကုိ select ပါ။ (သုိ႕မဟုတ္) command line မွ

ရိုက္ထည့္ျပီး ေခၚယူလိုက္ပါ။
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၃) Offset လုပ္ရန္ object ကို select ပါ။

၄) ပြားလုိေသာ Object ကုိ မူရင္း Object တည္ေနရာမွေနျပီး ထားလုိသည့္ေနရာ Through point ကုိသတ္မွတ္ေပးပါ။

၅) Offset command ကုိအဆုံးသတ္ရန္ Enter ႏိွပ္ပါ။

Procedure: Offsetting Multiple Objects

Offset command မွ Multiple option ျဖင့္ objects မ်ား offset လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး

ထားပါသည္။

၁) Ribbon, Home tab > Modify panel > Offset.

၂) Offset လုပ္မည့္ အကြာအေ၀းကုိ အမွတ္မ်ား ရိုက္ထည့္ေပးပါ။ (သုိ႕မဟုတ္) cursor ျဖင့္ point (2) points

သတ္မွတ္ေပး နိုင္ပါသည္။

၃) Offset လုပ္ရန္ object ကို select ပါ။
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၄) Drawing တြင္ Right – click ႏိွပ္ျပီး shortcut menu မွ Multiple ကို select ပါ။

၅) ပြားမည့္ Objects မ်ားထားလိုသည့္ ေနရာအမွတ္ကုိ click ေပးပါ။

၆) ထပ္မံ၍ ပြားမည့္ Objects အတြက္ ထားလုိသည့္ ေနရာအမွတ္ကုိ သတ္မွတ္ေပးပါ။

၇) ထပ္မံ၍ သတ္မွတ္ေပးပါ။
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၈) Command မဆံုးမခ်င္း objects အေရအတြက္ ကန္႕သတ္ခ်က္မရိွ ပြားႏိုင္ပါသည္။

Practice Exercise: Offsetting Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Objects မ်ားကုိ နည္းလမ္း (၃) မ်ိဳးျဖင့္ Offset ျပဳလုပ္သြားပါမည္။ ပထမဆံုး အေနနဲ႕

Circle, line န႕ဲ rectangle တို႕ကိုေရးဆြဲသြားျပီး၊ rectangle ကုိအကြာအေ၀း သတ္မွတ္ေပးေသာ နည္းလမး္ျဖင့္ offset

လုပ္ပါမည္။ Circle ကုိ Through point နည္းလမ္းျဖင့္ offset ျပဳျပီး၊ Line ကုိ Multiple option ျဖင့္ offset

ျပဳလုပ္သြားရပါမည္။

၁) အကြာအေ၀း သတ္မွတ္ေပးေသာ နည္လမ္းျဖင့္ offset လုပ္ရန္ -

 Ribbon, Home tab > Modify panel > Offset.

 offset distance အတြက္ 0.5 ဟုရိုက္ထည့္ေပးျပီး Enter ႏိွပ္ပါ။

 Rectangle (1) ကုိ select ပါ။

 Rectangle အတြင္းကုိ တစ္ခ်က္ click ပါ။

 Rectangle (2) ကုိ select ပါ။

 Rectangle အတြင္းကုိ တစ္ခ်က္ click ပါ။

 Rectangle (3) ကုိ select ပါ။
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 Rectangle အတြင္းကုိ တစ္ခ်က္ click ပါ။

 Rectangle command ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၂) Through apoint ျဖင့္ offset လုပ္ရန္ -

 Ribbon, Home tab > Modify panel > Offset.

 Drawing area တြင္ Right – click ႏိွပ္ျပီး Through ကို select ပါ။

 Offset လုပ္မည့္ object ကို select ပါ။ Circle ကုိ select လုပ္ပါ။

 Through apoint အတြက္ တစ္ျခားေသာ Object တြင္သတ္မွတ္ေပးလိုက္ပါ။ အနီးတြင္ရိွေသာ Rectangle ၏

တစ္ေနရာရာကို select ေပးလိုက္ပါ။

 Offset command ကုိျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။
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၃) Multiple Offset လုပ္ရန္ -

 Ribbon, Home tab > Modify panel > Offset.

 Offset distance အတြက္ .1 ရိုက္ထည့္လိုက္ျပီး၊ Enter ႏိွပ္ပါ။

 Offset မည့္ line ကုိ select လုိက္ပါ။

 Drawing area တြင္ Right – click ႏိွပ္ျပီး Multiple ကုိ select ပါ။

 Selected ထားေသာ Line ၏ေဘးတြင္ offset လုပ္ရန္ အတြက္ point သတ္မွတ္ေပးလိုက္ပါ။

 Offset လုပ္ရန္ အတြက္ ထပ္မံ၍ point သတ္မွတ္ေပးလုိက္ပါ။

 Offset command ကုိအဆုံးသတ္ရန္ အတြက္ Enter ႏိွပ္ပါ။

Exercise: Create Parallel and Offset Geometry

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Offset command ကိုအသံုးျပဳျပီး မူရင္း Object အတြင္းတြင္ Object မ်ား

ေရးဆြသဲြားရပါမည္။ ထုိ objects မ်ားကို offset လုပ္ျပီးသြားပါက Trim command အသုံးျပဳျပီး modify လုပ္သြား ရပါမည္။

ဤလက္တြ႕ ေလ့က်င့္ခန္းကုိ လိုက္ပါေလ့က်င့္မွဳ႕ ျပီးစီးသြားပါက အျခား drawings မ်ားတြင္လည္း Offset command

အသုံးျပဳျပီး၊ drawings မ်ားကို modify လုပ္တတ္သြားမည္ ျဖစ္သည္။
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The completed exercise

၁) M_Offset-Objects.dwg ကိုဖြင့္လုိက္ပါ။

၂) ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း အေပၚဘယ္ဖက္ေထာင့္ကုိ Zoom ခ်ဲ႕လုိက္ပါ။

၃) Circle ကုိ offset လုပ္ရန္ အတြက္ -

 Ribbon, Home tab > Modify panel > Offset.

 Offset command ကုိေခၚလိုက္သည္ႏွင့္ command line တြင္ ေဖာ္ျပမည့္ setting သည္ ေအာက္ပါအတိုင္း

ဟုတ္မဟုတ္ စစ္ေဆးၾကည့္ပါ။

 Current settings: Erase source=No

 Layer = Source

 OFFSETGAPTYPE = 0
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ဤကယ္၍ setting သည္ အထက္ပါအတိုင္း မဟုတ္ပါက -

 Drawing area တြင္ Right – click ႏိွပ္ပါ။ Erase ကုိ click ျပီး No ကုိ select လုိက္ပါ။

 Drawing area တြင္ Right – click ႏိွပ္ပါ။ Layer ကုိ click ျပီး source ကုိ select လိုက္ပါ။

 7.5 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Circle အေသးကုိ select ျပီး၊ ထုိ circle၏ အျပင္ဖက္တြင္ point ကို select ေပးလိုက္ပါ။

၄) ပုံတြင္ ျပထားသည့္ အတုိင္း circle ၏အေပၚတြင္ရိွေသာ အပိုင္းကုိ selectျပီး၊ ထုိအပိုင္း၏ ေအာက္နားတြင္ point တစ္

point သတ္မွတ္ေပး လိုက္ပါ။

၅) Offset command ျပီးေျမာက္ေစရန္ -

 ပုံတြင္ ျပထားသည့္ အတုိင္း circle ၏အေပၚတြင္ရိွေသာ အပိုင္းကုိ selectျပီး၊ ထိုအပိုင္း၏ ေအာက္နားတြင္ point

တစ္ point သတ္မွတ္ေပး လုိက္ပါ။

 Enter ႏိွပ္ျပီး offset command ကုိအဆံုးသတ္ေပး လုိက္ပါ။
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၆) Previous ကဖန္တီးခ႕ဲေသာ Object ကို Trim လုပ္ရန္ -

 Ribbon,Home tab, click Modify panel > Trim.

 Circle န႕ဲ Vertical line ကုိ Cutting edges အျဖစ္အသုံးျပဳသြားမည္။

 Offset command ျဖင့္ ေရးဆြဲထားေသာ Object ကုိ select လုိက္ပါ။( ျမွားျဖင့္ ညႊန္ျပေပးထားသည္။)

၇) Vertical line ကုိ offset လုပ္ရန္ႏွင့္ current layer တြင္ ထားရန္ -

 Ribbon, Home tab > Modify panel > Offset.

 Drawing area တြင္ Right–click ႏိွပ္ပါ။ Layer ကို click ျပီး Current ကုိ select လုိက္ပါ။

 5.25 ဟုရိုက္ထည့္ျပီး၊ Enter ႏိွပ္ပါ

 Vertical line ကုိ select လုိက္ျပီး၊ ထုိ line ၏ဘယ္ဖက္တြင္ point သတ္မွတ္ေပးလုိက္ပါ။

 Offset command ကုိအဆုံးသတ္ရန္ Enter ႏိွပ္လုိက္ပါ။
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၈) Drawing တစ္ခုလံုးကုိ Drawing window တြင္ျမင္ေတြ႕ႏိုင္ေအာင္ Zoom ခ်ဲ႕လိုက္ပါ။

၉) Centerlines ကို အကြာအေ၀း သတ္မွတ္ျပီး offset လုပ္ရန္ -

 Ribbon, Home tab > Modify panel > Offset.

 ပုံတြင္ျပထားသည့္ အတိုင္း point (2) points ကို select လုပ္ပါ။

၁၀) Offset ကုိျပီးေျမာက္ေစရန္ -

 အေပၚဘယ္ဖက္တြင္ရိွေသာ centerline ကုိ select ျပီး၊ ထို centerline အထက္တြင္ပင္ point သတ္မွတ္ေပး

လိုက္ပါ။

 Centerline ကို ထပ္မံ select ျပီး၊ centerline ေအာက္တြင္ point သတ္မွတ္ေပး လိုက္ပါ။

 Offset command ကုိအဆုံးသတ္ရန္ Enter ႏိွပ္လုိက္ပါ။
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၁၁) Trim command ကုိအသုံးျပဳျပီး၊ hidden lines မ်ားကို ေအာက္ပါ ပုံအတုိင္း ျဖစ္ေအာင္ ျဖတ္ေတာက္ လုိက္ပါ။

၁၂) Hidden pocket ေလးတစ္ခု ဖန္တီးရန္ -

 Ribbon, Home tab > Modify panel > Offset.

 Drawing area တြင္ Right – click ႏိွပ္ျပီး Throughကုိ select ပါ။

 Offset လုပ္ရန္ objects ကုိ select ရန္ Prompted လာလွ်င္ ဘယ္ဖက္ပုံမွ centerline (1) ကို select

ေပးလုိက္ပါ။

 Through point ကို Prompted လာလွ်င္ ညာဖက္ပုံ ( 2) ၌ ျပထားေပးေသာ ေနရာကို select လိုက္ပါ။
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၁၃) အျခား line တစ္ခုကို offset လုပ္ရန္ -

 Offset လုပ္ရန္ objects ကုိ select ရန္ Prompted လာလွ်င္ ဘယ္ဖက္ပုံမွ centerline (1) ကို select

ေပးလုိက္ပါ။

 Through point ကို Prompted လာလွ်င္ ညာဖက္ပုံ( 2) ၌ ျပထားေပးေသာ ေနရာကို select လိုက္ပါ။

၁၄) Pocket လုပ္ေဆာင္ျခင္း ျပီးျပည့္စုံေစရန္ -

 Offset လုပ္ရန္ objects ကုိ select ရန္ Prompted လာလွ်င္ ေအာက္ပုံတြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း

vertical line၏ ေအာက္ေျခ(1) ကို select လိုက္ပါ။

 Through point ကို Prompted လာလွ်င္ အေပၚပုံ (2) ေနရာကို select ေပးလိုက္ပါ။

 Offset command ကုိအဆုံးသတ္ရန္ Enter ႏိွပ္လုိက္ပါ။
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၁၅) Offset command ကိုအသံုးျပဳျပီး Centerline ကို circle အေသး၏ quadrants သုိ႕ျဖတ္ျပီး offset လုပ္ပါ။ ျပီးေနာက္

Trim command ကိုအသံုးျပဳျပီး Lines မ်ားကုိ ေအာက္ပါပုံတြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္းျဖတ္ေတာက္ လိုက္ပါ။

၁၆) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Joining Objects

ဤသင္ခန္းစာတြင္ objects အမ်ိဳးမ်ိဳးျဖင့္ ေပါင္းစပ္ေရးဆြဲထားေသာ drawing ကုိ object တစ္ခုတည္း ျဖစ္သြားေအာင္

ျပဳလုပ္ႏိုင္ေသာ Join command အေၾကာင္းကုိ ေလ့လာသြားရမည္ ျဖစ္ပါသည္။ Region ႏွင့္ အျခားေသာ 3DModel

objects မ်ားဖန္တီးရာတြင္ ေရးဆြဲထားေသာ geomentry မ်ား တစ္ခုခုနွင့္ ထိဆက္မွဳ႕ မရိွပါက၊ ဆက္လက္လုပ္ေဆာင္

ႏိုင္မည္ မဟုတ္ေပ။ ထိုအခါမ်ိဳးတြင္ Join command ကုိအသုံးျပဳျပီး၊ geomentry တစ္ခုတည္း ျဖစ္သြားေအာင္

ခ်ိတ္ဆက္ေပးႏိုင္ပါသည္။ Join command ၏လုပ္ေဆာင္မွဳ႕ အႏွစ္ခ်ဳပ္မွာ အပိုင္းပိုင္း ျဖစ္ေနေသာ Objects မ်ားကို Object

တစ္ခုတည္း ျဖစ္ေအာင္ ေပါင္းစပ္ေပးျခင္းပင္ ျဖစ္ပါသည္။
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Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္းျပီးစီးသြားပါက -

 Join command ကုိအသုံးျပဳျပီး Objects မ်ားကုိ ေပါင္းစပ္ျခင္းကုိ သေဘာေပါက္လာေစရန္။

Joining Objects

Drawing အတြင္းရိွ တစ္ပိုင္းစီ ျဖစ္ေနေသာ Objects မ်ားကုိ Object တစ္ခုတည္းျဖစ္ေအာင္ ေပါင္းစည္ေပးရာတြင္ Join

command ကိုအသံုးျပဳရပါမည္။ Join command ကုိ polylines, lines, arcs, elliptical arcs ႏွင့္ splines တုိ႕ကုိ တစ္ခုႏွင့္

တစ္ခုခ်ိတ္ဆက္ေပးစည္း ေပးရာတြင္ အသံုးျပဳႏိုင္ပါသည္။

Command Access

Join

Command Line: JOIN, J

Ribbon: Home tab > extended Modify panel > Join
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Menu Bar: Modify > Join

Command Options

Select source object - တစ္ပိုင္းစီျဖစ္ေနေသာ Objects မ်ားကုိ Object တစ္ခုတည္း ျဖစ္လာေစရန္ ျပဳလုပ္ရာတြင္ ပင္မ

object အျဖစ္ ထားရိွမည့္ object ကုိ ေရြးခ်ယ္ေပးျခင္း။

Select objects to join to source - ပင္မ Object ဆီသုိ႕ ေပါင္းစည္းေစမည့္ objects မ်ားကို ေရြးခ်ယ္ေပးျခင္း။

Select arcs to join to source or [cLose] - အကယ္၍ ပင္မ object Arc object ျဖစ္ေသာအခါ ဤ option ကုိေတြ႕ရ

ပါမည္။ Arc ကုိ close မွာလား (သို႕မဟုတ္) စက္၀ိုင္းအျဖစ္ေျပာင္းမည္လား ဆုိသည္ကုိ ေရြးခ်ယ္ေပးရျခင္း။

Select elliptical arcs to join to source or [cLose] - အကယ္၍ ပင္မ elliptical arc object ျဖစ္ေသာအခါ ဤ option

ကုိေတြ႕ရပါမည္။ Elliptical arc object ကုိ close မည္လားဆိုသည္ကုိ ေရြးခ်ယ္ေပးရျခင္း။

Join Command Example

Gap ျဖင့္ line (2) ေၾကာင္းကုိ Single line ျဖင့္ Join ထားျခင္း။

Concentric arcs (2) ခုကို single arc ျဖင့္ Join ထားျခင္း။

Concentric ellipse objects (2) ကုိ single ellipse ျဖင့္ Join ထားျခင္း။

တစ္ေၾကာင္းတည္း ျဖစ္ေနေသာ Line ကုိ Polyline ျဖင့္ Join ထားျခင္း။

Procedure: Joining Lines with the Join Command

Join command ကုိအသုံးျပဳျပီး၊ Lines မ်ား Join ပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါသည္။

၁) Modify panel မွ Join ကို click လုိက္ပါ။

၂) ပင္မ Object အျဖစ္ ထားမည့္ line ကို select လိုက္ပါ။
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၃) ပင္မ Line object သုိ႕ Join မည့္ lines မ်ားကို select လိုက္ပါ။

၄) Lines မ်ားကုိ selected ျပီးသြားပါက ေအာက္ပါပုံအတုိင္း ရရိွသြားမည္ ျဖစ္သည္။

Procedure: Converting an Arc to a Circle with the Join Command

Join command ကုိအသုံးျပဳျပီး Arc မွ Circle သို႕ေျပာင္းလဲပုံကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Modify panel မွ Join ကို click လုိက္ပါ။

၂) Arc ကုိ select ပါ။

၃) Right – click ႏိွပ္ျပီး၊ shortcut menu မွ close ကုိ click ပါ။ ထုိအခါ Arc သည္ Circle သို႕ေျပာင္းသြားမည္ ျဖစ္သည္။

Practice Exercise: Joining Objects

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Circle န႕ဲ Line ကုိေရးဆြဲလုိက္ျပီး၊ ထုိ Objects နွစ္ခုလုံးအေပၚတြင္ Rectangle ကုိထပ္ျပီး၊

ေရးဆြေဲပးလိုက္ပါ။ ျပီးေနာက္ ထုိ Object မ်ားကုိ Trim လုပ္ျပီး၊ Rectangle ကုိ Erase လုပ္လိုက္ပါ။ ထို႕ေနာက္ Join

commandကို အသံုးျပဳျပီး Circle ႏွင့္ Line ကုိ ခ်ိတ္ဆက္ေပးလုိက္ပါ။ လုိက္ပါေလ့က်င့္ ၾကည့္ရ ေအာင္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

424

၁) အထက္တြင္ ေဖာ္ျပေပးထားသည့္ ပုံအတိုင္း Circle, Line ႏွင့္ Rectangle ကိုေရးဆြဲလိုက္ပါ။

၂) Circle ႏွင့္ Rectangle ကုိ Trim လုပ္ရန္ -

 Trim command ကို စတင္လုိက္ပါ။

 cutting edge အျဖစ္ Rectangle ကုိ select လုိက္ျပီး၊ Enter ႏိွပ္လိုက္ပါ။

 Rectangle အတြင္းမွ ျဖတ္ေတာက္ပစ္မည့္ Circle ႏွင့္ Line အပိုင္းမ်ားကို trim လုပ္ရန္ select လုိက္ပါ။

၃) Rectangle ကုိ Erase လုပ္လိုက္ပါ။

၄) Line အပိုင္းေလးမ်ားကုိ Join ရန္ -

 Join command ကုိစတင္လုိက္ပါ။

 ပင္မ object အျဖစ္ သတ္မွတ္ေပးမည့္ Object (1) ကို select လိုက္ပါ။

 ပင္မ object သို႕ Join မည့္ Object (2) ကုိ select လိုက္ပါ။
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 Join command ကုိ ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

၅) Arc အပိုင္းႏွစ္ပိုင္းကို Join command ျဖင့္ close ေပးရန္ -

 Join command ကုိစတင္လုိက္ပါ။

 Arc (1) ကို select ျပီးပါက Arc (2) ကို select လိုက္ပါ။

 Arc ႏွစ္ခုကုိ Join ေပးရန္ Enter ႏိွပ္လိုက္ပါ။

 Join command ကုိျပန္ေခၚလုိက္ပါ။

 ျပီးလွ်င္ Arc ကုိ select လုိက္ပါ။

 Selected ထားေသာ Object ေပၚတြင္ Right – click ႏွိပ္ျပီး၊ Close ကုိ click လိုက္ပါ။
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 Command line မွ ေခၚယူအသံုးျပဳခ်င္ပါက L ဟုရိုက္ထည့္ေပးျပီး၊ Close ကုိ ေခၚယူႏိုင္ပါသည္။

 Arc ဟာ closed သြားျပီး Circle ျဖစ္သြားသည္ကုိ ေတြ႕ရမည္။

၆) Arc အပိုင္းႏွစ္ပိုင္းကို Join command ျဖင့္ close ေပးရန္ (နည္းလမ္း - ၂) –

 Join command ကုိစတင္လုိက္ပါ။

 Arc တစ္ခုကို select လုိက္ပါ။

 Selected ထားေသာ Object ေပၚတြင္ Right – click ႏွိပ္ျပီး၊ Close ကုိ click လိုက္ပါ။

 Arc ဟာ closed သြားျပီ ျဖစ္ေသာ္လည္း၊ က်န္ရိွေနေသးေသာ Arc အပိုင္းမ်ားကို Erase လုပ္ေပးရမည္။

 Erase command ကိုေခၚလိုက္ပါ။
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 Shift + Spacebar key ကုိဖိထားျပီး၊ Circle area ထမွဲ က်န္ေနေေသာ Arc အပိုင္းမ်ားကုိ select လုိက္ပါ။ Arc

အပိုင္းမ်ား အစြန္းထြက္ မက်န္တ႕ဲ အထိ select ပါ။

 Arc ကုိ Erase ရန္ Enter ႏိွပ္ပါ။

Exercise: Join Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Arc န႕ဲ Line မ်ား Join ေပးျခင္းကုိ ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

The completed exercise
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၁) M_Join-Objects.dwg ကို ဖြင့္လိုက္ပါ။

၂) အခန္း၏ ညာဖက္တြင္ ရိွေသာ တံခါးကို ဘယ္ဖက္သို႕ Mirror လုပ္ေပးပါ။ Object snap ၏ Midpoint mode ျဖင့္

အခန္း၏ Midpoint ကို basepoint ထားျပီး၊ erase source object option ျဖင့္ Mirror လုပ္လိုက္ပါ။

၃) ဘယ္ဖက္နံရံမွ Line ျဖင့္ တံခါးကို ပိတ္ပစ္ရန္ ညာဖက္ နံရံသုိ႕ Join ပါ။

 Modify panel မွ Join ကို click လုိက္ပါ။

 Source subject ကုိ select ေပးရန္ Prompted လာလွ်င္၊ ဘယ္ဖက္နံရံမွ Line (1)ကုိ select လုိက္ပါ။

 Joine လာမည့္ Object ကုိ select ေပးရန္ Prompted လာလွ်င္၊ ညာဖက္မွ မ်ဥ္းတို (2) ကုိ select ေပးလိုက္ပါ။

 Enter ႏိွပ္လုိက္ပါ။

၄) နံရံအျပင္ဖက္မွ Line ႏွစ္ေၾကာင္းကုိ Join ေပးရန္ အထက္တြင္ အသံုးျပဳခ႕ဲေသာ နည္းလမ္းျဖင့္ Join ေပးလိုက္ပါ။

Joined ေပးျပီးေသာအခါ ေအာက္တြင္ေဖာ္ျပထားေသာ ပုံအတိုင္း ရရိွလာမည္ ျဖစ္သည္။

၅) တံခါးနားမွ နံရံအစိတ္အပိုင္း တစ္ခ်ိဳ႕ကုိ Trim လုပ္ေပးလိုက္ပါ။ လုပ္ျပီးလွ်င္ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း ရရိွ

လာမည္ျဖစ္သည္။
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၆) Office အတြင္းမွ အစည္းအေ၀း စားပြဲကုိ modify လုပ္ရန္ Rectangle ကုိ remove လုပ္ပါမည္။

 အစည္းအေ၀း စားပြဲကုိ Zoom ခ်႕ဲလိုက္ပါ။

 ေအာက္ပါပုံတြင္ ျမွားျဖင့္ညႊန္ျပေပးထားေသာ Lines (၃)ေၾကာင္းကုိ delete လုပ္ေပးလိုက္ပါ။

၇) အစည္းေ၀း စားပြဲကုိ Circle ျဖစ္သြားေအာင္ Join ေပးလိုက္ပါ။

 Join command ကုိစတင္လုိက္ပါ။

 Source subject ကုိ select ေပးရန္ Prompted လာလွ်င္၊ စက္၀ိုင္းျပတ္ ျဖစ္ေနေသာ စားပြကိုဲ select ေပးလိုက္ပါ။

 Selected ထားေသာ Object ေပၚတြင္ Right – click ႏွိပ္ျပီး၊ Close ကုိ click လိုက္ပါ။

၈) Files အားလံုးကို မ Save ပဲပိတ္လုိက္ပါ။

Lesson: Breaking an Object into Two Objects

ဤသင္ခန္းစာတြင္ drawing အတြင္းမွ Object တစ္ခုကုိ Break command အသုံးျပဳျပီး၊ အပိုင္းပိုင္း ခြဲေပးျခင္း

သင္ခန္းစာကို ေလ့လာသြားရမည္ ျဖစ္သည္။ ထိုသုိ႕ အပိုင္းလုိက္ ခြဲေပးလိုက္ေသာ္လည္း၊ ထိုအပိုင္းကြသဲြားေသာ Objects

မ်ား၏ Properties မွာ နဂိုမူလအတိုင္း ဆင္တူ အျဖစ္သာ ရိွေနမည္ ျဖစ္သည္။

Break command ျဖင့္ Object ကုိ အပိုင္းအေရအတြက္ အကန္႕အသတ္မရိွပိုင္းျဖတ္ႏိုင္ျပီး၊ Trim command က႕ဲသုိ႕

cutting edge မလုိအပ္ေပ။ ေအာက္တြင္ေဖာ္ျပေပးထားေသာ drawing ႏွစ္ခုကို ေလ့လာၾကည့္ပါ။ Drawing နွစ္ခုကို

break command ျဖင့္အသုံးျပဳျပီး၊ ႏွစ္ပိုင္းခြဲလိုက္ျပီးေသာအခါ၊ ခြထုဲတ္လိုက္ေသာ အပိုင္း (2)၏ Properties

ကုိျပင္ဆင္ထားျခင္း ျဖစ္ပါသည္။
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Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးေျမာက္သြားပါက -

 Objects မ်ားကို Break command အသုံးျပဳျပီး အပိုင္းလိုက္ ခြဲထုတ္တတ္ေစရန္။

Breaking Objects

Break command ျဖင့္ Single object ကို မိမိတုိ႕ လုိအပ္သေလာက္ ပိုင္းျဖတ္ႏိုင္ပါသည္။ Objects မ်ားကို Break

လုပ္ေတာ႕မည္ ဆုိလွ်င္ break လုပ္မည့္ Object ကုိ select လိုက္ပါ။ ျပီးလွ်င္ မိမိတုိ႕ break လုပ္ခ်င္ေနေသာ ေနရာ (

Point) ကို select လိုက္ပါ။

Modify panel တြင္ Break command ႏွစ္မ်ိဳးရိွပါသည္။ Break ႏွင့္ Break a point ဟူ၍ျဖစ္ပါသည္။ Break သည္ မိမိတုိ႕

Break လုပ္မည့္ Object ကို select ျပီး၊ အမွတ္တစ္မွတ္ကုိ select လိုက္ပါ။ ထို selected ထားေသာ ေနရာမွ စတင္ျပီး

Object သည္ ႏွစ္ပိုင္းျပတ္သြားမည္ ျဖစ္သည္။ Break a point ကမူ မိမိတို႕ break လုပ္မည့္ object တြင္ အမွတ္ ႏွစ္မွတ္

သတ္မွတ္ေပးရပါသည္။ ထိုသတ္မွတ္ ေပးလိုက္ေသာ အမွတ္ႏွစ္ၾကားက Object သည္ ျပတ္ေတာက္သြားမည္ ျဖစ္သည္။

ေအာက္တြင္ေဖာ္ျပေပးထားေသာ ပုံကုိေလ့လာၾကည့္ပါ။ Break a point ကိုအသံုးျပဳျပီး ျမွားျပထားေသာ အမွတ္နွစ္မွတ္ကို

selectျပီး ထိုၾကားထဲက မ်ဥ္းကို ျဖတ္ေတာက္ထားျခင္း ျဖစ္ပါသည္။
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Command Access

Break

Command Line: BREAK, BR

Ribbon: Home tab > Modify panel > Break

Menu Bar: Modify > Break

Command Access

Break a point

Command Line: BREAK, BR
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Ribbon: Home tab > Modify panel > Break at Point

Menu Bar: Modify > Break

Command Options

Break point command တြင္ ေအာက္ပါ Option မ်ားရိွပါသည္။

First Point – Break လုပ္ရန္ First point သတ္မွတ္ေပးရသည္။

Second Point – Break လုပ္ရန္ Second point သတ္မွတ္ေပးရပါသည္။ First point နွင့္ Second point ၾကားမွ Object

သည break ျဖစ္သြားမည္ ျဖစ္သည္။

Procedure: Breaking Objects Using the Break Command

Break command ကိုအသံုးျပဳျပီး၊ Object မ်ား break လုပ္ျခင္းကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါ သည္။

၁) Ribbon: Home tab > Modify panel > Break.

၂) Break လုပ္မည့္ Object ကုိ select ပါ။ အကယ္၍ First point ကုိ သတ္မွတ္ေပးျခင္း မရိွပါက၊ မိမိတုိ႕ select

လိုက္ေသာ ေနရာသည္ First point ျဖစ္သြားမည္။

၃) Drawing အတြင္း တစ္ေနရာရာကို Right – click ႏိွပ္ပါ။ ျပီးလွ်င္ First point ကို select လိုက္ပါ။

၄) Break လုပ္ရန္ First point သတ္မွတ္လုိက္ပါ။
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၅) Break လုပ္ရန္ Second point သတ္မွတ္လိုက္ပါ။

 First point နဲ႕ Second point သတ္မွတ္ေပးျပီးပါက Object သည္ break ျဖစ္သြားပါလိမ္႕မည္။

Procedure: Breaking Objects Using the Break at Point Command

Break command ကိုအသံုးျပဳျပီး၊ Object မ်ား break လုပ္ျခင္းကို ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပး ထားပါ သည္။

၁) Ribbon: Home tab > Modify panel > Break at point.

၂) Break လုပ္မည့္ Object ကုိ select ပါ။

၃) First point ကို select လိုက္ပါ။
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၄) First point သတ္မွတ္ခ႕ဲေသာ ေနရာသည္ Second point အတြက္ပါ အလိုအေလ်ာက္ သတ္မွတ္ျပီးသား ျဖစ္သြားျပီ

ျဖစ္ေသာေၾကာင့္ Object သည္ Break ျဖစ္သြားမည္ ကိုေတြ႕ရမည္။

မွတ္ခ်က္။ ။ Break ျဖစ္မျဖစ္ သိသာေစရန္ Object ကုိ select လိုက္ပါက grips သည္ break ျဖစ္သြားျပီ ျဖစ္ေၾကာင္းကို

ျပသပါလိမ္႕မည္။

Practice Exercise: Breaking Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Offset ျဖင့္ series lines မ်ားေရးဆြဲထားေသာ Object မ်ား၏ Intersections point

ေနရာမ်ား၌ break လုပ္ျခင္း ေလ့က်င့္ခန္းကုိ လက္ေတြ႕ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

၁) အထက္တြင္ ျပထားေသာ ပုံအတိုင္း Lines မ်ားကိုေရးဆြဲလုိက္ပါ။

၂) Break လုပ္ရန္ -

 Intersections point မ်ားတြင္ break မည္ျဖစ္ေသာေၾကာင့္ Object snap ကုိပိတ္လိုက္ပါ။

 Break command ကိုစတင္လိုက္ပါ။

 Line တြင္ (1) ေနရာကုိ select လုိက္ပါ။

 Second break point (2) ကုိ select လုိက္ပါ။
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 Break command ကိုျပန္ေခၚလုိက္ပါ။

 Vertical line ေပၚျဖတ္ေနေသာ Lines မ်ားအားလံုးကို ေအာက္တြင္ေဖာ္ျပ ေပးထားသည့္ အတိုင္း break

လုပ္လုိက္ပါ။

၃) Object ကုိ select point ျဖင့္ break လုပ္ရန္ -

 Osanp (Object snap) ကုိဖြင့္လိုက္ပါ။

 Break at a point command ကိုစတင္လိုက္ပါ။
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 ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတုိင္း line ကို select လိုက္ပါ။

 Line (2) ေၾကာင္းလုံး၏ Intersections မ်ားကုိ select လိုက္ပါ။

 Line ၏ Intersections ေနရာမ်ားတြင္ break ျဖစ္သြားမည္ကို ေတြ႕ရမည္။
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Exercise: Break Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Object ၏ hidden part မ်ား၏ Layre ကို မတူညီေသာ နည္းလမ္း နွစ္မ်ိဳးျဖင့္

ေျပာင္းလဲေပး ရမည္ျဖစ္ျပီး၊ Break နဲ႕ Brak at a point command ကုိအသုံးျပဳကာ objects မ်ားကို break ေပးရမည္

ျဖစ္သည္။ ေလ့က်င့္ခန္းကုိ လိုက္ပါေလ့က်င့္မွဳ႕ ျပီးစီးသြားပါက Break န႕ဲ Brak at a point command တုိ႕အၾကား

ကြာျခားမွဳ႕ကုိ သိရိွနားလည္လာမည္ ျဖစ္သည္။

The completed exercise

၁)C_Break-Object.dwg ကုိဖြင့္လိုက္ပါ။

၂) ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း Zoom ခ်ဲ႕လိုက္ပါ။

၃) Line ၏အစိတ္အပိုင္း တစ္ခုကုိ Remove လုပ္ရန္ -
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 Break command ကိုစတင္လိုက္ပါ။

 ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း Object ကို select လိုက္ပါ။

 Right – click ႏိွပ္ျပီး First point ကုိ select လိုက္ပါ။

၄) First break point (1) န႕ဲ Second break point (2) ကုိ select ေပးလုိက္ပါ။

၅) Object တစ္ခုလံုး ျမင္ႏိုင္ေအာင္ Zoom ခ်ဲ႕ လုိက္ပါ။ ျပီးလွ်င္ ေအာက္ေဖာ္ျပပါ ပုံတြင္ select ထားသည့္ အတုိင္း select

လိုက္ပါ။

၆) Line ၏ မည္သည့္ အစိတ္အပိုင္း ကုိမွ Remove မလုပ္ပဲ Break at a point ျဖင့္ break လုပ္ရန္ -

 Break at a point command ကို စတင္လို္က္ပါ။
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 ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတုိင္း Object ကုိ selectလုိက္ပါ။

၇) Break point အတြက္ Point (1) ကုိ သတ္မွတ္ေပးလိုက္ပါ။

၈) မည္သည့္ အစိတ္အပိုင္း ကိုမွ Remove မလုပ္ပဲ Break at a point ျဖင့္ break လုပ္ရန္-

 Break at a point command ကို စတင္လို္က္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတုိင္း Object (1) ကုိ selectလိုက္ပါ။

 Point (2) အတြက္ Intersections Pointကို select ေပးပါ။

၉) Break point ၾကားမွ Line ကုိ select ၾကည့္ပါ။ Hightlight ျဖစ္သြားသည္ကို ေတြ႕ရမည္။
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၁၀) ထို Object ကို Hidden2 layer သုိ႕ Move ရန္ -

 Layers panel မွ Layer List ကုိ click ပါ။

 Selected ထားေသာ Object ကို Hidden2 layer သုိ႕ Move ရန္ Hidden2 layer ကုိ click လိုက္ပါ။

၁၁) Esc key ကို နိွပ္လိုက္ပါက drawing သည္ ေအာက္ေဖာ္ျပပါပုံအတိုင္း ျဖစ္သြားမည္။

၁၂) Files အားလုံးကို မ Save ပဲ ပိတ္လုိက္ပါ။
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Lesson: Applying a Radius Corner to Two Objects

ဤသင္ခန္းစာတြင္ Fillet command အသံုးျပဳျပီး၊ Objects မ်ား Fillet လုပ္ပုံကုိ ရွင္းလင္းတင္ျပ သြားမည္ ျဖစ္သည္။ Fillet

command ကိုမ်ားေသာ အားျဖင့္ mechanical drawings မ်ားတြင္ အသုံးမ်ားသည္။ သုိ႕ေသာ္ Desings အားလုံးတြင္ Fillet

ကုိ Objects မ်ား တစ္ခုႏွင့္ တစ္ခု ခ်ိတ္ဆက္ သည့္ေနရာမ်ား၌ Radius မ်ားဖန္တီး ရာတြင္ အသုံးျပဳႏိုင္ပါသည္။

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက Fillet command ကုိ ကြဲကြဲျပားျပား သိရိွနားလည္ လာမွာ ျဖစ္ျပီး၊ Objects

မ်ား တစ္ခုႏွင့္ တစ္ခု ခ်ိတ္ဆက္ သည့္ေနရာမ်ား၌ Radius မ်ားဖန္တီး တတ္လာမည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Fillet command ျဖင့္ Objects မ်ား တစ္ခုႏွင့္ တစ္ခု ခ်ိတ္ဆက္ သည့္ေနရာမ်ား၌ Radius မ်ားဖန္တီး တတ္လာ

ေစရန္။

Creating Fillets

Fillet command ကုိအသံုးျပဳျပီး၊ Objects နွစ္ခုကုိ ေခ်ာေမြ႕ေျပျပစ္ေသာ Arc ျဖင့္ radius မ်ားသတ္မွတ္ေပး ႏိုင္ပါသည္။

ပုံမွန္အားျဖင့္ Objects ႏွစ္ခုဆံုေသာ ေထာင့္ (သုိ႕မဟုတ္) Objects မ်ား၏ Intersections အပိုင္းကုိ အနားသတ္

လုံုးေပးေသာ ေနရာတြင္ အသံုးျပဳၾကပါသည္။ ထုိ အနားသတ္ေပးေသာ ေထာင့္၏ အတြင္းပိုင္းကုိ Fillet ဟုေခၚျပီး၊

အျပင္ဖက္ပိုင္းကို a round ဟုေခၚပါသည္။ Fillet ကို lines, arcs, circles, ellipses, polylines, xlines, splines န႕ဲ rays

စသည့္ Objects မ်ားတြင္ အသံုးျပဳႏိုင္ပါသည္။

Objects မ်ား၏ ေထာင့္ကုိ Fillet command ျဖင့္ radius 0 ဒီဂရီ သတ္မွတ္၍လည္း ေရးဆြဲႏိုင္ပါသည္။
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Original objects Fillet radius nonzero Fillet radius zero

Command Access

Fillet

Command Line: FILLET, F

Ribbon: Home tab > Modify panel > Fillet

Menu Bar: Modify > Fillet

Command Options

Fillet command တြင္ ေရြးခ်ယ္အသံုးျပဳ ႏိုင္ေသာ Options မ်ားကုိ ေအာက္တြင္ ေဖာ္ျပေပးလုိက္ပါသည္။

Undo - Fillet command အသံုးမျပဳခင္က အေျခအေနကုိ ျပန္လည္ ေခၚယူရန္။

Polyline - Polyline ၏ေထာင့္အားလုံးကို လက္ရိွ radius တန္ဖိုးျဖင့္ Fillet လုပ္ရန္။

Radius – Fillet arc အတြက္ radius သတ္မွတ္ေပးရန္။

Trim/No Trim – Trim mode ကုိ select ျပီး fillet လုပ္လိုက္လွ်င္ Object ၏ ေထာင့္ခၽြန္းကိုပါ ျဖတ္ေတာက္ျပီး၊

အနားသတ္ေပးသြားမည္ ျဖစ္သည္။ No Trim mode ကို select ျပီး fillet လုပ္မည္ ဆုိပါက Object ၏ ေထာင့္ခၽြန္း

ကုိအနားသတ္ေပး လုိက္ေသာ္လည္း၊ မူရင္းေထာင့္ခၽြန္းကမူ က်န္ရွိေနေသးမည္ ျဖစ္သည္။
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Multiple - Multiple mode ကုိ select ျပီး fillet လုပ္မည္ ဆုိပါက၊ object တစ္ခုကုိ fillet လုပ္ျပီး fillet command

ကျပီးသြားေပမည္။ ထုိ႕ေၾကာင့္ မိမိတုိ႕ ထပ္မံ fillet လုပ္ခ်င္ေသာ object ကို ဆက္တုိက္ select ျပီး fillet လုပ္သြား

ႏိုင္ပါသည္။

Procedure: Applying a Radius Corner with the Fillet Command

Fillet command တြင္ radius သတ္မွတ္ေပးပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထားပါသည္။

၁) Fillet command ကိုစတင္လိုက္ပါ။

၂) Command line ေပၚမွ Fillet command setting ကို စစ္ေဆးၾကည့္ပါ။ Command: FILLETCurrent settings: Mode

= TRIM, Radius = 1.0000Select first object or [Undo/Polyline/Radius/Trim/Multiple]:

 Options ကုိမူ မိမိတို႕ စိတ္ၾကိဳက္ ေရြးခ်ယ္ႏိုင္ပါသည္။

၃) Fillet လုပ္ရန္ First object ကုိ select ပါ။

၄) Fillet လုပ္မည့္ Second object ကုိ select ပါ။ Fillet ဖန္တီးျပီးသည္ကုိ ေတြ႕ရမည္။

မွတ္ခ်က္။ ။ Selected ထားေသာ Option က Polyline ဆိုပါက ေနာက္ဆုံးဆင့္ကို မလုိအပ္ေပ။ Polyline တြင္ fillet

command ေခၚျပီး Object ကိုတစ္ၾကိမ္ select ယုံျဖင့္ filleted ျဖစ္သြားမည္ ျဖစ္သည္။

Guidelines

Selected ထားေသာObjects မ်ားကို fillet လုပ္ရာတြင္ မိမိတုိ႕ select တဲ႕ အေျခအေနေပၚ မူတည္ျပီး results မ်ား

ရရိွလာမည္ ျဖစ္ပါသည္။ ေနရာ ကန္႕သတ္ခ်က္မရိွေပ။
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Original objects Possible results Possible results

Fillet ကို parallel lines, xlines, circles , ellipses န႕ဲ rays တုိ႕တြင္ အသံုးျပဳႏိုင္ပါသည္။

Polygon မ်ားတြင္လည္း Fillet ကုိသုံးျပဳႏိုင္ပါသည္။

Practice Exercise: Creating Fillets

Rectangle တြင္ Fillet command ျဖင့္ Fillet လုပ္ျခင္းကုိ ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။

၁) Rectangle ကုိ select ပါ။

၂) ေထာင့္တစ္ေထာင့္ျခင္းကို Fillet လုပ္ရန္ -

 Fillet command ကိုစတင္ပါ။

 R ဟုရိုက္ထည့္ျပီး၊ Enterႏိွပ္ပါ။

 Fillet radius အတြက္ .25 ဟုရိုက္ထည့္ေပးျပီး၊ Enter ႏိွပ္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထား သည့္တုိင္း Rectangle ၏ ေထာင့္ကုိ selectပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

445

၃) Radius ကုိေျပာင္းျပီး၊ Fillet အတြက္ Polyline option ကုိ select ရန္ -

 Fillet commandကုိ စတင္လိုက္ပါ။

 R ဟုရိုက္ထည့္ျပီး၊ Enterႏိွပ္ပါ။

 Fillet radius အတြက္ .5 ဟုရိုက္ထည့္ေပးျပီး၊ Enter ႏိွပ္ပါ။

 P ဟုရိုက္ထည့္ျပီး၊ Enterႏိွပ္ပါ။

 Rectangle ကို select လိုက္ပါ။

၄) Fillet radius ကုိ 0 ဒီဂရီထားျပီး၊ နဂိုမူရင္း ပုံသုိ႕ ျပန္လည္ေျပာင္းလဲေပးရန္ -

 Fillet command ကိုစတင္လိုက္ပါ။

 R ဟုရိုက္ထည့္ျပီး၊ Enterႏိွပ္ပါ။

 Fillet radius အတြက္ 0 ဟုရိုက္ထည့္ေပးျပီး၊ Enter ႏိွပ္ပါ။

 P ဟုရိုက္ထည့္ျပီး၊ Enterႏိွပ္ပါ။

 Rectangle ကို select လိုက္ပါ။

Exercise: Create a Filleted Corner
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Drawing အတြင္းမွ Objects မ်ားကုိ Fillet လုပ္ျခင္းကုိ လက္ေတြ႕ေလ့က်င့္သြား ရမည္ျဖစ္သည္။ မိမိတုိ႕ အလုိရိွ

ေသာပုံရေအာင္ Fillet option အမ်ိဳးမ်ိဳးကို အသံုးျပဳသြားရမည္ ျဖစ္သည္။ ဤလက္ေတြ႕ ေလ့က်င့္ခန္းကုိ လိုက္ပါ

ေလ့က်င့္ျပီးသြားပါက အျခားေသာ drawing မွ objects မ်ားကို Fillet လုပ္တတ္သြားမည္ ျဖစ္သည္။

The completed exercise

၁) M_Create-Fillets.dwg ကုိဖြင့္ပါ။

၂) Drawing ၏ဘယ္ဖက္ ေအာက္ေျခတြင္ ရိွေသာ Object ကို Zoom ခ်ဲ႕လိုက္ပါ။

၃) Parallel lines ၏အဆံုးကုိ Fillet command ျဖင့္ Cap အခုံးေလး ဖန္တီးရန္ -

 Fillet command ကိုစတင္လိုက္ပါ။

 Drawing ၏တစ္ေနရာရာကုိ Right – click ႏိွပ္ျပီး၊ Multiple ကုိ select ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံအတိုင္း select လိုက္ပါ။
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၄) Fillet လုပ္ျခင္း ျပီးေျမာက္ရန္ -

 အထက္တြင္ လုပ္ခ႕ဲေသာ Line ၏ဆန္႕က်င္ဘက္တြင္ ရိွေသာ Line ကုိ select လိုက္ပါ။

 Fillet command ကိုျပီးဆံုးသြားေစရန္ Enterႏိွပ္လုိက္ပါ။

၅) Pan (သုိ႕မဟုတ္) Zoom ကုိအသုံးျပဳျပီး drawing ၏ ဘယ္ဖက္ထိပ္ကုိ ခ်ဲ႕လုိက္ပါ။

၆) Screw bosses န႕ဲ Part profile အၾကားတြင္ blend ဖန္တီးရန္ -

 Fillet command ကိုစတင္လိုက္ပါ။

 Drawing ၏တစ္ေနရာရာကုိ Right – click ႏိွပ္ျပီး၊ Multiple ကုိ select ပါ။

 Drawing ၏တစ္ေနရာရာကုိ Right – click ႏိွပ္ျပီး၊ Trimကို select ပါ။ ျပီးလွ်င္ No Trim ကို selet လိုက္ပါ။

 Drawing ၏တစ္ေနရာရာကုိ Right – click ႏိွပ္ျပီး၊ Radius ကုိ select ပါ။

 2 ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 ေရျပင္ညီမ်ဥ္းကုိ select ျပီး၊ Circle အၾကီးကုိ select လုိက္ပါ။
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၇) Circle ၏ ဆန္႕က်င္ဘက္ အပိုင္းကုိ ထပ္မံ select လုိက္ပါ။ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း Fillet လုပ္သြားမည္ ျဖစ္သည္။

၈) Boss ဖန္တီးျခင္း ျပီးဆုံးေစရန္ -

 ေအာက္ေဖာ္ျပပါ ပုံတြင္ ျပထားသည့္ အတိုင္း drawing အတြင္းမွ အျခားေသာ bossed areas မ်ားကုိ select

လိုက္ပါ။

 Fillet command ကိုျပီးဆံုးသြားေစရန္ Enterႏိွပ္လုိက္ပါ။
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၉) Drawing တစ္ခုလံုးကုိ Zoom ခ်ဲ႕လုိက္ပါ။

၁၀) radius setting ကုိခဏေမ႕ထားျပီး၊ Fillet command ျဖင့္ေထာင့္ခ်ိဳးမ်ား ဖန္တီးရန္ -

 Fillet command ကိုစတင္လိုက္ပါ။

 Command line တြင္ radius အတြက္ Prompted ေပးမည့္ 2.0000 ကုိပင္ဆက္လက္ အသုံးျပဳ သြားမည္

ျဖစ္သည္။

 ေရျပင္ညီမ်ဥ္းကုိ select လိုက္ပါ။

 Shift key ႏိွပ္ထားျပီး၊ ေဒါင္လိုက္မ်ဥ္းကုိ select ကာ radius 0 ျဖင့္ Fillet လုပ္လိုက္ပါ။

၁၂) ညာဖက္ျမင္ကြင္းမွ ပုံကုိလည္း ဆက္လက္ လုပ္သြားရန္ -

 Enter ႏိွပ္ျပီး Fillet command ကုိျပန္ေခၚလိုက္ပါ။

 ျမွားျဖင့္ညႊန္ျပေပးထားေသာ ထိပ္မွ ေရျပင္ညီမ်ဥ္းကုိ select လုိက္ပါ။

 ညာဖက္တြင္ ရိွေသာ ေဒါင္လိုက္မ်ဥ္းကုိပါ select ျပီး၊ radius 0 ျဖင့္ Fillet လုပ္လိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။

“Workgroup AutoCAD & 3ds Max Job Training Center” International Computer Driving Licence Approved Test Center
Rm- 403, Excel Tower, Yangon, Myanmar. Ph: 951 559377 Ext: 6413 or 6403, Email – infor@workgroupweb.com

450

၁၃) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Creating an Angled Corner Between Two Objects

ဤသင္ခန္းစာတြင္ Drawing အတြင္းမွ objects မ်ားကို Chamfer command အသံုးျပဳျပီး၊ Chamer လုပ္ျခင္း

ကုိေလ့လာသြားရမည္ ျဖစ္သည္။ Chamfer command သည္ Fillet command ႏွင့္ သေဘာတရားခ်င္း အားလုံး နီးပါး

တူညီပါသည္။ သုိ႕ေသာ္ Fillet commandသည္ Objects မ်ား၏ အနားသတ္ကို radius ပါရရိွေအာင္ လံုးေပးေသာ္လည္း၊

Chamfer command ကမူ Objects မ်ား၏ အနားသတ္ကုိ ေထာင့္ခ်ဳိးညီ ျဖတ္ေတာက္ ေပးျခင္း ျဖစ္ပါသည္။ Drawing

အတြင္းမွ Objects မ်ားကုိ Angled Intersections ဖန္တီးေသာ အခ်ိန္တြင္၊ အသုံးျပဳမည့္ command အျဖစ္ Chamfer

command ကို ပထမဦးစားေပး ေရြးခ်ယ္အသံုးျပဳ သင့္ပါသည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျခင္း ျပီးစီးသြားပါက -

 Drawing အတြင္းမွ Objects မ်ားကုိ Chamfer command ျဖင့္ Chamfer လုပ္တတ္ေစရန္။
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Creating Chamfers

Chamfer command သည္ obects ႏွစ္ခုဆုံသည့္ ေထာင့္ခ်ိဳးကို အနားသတ္ ျဖတ္ေတာက္ ေပးျခင္းျဖစ္ပါသည္။ Chamfer

command ျဖင့္ lines, polylines, xlines န႕ဲ rays စသည့္ Objects မ်ားဆံုမွတ္ ကုိေထာင့္ခ်ိဳးညီ အနား သတ္ေပးျခင္း

ျပဳလုပ္ႏိုင္ပါသည္။

Command Access

Chamfer

Command Line: CHAMFER, CHA

Ribbon: Home tab > Modify panel > Chamfer

Menu Bar: Modify > Chamfer

Command Options
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Chamfer command ကိုအသံုးျပေနခ်ိန္ ေရြးခ်ယ္ႏိုင္ေသာ Options မ်ားကုိ ေအာက္တြင္ေဖာ္ျပ ေပးထားပါသည္။

Undo - Fillet command အသံုးမျပဳခင္က အေျခအေနကုိ ျပန္လည္ ေခၚယူရန္။

Polyline - Polyline option ကိုအသံုးျပဳျပီး၊ 2D Polyline မ်ားကုိ Chamfer လုပ္ႏိုင္သည္။

Distance – Chamfer လုပ္ရာတြင္ အကြာအေ၀း သတ္မွတ္ေပးရန္။

Angle - Chamfer အကြာအေ၀းကုိ သတ္မွတ္ေပးျပီးပါက၊ ေထာင့္ခ်ိဳး၏ angle သတ္မွတ္ရန္။

Trim/No Trim – Trim mode ကို select ျပီး chamfer လုပ္လိုက္လွ်င္ Object ၏ ေထာင့္ခၽြန္းကုိပါ ျဖတ္ေတာက္ျပီး၊

အနားသတ္ေပးသြားမည္ ျဖစ္သည္။ No Trim mode ကုိ select ျပီး chamfer လုပ္မည္ ဆုိပါက Object ၏ ေထာင့္ခၽြန္း

ကုိအနားသတ္ေပး လုိက္ေသာ္လည္း၊ မူရင္းေထာင့္ခၽြန္းကမူ က်န္ရွိေနေသးမည္ ျဖစ္သည္။

Method – Chamfer လုပ္ရာတြင္ Distance (သို႕မဟုတ္) Angle ျဖင့္ လုပ္ေရး ေရြးခ်ယ္ရန္။

Multiple - Multiple mode ကို select ျပီး chamfer လုပ္မည္ ဆိုပါက၊ object တစ္ခုကုိ chamfer လုပ္ျပီး chamfer

command ကျပီးသြားေပမည္။ ထုိ႕ေၾကာင့္ မိမိတုိ႕ ထပ္မံ chamfer လုပ္ခ်င္ေသာ object ကုိ ဆက္တိုက္ select ျပီး

chamfer လုပ္သြား ႏိုင္ပါသည္။

Using Chamfer Options

Distance method ျဖင့္ chamfer ျပဳလုပ္ျခင္း။

Original objects Chamfer distances nonzero Chamfer distances zero

Angle method ျဖင့္ chamfer ျပဳလုပ္ျခင္း။

Trim န႕ဲ No Trim modes ျဖင့္ chamfer ျပဳလုပ္ျခင္း။
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Polyline option ျဖင့္ Polyline အားလုံးကုိ Chamfer လုပ္ႏိုင္ပါသည္။

Chamfer command ကို အၾကိမ္ၾကိမ္ အသံုးျပဳ ႏိုင္ရန္ Multiple option ကုိ select ျပီး ေရးဆြဲထားျခင္း။

Procedure: Creating Chamfers

Chamfer command ျဖင့္ Drawing အတြင္းမွ Objects မ်ား Chamfer လုပ္ပုံကုိ ေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပ

ေပးထားပါသည္။

၁) Chamfer command ကုိစတင္လိုက္ပါ။

၂) Command line ေပၚမွ Fillet command setting ကုိ စစ္ေဆးၾကည့္ပါ။ Command: _chamfer(NOTRIM mode)

Current chamfer Dist1 = 1.0000, Dist2 = 1.5000Select first line or [Undo/Polyline/

Distance/Angle/Trim/mEthod/Multiple]:

၃) Chamfer လုပ္ရန္ First object ကို select ပါ။

၄) Chamfer လုပ္မည့္ Second object ကို select ပါ။ Fillet ဖန္တီးျပီးသည္ကုိ ေတြ႕ရမည္။

Practice Exercise: Creating Chamfers

ဤလက္တြ႕ ေလ့က်င့္ခန္းတြင္ 8X6 Units ရိွေသာ Rectangle ကုိေရးဆြဲျပီး၊ Chamfer ျပဳလုပ္ျခင္း ေလ့က်င့္ခန္း

ကုိလက္ေတြ႕ ေလ့က်င့္သြားရမည္ ျဖစ္ပါသည္။
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၁) Rectangle ေရးဆြရဲန္ -

 Rectangle ကိုစတင္လိုက္ပါ။

 Drawing window တြင္ Rectangle အတြက္ First point ကုိသတ္မွတ္ ေပးလိုက္ပါ။

 ေနာက္ Corner တစ္ခုအတြက္ @8,6 ဟုရိုက္ထည့္ေပးျပီး Enter ႏိွပ္ပါ။

၂) Corner ကုိ 45 ဒီဂရီ ျဖစ္သြားေအာင္ Chamfer အသံုးျပဳရန္ -

 Chamfer command ကိုစတင္လိုက္ပါ။

 Drawing window တစ္ေနရာရာတြင္ Right – click ႏိွပ္ျပီး၊ Angle ကို click ပါ။

 1 ဟုရိုက္ထည့္ျပီး၊ First line ေပၚက chamfer length အတြက္ Enter ႏိွပ္ပါ။

 45 ဟုရိုက္ထည့္ျပီး၊ First line ေပၚက chamfer angle အတြက္ Enter ႏိွပ္ပါ။

 နီးစပ္အနားတြင္ ရိွေသာ Corner ကို First corner အျဖစ္ select လိုက္ပါ။ (ပုံတြင္ေဖာ္ျပထားသည့္ အတုိင္း)
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 အထက္ပါနည္းအတိုင္း ေထာင့္ (၄) ေထာင့္လံုး chamfered ျဖစ္သြားေအာင္ လုပ္လုိက္ပါ။

 Chamfer command ျပီးေျမာက္ေစရန္ Enter ႏိွပ္လိုက္ပါ။

၃) Polyline Option အသုံးျပဳျပီး Chamfer လုပ္ရန္ -

 8 x 6 rectangle တစ္ခုကို ထပ္မံေရးဆြဲလုိက္ပါ။

 Chamfer command ကိုစတင္လိုက္ပါ။

 လက္ရိွ chamfer length သည္ 1 ျဖစ္ေနျပီး၊ chamfer angle 45 ျဖစ္ေနမည္ကုိ ေတြ႕ရမည္။

 တစ္ေနရာရာကို Right–click ႏိွပ္ျပီး၊ Polyline ကို select လိုက္ပါ။

 Rectangle ကို select လိုက္ပါ။

 ေထာင့္အားလံုး Chamfered ျဖစ္သြားမည္။

၄) အကြာအေ၀း မတူညီေသာ ေနရာတြင္ Distance option ကုိအသံုးျပဳျပီး၊ Chamfer လုပ္ရန္ -
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 8 x 4 rectangle ကိုေရးဆြဲလုိက္ပါ။

 Chamfer command ကိုစတင္လိုက္ပါ။

 တစ္ေနရာရာကို Right–click ႏိွပ္ျပီး၊ Distance ကို select လိုက္ပါ။

 First chamfer distance အတြက္ 1 ရိုက္ထည့္ျပီး၊ Enter ႏိွပ္လုိက္ပါ။

 Second chamfer distance အတြက္ .5 ရိုက္ထည့္ျပီး၊ Enter ႏိွပ္လိုက္ပါ။

 First line (1) ကို select ျပီး၊ second line (2) ကုိ select လိုက္ပါ။

 Chamfer command ကိုျပန္ေခၚလိုက္ပါ။

 Line (3) ကို select ျပီး၊ line (4) ကုိ select လိုက္ပါ။

 သတ္မွတ္လုိက္ေသာ First distance သည္ First line အေပၚ သက္ေရာက္သြားမည္ ျဖစ္ျပီး၊ Second distance

Second line ေပၚတြင္ သက္ေရာက္မည္ ျဖစ္သည္။

 Chamfer command ကုိျပန္ေခၚျပီး၊ ေအာက္တြင္ ေဖာ္ျပထားေသာ အတိုင္း ေထာင့္ေလးေထာင့္လုံးကို chamfer

လုပ္လိုက္ပါ။
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၅) အကြာအေ၀း မတူညီေသာ အေျခအေနတြင္ Distance option ကုိ Polyline Option နဲ႕ ေပါင္းစပ္ျပီး chamfer လုပ္ရန္ -

 8 x 6 rectangle တစ္ခုကို ေရြးဆြဲလုိက္ပါ။

 Chamfer command ကိုစတင္လိုက္ပါ။

 လက္ရိွ chamfer distance (1) သည္ 1 ျဖစ္ျပီး၊ chamfer distance (2) သည္ .5 ျဖစ္ေနေပလိမ္႕မည္။

 တစ္ေနရာရာတြင္ Right – click ႏိွပ္ျပီး Polyline ကုိ select လုိက္ပါ။

 Rectangle ကို select လိုက္ပါ။

 Chamfer သည္ နာရီလက္တံ ေျပာင္းျပန္အတိုင္း အလုပ္လုပ္သြားမည္ ျဖစ္သည္။ ထုိ႕ေၾကာင့္ Chamfer

လုပ္ထားေသာ Polyline တြင္မတူညီေသာ အကြာအေ၀း မ်ိဳးျဖင့္ Result ရရိွလာမည္ကုိ ေတြ႕ရမည္။
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Exercise: Create a Chamfered Corner

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္Objects မ်ားကုိ Multiple, Distance, န႕ဲ Angle options တို႕ကိုအသံုးျပဳျပီး၊ Chamfer မ်ား

ျပဳလုပ္သြားရမည္ ျဖစ္သည္။ လက္ေတြ႕ေလ့က်င့္ျပီးသြားပါက Drawing မ်ားတြင္ Chamfer command ကုိ ပိုင္ႏိုင္စြာ

အသုံးျပဳတတ္လာမည္ ျဖစ္သည္။

The completed exercise

၁) M_Create-Chamfers.dwg ကုိဖြင့္လိုက္ပါ။

၂) ေအာက္ေဖာ္ျပပါပုံအတုိင္း ဘယ္ဖက္ေအာက္ပုံကုိ Zoom ခ်ဲ႕လုိက္ပါ။

၃) 1-unit chamfer ဖန္တီးရန္ -

 Chamfer command ကိုစတင္လိုက္ပါ။

 Drawing window တစ္ေနရာရာတြင္ Right–click ႏိွပ္ျပီး၊ Distance ကုိ click ပါ။

 First chamfer distance အတြက္ Prompted ေသာအခါ 1 ဟုရိုက္ထည့္ျပီး၊ Enter ႏိွပ္ပါ။

 Second chamfer distance အတြက္ Enter ႏိွပ္ပါ။ အဘယ့္ေၾကာင့္ ဆိုေသာ္ First chamfer distance

၏တန္ဖိုးကို default အျဖစ္ အသံုးျပဳမည္ ဆုိေသာ သေဘာမ်ိဳးျဖင့္၊ တန္ဖိုးမသတ္မွတ္ ေပးေတာ႕ပဲ Enter ႏိွပ္ျခင္း

ျဖစ္ပါသည္။

 Drawing window တစ္ေနရာရာတြင္ Right–click ႏိွပ္ျပီး၊ Multiple ကို click ပါ။
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 Chamfer ကိုမျပီးဆုံးေစပဲ အၾကိမ္ၾကိမ္ အသုံးျပဳမည္ဆိုေသာ သေဘာျဖင့္ Multiple ကုိ enable ေပးျခင္းျဖစ္ပါ

သည္။

၄) ေအာက္ပါ ပုံတြင္ ေဖာ္ျပထားသည့္ အတုိင္း Intersections ေနရာမ်ားတြင္ ရိွေသာ Line မ်ားကို select ေပးလုိက္ပါ။

 Chamfer command ကုိ exit မေပးလုိက္ပါႏွင့္။ ေနာက္တစ္ဆင့္ ဆက္လက္ အသုံးျပဳမည္ ျဖစ္ေသာေၾကာင့္

ျဖစ္သည္။

၅) ေအာက္ပါ ပုံတြင္ ေဖာ္ျပထားသည့္ အတိုင္း Intersections ေနရာမ်ားတြင္ ရိွေသာ Line မ်ားကုိ select ေပးလိုက္ပါ။

Enter ႏိွပ္ျပီး Chamfer command ကုိ exit ေပးလုိက္ပါ။

၆) Zoom န႕ဲ Pan ကုိအသံုးျပဳျပီး drawing အတြင္း ဘယ္ဖက္ထိပ္ေထာင့္ကုိ Zoom ခ်႕ဲလိုက္ပါ။

၇) Chamfer ကုိ ေနာက္ 1 – Unit တိုး လုပ္ရန္ -
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 Chamfer command ကိုစတင္လိုက္ပါ။

 Drawing window တစ္ေနရာရာတြင္ Right–click ႏိွပ္ျပီး၊ Multiple ကို click ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ Lines မ်ားကုိ select လုိက္ပါ။

မွတ္ခ်က္။ ။ ေအာက္ေဖာ္ျပပါပုံသည္ Chamfered ျဖစ္ပါသည္။ 1-Unit တုိးျပီး Chamfer လုပ္ျခင္း ျဖစ္ပါသည္။

၈) အထက္ပါပုံ၏ ညာဖက္အျခမ္းကိုလည္း Chamfer လုပ္ေပးလုိက္ပါ။ Enter ႏိွပ္ျပီး Chamfer command ကို

exit ေပးလုိက္ပါ။

၉) Multiple န႕ဲ Angle options အသံုးျပဳျပီး Chamfer လုပ္ရန္ -

 Chamfer command ကို ျပန္လည္ အသံုးျပဳရန္ Enter ႏိွပ္လိုက္ပါ။

 Drawing window တစ္ေနရာရာတြင္ Right–click ႏိွပ္ပါ။

 Angle ကုိ click ပါ။

 First line ေပၚတြင္ Chamfer length အတြက္ 1 ဟုရိုက္ထည့္ေပးပါ။

 First line ေပၚတြင္ Chamfer Angle အတြက္ 60 ဟုရိုက္ထည့္ေပးပါ။

 Drawing window တစ္ေနရာရာတြင္ Right–click ႏိွပ္ပါ။

 Multiple ကို click ပါ။

 ေအာက္ေဖာ္ျပပါပုံမွ edges မ်ားကို select လိုက္ပါ။
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၁၀) ဆန္႕က်င္ဖက္တြင္ ရိွေသာ Edges မ်ားကုိ select လိုက္ပါ။

၁၁) Zoom နဲ႕ Pan ကိုအသံုးျပဳျပီး drawing အတြင္း ဘယ္ဖက္ေအာက္ေထာင့္ကုိ Zoom ခ်ဲ႕လုိက္ပါ။

 ပုံ၏ Edges ႏွစ္ဖက္လံုးသည္ ေအာက္ပါပုံအတုိင္း ျဖစ္မည္။

 Enter ႏိွပ္ျပီး Chamfer command ကုိ exit ေပးလုိက္ပါ။

၁၂) Line command ကုိအသံုးျပဳျပီး၊ ေအာက္တြင္ ျမွားျဖင့္ ေဖာ္ျပေပးထားေသာ ေနရာမ်ား၌ Line ေရးဆြဲေပးလုိက္ပါ။
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၁၃) Drawing area တြင္ပုံတစ္ပုံ လံုးျမင္ႏိုင္ေအာင္ Zoom ခ်ဲ႕လိုက္ပါ။

၁၄) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Lesson: Changing Part of an Object's Shape

ဤသင္ခန္းစာတြင္ Drawing အတြင္းမွ Objects အစိတ္အပိုင္းမ်ားကို Stretch command ျဖင့္ ေျပာင္းေရြ႕ျခင္း

ကုိေလ့လာသြားရမည္ ျဖစ္သည္။ Drawing အတြင္းရိွ objects မ်ားကို မိမိတို႕ စိတ္ၾကိဳက္ လုိအပ္သလို Move command

က႕ဲသုိ႕ ေရြ႕ေျပာင္းေပးႏိုင္သလုိ၊ Shape မ်ားကုိလည္း Modify လုပ္ႏိုင္ပါသည္။

Objectives

ဤသင္ခန္းစာကုိ ေလ့လာျပီးသြားခ်ိန္တြင္ -

 Stretch command ျဖင့္ Objects မ်ားကုိ Stretch လုပ္တတ္သြားေစရန္။
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Stretching Objects

Stretch command ကုိအသံုးျပဳျပီး၊ drawing အတြင္းမွ Objects မ်ားကုိ shape မ်ားေျပာင္းလဲေပးျခင္း၊ ေနရာမ်ား

ျပန္လည္ ျပင္ဆင္သတ္မွတ္ ေပးျခင္းတုိ႕ကုိ crossing window (သို႕မဟုတ္) crossing polygon selection တုိ႕ျဖင့္

အသုံးျပဳသြား ႏိုင္ပါသည္။ Stretch လုပ္မည့္ Object ကုိ select ျပီးသြားပါက၊အရင္ဆံုး base point သတ္မွတ္ေပးရပါမည္။

ထုိသို႕ သတ္မွတ္ေပးျပီးပါက၊ Stretch လုပ္ရန္ Second point ကုိ သတ္မွတ္ေပးရမည္ ျဖစ္ပါသည္။

Command Access

Stretch

Command Line: STRETCH, S

Ribbon: Home tab > Modify panel > Stretch

Menu Bar: Modify > Stretch

Procedure: Stretching Objects Using Grips

Stretch command ကုိ Grips ျဖင့္အသံုးျပဳျပီး Objects မ်ား Stretch လုပ္ပုံကိုေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပ

ေပးထားပါသည္။
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၁) Grips activate ျဖစ္သြားေစရန္ Object ကုိ select လုိက္ပါ။

၂) Grip တစ္ခုခုကုိ select လုိက္ပါ။ ( Shift key ကုိ ႏိွပ္ထားျပီး Multiple grips မ်ား select ႏိုင္ပါသည္။)

၃) Grip ကို click လုိက္ျပီး ေနရာအသစ္သို႕ ေရြ႕လုိက္ပါ။

Procedure: Stretching Objects

Stretch command ကုိ္အသုံးျပဳျပီး Objects မ်ား Stretch လုပ္ပုံကိုေအာက္တြင္ အဆင့္ဆင့္ ေဖာ္ျပေပးထား ပါသည္။

၁) Stretch command ကုိစတင္လုိက္ပါ။

၂) crossing window or crossing polygon selection တုိ႕ျဖင့္ Objects မ်ားကုိ select ျပီး Stretch လုပ္ပါ။

၃) Stretch လုပ္ရန္ basepoint ကုိ select လုပ္ပါ။
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၄) Second point ကိုသတ္မွတ္ေပးပါ။ (သုိ႕မဟုတ္) Stretch လုပ္ရန္အတြက္ အကြာအေ၀း တန္ဖိုးကုိ ရိုက္ထည့္ေပးပါ။

Practice Exercise: Stretching Objects

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ Rectangle တစ္ခ်ိဳ႕ကုိ ေရြးဆြဲျပီး၊ Stretch လုပ္ျခင္းကို လက္ေတြ႕ေလ့က်င့္သြား

ရမည္ျဖစ္ပါသည္။ Stretch command မွ Grip ျဖင့္ select လုပ္ျပီး Stretch လုပ္ျခင္းနည္းလမ္းကုိ အသံုးျပဳသြားမည္

ျဖစ္သည္။ ေအာက္ေဖာ္ျပပါ Rectangle ပုံကုိ ေရးဆြဲလုိက္ပါ။

၁) Rectangle အၾကီးကုိ Stretch လုပ္ရန္ -

 အထက္တြင္ ေဖာ္ျပေပးထားေသာ Rectangle ပုံကို ေရးဆြဲလုိက္ပါ။

 Stretch command ကုိစတင္လုိက္ပါ။

 Crossing window ျဖင့္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း Rectangle ညာဖက္ corner(1) တြင္တစ္ခ်က္၊

ဆန္႕က်င္ဘက္ corner (2) တြင္တစ္ခ်က္ Click ျပီး Rectangle အၾကီးကုိ select ေပးလုိက္ပါ။

 Selection ျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။
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 Object (1) အနီးတြင္ basepoint သတ္မွတ္ေပးလိုက္ပါ။ ေနာက္တစ္မွတ္ကုိ select လုပ္ျခင္း မျပဳေသး ပါႏွင့္။

Cursor ကုိ ပုံတြင္ျပထားသည့္ အတုိင္း ဘယ္ဖက္ (2) သုိ႕ drag ျပီး 2 ဟုရိုက္ထည့္ကာ Enter ႏိွပ္ လိုက္ပါ။

 Drag ကိုေျဖာင့္ေျဖာင့္ ဆြဲႏိုင္ေအာင္ Polar Tracking (သို႕မဟုတ္) Ortho Mode ကုိဖြင့္ထားသင့္ပါသည္။

၂) Rectangles ႏွစ္ခုလံုးကုိ Stretch လုပ္ရန္ -

 Stretch command ကုိစတင္လုိက္ပါ။

 Crossing window ျဖင့္ Rectangles မ်ားကုိ ေအာက္တြင္ေဖာ္ျပေပးသည့္ အတိုင္း First Corner(1) န႕ဲ

ဆန္႕က်င္ဘက္တြင္ Second Corner (2) click ျပီး select ေပးလိုက္ပါ။

 Selection ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္လိုက္ပါ။

 Basepoint ကုိ ေအာက္ပုံတြင္ ျပထားသည့္ အတုိင္း Object အနီးတြင္ပင္ click ျပီး၊ Cursor ကုိဘယ္ဖက္သုိ႕ drag

လိုက္ပါ။
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 2 ဟုရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Drag ကိုေျဖာင့္ေျဖာင့္ ဆြဲႏိုင္ေအာင္ Polar Tracking (သို႕မဟုတ္) Ortho Mode ကုိဖြင့္ထားသင့္ပါသည္။

၃) Rectangle အၾကီးကုိ Stretch ရန္ႏွင့္ Rectangle အေသးကို Stretch command အသံုးျပဳျပီး Move ရန္ -

 Stretch command ကုိစတင္လုိက္ပါ။

 Crossing window ျဖင့္ Rectangles မ်ားကုိ ေအာက္တြင္ေဖာ္ျပေပးသည့္ အတိုင္း First Corner(1) န႕ဲ

ဆန္႕က်င္ဘက္တြင္ Second Corner (2) click ျပီး select ေပးလိုက္ပါ။

 အတြင္းမွ Rectagle အေသးတစ္ခုလုံး Crossing window ျဖင့္ selected မိေအာင္ သတိထားပါ။

 Selection ျပီးဆံုးေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 ေအာက္တြင္ ေဖာ္ျပေပးထားသည့္ အတုိင္း basepoint ကို object အနီးတြင္ပင္ click ေပးလုိက္ပါ။
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 Cursor ကုိဘယ္ဖက္သုိ႕ drag လိုက္ပါ။

 2 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

၄) Grips အသံုးျပဳျပီး Object မ်ားကုိ Stretch လုပ္ရန္ -

 Command line ကုိ Blank အေနအထားျဖင့္၊ Rectangle ကို select ပါ။

 Shift key ကုိ ႏိွပ္ထားျပီး ေအာက္ပါပုံတြင္ ေဖာ္ျပေပးထားသည့္ အတုိင္း End point ႏွစ္ခုကို click ေပးလုိက္ပါ။

 Shift key ကုိလႊတ္လုိက္ျပီး End point တစ္ခုကုိ click လုိက္ပါ။
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 Cursor ကုိဘယ္ဖက္သုိ႕ drag လိုက္ျပီး၊ Line ၏ Midpoint ကို select ေပးလုိက္ပါ။

၅) Object ၏ ေထာင့္ခၽြန္း End point ကုိ Stretch ရန္ -

 Command line ကုိ Blank အေနအထားျဖင့္၊ Rectangle ကို select ပါ။

 ေထာင့္စြန္းမွ End point ကုိ click ပါ။

 ညာဖက္သုိ႕ drag ျပီး click လိုက္ပါ။

 Deselect object ျဖစ္ရန္ Esc key ကုိႏိွပ္ပါ။

Exercise: Stretch Objects

ဤလက္ေတြ႕ေလ့က်င့္ခန္းတြင္ Stretch command ကုိအသံုးျပဳျပီး floor plan တြင္ရွိေသာ room မ်ား၏ area ကို

တုိးခ်ဲ႕သြားရမည္ ျဖစ္သည္။ ဤလက္ေတြ႕ ေလ့က်င့္ခန္းကို ျပီးေျမာက္သြားပါက အျခားေသာ drawing မ်ားတြင္လည္း

Stretch command ကုိလည္း ေကာင္းမြန္စြာ အသုံးျပဳသြားႏိုင္မည္ ျဖစ္သည္။
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The completed exercise

၁) M_Stretch-Objects.dwg ကိုဖြင့္လုိက္ပါ။

၂) Status bar မွ Osnap ကို turn off ေပးလိုက္ပါ။

၃) Structure ၏ ဘယ္ဖက္ေထာင့္ကုိ 2000 Units Add ရန္ -

 Modify panel မွ Stretch ကုိ click ပါ။

 Stretch လုပ္ရန္ အတြက္ crossing window ျဖင့္ point (1) နဲ႕ point (2) ကို select ေပးလိုက္ပါ။

 Enter ႏိွပ္ပါ။
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၄) Stretch ျပဳလုပ္ျခင္း ျပီးေျမာက္သြားရန္ -

 နံရံေအာက္ေျခတြင္ တစ္ခ်က္ Click လိုက္ျပီး၊ Curosor ကိုဘယ္ဖက္သို႕ 180 ဒီဂရီ အတိုင္း drag လုပ္ လိုက္ပါ။

 2000 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Dimensions မ်ားသည္လည္း ပုံနွင့္အတူ ၾကီးလာမည္ကုိ ေတြ႕ရမည္။

၅) Crossing Polygon selection ျဖင့္ Stretch ကုိအသုံးျပဳရန္ -

 Stretch command ကုိျပန္ေခၚရန္ Enter ႏိွပ္ပါ။

 Crossing Polygon selection ကုိ အသံုးျပဳရန္ အတြက္ CP ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Crossing Polygon selection သတ္မွတ္ေပးရန္ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း Click လိုက္ပါ။
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၆) Structure ၏ ညာဖက္ေထာင့္ကို 2000 Units Add ရန္ -

 Crossing Polygon selection ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 Object selection လုပ္ျခင္း ျပီးေျမာက္ေၾကာင္း အတည္ျပဳရန္ Enter ႏိွပ္ပါ။

 နံရံေအာက္ေျခတြင္ တစ္ခ်က္ Click လိုက္ျပီး၊ Point သတ္မွတ္ေပးလုိက္ပါ။

 Curosor ကုိညာဖက္သုိ႕ 0 ဒီဂရီ အတိုင္း drag လုပ္ျပီး 2000 ရိုက္ထည့္ကာ Enter ႏိွပ္ပါ။

၇) Crossing selection ျဖင့္ Stretch ကိုအသံုးျပဳရန္ -

 Drawing area တြင္Right–click ႏိွပ္ျပီး Stretch ကုိ select လုိက္ပါ။
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 Crossing selection အတြက္ C ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 Crossing window သတ္မွတ္ရန္ Point(1) န႕ဲ Point (2) အနီးတြင္ click ျပီး Enter ႏိွပ္လိုက္ပါ။

၈) အတြင္းနံရံကုိ ညာဖက္သို႕ 1500 units ျဖင့္ ေလွ်ာေစာက္ လုပ္ရန္ -

 Floor plan ေအာက္တြင္ Cursor ကုိညာဖက္သို႕ 0 ဒီဂရီ အတိုင္း drag လုပ္ပါ။

 1500 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

၉) တံခါးကို နံရံအတြင္းသုိ႕ ေရြ႕ရန္ -

 Stretch command ကုိစတင္လုိက္ပါ။

 Crossing window သတ္မွတ္ရန္ Point(1) န႕ဲ Point (2) အနီးတြင္ click ျပီး Enter ႏိွပ္လိုက္ပါ။

 Enter ႏိွပ္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၁၀) Move လုပ္ျခင္း ျပီးေျမာက္ေစရန္ -

 တံခါးေပါက္၏ ညာဖက္တြင္ Point တစ္ခု သတ္မွတ္ရန္ click လုိက္ပါ။ ျပီးလွ်င္ ညာဖက္သုိ႕ 0 ဒီဂရီအတိုင္း

Curosr ကုိ drag လုိက္ပါ။

 1000 ရိုက္ထည့္ျပီး Enter နိွပ္ပါ။

 တံခါးေပါက္ ေနရာေရြ႕သြားသည္ကုိ သတိထား ၾကည့္ၾကည့္ပါ။

၁၁) တံခါးမကုိ နံရံအတြင္းသုိ႕ ေနရာျပန္လည္ သတ္မွတ္ေပးရန္ -

 Stretch command ကုိစတင္လုိက္ပါ။

 Crossing window သတ္မွတ္ရန္ Point(1) န႕ဲ Point (2) အနီးတြင္ click ျပီး Enter ႏိွပ္လိုက္ပါ။

 Enter ႏိွပ္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၁၂) ) တံခါးမကုိ ေနရာျပန္လည္ သတ္မွတ္ေပးရန္ -

 တံခါး၏ ညာဖက္တြင္ Point တစ္ခု သတ္မွတ္ရန္ Click လုိက္ပါ။ Cursor ကုိညာဖက္သို႕ 0 ဒီဂရီ အတုိင္း drag

လိုက္ပါ။

 1200 ရိုက္ထည့္ျပီး Enter ႏိွပ္ပါ။

 တံခါးမၾကီး ေနရာေရြ႕သြားသည္ကို သတိထား ၾကည့္ၾကည့္ပါ။

၁၃) Files အားလုံးကို မ Save ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Architectural

ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္၌ေလ့လာျပီး ခ႕ဲေသာ altering objects ဆုိေသာ သင္ခန္းစာမ်ားမွ modify tools

မ်ားျဖင့္ Floor plan modify လုပ္ျခင္းကုိ လက္ေတြ႕ေလ့က်င့္သြားရမည္ ျဖစ္သည္။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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The completed exercise

Metric Units

၁) M_ARCH-Challenge- CHP05.dwg ကုိဖြင့္ပါ။

၂) 189 mm အထူရိွေသာ နံရံကိုယ္စားျပဳ geomentry ကုိအျပင္နံရံ အျဖစ္ ကိုယ္စားျပဳ ေရးဆြဲထားေသာ Original line

ေပၚတြင္ ေရးဆြသဲြားရမည္ ျဖစ္သည္။ ေလွကားပါ၀င္ေနသည့္ ေအာက္ေဖာ္ျပပုံ အတုိင္းေရးဆြဲ သြားရမည္ ျဖစ္သည္။

၃) ေအာက္ေဖာ္ျပပါ ပံုအတိုင္း 199 mm ရိွေသာ တံခါးေပါက္ကုိ ညာဖက္နံရံ တြင္ Addရန္ -



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၄) 914 mm အက်ယ္ရိွေသာ တံခါးေပါက္ 15 ခုကို ေအာက္တြင္ dimensioned မ်ားျဖင့္ ေဖာ္ျပေပးထားသည့္ အတုိင္း Add

လိုက္ပါ။ ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ dimensions မ်ား အတုိင္း drawing ကိုဖန္တီးလုိက္ပါ။

၅) 610 mm အက်ယ္ရိွေသာ တံခါးေပါက္ 6 ခုကုိ ေအာက္ေဖာ္ျပပါ ပုံအတိုင္း Add လိုက္ပါ။

၆) Wall-Interior layer တြင္ 124 mm အက်ယ္ရိွေသာ အတြင္းနံရံမ်ားကုိ ဖန္တီးလိုက္ပါ။ 336 mm ထူေသာ နံရံမွာ 3

ခုရိွမည္။ အျခားေသာ အတြင္းတံခါးအားလုံးမွာ 915 mm အက်ယ္ရိွရပါမည္။ နံရံမ်ားအတြက္ ေအာက္တြင္

ေဖာ္ျပေပးထားေသာ ပုံ၌ dimensions မ်ားျဖင့္ ေဖာ္ျပေပးထားသည္။ ထုိပုံအတုိင္း က်န္ေသာ geomentry မ်ားကို

လိုက္ပါေရးဆြဲလိုက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၇) Files အားလံုးကိုမ Save ပဲပိတ္လိုက္ပါ။

Imperial Units

၁) I_ARCH-Challenge- CHP05.dwg ကိုဖြင့္ပါ။

၂) 7” အထူရိွေသာ နံရံကုိယ္စားျပဳ geomentry ကုိ အျပင္နံရံ အျဖစ္ ကုိယ္စားျပဳ ေရးဆြဲထားေသာ Original line ေပၚတြင္

ေရးဆြသဲြားရမည္ ျဖစ္သည္။ ေလွကားပါ၀င္ေနသည့္ ေအာက္ေဖာ္ျပပုံ အတုိင္းေရးဆြဲ သြားရမည္ ျဖစ္သည္။

၃) ေအာက္ေဖာ္ျပပါ ပံုအတိုင္း 3'-0" ရိွေသာ တံခါးေပါက္ကုိ ညာဖက္နံရံ တြင္ Addရန္ -



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၄) 36” အက်ယ္ရိွေသာ တံခါးေပါက္ 15 ခုကုိ ေအာက္တြင္ dimensioned မ်ားျဖင့္ ေဖာ္ျပေပးထားသည့္ အတိုင္း Add

လိုက္ပါ။ ေအာက္တြင္ေဖာ္ျပ ေပးထားေသာ dimensions မ်ား အတုိင္း drawing ကိုဖန္တီးလုိက္ပါ။

၅) 24” အက်ယ္ရိွေသာ တံခါးေပါက္ 6 ခုကုိ ေအာက္ေဖာ္ျပပါ ပုံအတုိင္း Add လုိက္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၆) Wall-Interior layer တြင္ 5" အက်ယ္ရိွေသာ အတြင္းနံရံမ်ားကို ဖန္တီးလိုက္ပါ။ 13.5"ထူေသာ နံရံမွာ 3 ခုရိွမည္။

အျခားေသာ အတြင္းတံခါးအားလံုးမွာ 3'-0" အက်ယ္ရိွရပါမည္။ နံရံမ်ားအတြက္ ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံ၌

dimensions မ်ားျဖင့္ ေဖာ္ျပေပးထားသည္။ ထုိပုံအတုိင္း က်န္ေသာ geomentry မ်ားကုိ လိုက္ပါေရးဆြဲလိုက္ပါ။

၇) Files အားလံုးကိုမ Save ပဲပိတ္လိုက္ပါ။

Challenge Exercise: Mechanical



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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ဤလက္ေတြ႕ ေလ့က်င့္ခန္းတြင္ အထက္၌ေလ့လာျပီး ခ႕ဲေသာ altering objects ဆုိေသာ သင္ခန္းစာမ်ားမွ modify tools

မ်ားျဖင့္ Floor plan modify လုပ္ျခင္းကုိ လက္ေတြ႕ေလ့က်င့္သြားရမည္ ျဖစ္သည္။

The completed exercise

၁) M_MECH-Challenge- CHP05.dwg ကိုဖြင့္ပါ။

၂) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ geomentry မ်ားကို ထိပ္ဆံုးတြင္ ေဖာ္ျပထားေသာ ပုံအတိုင္းျဖစ္ေအာင္

ျပင္ဆင္ေရးဆြဲၾကည့္ပါ။



“Workgroup” AotoCAD & 3ds Max Job Training Center မွ ပညာဒါန အခမ့ဲ ျဖန္႔ေ၀သည္။

( ဤစာအုပ္ကုိ ေငြေၾကးျဖင့္ ျပန္လည္ေရာင္းခ် ခြင့္မျပဳ )

ေအာင္ေဇာ္လတ္ {(Master of Engineering in Science and Production Engineering) Moscow State University Of Railway Engineering}

ဘာသာျပန္ ေရးသား ျပဳစုသည္။
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၃) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ geomentry မ်ားကို ထိပ္ဆံုးဒုတိယေနရာ၌ ေဖာ္ျပထားေသာ ပုံအတိုင္းျဖစ္ေအာင္

ျပင္ဆင္ေရးဆြဲၾကည့္ပါ။

၄) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ geomentry မ်ားကို အထက္မူရင္းပုံတြင္ ေဖာ္ျပထားေသာ ပုံအတိုင္း ျဖစ္ေအာင္

ျပင္ဆင္ေရးဆြဲၾကည့္ပါ။ Fillet ၏ radiusကို 3 mm သတ္မွတ္ေပးရမည္။

၅) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ ပုံသည္ အေပၚညာဖက္တြင္ ရိွေသာ area မွ geomentry ကို copy လုပ္ေပးရမည္

ျဖစ္သည္။
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 Geomentry ကိုနဂိုမူရင္း ပုံထက္ Scale ၂ဆ တင္ေပးလိုက္ပါ။

 Scaled လုပ္ထားေသာ geomentry ပတ္လည္တြင္ Cirlce ေရးဆြဲေပးလုိက္ပါ။ ျပီးလွ်င္ Circle အတိုင္း

geomentry ကုိ trim လုပ္ပါ။

၆) ေအာက္တြင္ ျမင္ေတြ႕ေနရေသာ Assembly Objects မ်ားကုိ Copy လုပ္လုိက္ပါ။ Hidden န႕ဲ centerlines ကုိမူ

မလုိအပ္ေပ။

 Start Points layer ကို Thaw လုပ္ပါ။

 Assembly Start Point ကုိအသုံးျပဳျပီး Assembly ၏ View ကို ေနရာျပန္လည္ သတ္မွတ္ေပးပါ။

 Geomentry မ်ားကို လုိအပ္သလို Erase လုပ္ေပးပါ။
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၇) Assembly Start Point ကုိညြန္ျပထားေသာ ညႊန္တံနွင့္ Text ကုိ delete လုပ္လိုက္ပါ။

၈) ေအာက္ပုံတြင္ ေဖာ္ျပေပးထားသည့္ အတိုင္း centerlines ကိုအေသးစိတ္ ေရးဆြဲေပးလိုက္ပါ။

၉) Hidden layer ကုိ current အျဖစ္ထားျပီး hidden geometry မ်ားကို ေအာက္ပါပုံအတုိင္း ဖန္တီးေပးလိုက္ပါ။

ထုိ႕ေနာက္ centerline objects မ်ားဖန္တီးျပီး Centerline layer ေအာက္တြင္ ထားေပးလိုက္ပါ။
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၁၀) ေအာက္တြင္ ေဖာ္ျပေပးထားေသာ geomentry ကို copy လုပ္လုိက္ပါ။ Hidden geometry ကို Visible layer

သုိ႕ေျပာင္းလိုက္ျပီး၊ မလိုအပ္ေသာ geomentry မ်ားကုိ delete န႕ဲ trim လုပ္ေပးလုိက္ပါ။ Hole geometry မ်ားကုိ delete

လုပ္ပါ။

၁၁) Start point မွညာဖက္တြင္ ျမင္ရေသာ sections မ်ားကို Copy လုပ္လိုက္ပါ။ Hidden lines မ်ားကို visible layer သုိ႕

ေရြ႕ေျပာင္းေပးျပီး၊ မလုိအပ္ေသာ geomentry မ်ားကို remove လုပ္လုိက္ပါ။

၁၂) Files မ်ားကို Save ျပီး ပိတ္လိုက္ပါ။

Chapter Summary

Desings တုိင္းသည္ ရိုးရွင္းေသာ geomentry မ်ားျဖင့္သာ စတင္ဖန္တီးထားၾကျခင္း ျဖစ္ပါသည္။ ထိုရိုးရွင္းေသာ

geomentry မ်ားကို edit လုပ္ျပီး၊ ရႈပ္ေထြးမ်ားျပားကာ ရုပ္လံုးၾကြလာေအာင္ ဖန္တီးၾကရပါသည္။

Modify command အမ်ားစုပါ၀င္ေသာ ဤ chapter ေလ့လာျခင္း ျပီးေျမာက္သြားပါက ေလ့လာသူမ်ား အေနျဖင့္ -

 Trim န႕ဲ Extend commands အသံုးျပီးျပီး objects မ်ား၏ length ကိုျပဳျပင္ေျပာင္းလဲ တတ္လာမည္။

 Offset command ကုိအသုံးျပဳျပီး၊ geometry မ်ားကုိ parallel န႕ဲoffset လုပ္တတ္လာမည္။
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 Join command ကိုအသံုးျပဳျပီး၊ objects နွစ္ခုကို Join ေပးျပီး object တစ္ခုတည္း ျဖစ္လာေအာင္ ဖန္တီး

တတ္လာမည္။

 Object တစ္ခုတည္းကို မိမိတို႕ လိုအပ္သေလာက္ အပိုင္းပိုင္း ျဖစ္ေအာင္ ဖန္တီးတတ္လာမည္.

 Stretch command ကုိအသံုးျပဳျပီး၊ drawing အတြင္းမွ Object မ်ား၏ ပုံသ႑ာန္ကို ေျပာင္းလဲ

တတ္လာမည္ျဖစ္ပါသည္။


